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Preface

Topics in this chapter:

■ About Composite on page 1
■ About This Guide on page 2
■ Getting Help on page 2

About Composite
Composite is Autodesk’s interactive solution for film compositing. It brings
compositing and visual effects tools to high-end 2D artists working at HD, 2K,
4K or above, in film, television, and design. It features a full High Dynamic
Range (HDR) pipeline, next-generation 3D compositing, high performance
interaction at extremely high resolutions, and advanced rendering. It primarily
features a database-less workflow for data management, one Composite seat,
one scripting license, and unlimited rendering capabilities.

The Composite creative toolset includes keying, color correction, tracking,
camera mapping, paint, spline-based warping, motion blur, and depth of field.
Furthermore, it can be updated with extensions that add functionality to the
product by means of new tools and core fixes.
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About This Guide
The Composite User Guide is made up of two major sections: Getting Started
and Reference.

Getting Started
This section describes the basic information you needs to know in order to
get up and running with Composite quickly. Topics ranging from key interface
features and accessing the Help provide you with everything you need to start
compositing now! It is strongly recommended that you read this section before
exploring the Reference portion of the User Guide.

Reference
This section provides in-depth information about all the tools and key features
associated with Composite. Some features discussed in the Getting Started
section are described in further detail here. The reference section includes
advanced topics and is most useful for users who have a good understanding
of Composite basics.

Getting Help
There are two ways to access Help for Composite, depending on whether you
want more information on a particular subject or whether you need assistance
with a specific problem

Viewing Online Help
Autodesk provides documentation in an HTML help system displayed in a
Web browser. The Help is automatically installed with the software.

To launch the Help, do one of the following:

1 From the Composite menu, choose Help > Composite Help.

2 From the Windows taskbar, choose Start > programs > Autodesk > Autodesk
Composite 2011 > Composite Documentation > Online Help.

The Help appears in the browser window.

2 | Chapter 1   Preface



Contacting Support
For further assistance, please contact Technical Support at the following
address: http://www.autodesk.com/subscriptionlogin.

Contacting Support | 3
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Part 1: Getting Started

Getting Started includes these chapters:

■ About Getting Started on page 7

■ Interface Fundamentals on page 9

■ Start Compositing Now! on page 77
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About Getting Started

Topics in this chapter:

■ About The Chapters on page 7

About The Chapters
The Getting Started section describes fundamental Composite concepts and
explains some of the tool’s basic functionality, which should allow you to begin
using Composite as quickly as possible. Here is a brief description of the chapters
included in this section.

Interface Fundamentals
This chapter provides the first detailed descriptions about some essential
Composite interface features. Composite interface mechanics like the Gate UI
and the Pick List, as well as critical functions such as zooming and panning,
and working with nodes are explained. You’ll find more in-depth information
about some of the features discussed here, like The Player, in the Reference
section.
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Start Compositing Now! A Simple Workflow Overview
This chapter provides you with a step-by-step example of how to composite
using Composite. The goal is to demonstrate how easily you can begin to use
the tool, even before you explore some of the more advanced topics covered
in the Reference section.
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Interface Fundamentals

Topics in this chapter:

■ Basic Interface Functions on page 9
■ The Gate UI on page 12
■ The Drop Gate on page 14
■ The Composite Interface on page 17
■ Tools, Views & Pick List tabs on page 30
■ The Player on page 34
■ Zooming and Panning on page 39
■ Navigating and Browsing on page 40
■ Working with Schematic on page 50

Basic Interface Functions
An intuitive set of editing functions are available to manipulate elements, such
as compositions, folders, and so on. These include basic functions for cutting,
copying, pasting, and deleting, as well as more advanced functions.

3
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Mouse, Pen, Keyboard
You can interact with the user interface using a mouse or a pen and graphics
tablet, in concert with the keyboard. If you have a mouse wheel, you can use
it to scroll through menus.

NOTE To generate a right-click with a pen, press the Context Menu key in
concert with the pen. If a key board includes a Context Menu key, it is typically
located three keys to the right of the Spacebar.

Cutting, Copying and Pasting
Standard cut, copy, and paste commands let you manipulate elements, such
as composition and folders.

To cut or copy, then paste an element:

1 Right-click the element and select Cut (Ctrl + X for Windows, Linux
or Cmd + X for Mac OS) or Copy (Ctrl + C for Windows, Linux or
Cmd + C  for Mac OS).

2 Navigate to the location where you want to paste the element. Then
right-click the location and select Paste or press (Ctrl + V for Windows,
Linux or Cmd + V for Mac OS).

Entering Text
Tools such as the Slate and Notes tools require that you type into text editor
fields.

To accept changes in a text editor field, do one of the following:

■ Press Enter in the case of a single-line editor.

■ Press Ctrl + Enter in the case of a multi-line editor.

■ Click outside the editor.

To revert to the previous text:

■ Press Esc.
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For more text editor/field hotkey combinations, see Text Editor and Text Fields
on page 820.

Dragging and Dropping
You can drag and drop the contents of most folders in the user interface. In
the user preferences, you can choose whether you see the ghosted image of
the composition or not. See Setting User Preferences on page 168.

Undoing and Redoing
You can undo most operations. You can also redo any operation you undo.

To undo or redo an operation, do one of the following:

■ From the Edit menu, select Undo (or press Ctrl + Z for Windows, Linux
or Cmd + Z for Mac OS). Or select Redo (or press Ctrl + Y for Windows,
Linux or Cmd + Shift +Z for Mac OS).

■ Or, in the taskbar, at the bottom of the UI, locate the Undo icon. The last
action performed is displayed beside it. Then do one of two things:

■ To undo the last operation you performed, click the arrow next the
Undo icon.

■ To undo any operation other than the last one you performed, or to
redo an operation, click the text to the right of the Undo button, and
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select the operation you want to undo or redo from the list. Note that
the arrow that appears in the list indicates the most recent operation
you performed. This operation and all operations above it are operations
you can undo. All operations below the arrow are ones you can redo.

Things to Remember:

■ You set the maximum number of items in the undo/redo list in the user
preferences General tab.

■ Browsers have a separate undo/redo list.

■ Press Ctrl + Y for Windows and Linux, or Cmd + Shift + Z for
Mac OS to redo an operation.

Deleting Elements and Compositions
You can delete an element, such as a composition or folder.

To delete an element do one of the following:

■ Select the element and press Delete.

■ Right-click the element and select Delete.

The Gate UI
The Gate UI allows you to access any of the four hidden panels in the
workspace. The Gate UI resembles a compass; it has four gates that each
correspond to one of the hidden panels. The gates are distributed along the
four cardinal directions.
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The four gates are as follows:

Displays:Gate:

The Schematic overlay. This is a semi-
transparent, larger view of the Schematic.

a) North gate

You can set the transparency of the back-
ground and nodes in the overlay, in the
Creative tab of the User Preferences.

Pick List, Tools, or Views tab (depends on
the last chosen option). You can drop

b) East gate

views onto viewports, add tools to compos-
itions, and access the Pick List -- see Tools,
Views & Pick List tabs on page 30.

View options for the view on which the
cursor is currently paused. For example, if

c) South gate

you access the Gate UI when the cursor is
over a Player, the south gate will display
the Player options.

The Composition Browser.d) West gate

To access the Gate UI:

1 Press the tilde (~) key or middle-click your mouse. The Gate UI appears.

2 Swipe north, south, east or west. The panel associated with that gate
appears.

3 To exit the panel. move the cursor away from the panel.
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NOTE  If you press the tilde (~) key, or middle-click and swipe simultaneously,
the Gate UI is not displayed. If you press the Alt key while swiping, the panel
will stay open until you press Esc.

The Drop Gate
Similar to the Gate UI in appearance, the Drop Gate appears when you drop
a composition or a tool into a Player, Layer Editor, or Schematic view. The
available options for the Drop Gate depend on whether you are dropping a
tool or composition, the view you are dropping it in, and also what node is
currently selected in the dependency graph. For example, if you drop a
composition on a Reaction node in the Schematic view, the Composition
Drop Gate appears.

Here are the options associated with the Drop Gate when used in conjunction
with a composition or a tool.

To use the Drop gate when dropping a composition, do the following:

1 Either drop a composition into the Player or Layer Editor. Or, drop a
composition onto a tool in the Schematic view.

2 Then swipe through the appropriate option to select it, or click to cancel
the drop.

NOTE If you drop the composition or tool, and swipe to select an option
simultaneously, the option is executed but the Drop Gate is not displayed.
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To use the Drop gate when dropping a tool do one of the following:

1 Drop a tool into a Player, Composition Browser (with no composition or
tool selected), or Layer Editor (with no composition or tool selected).

2 Or, drop a tool onto a selected composition in the Schematic view or the
Composition Browser. The Tool Drop Gate appears.

3 Or, drop a tool onto a selected tool in the Schematic view or the
Composition Browser.
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4 Or, drop a tool onto a primary output node in the Schematic view or a
selected primary output node in the Composition Browser.

5 Drop a tool onto a secondary output node in the Schematic view or a
selected secondary output node in the Composition Browser. The Tool
Drop Gate appears.
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6 After you have performed one of the preceding actions, swipe through
the appropriate option to select it, or click to cancel the drop.

The Composite Interface
The Composite interface may include a variety of views and elements, all of
which are designed to ensure a seamless and intuitive workflow. Each preset
contains views typically used to perform particular tasks.
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Views and elements include:

a Menu Bar  This is always visible by default and cannot be modified. See
The Menu Bar on page 19.

b Viewports  There can be one or more viewports in the Composite
interface, depending on the currently selected preset or on a user-defined
layout. You can populate the viewports with views such as the Player,
the Schematic, and Browser views. See Viewports and Views on page 20.

c Tool UI  Displays information about the current tool or composition,
or the current view when accessed from the Gate UI. You can edit
information, or set options and attributes in this view. It is composed of
four main sections: Animation controls, Player controls,
Node-Independent tabs and Node-Specific tabs. See The Tool UI on page
23.

d Taskbar  This is always visible by default and cannot be modified. You
can, however, show/hide the taskbar by pressing Ctrl + T(for Windows
and Linux) or Cmd T(for Mac OS). See Taskbar on page 29.
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The Menu Bar
The menu bar appears at the top of the Composite window. It contains the
following menus: File, Edit Preferences, and Help. There is also a minimize
button at the far right.

To show or hide the menu bar: press Ctrl + M.

To:Use:

Open new or existing projects, close or
save projects, import projects, archive or
render projects, create new versions, per-
form pre-compositing, import projects, or
exit projects.

Undo, redo actions, access the Hotkeys,
Project and User preferences and the Lay-
out presets.

The Menu Bar | 19



To:Use:

Create, delete, rename, reset layout pre-
sets. Or set a layout preset as default.

Allows you to load or reload scripts.

Access Composite help or documentation,
Python scripting info, Learning Movies or
Tutorials, the Support Centre, Release
Notes, The AREA, the Hotkeys doc, Script-
ing, Token Substitutions and Initialization
Variables, and About Composite.

Minimize the Composite window

Viewports and Views
The Composite UI is composed of one or more viewports and populated with
one or more views.

Viewport
A viewport is simply a container in which you can drop a view into. You can
modify a viewport’s layout using the Layout icon in the taskbar. You can
change a viewport’s size or drag it to another location by placing your cursor
over a viewport border. See Taskbar on page 29.
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Views
You can access all available views from the Views tab, using the Gate UI and
then dragging a view into a viewport.

NOTE You cannot undo a drag view operation. If you frequently add or remove
specific views, you can add them to the Pick List for even faster access.

A view can be:

1 A view where you work on or view your composition;

2 A browser where you work with files.

The following views are available:

DescriptionView

Allows you to edit animations.Animation

Allows you to view and to work with all
the tools and parameters in a composition

Composition

in a browser format. See The Composition
Browser on page 48.

Allows you to create compositions by im-
porting media and provides a view of the
folders that your installation references.

File Browser

Allows you to add, edit and reorder layers
associated with one or more Reaction
compositing nodes.

Layer Editor

Allows you to store frequently used tools,
views and compositions. See Pick List on
page 141.

Pick List

Allows you play a composition. The Player
options determine what appears in the
Player. See Player on page 153.

Player

Allows you to build a dependency graph
for a composition. See Working with
Schematic on page 50.

Schematic
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DescriptionView

Scripting

Allows you to add a tools browser to any
viewport.

Tools

Four Views: a) File browser b) Layer Editor c) Schematic d) Player

To add a view to a viewport:

1 Press the tilde key or middle-click your mouse to display the Gate UI,
then swipe through the east gate to display the Tools, Views and Pick List
tabs.

2 Select the Views tab.
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3 Select a view and drag it into a viewport.

To display a view in a fullscreen view:

1 Pause over a view you want to display as a fullscreen view and press the
F key.

2 In the Player controls, click the fullscreen button to play the composition.

The view displays as a fullscreen view. Press F to exit the fullscreen view.

The Tool UI
The Tool UI is located at the bottom of the user interface, just above the task
bar. It allows you to view information about the composition which is currently
open, as well as view and adjust settings for any of the tool nodes in that
composition.
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The Tool UI has four main areas:

Description:Item:

Controls for setting and working with cue
marks and keyframes. See Keyframing
Workflows on page 674.

a) Animation controls

Controls for playing media associated with
a composition, in any of the views. See
Using the Player Controls on page 36.

b) Player controls

A set of tabs that contain information
about the composition and controls that

c) Details or node-independent tabs

are relevant for any of the nodes in the
composition.

A tab that contains information and con-
trols specific to the currently selected node
in the composition.

d) Tool UI or node-specific tabs

Node-Independent Tabs
There are several node-independent tabs, including (from left to right in the
user interface): Composition, Versions, Metadata, Animation, Cue Marks and
Pick List. Here is a short description of each tab:

Composition: Displays information about the composition you currently have
open.
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Versions: Displays a list of all current versions, including the working or current
version, associated with the composition you currently have open.

Metadata: Displays the description of the composition you currently have
open, along with any custom attributes you have added. You can use this tab
to edit the data associated with an individual field.

Animation: Displays controls for animating individual variables in the
composition. See The Animation Tab on page 661.

Cue Marks: Displays the list of cue marks set for the composition you currently
have open. See Working with Cue Marks on page 668.

Pick List: Provides a place for storing frequently used tools, view and
compositions. See Working with the Pick List on page 142.
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Node-Specific Tabs
One or more node-specific tabs appear when you select a node in a
composition. For example, if you select the CC Histo tool, you’ll see that it
has a main tab, as well as a Ranges tab. You will typically select a node from
the Schematic view, from the Composition Browser or from the Layer Editor
context menu.

Each composition node has a tab associated with it. In the case of imported
media, the composition node for the composition you currently have open
has an Image Import tab that contains the same information as in the Import
browser when you imported the media to create the composition -- see
Importing Media on page 115. The composition node for a linked composition
has a Link Image tab that contains a list of the rendered output associated
with that composition -- see Linking Compositions on page 234.

A vertical bar in the tab indicates more options may exist underneath the area
to the right of the bar. Drag right on the bar to expose the options.

The contents of most tool node tabs are organized into left and right areas.
The left hand area contains Player-related controls and direct manipulation
controls unrelated to the Player (for example, in the Diamond Keyer, the color
prism), and fields and widgets you can use to set or enter values. The area on
the right is the Tool Options area; these options are common to all tools.

The top row is used for selection history and navigation, and contains the
following controls:

(a) Navigate to previously selected node (b) Navigate to next selected node (c) Go to
home node (d) History (e) Set Home

a Navigate to previous node  Navigate nodes before current selection.

b Navigate to next node  Navigate to nodes selected after current selection.
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c Go to home node  Navigate to node set as Home node.

d History  View entire node list and select a node.

e Set Home  Set a home node from the history list. To set another node
as a home node, select a node name and click Set Home.

The next set of controls is for using Tool presets. See Tool Presets on page 146.

(a) Preset (b) Save (c) Load (d) Reload

a Preset  Displays the name of the tool preset currently loaded in a
selected tool node.

b Save  After customizing a tool, you can save it as a tool preset.

c Load  Displays a list of tool presets.

d Reload  Reloads the currently selected tool node with the same tool
preset. This lets you revert back to the parameters contained in the tool
preset.

The lower portion of the Tool Options area contains the following controls:

(a) Back One Keyframe (b) Set Keyframe (c) Forward One Key (d) Mute (e) Reset (f)
Name (g) Time (h) Affects (i) IR (j) Delete

a Back one keyframe  Move back one keyframe in the currently selected
animation curve for this too node. For more information on setting the
animation keys, see Keyframing Workflows on page 674.

b Set keyframe  Set Keyframe: set a keyframe in the animation editor for
this tool node. For more information on setting the animation keys, see
Keyframing Workflows on page 674.
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c Forward one key  Move froward one keyframe in the currently selected
animation curve for this tool node. or more information on setting
animation keys, see Keyframing Workflows on page 674.

d Mute  Mute the currently selected tool node. This is a convenient way
to toggle the effect of that node on or off. When you mute a tool node,
the node has no effect on the input it receives; it simply passes that input
to the next tool node in the dependency graph. If you mute a tool node
that accepts multiple inputs, the node passes its primary input to the
next too node.

NOTE  Note that muting a tool node may not always be equivalent to
removing it from the dependency graph. That is, if the input and output
formats of a tool node are different, removing the tool node may cause format
conflicts in nodes further along the dependency graph, but muting the tool
would not cause format conflicts. For example, if the format of the output is
different from that of the primary input, the muted node adjusts the format,
possibly in a tool specific way. For example, a muted Diamond Keyer node
outputs a solid white matte, a muted Noise node outputs a black image. You
cannot mute a supertool.

e Reset  Resets all parameters of this tool node to their default values.

f Name  Examine or edit the name of the currently selected tool node.
To edit the name, click in the field, enter your edits, and then press Enter.

g Time  Displays the global and local time in a node affected by a Time
Offset tool. Enables Global to display the global time in the field to the
right of the Global button. Disables Global to display the local time of
the node in that field.

h Affects  Specifies the channels (RGB, RGBA, or A) the currently selected
tool uses. The options available depend on the currently selected tool.
In some tools, this options may not be available.

i IR  Allows the currently selected tool node to create an intermediate
result whenever you play the composition. You can also enable or disable
intermediate results in the Schematic, by clicking the IR tab in the
bottom-right corner of the node icon; this tab is orange when you enable
IR. See Caching on page 226.

j Delete  Delete the currently selected tool node.
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Taskbar
The taskbar anchors the user interface and gives you immediate and consistent
access to frequently-used core features and commands, such as presets, undo,
warning messages, as well as the current composition, version, project, and
user. The taskbar is located at the bottom of the desktop.

To show or hide the task bar, press Ctrl + T on Windows and Linux, or
Cmd + Ton Mac OS.

The following describes each element in the taskbar, from left to right.

To:Click:

Display the Preset list. You can choose from
preconfigured presets or create your own.

Select a different layout for the current
preset. Click the icon and select a layout.

Undo or redo an operation. Click the arrow
icon to undo the last operation in the list,
or click the text beside the arrow to display
the list of operations performed. The arrow
that appears in the list indicates your cur-
rent position in the undo list; all operations
above it are operations you can undo, and
all operations below are ones you can redo.
In the User Preferences window (General
tab), you can specify the number of undo
levels.

View messages. When messages are issued,
the icon color reflects the severity: white,
yellow, or red. Click the message area to
display a list of messages received to date.
In the User Preferences window (General
tab), you can specify the type of messages
that are displayed and the maximum
number of items in the User Preferences.

Start the render queue monitor or view the
progress of a render. Click the icon to start
the render queue monitor. Click the num-
ber and select a background rendering task
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To:Click:

from the list that appears; the number in-
dicates how many render tasks in the list
are currently in progress. The progress bar
to the right of the render task name in the
list shows the task's progress: a blue bar is
displayed as the task progresses and is
completed successfully. A gray bar is dis-
played if the render task failed or was can-
celled (the text "failed" is also displayed if
a failure occurs). To remove a failed or
completed render task from the list, select
it, and then respond to the prompt for re-
moval. To cancel a task that is in progress,
select it, and then respond to the prompt
for cancellation. To delete a task in pro-
gress, first cancel it, and then delete it.

Displays the list of compositions that are
currently open. The name of the current
composition is displayed beside the icon.
If the user opens a composition version,
the version name appears to the right of
the composition name. The gray icon rep-
resents a read-write version, while a yellow
icon represents a read-only version. To
switch to a composition (or version), select
it from the list.

Open the Project Preferences window. The
current project is displayed beside the icon.

Open the User Preferences window. The
user name is displayed beside the icon.

Tools, Views & Pick List tabs
Tools and Views tabs display all the available tools you can add to
compositions, as well as the views you can display. Tools and views are stored
in their respective folders. When you click a tool category folder, the tools are
displayed in the lower portion of the panel.
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The Pick list tab provides you with easy access to frequently used tools, view
and other elements. Each user has a Pick List. Its contents are independent of
any project and are consistent across sessions. The Pick List exists as a tab in
two locations: a) through the east gate of the Gate UI and b) the tool UI.

a) Pick List tab

b) Pick List in Tool UI

To display the Tools, Views and Pick List tabs:

1 Middle-click or press the tilde (~) key to display the Gate UI.

2 Swipe through the east gate and select one of the tabs.
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To drag an item from the Tools or Views tab:

 ➤ In the Tools or Views tab, select an item from the lower portion of the
panel, and drag it into a view. If you drag a tool into the Schematic view,
you can drop it onto any connection to insert it in the composition.

a) Tool Category b) Tools

For more information on views, please see Viewports and Views on page 20.
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For more information on the Pick List, please see Pick List on page 141 in the
Getting Familiar with Your Workspace chapter.

In addition to regular tools, there is a specific category of tools known as Super
tools. A super tool is a tool that is composed of a set of tools. Super tools
include Macro, Reaction, Garbage Mask, 2D Compositor, Image Import, Keyer,
Tracker, and Paint. Super tools are indicated by a sphere icon.

For more information on each of these super tools, please see the following:

■ The Macro Super Tool on page 699

Tools, Views & Pick List tabs | 33



■ Reaction Compositing and Effects on page 240

■ Garbage Mask Tool Tabs on page 538

■ 2D Compositor on page 339

■ Using the Image Import Tool on page 125

■ Keyer Super Tool on page 522

■ About Tracking and Stabilizing on page 754

■ About Raster Paint on page 567

■ Vector Paint on page 595

The Player
The Player is used to play or preview a composition, or preview media. There
are three different versions of the Player: the Player View, the Mini-Player and
the Fullscreen Player.

■ The Player View: Allows you to play compositions and view the changes
you make to compositions as you work. You can drag a Player View from
the Views tab and drop it into a viewport.
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■ The Mini-Player: Allows you to preview compositions located in the Footage
folder or on your Desktop. See The Mini-Player on page 211.

■ The Fullscreen Player: This version of the player is useful when you want
a more immersive environment. You can use it to play compositions, work
on compositions, and preview media. See The Fullscreen Player on page
213.
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Using the Player Controls
The Player controls are shared by all Player views. The Start Frame, End Frame,
and Current Frame numbers in the Player controls reflect those of the currently
selected Player.

The Player controls allow you to:

■ Play a composition

■ Set the repeat mode for the playback

■ Scrub through the composition

■ Adjust the start or end frames of the composition

■ Set a cue mark

■ Move to an existing cue mark

■ Delete a cue mark

■ Set a keyframe manually

■ Move to an existing keyframe

■ Turn Autokey on or off

To play a composition:

To:Click:

Play the composition backward.

Play the composition forward.

Enter the fullscreen Player. Press theF key
to return to the Player view.

Step backward one frame.

Step forward one frame.

Move to mark in.
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To:Click:

Move to mark out.

To set the repeat mode:

Click the Repeat Mode on the left of the Player controls, and select a repeat
mode from the menu:

To set the repeat mode to:Select:

No repeat. Playback ends when the Player
reaches the last frame of the composition.

Loop continuously.

Ping-pong. Plays the composition forward
to the last frame then backward to the first
frame, in a continuous cycle.

No repeat, to restrict playback to the re-
gion between the mark in and mark out
frames.

Loop continuously, restrict playback to the
region between the mark in and mark out
frames.

Ping-pong, restrict playback to the region
between the mark in and mark out frames.

To scrub through a composition:

Click and drag in the Current Frame field.

To adjust the start or end frames of the composition:
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a) Start Frame field b) End Frame field

Click and drag in the Start Frame field to adjust the start frame for the
composition, and/or in the End Frame field to adjust the end frame for the
composition. The Start and End fields in the Composition tab of the Tool UI
update to reflect the changes you make here.

To set a cue mark:

Advance to the frame for which you want to set a cue mark, then click the
Set Cue Mark button.

The cue mark appears in the Current Frame field.

To move to an existing cue mark:

Click a cue mark button on the left of the Player controls to move to an
existing cue mark.

To:Click:

Move to the previous cue mark.

Move to the next cue mark.

To delete a cue mark:

In the Tool UI, select the Cue Mark tab, locate the cue mark you want to delete,
then right-click and select Delete.

To set a keyframe manually:

1 Mark the attributes for which you want to set a keyframe. See Marking
Attributes for Keyframing on page 674.
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2 Advance to the frame at which you want to set a keyframe.

3 Click the Set Keyframe button.

To move an existing keyframe:

Click a keyframe button on the left of the Player controls to move to an
existing keyframe.

To:Click:

Move to the previous keyframe of the cur-
rently selected tool node.

Move to the next keyframe of the currently
selected tool node.

To turn Autokey on or off:

Click the Autokey button. See Setting Keyframes Automatically on page 680.

For more information on the player, please see The Player on page 189.

Zooming and Panning
You can zoom or pan in the Schematic view and in any of the three player
views: Player View, the Mini-Player, and the Fullscreen Player.

To zoom do one of the following:

■ In the view or player, press the Up Arrow to zoom in, or the Down Arrow
to zoom out.

■ Press Ctrl + Spacebar (on Windows, Linux) or Cmd + Spacebar
(on Mac OS) and drag to the right to zoom in or left to zoom out.

■ Press Home to reset the zoom factor to 1. Pressing Home again will set zoom
to previous zoom factor. This is not available to all viewers.
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To pan:

■ In the view, press Spacebar and drag.

To navigate views:

■ Press Ctrl + Tab to move to the next view. Press Ctrl + Shift +
Tab to move to the previous view.

Things to remember:

■ When you zoom out in a Player view, the resolution is automatically
adjusted to the optimal one for that zoom level. This reduces the load on
the computer.

Navigating and Browsing
The Composite File browser enables you to locate, organize, and manage
compositions, projects, etc.

The File browser is a central tool in the overall Composite workflow. It has
the following general uses:

■ Identifies Composite compositions or external media, such as files on a
hard disk.

■ Helps you locate, organize, and manage compositions already in a project.

■ Provides access to compositions for Composite tools and for Composite
utilities.

Customizing the File Browser
You can resize any component panel in the Composite browser by dragging
its side. For example, you can change the division between the Folders and
Contents area in the File browser by dragging the border between the two
areas.

40 | Chapter 3   Interface Fundamentals



The File Browser
The File Browser provides a view of the folders that your installation references.
It also allows you to create compositions by importing media.

The Folders area in the File browser shows the hierarchy of available folders
in your project, as well as external drives and resources, in an expandable
tree-like structure. By default, the Folders area appears on the left side of the
browser, but you can close it to increase the size of the Contents area.

To show or hide the folders area:

■ Click the View button and select Folder.
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Browser Settings and Controls
The File Browser contains the following main areas and buttons:

DescriptionItem

Displays the file system on your machine,
including all mapped drives, as well as

Folders list

Wiretap. Using this area, you can navigate
to the media you want to import.

Displays the contents of the folder cur-
rently selected in the Folders list.

Folder Contents area

Use these buttons to navigate through
folders and files.

Navigation buttons

These are the navigation buttons:

NOTE You can also navigate in the browser using Hotkeys. See Browsers on page
823.

To:Use:

Return to the top level of the project
folder.

Home:

Move back through the folder list in the
File Browser.

Back:

Move to the level of the parent folder.Up:

You can enter paths in this field. Paths can
be separated by either forward or back-
ward slashes.

Path Field:

View a list of recently viewed folders. Place
the cursor over a visited folder and click its
name to return to that folder.

Recent:

Change the way a browser displays inform-
ation. See The View Button on page 43.

View:
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To:Use:

Navigate to a directory. See The Book-
marks Button on page 44.

Bookmarks:

Opens the selected files and adds them to
the current Composite composition. If the

Open:

File Browser selection is a Composite
composition, this button will be labeled
Open, and will open the selected compos-
ition.

The View Button
A view is how the browser displays information in the Contents area. You can
view information as a list or as thumbnails in the Contents area. The List view
displays more information in the Contents area than other views and allows
you to easily sort information by clicking one of the column headings. A
thumbnail is an icon for a folder, source, or composition. There are thumbnails
for folders, fonts, audio, and so on. The thumbnails for sources or compositions
show a frame.

You can change thumbnails to show a source or composition's matte, if it
contains one.

The folder hierarchy shows folder relationships: child folders cascade from
the parent folder(s). Parent folders are displayed with triangle icons that cascade
child folders below and to the right when clicked. The area below the folder
shows either thumbnails or a list of the folder's contents depending on the
mode you're in (list or thumbnail).

To view thumbnails or a list in a browser:
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Click the View button and select Thumbnails to view thumbnails. Deselect
Thumbnails to see a list.

To change the thumbnail size in the Contents area:

Click the View button and select Small or Large.

The sources or compositions in the Contents area are resized as follows:

Size (in pixels)Thumbnails

160 x 120Small

249 x 180Large

To view mattes:

Click the View button and select Alpha.

Thumbnails for sources or compositions with mattes display their black and
white matte. Thumbnails for sources or compositions without mattes remain
in color.

The Bookmarks Button
Bookmarks allow you to quickly navigate to a directory. Click the button and
then click a name in the pop-up list. Clicking a bookmark's name positions
the browser in the target directory just as if the path had been entered
manually.
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There are five predefined bookmarks, which cannot be removed or renamed.
They are the following:

CommentValueFunctionName

Depends on the “Set as
Home” setting

Not edit-
able

Shorthand to browser's
home

Home

Depends on selected
project

Not edit-
able

Bookmarks location of
project root

Project
Home

Depends on user logged
on

Not edit-
able

Bookmarks location of
user directory

User Data

Depends on user logged
on

No editableHome directory of user
logged on

OS User
Home

Not edit-
able

Composite installation
folder

Install
Folder

In addition to the predefined bookmarks, personal bookmarks can also be
created. There are two methods to create personal bookmarks:

To create a personal bookmark:

From the bookmarks list, select Add Bookmark or press Ctrl + D (on
Windows and Linux) or Cmd + D (on Mac OS). The Add Bookmark dialog
appears.
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Or right-click on a directory in the File browser and select “Bookmark,” to
bookmark that directory.

All personal bookmarks are automatically assigned the name of the bookmarked
directory, or the name of the bookmarked directory plus a "#" extension, where
"#" is the first number, beginning with 1, which makes the name unique.
Although multiple bookmarks can share the same target directory, duplicate
naming of bookmarks is not permitted. The "#" extension ensures that no two
bookmarks have exactly the same name. For example, if you name a bookmark
"New Bookmark," and then try to give another bookmark the same name, it
will be named "New Bookmark (1)."

Managing Bookmarks

Bookmarks are managed through the Bookmark Manager.

It is used for the following tasks:

■ Adding new bookmarks
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■ Creating bookmark folders in order to categorize bookmarks

■ Editing personal bookmark labels

■ Editing personal bookmarks or the Media bookmark's target

■ Customizing the bookmarks and bookmark folders order

■ Moving personal bookmarks from one folder to another

■ Removing bookmark folders and personal bookmarks

To manage bookmarks:

1 Use the Manage Bookmarks option. It is accessible through the bookmarks
pop-up list.

2 Clicking Manage Bookmarks opens the Bookmark Manager.

3 Use the up or down arrows to rearrange the order of the bookmarks in
the Bookmark Manager. Click the Sort button to arrange the bookmarks
in alphabetical order.
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Floating File Browser
You can also display the File Browser as a floating browser, so that you can
use it at any point during a session to access project folders.

To display the floating File Browser, do one of the following:

■ Press Ctrl + O (for Windows and Linux) Cmd + O (on Mac OS) or to
open the File Browser with the “Show Compositions Only” view option
set.

■ Press Ctrl + I (for Windows and Linux) orCmd + I (for Mac OS) to
open the File Browser without the “Show Compositions Only” view option,
i.e. view all files.

The Composition Browser
The Composition Browser displays all the nodes for the current composition.
Using this browser, you can view parameters and set keyframes for animation.
It's also an easy way to quickly view parameter names when referencing them
in expressions.
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The Composition Browser has three columns. The Name column contains the
name of the node or attribute. The Value column contains the value associated
with an attribute. The M (marked) column indicates whether an attribute is
marked for keyframing.

The Composition Browser is also available in the Animation tab of the tool
UI.

Composition Browser Functionality
There are five buttons at the bottom of the Composition Browser: the Filters
Option button, the Filter button, The Auto Expand button, The Expand
Column button, and the Collapse Column button.

The Filters Options Button

The Filters Options lets you select one or more filters. The filters are divided
into two groups: Tools and Channels.

Multiple filters are additive (except for the All filter option, which unselects
other filters and shows all nodes). For example, clicking Mute and Context
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Point would display muted nodes as well as nodes that have a context point
set on them. Therefor adding tool filters adds tool nodes to your display.

To:Click:

Tools

Display tools (in the result) that are currently selected.Selected

Filter tools that are similar to the selected tools.Similar

Display tools (in the result) that are muted.Muted

Filter tools that have context points on them.Context Point

Display all nodes in the composition.All

Channels

Display nodes (in the result) that contain channels
that are animated.

Animated

Filter inputs that are connected to expressions.Expression

Display nodes (in the result) that contain channels marked for
keyframing.

Marked

The Filter Button

Click this button to apply the filters you have selected.

The Auto Expand button

Click this button to expand the parent folders of the selection and center on
the first item, when the global selection changes.

The Expand Columns button

Click this button to expand all the columns in the browser.

The Collapse Columns button

Click this button to collapse all the columns in the browser.

Working with Schematic
The Schematic is the view in which you build the composition – a set of
connected nodes – for a composition. When you create a new composition,
the only node in the tree is the output node; by default, every composition
has only one primary output node.
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NOTE Unless otherwise specified, the term “node” and “tool node” are
interchangeable throughout this guide.

When you create a composition by importing media, the composition contains
one input node (which points to the media you imported) and one output
node. You then build the dependency graph by adding tool nodes. For more
detailed information on the different types of nodes, see Node Overview on
page 52.

You can set the direction in which processing proceeds in the User Preferences
Creative tab. For 2D workflows, you can build the dependency graph
left-to-right or top-down direction. For 3D workflfows, you can build the
dependency graph in a left-to-right or bottom-top direction -- see Setting User
Preferences on page 168.

A dependency graph with left-to-right flow.

A dependency graph with a top-down flow.

NOTE Nodes do not necessarily have to be connected. For example, you can
create branches that you connect or disconnect to experiment with different
scenarios.
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When working in the Schematic view, you can:

■ Show or hide the Schematic Navigator.

■ Clean up the view (clean up all or a portion of the composition,
automatically zoom to fit the dependency graph in the view).

■ Change the name of a node.

■ Work with connections (connect one node to another, insert a node
between two nodes, disconnect one node from another, reposition a node
within the composition, change the appearance of connections, have
connections highlight when you pass the cursor over them).

■ Work with groups and super tools (create a group, edit a group or enter a
Super tool, exit a group or a Super tool, ungroup a group, add inputs and
outputs to group nodes).

■ Work with branches (collapse or expand a branch).

■ Mute or unmute a node.

■ Turn intermediate results on or off for a node.

■ Set or clear a context point on a node. See Setting Context Points on page
191.

■ • Reset the node to its default values.

■ Cut, copy, paste, or delete nodes. Navigate nodes.

NOTE When using super tools or working inside a grouped tool, the name of the
tool or group is displayed a the bottom of the Schematic, so you always know
where you are in relation to the dependency graph.

Node Overview
There are several different types of node features, as well as different types of
node connections.
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Node Types
There are a number of different types of nodes, each represented by a different
icon.

DescriptionNode type

An input node for a composition created
during a normal media import. It is identi-
fied by a small sheet icon on the left of the
proxy. When you select an imported media
input node, the tool UI displays the Import
Image tab. The input node displays a proxy
of the media it references.

An input node for footage, created using
“Import as Footage”. It is identified by a
small film icon on the left of the proxy. The
Link Image tab opens when a footage in-
put node is selected in the Schematic view.

An input node for a linked composition. It
is identified by a small composition icon
on the left of the proxy. When you select
a linked composition input node, the tool
UI displays the Link Image tab. The input
node displays a proxy of the rendered
output it references.

A normal tool node.

A super tool node. Each super tool can
have its own icon. The Reaction super tool
icon is shown here. A super tool node be-
haves as a group node in that you can
enter the node to work with the tools it
contains.
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DescriptionNode type

A group node that you create by selecting
two or more nodes and grouping them
together. You can right-click a group and
select Edit Group to work only with the
nodes in that group.

A visual group node is similar to a normal
group node, however you are able to see
its contents without entering it. You can
also change its background color.

The primary output node for a composi-
tion. A dependency graph always has ex-
actly one primary output node. You cannot
delete this node, but you can add second-
ary output nodes to the composition. See
Multiple Output Nodes on page 56. The
output node represents the result of the
composition. When you select this node,
the tool UI displays the Output tab. The
output node does not display a proxy of
the result.

A secondary output node for a composi-
tion. Note that secondary output nodes
vary slightly in appearance from the
primary input node, it is a lighter gray.

Node Anatomy
Each node has a set of tabs around its outer edge. The name of each node
appears either underneath it or inside it.

Description:Tab:

You connect an input to this tab. If a node
accepts multiple inputs, the tab is divided

Input

into the number of inputs the node ac-
cepts.

■ A node that accepts a single input:
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Description:Tab:

■ A node that accepts nine inputs:

Contains the output of the node. You cre-
ate connections between nodes by connect-

Output

ing the output tab of one node to the in-
put tab of another. The Output node con-
tains the result of the dependency graph.
Note that you can connect an output to
more than one input.

Click this tab, or the T hotkey, to show or
hide the proxy for the node.

Proxy
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Description:Tab:

There is an input for masking. See Pixel
Masking on page 560.

Masking

Click this tab to enable intermediate results
for the node. See Caching on page 226.

Intermediate Result

A yellow icon appears nest to the image
input tab when the tool has been marked

Marked for keyframing icon

for keyframing. See Marking Attributes for
Keyframing on page 674.

Output Nodes
There are several characteristics of Output nodes that are useful for you to
know.

Multiple Output Nodes
A composition can support multiple output nodes which provide simultaneous
renders from different points in the dependency graph. This characteristic of
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the composition lets you link to a composition at different points in the
dependency graph.

An output node cannot be muted, however, intermediate results can be enabled
on output nodes and output nodes can be grouped at any level. There's no
restriction on the presence of an output node at the highest group level (the
composition level).

Each output node has its own format (resolution, pixel aspect ratio, rate,
channels and depth) and it crops its input image according to its format.

An output node has the following editable values. You can reset the values
back to their defaults in the Tool Options area (Reset button):

Description:Value:

Initialized to Output (#).Name

Of arbitrary length, empty by default.Description

Width, height, pixel aspect ratio and rate. Primary output is
initialized from the composition project settings, additional
outputs from the primary output.

Image Format

Channels and depth. Primary output is initialized from the
composition project settings, additional outputs from the
primary output.

Pixel Format

Start frame index. Primary output is initialized from the compos-
ition project settings, additional outputs from the primary out-
put.

Start

End frame index, exclusive. Primary output is initialized from
the composition project settings, additional outputs from the
primary output.

End

End – Start.Duration

Frame used for Proxies, defaults to start value.Poster
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Description:Value:

Whether the width, height, pixel ratio and rate values follow
the primary output values. Always off on primary output. On
by default on additional outputs.

As Primary Output
Image Format

Whether the channels and depth values follow the primary
output values. Always off on primary output. On by default on
additional outputs.

As Primary Output
Pixel Format

Whether the start, end and poster values follow the primary
output values. Always off on primary output. On by default on
additional outputs.

As Primary Output
Time

Whether the output is rendered upon a render command, on
by default.

Rendered on/off

Render mode used upon a render command. Set by the com-
position render mode project setting by default.

Render mode

Primary Output
One of the outputs is tagged as being the primary output. Aside from
identifying the principal output of a composition, the primary output is most
useful in the following workflows:

■ The composition start/end (in the timeline) and rate are dictated by the
primary output start/end and rate respectively.

■ Composition format displayed in the File Browser is driven by the format
of the primary output.

■ Composition proxies shown in the File Browser are generated from the
primary output.

■ Player in Composition display mode shows the image results of the primary
output node.

■ Comparison in the player against the composition refers to the primary
output.

■ When linking to a composition, even though all outputs of the linked
composition are represented on the link node, only the primary output
socket is automatically connected to the destination graph.
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■ When inserting a composition into another one, the input node of the
primary output from the source graph is used as the connection point
when the composition is dropped on an input socket in the destination
graph.

■ When dropping tools in the Schematic view, the south gate option Add
Before Primary Output connects the new nodes before the primary output
node.

■ Additional outputs are initialized (or reset) with the values of the primary
output. Other outputs can also follow various sets of values from the
primary output (image format, pixel format, time).

The first output node that is automatically created with a new composition
is the primary output by default. However, in a composition with multiple
outputs, any output can be set as the primary output at any time. This can be
achieved through a drop-down menu listing the output node names in the
Composition tab.

You can also use the Set As Primary right-click option on an output node in
the Schematic view.
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Adding Output Nodes
Creating a new composition automatically adds an output node to it. However,
you can add more output nodes anywhere in the composition.

To add an output node to a composition, do one of the following:

■ Drag the output tool from the Utilities folder in the Tools tab and drop it
into the Schematic view.

■ Select an output node in the Schematic view, right-click and select Copy,
or press Ctrl + C (for Windows and Linux) or Cmd + C (for Mac OS).
Then right-click again and select Paste or press Ctrl + V (for Windows
and Linux) or Cmd + V (for Mac OS).

■ If you have added the Output tool to a Pick List, right-click in the Schematic
view and select the Output tool from the Pick List.
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Deleting Output Nodes
The primary output node cannot be deleted, which ensures that a composition
has at least one output. Graphical delete options on the primary output are
absent and any attempt to delete it in another way (hotkey or scripting) results
in an error message.

To delete a secondary output node, do one of the following:

■ In the Schematic view, highlight the secondary output(s) you want to
delete, right-click and select Delete or press the Delete key.

■ Highlight the secondary output node(s) you want to delete in the
Composition Browser, right-click and select Delete.

Node Connections
The connection lines in a dependency graph visually indicate by color and
style what you are outputting: RGBA, RGB or A. You can also choose how you
want the lines to appear: curved, angled or straight.

OutputLine StyleColor

RGBASolid lineGray

RGBDashed lineLight-blue
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OutputLine StyleColor

ADashed lineWhite

To change the appearance of a connection line:

1 Middle-click or press the tilde key (~) key to display the drop gate, and
swipe south to the Schematic Options.

2 Under Display, select an option form Links for the connection lines.

NOTE You can also set the links style in your user preferences. See Setting User
Preferences on page 168.

Node Options
There are a number of ways to manipulate nodes in the Schematic view.

To clean up all or a portion of the dependently graph, do one of the following:

1 To clean up the complete tree, right-click and select Layout All, or press
Ctrl + L (for Windows and Linux) or Cmd + L (for Mac OS).

2 To clean up a portion of the tree, select the nodes to clean up, then
right-click, and select Layout Selected or press L.

To reset the zoom and pan to fit the dependency graph:

 ➤ Right-click and select Reset Zoom/Pan or press Home.

To change the name of a node:

1 Select the node to display its tabs in the tool UI.
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2 In the Tool Options at the right, click in the Name field and edit the
name.

3 Press Enter to accept your edits.

The node in the Schematic view updates to reflect the new name.

To display the details of a node without opening a node:

1 Press the D key and pass the cursor over a node. Shift + D will turn
on all the node details without having to pass over the node. Press Shift
+ D again to turn off the node details.

2 A tooltip displays the details of the selected node. If the node was
renamed, the node's original name appears in the tooltip.

To display the thumbnail of a node, select one or more nodes and do one of
the following:

1 Right-click the node and select Thumbnail.

2 Click T.

3 Click the tab on the node.

To connect two nodes, do one of the following:

1 Click the output of a node and drag to the input of another node (or
click and drag from the input area of one node to the output area of
another). A gray connection line appears as you drag. Release to create
the connection.

2 Press Shift and drag one of the nodes to the other, so that the output
area of one node brushes, or "kisses", the input area of the other. A
connection line appears when the two nodes kiss. Release to establish
the connection. If you want to cancel the operation, release Shift as
you continue to drag.
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NOTE There are hotspots located along each edge of the viewer to be used to
auto-pan the viewer when holding the cursor down over these areas for a
predetermined time. This will be used when dragging or connecting nodes. The
speed at which the panning is done can be controlled by using the Ctrl hotkey
to speed up panning or the Alt hotkey to slow down panning.

To insert a node between two other nodes:

 ➤ Press Alt and drag the node you want to insert onto the connection line
between the two nodes, then release. If you want to cancel the operation,
release Alt as you continue to drag.

To disconnect nodes, do one of the following:

1 Press Ctrl and drag the cursor (scissors icon) through the connection.

2 Right-click the connection line between the nodes and select Disconnect.

To quickly disconnect and reconnect nodes:

 ➤ Hold down the Ctrl key, click one end of a connection link to break
the link. Drop the link on a different node.

To reposition a node within a dependency graph, do one of the following:

1 Disconnect the node and then connect it in a new position.

2 Press Alt and drag the node to a new position in the tree, then release.
The connection lines adjust to disconnect the node from its previous
neighbors and connect it in the new position.

To replace a node’s tool with another tool:

1 Display the Tools, Views & Pick List tab by middle-clicking or pressing
the tilde (~) key. Drag and drop a tool onto the selected node. A drop
gate appears.

2 Swipe through the Replace option. The selected node is replaced with a
new tool.

To create a group consisting of multiple nodes:

Select the nodes you want to group, right-click one of the nodes and select
Group or Group (Visual). You can also press G for Group or Shift + G for
Group (Visual).
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NOTE If more than one node is selected, they will be grouped. If there is only one
node selected and it is not a group node, it is grouped, otherwise if it is a group
node, it is ungrouped.

When you create a visual group node, all the nodes in this group display
semi-transparent backgrounds that allow the nodes to adopt the color of the
visual group itself. Nodes which are not part of the visual group that are
dragged over the group will stand out because they will be a different color
from the nodes in the visual group.

Visual group nodes are created with a default color. However, by right-clicking
on the title bar of the visual group, you can select the Color option, which
will display a color picker that allows you to choose a new color.

A new node-independent tab is created in the Tool UI for the group node. By
default, it will be named "Group (#)," for example, "Group(1)." You can rename
the group tab by entering a new name in the Name field in the Tool Options.

To edit a group or enter a super tool:

1 Right-click the group node (to edit a group) or the super tool (to enter
the super tool) and select Edit Group, or double-click the node.

2 The Schematic view updates to display the nodes in the group or the
nodes of the super tool.

To exit a group or a super tool:

 ➤ Right-click in the Group Schematic view and select Exit Group, or
double-click the background.

To resize or move a visual group node:

 ➤ The size of the visual group node is determined by the location of the
contained nodes. The size of the visual group node will expand or contract
as the contained nodes are moved around. To move a visual group node,
drag the title bar of the group node.

To lock a visual group or lock the nodes in a visual group:

1 Right-click on the title bar of a visual group node and select Lock, which
locks the group node, as well as all the nodes inside the group. This means
that all the nodes inside the group, as well as the group itself, are locked
in place.
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2 To lock just the nodes inside a group, while still allowing the group itself
to be moved, right-click on the title bar of the visual group node and
select Lock Tools.

To open or close a visual group node:

1 To open a group node, right-click on the node and select Open or press
Shift + O. Opening a group node displays the contents of the group
node while applying the visual group attribute.

2 To close a group node, right-click on the title bar of the group node and
select Close or press Shift + C. Closing a group node removes the
visual attributes of the node and collapses it back to its regular appearance.

To ungroup a group:

 ➤ Right-click the group node or the title bar of the visual group node and
select Ungroup, or press G.

To add input or output connections to a group node:

1 Enter the group node by double-clicking the node, then drag the link
from an input or output beyond the top border of the schematic. Control
will be transferred to the group level one up in the hierarchy. At this
point, releasing beyond the border will create a connection node. Moving
within the border will allow connection to another node. If this group
level is not the top most, moving within the border and back up again
will transfer control to the next group up in the hierarchy. Moving down
in the group hierarchy is accomplished by dragging beyond the bottom
border of the Schematic view. All dragging must be done in conjunction
with the Shift hotkey.

2 Enter the group node by double-clicking the node, then right-click and
select New Output Connection. Note that the cursor must be over an
input or output.
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To collapse a branch of the dependency graph:

1 Locate the node at which you want to collapse the branch.

2 Right-click the node and select Expand or Collapse or press E.

3 The branch leading into that node collapses. The arrow on the left of the
node indicates a collapsed branch.

To expand a collapsed node:

 ➤ Right-click the node containing the collapsed branch and select Expand
or Collapse, or press E.
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To mute or unmute a node:

1 Select the node.

2 Right-click a node and select Mute or Unmute, or press M.

NOTE You can also mute/unmute a node by selecting it and clicking the Mute
button in the Tool Options area. This button is located to the left of the Reset
button.

To select an entire branch of the dependency graph, do one of the following:

1 Press X and click a node.

2 Right-click and choose Select Upstream.

All nodes upstream are selected.

Hint: You can select multiple branches without clearing the selection.
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To turn intermediate results on or off for a node:

 ➤ Click the orange tab in the lower-right of the node. The orange tab
brightens or darkens to indicate results are, respectively, on or off for the
node. See Caching on page 226.

NOTE You can also turn intermediate results on/off for anode by selecting the
node and clicking the IR button in the Tool Options area.

To set a context point on a node:

1 Press the number of the context point you want to set and click the node
on which you want the context point, or right-click the node and select
Context # (Set). For example, to set context point 3, press 3 and click the
node.

2 The number of the context point, preceded by the letter C (for example
C3 for context point 3), appears to the left of the node name and a broken
green line appears around the center of the node.

3

NOTE If you set more than one context point on a node, the numbers of all
context points set on the node appear after the C. For example, C134 indicates
you set context points 1, 3 and 4 on the node.

To clear a context point on a node:

1 Press the number of the context point you want to clear and click the
Schematic background or right-click the node and select Context #
(Remove).

2 The context point label (for example C4 for context point 4) is deleted
along with the broken green line around the center of the node.

To reset a tool node:

 ➤ Right-click the tool node you want to reset and select Reset, or press Ctrl
+ R (for Windows and Linux) or Cmd + Shift + R (for Mac OS).

NOTE You can also reset a node by selecting it and clicking the Reset button in
the Tool options area.
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To cut, copy or paste one or more nodes:

1 Select the node(s) you want to cut or copy.

2 Then, do one of two things. To cut the node(s), right-click one of the
selected nodes and select Cut, or press Ctrl + X (for Windows and
Linux) or Cmd + X (for Mac OS). To copy the node(s), right-click one
of the selected nodes and select Copy, or press Ctrl + C (for Windows
and Linux) or Cmd + C (for Mac OS).

3 To paste the cut or copied node(s), right-click outside all nodes and select
Paste, or press Ctrl + V (for Windows and Linux) or Cmd + V (for
Mac OS).

To delete one or more nodes:

1 Select the node or nodes you want to delete.

2 Then, do one of the following. Either right-click one of the nodes and
select Delete, or press Delete. Or drag a reasonable distance outside the
bottom edge of the Schematic view and release. A garbage icon will appear
to indicate the point at which it is possible to release the node.

NOTE You can also delete nodes by selecting then and clicking the Delete button
in the Tool Options area of the tool.
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To select all nodes, do one of the following:

1 Right-click the Schematic view and choose Select All.

2 Press Ctrl + A (for Windows and Linux) or Cmd + A (for Mac OS).

All nodes and connection lines are selected in the Schematic view.

Selecting Nodes Upstream and Downstream
Drill-Down is a way to change the currently selected node without depending
on a viewer, such as the Schematic view or the Composition browser. It changes
the current node by navigating upstream (towards inputs) or downstream
(towards outputs) using hotkeys. It only allows navigating through connected
nodes.

To navigate through a series of nodes, do one of the following:

1 Press Alt + Shift + Left arrow to select the upstream node
connected to the current node's primary input.

2 Press Alt + Shift + Right Arrow to select the first downstream
node connected to the first output.

3 Press Alt + Shift Down arrow to select the next node for the last
direction taken. For example, after pressing Alt + Shift + Left
Arrow to go towards the primary input, pressing Alt + Shift +
Down Arrow will select the node on the second input. It works similarly
for outputs: pressing Alt + Shift + Down Arrow will visit the next
node connected the output, or go to the next output, whichever applies.

4 Repeatedly press Alt + Shift + Down arrow to cycle through the
candidates in their order of presentation.

5 Press Alt + Shift + Up arrow to select the previous candidate
for the last direction taken, following the same logic as for Alt + Shift
+ Down arrow.

Cycling Through Inputs and Outputs
For easy display of a node's multiple inputs and outputs in the Player, you
can cycle the inputs or outputs shown by the Player using hotkeys. When in
tool input mode in the Player, pressing the 5 hotkey a second time cycles to
the next image input. Once the last input is reached, pressing the 5 hotkey
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again cycles back to the first image input. When in tool output mode in the
Player, pressing the 6 hotkey a second time cycles to the next image output.
once the last output is reached, pressing the 6 hotkey again cycles back to the
first image output.

For added flexibility, you can assign a context point to a tool node. For
example, while viewing the output of a tool in one Player, you may also want
to view the result of a composition, matte, or other Keyer super tool output
in another Player. To do this, add a context point (C1, C2, C3 or C4) to the
Keyer super tool and assign a Player view to that context point. Then, use the
context point's hotkey number (1, 2, 3 or 4) to cycle through the Keyer's
outputs. See Setting Context Points on page 191.

Schematic Options
You can set a number of display and playback option for the Schematic view.

To access the Schematic options:

1 With the cursor over the Schematic view, middle-click or press the tilde
(~) key and go through the south gate.

2 The settings for that Schematic view are displayed.

NOTE If more than one Schematic view is open, your cursor must be placed over
the Schematic view on which you want to set options.

To set the display options:

■ Select the display tab.

■ Then set the display options.

To:Select:

Show or hide the Schematic Navigator. By default, the Navig-
ator is displayed.

Navigator
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To:Select:

Expand and highlight the tabs of a node when you pass the
cursor over them.

Highlights

Change the line style of connections. Lines can appear as:
Curved, Straight, or Angled.

Links

■ Finally, set the placement options.

To:Select:

Automatically organize all of the nodes in the dependency
graph.

Auto Layout

Automatically zoom to keep the complete dependency graph
visible in the center of the Schematic view.

Auto Zoom

Automatically locates a specific node in the Schematic when
you select in the Composition browser.

Locate Node

NOTE You can make any of the display settings the default settings for the view
by selecting them in your user preferences. See Setting User Preferences on page
168.

To hide the Schematic Navigator in the full screen Schematic:

1 Middle-click or press the tilde (~) key to display the drop gate, and swipe
north to view the full screen Schematic.

2 Middle-click or press the tilde (~) key to display the drop gate, and swipe
south to the Schematic Options.

3 Under Display, select Navigator to hide the Navigator. By default, the
Navigator is visible.

To set the playback options:

■ Select the Playback tab.
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■ Then set the ViewerTime options:

To:Set:

Sets the view to global time. Disable to use its own global time.Follow Master

Lets you set a frame offset for the time. The frame offset is with
respect to the time you set for the view. For example, if you set

Offset

a frame offset of 5 and selected the Follow Master option, the
proxy in the view always displays the frame that is five frames
ahead of the frame currently running in global time. If you
deselected Follow Master, the proxy in the view always displays
the frame that is five frames ahead of the frame running in the
local time of the view.

Updates the proxy at each frame when you play the composi-
tion. Deselect to update proxy only when you stop playing the

Update on Play

composition, and only at the scrub frames when you scrub
through the composition.

■ Finally, set the Frame Rate options:

To:Set:

Plays all frames in the composition, regardless of whether it
maintains the frame rate set for the composition. Deselect to

Play All Frames

have the view maintain the frame rate for the composition, at
the expense of dropping the frames where necessary.

Lets you set the frame rate at which you want the Schematic
view to play the composition. Type the frame rate in the field

User

to the right of this button, or click and drag the bottom edge
of the field to adjust the value.

Stops the Player if a tool is dropped into the dependency graphStop on Drop
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Things to Remember:

■ Each Schematic view has its own set of options except for the flow
(left-right, top-bottom, etc.)

Schematic Options | 75



76



Start Compositing Now!

Topics in this chapter:

■ Try First, Read Later on page 77
■ Start Composite, Create Composition, Import Media and Go on page 77
■ Add Media on page 81
■ Add Tools on page 83
■ To Render the Composition on page 86

Try First, Read Later
This chapter will allow you to start experimenting with Composite tools right
away. You’ll find that many of the tools available in Composite are probably
familiar to you, and as soon as you import some media, you can start trying it
out. Later on, you’ll want to review the Projects on page 95 and Getting Familiar
with Your Workspace on page 139 chapters to get a deeper understanding of
how best to take advantage of Composite’s many capabilities.

Start Composite, Create Composition, Import
Media and Go
To get up and running fast with Composite, simply start Composite, create a
composition, add media and start working. When you import media into

4
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Composite, it becomes a composition that you can open, or use to insert or
link to/from another composition. The Tool UI at the bottom of the Composite
desktop shows composition information, and updates to show the Tool UI of
the tool you are currently working with.

Composite comes with a set of default user interface presets, called task group
presets, that let you begin working effectively, immediately. Presets are grouped
according to task; you simply choose the desired task group and a preset
displays a UI configuration with the views you need to perform a particular
task. After you've chosen a preset and created a composition, press the tilde
key (~) or middle-click to display the Gate UI. Swipe to the right (east) and
choose a tool from the Tools tab.

NOTE You can, of course, customize presets or create your own.

To start a new composition in Composite:

1 Start Composite.

NOTE You can choose to watch one of the Essential Skills movies, or just
close the dialog box.

2 The Composite desktop is displayed with the following views: Schematic,
Player, and Tool UI/Tool Options.

(a) Schematic view (b) Player (c) Tool UI/Tool Options area
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3 From the File menu, select “New.”

4 The Create Composition dialog appears.

5 In the Name field, enter a name for the composition. You can change
the location of the composition in the field above the Name field. Once
you have entered the information, click the Create button.
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6 A new composition has been created.
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Add Media
When you have created a new composition, you can import media and then
add it to your composition and start working—see Importing Media on page
118.

To import media:

1 Select File > Import or press Ctrl + I( for Windows and Linux) or Cmd +
I(for Mac OS).

The File Browser appears.

2 Navigate to the location (on your machine or network) where your media
is stored. The View button at the bottom of the File browser allows you
to change the Details view to a Thumbnail display in the Contents area,
which is on the right side of the browser.
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3 In the Contents area, select the media file(s) you want to import. To select
multiple files, press Ctrl + click.

4 Click the Import button, or right-click one of the selected media files and
select Import File(s).

The media files are imported into the composition using an Image Import
tool.

82 | Chapter 4   Start Compositing Now!



Add Tools
Once your media is added, you can start to add tools to your composition.

To add tools to your composition:

1 Middle-click or press the tilde (~) key to display the Gate UI and swipe
east (right).

2 If it isn’t already selected, select the Tools tab.
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3 Select a tool and add it to your composition by dragging it into the
Schematic. For this example, we will add a Garbage Mask, a Panner tool
and a Blend & Comp tool.
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4 Use the controls on each tool to modify your composition:

■ Use the Garbage Mask to key out areas of the image which you don’t
need. See Garbage Mask Tool Tabs on page 538.

■ Use the Panner tool to position the image. See Panner Tool on page
437.

■ Use the Blend & Comp tool to blend the two images together. See
Blend & Comp on page 367.
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To Render the Composition
Now that you have completed your composition, you’ll want to render it.
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To render your composition:

1 Select the output node.

2 In the Tool Details area, select the Output tab.

3 Set the image format to the proper format you want to render.

4 Click on the render tab.
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5 Under the file format choose the sequence file format to be rendered.

6 The default is to name the rendered file the comp name and the output
name. Change the output name if desired.

7 Go to the file menu and choose render.
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8 The Render dialog appears. Click the Start button to start the rendering
process.
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Part 2: Reference

Reference includes these chapters:

■ About Reference on page 93

■ Projects on page 95

■ Wiretap on page 111

■ Importing Media on page 115

■ Getting Familiar with Your Workspace on page 139

■ The Player on page 189

■ Working with Compositions on page 217

■ Multilayer Compositing and 3D Effects on page 239

■ Pre-Compositing on page 299

■ Importing FBX Files on page 323

■ Premultiplication on page 337

■ 2D Compositing on page 339

■ Image Processing Tools on page 379

■ Pixel Expressions on page 439

■ Warping on page 467

■ Effects Tools on page 497
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■ Managing Film Grain on page 501

■ Pulling Keys and Creating Mattes on page 509

■ Masking on page 537

■ Raster Paint on page 567

■ Vector Paint on page 595

■ Color Correction on page 617

■ Animation on page 659

■ Time Tools on page 691

■ Customization Tools on page 699

■ Vectors on page 711

■ Expressions on page 719

■ Tracking and Stabilizing on page 753

■ Video Tools on page 795

■ Utilities on page 805
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About Reference

Topics in this chapter:

■ About the Chapters on page 93

About the Chapters
The Reference section goes into detail about Composite tools and functionality.
This section allows you to build on the Getting Started section by providing in
depth information about topics that were introduced in that section, as well as
the rest of the Composite application.

The Reference section contains the following chapters:

1 Projects on page 95

2 Wiretap on page 111

3 Importing Media on page 115

4 Getting Familiar with Your Workspace on page 139

5 The Player on page 189

6 Working with Compositions on page 217

7 Multilayer Compositing and 3D Effects on page 239
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8 Pre-Compositing on page 299

9 Importing FBX Files on page 323

10 Premultiplication on page 337

11 2D Compositing on page 339

12 Image Processing Tools on page 379

13 Pixel Expressions on page 439

14 Warping on page 467

15 Effects Tools on page 497

16 Managing Film Grain on page 501

17 Pulling Keys and Creating Mattes on page 509

18 Masking on page 537

19 Raster Paint on page 567

20 Vector Paint on page 595

21 Color Correction on page 617

22 Animation on page 659

23 Time Tools on page 691

24 Customization Tools on page 699

25 Vectors on page 711

26 Expressions on page 719

27 Tracking and Stabilizing on page 753

28 Video Tools on page 795

29 Utilities on page 805
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Projects

Topics in this chapter:

■ About Projects on page 95
■ Example Workflows on page 97
■ Setting Project Preferences on page 97
■ Archiving or Restoring on page 104

About Projects
Projects allow users to keep a part of their preferences separately, in order to
better accommodate separation of the work in multiple sub-tasks. For example,
a common way of using projects would be to have one project per special-effects
shot in a film. To this end, one would want, for example, to specify render
directories that will differ from one shot to the other, without having to re-type
them for every composition used within this shot. This is the kind of service
that project management is intended for. By comparison, the User Preferences
are more geared towards controlling the behavior of the user interface.

By default, project management is turned off in Composite, but can be enabled
by visiting the User Preferences (Edit->User Preferences). In the tab labeled
General, enable the Project Selection Dialog setting and click OK or Apply at
the bottom right. The project selection will be enabled for the next time you
start the application.
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When project management is turned off, Composite uses a default project file
that is called Default.txproject. You can view the location of this file by visiting
the project preferences (Edit -> Project Preferences) and viewing the
Information tab.

Project
The scope of a project depends on your facility's needs or individual projects.
It may be a complete film, a special effects shot, an image sequence, or any
other collection of shots/images. From an administrative point of view, a
project is a set of folders and a set of preferences.

NOTE You can use scripts to automate the creation of projects, either to build a
project structure from scratch, or to bring a project structure into Composite
(including media). For more information on scripts, see the Composite Python®

API online documentation (from the Windows Start menu, choose Programs >
Autodesk > Composite > Composite Documentation > Scripting API).

Project Preferences

At the beginning of a project, you can define the following preferences:

■ General  The physical location of the home folder and the command
line for the render queue.

■ Composition  The default format for any compositions you create in the
project, as well as the name template used when creating new versions for
this composition.

■ Render  To select a render folder, file name pattern, file format and
optional wiretap location.

■ Render Actions  To create render actions and define the command-line
associated with them.

■ Import  To define the folder in which imported media is stored.

■ Post-Import  To define tasks that can be executed after footage has been
imported. Caching is one of these tasks, but you can define arbitrary
post-import tasks that will become available in the contextual menus for
importing footage.

■ Pre-Compositing  To set the properties for working with pre-comp files—
see About Pre-Compositing on page 299.
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■ Tools  Tool-specific preferences can be set here. Currently only the CTL
tool allows these preferences — see CTL Tool on page 463.

■ Archive  The target directory and file name pattern of archives you create
in Composite, and the scripts that are executed to perform, archive and
restore operations.

■ Metadata  User Defined Attributes (UDA) editor for project-specific
attributes. You can add, modify or remove UDAs that can then be used in
token substitutions to form paths and file names.

For more information, see Setting Project Preferences on page 97.

Example Workflows
These examples let you perform administrative and project management tasks
in Composite.

TIP You can use scripts to perform virtually any task you can accomplish through
the user interface. For example, you might have a script that creates projects. Refer
to the Composite Python API documentation. In the Windows Start menu choose
Programs > Autodesk > Composite > Composite Documentation > Scripting API.

Workflow for administrative tasks during a project:

1 Import media—see Importing Media on page 118.

2 Set up and manage background rendering of the work produced during
the project.

3 Archive projects periodically to back them up—see Archiving or Restoring
on page 104.

Setting Project Preferences
You typically set project preferences when you first set up a project. If you
modify preferences during the project, the changes take effect from that point
on. The changes do not affect operations performed using the previous
preference settings. For example, if you change the Channel setting in the
Composition preferences from RGB to RGBA, the change has no effect on
compositions you created previously; those compositions remain RGB.
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NOTE All operations you perform during a session use the project preferences of
the currently open project.

NOTE Project preferences from a read-only file are not modifiable, unless saved
under a different location with read/write permissions, and then reloaded.

To set project preferences:

1 Open a project in Composite.

2 Do one of the following:

■ From the menu bar, select Edit > Project Preferences.

■ In the taskbar, click the project name or use the Ctrl + Alt + P hotkey.

The Project Preferences window is displayed.

Information on the project is displayed on the Information tab. It contains
basic information that is set automatically when the project was created.
You can enter a description of your project in the Description field. The
remaining tabs contain the preferences you can set for the project.

3 Select the General tab and set the preferences for the home folder and
the monitor executable.
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Home Folder  Indicate the path for the home folder.

Monitor Executable  Enter the command line that launches the render
queue monitor.

4 Select the Composition tab and set the media preferences for the project.
These preferences set the media format for any compositions you
subsequently create.

NOTE These preferences apply only to compositions you create in the project.
The compositions Composite creates when you import media retain their
original format information.

Format  Set the media format for the project. Select Custom to define
a custom format.

Width, Height  Displays the width and height (in pixels) of the selected
format. If you selected Custom in the Format box, you can click in these
boxes and edit the values.

Image Aspect Ratio  Displays the image aspect ratio of the selected
format. If you selected Custom in the Format box, you can click in this
box and edit the ratio.
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Pixel Aspect Ratio  Displays the aspect ratio of each of the pixels of the
selected format. If you selected Custom in the Format box, you can click
in this box and edit the ratio.

Rate  View the frame rate of the selected format. Click to display the
list of frame rates available for this format, and select the one you want
to use.

Version Name  Enter a default name pattern for new versions created
in compositions. You can enter any alphanumeric character, or click the
Comp Name, Date, Time, or Frame No. buttons to insert any of those
variables as part of the name. If you defined custom attributes, you can
also insert any of these as variables in the file name. Click the Select UDA
button to select the custom attribute you want to insert, then click UDA
to insert it. Note that the file name, after all variables are resolved, cannot
exceed 126 characters in length.Select a name for the composition version.

Channels  Select the channels you want the media for the new
composition to have by default. Select A to only have the alpha channel,
RGB to have only red, green, and blue channels or RGBA to have all
channels (red, green, blue, and alpha).

Depth  Select the bit depth (8, 16, or 32 bits) for new compositions.

Start, End, Duration  Set the start, end, and duration of the footage.

Repeat  Select the default repeat mode (Hold, Loop, Ping-Pong, No
Repeat) for new compositions when you play them in the Player.

5 Select the Render tab. Select a default file format and set the render folder,
file name pattern and Wiretap preferences.

6 Select the Render Actions tab.
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7 Select the Import tab to set preferences for the import operation—see
Channel Assignments on page 128 and Channel Groups (Import
Preferences) on page 131, Unpremultiply in Import Mode on page 134 and
Specifying the Destination Format on page 135.

Destination Folder  Enter the path to the project folder in which you
want to import media, when using the Import as Footage actions in the
contextual menus. By default the path is ad rectory inside the project
home folder, but you can specify any folder.

8 Select the Post-Import tab and add any command, such as Python
command(s), that will become available as post-import processing actions
in the contextual menus.
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9 Select the Pre-Compositing tab and set the preferences for importing
pre-comp files—see About Pre-Compositing on page 299.

10 Select the Tools tab and set the path for the CTL tool—see CTL Tool on
page 463.

11 Select the Archive tab and set the preferences for your archive and restore
operations—see Archiving or Restoring on page 104.

Archive Name  The name template, using substitution tokens, that you
select for the archive.
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Archive Folder  The folder or folder template (using substitution tokens)
in which archives are stored.

Archiving Executable  The command line that executes when you
perform an archive operation in Composite. It starts the archive.py script,
located in the \resources\bgTasks folder of the Composite program folder.
Consult the script for an explanation of each of the command line
options. You can click in the Archiving Executable field to edit the
command line. For example, you can edit the argument for the silent
option to prevent Composite from asking what archiving options you
want to use (i.e. you are always comfortable with the defaults).

NOTE The following are illegal characters in file names and will cause the
archiving to fail: *?:”<> (asterisk, question mark, colon, quote mark, open
angle bracket, close angle bracket).

Restore Executable  The command line that executes when you perform
a restore operation in Composite. This command line launches the
restore.py script, which is located in the \resources\scripts folder of the
Composite program folder. Consult the script for an explanation of each
of the command line options. You can click in the Restore Executable
field to edit the command line (for example to change the script that the
command line launches).

12 Select the Metadata tab and enter any information you'd like to describe
the project—see Creating UDAs on page 177.

Things to Remember

■ If you change preferences during the project, it does not affect operations
performed using the previous preference settings.

NOTE Any change done to a project must be confirmed using the OK button (to
confirm + dismiss) or Apply (to confirm and stay open).
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Archiving or Restoring
An archive can contain an arbitrary selection of folders, compositions and
project files. When archiving linked compositions, all versions of the linked
composition are included. If you archive a link, Composite archives the object
to which the link points, not the link itself.

When archiving a composition, you should save all versions. Otherwise, when
you restore the composition, you may be missing some versions. Also, if you
are archiving any dependencies, such as linked compositions, media, paint
strokes, and LUTs all compositions are opened to locate them.

NOTE You cannot append to an archive.

You can archive and restore elements, such as projects, compositions, and
folders. However, to enable you to selectively archive and restore certain
elements of the archive (such as linked compositions, media LUTS, and paint
strokes), Composite generates not just an .xml file, but also an archive folder
containing the .txarchive file, as well as .zip files which store external
dependencies.

NOTE Archives created with earlier versions of Composite have the .dlarchive
extension and are supported for backward compatibility.

When you create an archive, you can produce compressed or non-compressed
.zip files. The maximum size of a .zip file cannot exceed 2 GB. However, if it
does, then the file is skipped and the archiving process continues.

The name of each .zip file is generated by the archive name, the type of external
dependency it contains, and an index. For example, MyArchive.MEDIA.0001.zip,
MyArchive.MEDIA.0002.zip, MyArchive.PAINT_STROKES.0001.zip.

The archive output folder uses the archive name you specify. This folder is
created by default in the archive folder specified in the Project Preferences
window (Archive tab)—see Setting Project Preferences on page 97.

You can configure the archive operation as either a local or remote background
task. By default it is a background task on the local machine.

As for most tasks, you can use scripting to improve efficiency. Consult the
online Composite Python API documentation for help with scripts (in the
Windows Start menu, choose Programs > Autodesk > Composite > Composite
Documentation > Scripting API).
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To archive the current composition:

1 Select File > Archive.

2 In the dialog that appears, enter a name for the archive and click OK.

NOTE The Python script for archiving does not recognize file names that
contain any of the following characters: *?:”<> (asterisk, question mark, colon,
quote mark, open angle bracket, close angle bracket). A file name with any
of these characters causes the archiving script to fail.

If you are archiving a composition, the following dialog appears in which
you can choose the archiving options. External dependencies, such as
linked compositions, paint strokes, 1D LUTs, and 3D LUTs are on by
default for all external dependency types, with the exception of media.

3 Select the archiving options and click OK.

All external dependency files are stored in one or many .zip files named
after their type (for example, MEDIA, PAINT_STROKES, 1D_LUT, 3D_LUT).

WARNING Changing the name of a .zip file, moving or transferring an archive
will result in undefined restoration behavior.

To archive an element:

1 In the File Browser, in the Folder list, navigate to and select the element
you want to archive.

2 In the Folder contents area, right-click the element to archive and select
Archive.

3 In the dialog that appears, enter a name for the archive and click OK.
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NOTE The Python script for archiving does not recognize file names that
contain any of the following characters: *?:”<> (i.e. asterisk, question mark,
colon, quote mark, open angle bracket, close angle bracket). A file name with
any of these characters causes the archiving script to fail.

If you are archiving a composition, the following dialog appears in which
you can choose the archiving options. External dependencies, such as
linked compositions, paint strokes, 1D LUTs, and 3D LUTs are on by
default for all external dependency types, with the exception of media.

4 Select the archiving options and click OK.

All external dependency files are stored in one or many .zip files named
after their type (for example, MEDIA, PAINT_STROKES, 1D_LUT, 3D_LUT).

WARNING Changing the name of a .zip file, moving or transferring an archive
will result in undefined restoration behavior.

Archiving Linked Compositions
You can recursively archive the compositions to which a composition is linked.
Linked composition archiving is optional and is on by default. Linked
compositions are stored in the same .xml file as the compositions selected for
archiving. You can archive a composition and its linked compositions in the
same way that you archive a composition.

To archive a composition:

1 In the File Browser, in the Folder list, navigate to and select the element
you want to archive.

2 In the Folder contents area, right-click the element you want to archive
and select Archive.

3 In the dialog that appears, enter a name for the archive and click OK.
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NOTE The Python script for archiving does not recognize file names that
contain any of the following characters: *?:”<> (i.e. asterisk, question mark,
colon, quote mark, open angle bracket, close angle bracket). A file name with
any of these characters causes the archiving script to fail.

WARNING Changing the name of a .zip file, moving or transferring an archive
will result in undefined restoration behavior.

4 Select Linked Compositions and any other archiving option, and click
OK.

All external dependency files are stored in one or many .zip files named
after their type (for example, MEDIA, PAINT_STROKES, 1D_LUT, 3D_LUT).

Restoring Archives
Unlike archiving, all the compositions in the archive, including the linked
compositions, are restored. That is, there is no selective restoring of
compositions.

NOTE When restoring an archive that contains a user and its settings, the user is
skipped and a warning message is displayed.

To restore an archived element:

1 In the File Browser, navigate in the Folder list and locate the archive
element in the default archives folder—see Setting Project Preferences on
page 97.

2 Right-click the .txarchive file in the folder contents area and choose
Restore.
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Depending on the dependencies (if any), you are prompted to restore the
archived dependencies.

3 Select the dependencies to restore.

4 Relocate the restored archive and its dependencies.

The external dependencies in the .zip files are restored. If some .zip files
are missing because they were moved, transferred, or renamed, the
external dependency files will not be restored. However, they can be
relocated.

Relocating Dependencies
You can change the location of external dependencies in an archive when
you restore the archive. The ability to relocate external files allows an archived
file created on a Windows environment to be restored in a UNIX environment
and vice versa.

Once you choose to restore an archive and any external dependencies, a
relocation dialog box appears showing the path used by the external
dependency files in the archive.

To relocate external dependencies:

 ➤ Navigate in the Folders area in the browser, and edit or enter an absolute
path to relocate the external dependencies.
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NOTE Some external dependencies, such as paint stroke files, do not appear
in the relocation dialog box as these are stored by default in the shared storage
folder. You can change the default shared storage directory in the Project
Preferences window (Site Preferences tab)—see Setting Project Preferences
on page 97.

The external files are restored according to the information entered in
the relocation browser. The restored compositions are updated to point
to the relocated files.

Changing Default Archive and Restore Settings
You can change the default settings for archiving and restoring.

To change the default archive and restore settings:

1 Do one of the following:

■ From the menu bar, select Edit > Preferences > Project.

■ In the taskbar, click the project name.

The Project Preferences window is displayed.

2 Select the Archive tab and set the preferences for archive and restore
operations—see Setting Project Preferences on page 97.
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Wiretap

Topics in this chapter:

■ Accessing the IFFFS Libraries on the Network Using Wiretap on page 111
■ Accessing Media Via Wiretap on page 112
■ Accessing IFFFS Clips on page 113

Accessing the IFFFS Libraries on the Network
Using Wiretap
Composite supports Wiretap, an enabling technology that uses client-server
architecture to enable applications running on a client system to access projects,
libraries, clips and frames on a remote storage device. The data is presented in
a tree-like hierarchy and is accessible via the Wiretap Client API. The ability for
Composite to support Wiretap improves interoperability between Composite
and IFFFS applications. Wiretap is comprised of a Client API that taps into the
remote storage filesystem through a Wiretap Server plug-in running on the
remote system via a high-performance network protocol.

To access images on the IFFFS filesystem and network, the Wiretap servers
running on IFFFS workstations must be configured to offer Wiretap Path
Translation Service—see the Autodesk® Stone® and Wire® Release Notes.
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Wiretap Concepts
To ensure efficient browsing of the Wiretap network, here are some basic
Wiretap concepts:

Wiretap Network: A collection of Wiretap-compliant servers that reside on a
network domain.

Wiretap Server: A single Wiretap-compliant server that exposes a proprietary
database as a tree-like hierarchy of Wiretap nodes. A Wiretap Server is typically
a daemon running on a host machine.

Accessing Media Via Wiretap
The IFFFS clips database is identified by the name of the host on which the
Wiretap server is running (for example, Wiretap:/<ServerName>). You can
access Wireptap as you would access any folder.

To access Wiretap:

1 Start Composite.

2 Open a File Browser and navigate to the Wiretap folder.

3 Expand the Wiretap folder. Wiretap displays a list of available servers.

If a Wiretap server does not appear in the list, it may be because it was not
running when you started Composite or because an older version of Wiretap
is used, in which case you can add the server manually to the list by typing
its path in the text field (for example, Wiretap:/MyServer/...where MyServer
is the name of the Wiretap server).
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Accessing IFFFS Clips
When you import media from a Wiretap server, the Information tab displays
information about the media and its path.

NOTE The path to clips is displayed, but not the path to images.

a) Clip name b) Clip path

You can access a subclip by specifying the range in the path field.

You can import singe images, as well as image sequences. You can also import
certain images from a sequence of images.

In general, it should be possible to import all Wiretap clips. In practice though,
it may happen that the media is not supported in Composite. In this case, the
images will display a red X to indicate media that is not accessible. See
Supported Media Formats on page 116.

An IFFFS clip can be made up of different types of formats. For example, it
can be made up of standard file formats from a NAS, or it can be made up of
images from a framestore or stonefs, or both. An example of an unsupported
file format is the stonefs 12-bit compressed.

NOTE Contrary to standard imported file formats, no Gamma or Cineon correction
options are available for Wiretap clips.
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Importing Media

Topics in this chapter:

■ About Media on page 115
■ Physical Location of Media on page 116
■ Supported Media Formats on page 116
■ Importing Media on page 118
■ Using the Image Import Tool on page 125
■ Log to Lin Workflows on page 126
■ Moving Imported Compositions into Project Folders on page 126
■ Image and File I/O on page 127
■ Premultiplication on page 138

About Media
In Composite, media is a sequence of one or more images that you import. All
media is represented as RGBA images. When you import media, Composite uses
the information in the media file to determine whether the media is RGB, RGBA,
or A. When you create a composition, Composite applies the project preferences
to create compositions as RGB, RGBA, or A—see Setting Project Preferences on
page 97.
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Physical Location of Media
The media you work with can reside anywhere on the network. When you
import media, you are not physically copying that media to another location,
but rather you are creating a composition for that media in Composite; the
actual physical location of the media is stored as information in the
composition. Composite recognizes both drive letters and Universal Naming
Convention (UNC) paths. Composite also supports Wiretap—see Accessing
the IFFFS Libraries on the Network Using Wiretap on page 111.

Supported Media Formats
You can import media in any of the following formats:

NOTE When you import .dpx media from Autodesk Flame®, you import the media
with LUT. To disable the import conversion, see Importing Media on page 118.

Supported bit depths for importsFile exten-
sion

Format

8.bmpBitmap

10.cinCineon

8, 10, 16.dpxDPX

32.hdrHDR

8, 16, 32.iffIFF

8.jpg, jpegJPEG /JFIF

16 bit float, 32.exrOpen EXR

8.psdPhotoshop

8.pictPICT

8.pngPNG

8.movQuickTime

8.sgiSGI

8.tgaTarga
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Supported bit depths for importsFile exten-
sion

Format

8, 16, 32.tif, .tiffTIFF

NOTE Bit depths 8, 10, and 16 are integer unless otherwise indicated. Bit depth
32 is float.

You can produce results in any of the following media formats. For 4K and
higher media, support is limited to tiled formats (OpenEXR, TIFF, and IFF).

Bit depth of produced resultFile exten-
sion

Format

8.bmpBitmap

10.cinCineon

10.dpxDPX

32.hdrHDR

8, 16, or 32, depending on the composition. The
media you create has the same bit depth as the

.iffIFF

composition. For 16-bit compositions, the bit depth
of the created media is 16-bit integer (not 16-bit
float).

8.jpg, jpegJPEG /JFIF

16 bit float, 32.exrOpen EXR

8.pngPNG

8.sgiSGI

8, 16, or 32, depending on the composition. The
media you create has the same bit depth as the

.tif, .tiffTIFF

composition. For 16-bit compositions, the bit depth
of the created media is 16-bit integer (not 16-bit
float).

NOTE Bit depths 8, 10, and 16 are integer unless otherwise indicated. Bit depth
32 is float.
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Pixel Aspect Ratio
Composite guesses the pixel aspect ratio of images by comparing an image's
resolution with a list of common combinations of pixel aspect ratio and
resolution. You can, however, override the guess that Composite makes.

Composite can also store and retrieve the pixel aspect ratio information from
file formats, such as .bmp, .jpg,  .tiff, and .dpx. As a result, you get accurate
pixel aspect ratio information of these types of images.

Mixed Resolutions
You can work with mixed resolutions in Composite. If a tool receives multiple
inputs which have different image aspect ratios and bit depths, Composite
changes the image aspect ratio and bit depth of all inputs to that of the primary
input for the tool. When the original image aspect ratio/bit depth of an input
does not match that of the primary input of a multiple input tool, the input
tab on the tool node turns red to indicate the difference.

Importing Media
While you are working, you can import media at any time using the File
Browser or the floating File Browser. You can browse the network and import
media on a shared folder using the UNC path or the Python script. You can
also drag and drop the media directly from the floating File Browser into a
Schematic view or the Player. To share your imported compositions, you
should use the Import button on the File Browser to create a Composite
compositions folder or another folder that you use to store your media.

To import media with the floating File Browser:

1 Select File > Import or press Ctrl + I (Windows and Linux) or Cmd + I (Mac
OS) to display the File Browser.
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2 Navigate to the folder that contains the media you want to import.

3 Select the media files you want to import. You can either import, drag
and drop, or use the UNC path to import the media.
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NOTE You can import multiple media files in the same folder, in a single
operation. However, when you do this, you cannot set the import options
for each file individually. To select multiple files, click the first file to import,
then Ctrl + click each additional file to add it to the selection. Shift + click a
file to select it and all files between it and the last file selected.

To import media with the File Browser view:

1 Middle-click or press the tilde key (~) to display the Gate UI. Swipe east
and select the Views tab. Drag a File Browser to a view.

2 In the File Browser view, navigate to the folder that contains the media
you want to import.

3 If necessary, view individual media files by selecting them and reviewing
the Information tab that appears in the Tool UI.

NOTE You can import an image sequence by entering the UNC path in the
Path field.

You can also play the media in the mini-Player at the bottom-left of the
Tool UI, or click the Full Screen button in the mini-Player to play it in
the full screen Player (press F to exit the full screen Player).

(a) Full Screen button

4 Select the media files to import. You can select the Options tab in the
Tool UI and set a color conversion to be performed during import. The
options available depend on the image format of the media file you
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selected—see Log to Lin Workflows on page 126, Image and File I/O on
page 127 and Channel Assignments on page 128.

NOTE Values are not clamped when you import media in log format, so no
image data is lost. All tools can work with all of the data contained in log
format images.

NOTE You can import multiple media files in the same folder, in a single
operation. However, when you do this, you cannot set the import options
for each file individually. To select multiple files, click the first file to import,
then Ctrl + click each additional file to add it to the selection. Shift + click a
file to select it and all files between it and the last file selected.

The following displays the color conversion options for Cineon and DPX
image formats.

(a) Select Raw to disable conversion.

The following displays the color conversion options for image formats
other than Cineon or DPX.

5 (a) Select Gamma to adjust the Gamma options.

Select Rec. 709 to convert to the Rec. 709 video capture board standard
or sRGB to convert to the sRGB standard. Select None to disable the
conversion.
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6 The destination folder is either the default Footage folder, or the one
specified in the Import tab of the Project Preferences window—see Setting
Project Preferences on page 97.

Drag the file directly into the Footage folder or click Import. You can
create other folders to store the compositions that you create when you
import. Dragging the file or using the Import button imports the media
quickly and is useful when you do not need to immediately work with
the media on the machine on which you are performing the import.

Things to Remember

■ You can define the folder into which the media is imported by specifying
it in the Project Preferences window. If necessary, you can also modify the
Python script or command line used to cache media when you perform
an Import/Cache.

The Information Tab
The Information tab in the Tool UI appears when you use the fixed File Browser
view. The first and second columns contain properties that belong to a
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sequence of image files. The third and fourth columns are the properties of
the resulting footage composition.

■ Path  Location of selected file. If you select more than one file, the path
of the last selected file is displayed.

■ Type  Displays the type of file that is selected—see Footage Role on page
137.

■ Created  Date the file was created.

■ Modified  Date the file was last modified.

■ Owner  Owner of the file on the file system. The creator of the file.

■ Size  The size of the selected file in megabytes.

■ Details  Information on the selected file, including channels, depth, pixel
ratio and whether it is tiled, and so on.

■ Duration  The length of the selected file in frames.

■ Start  The start frame of the selected file.

■ End  The end frame of the selected file.

■ Poster  The thumbnail of the selected file that is displayed in the File
Browser (in Proxy view) and in the mini-Player of the Information tab.

■ Format  The destination format of the selected file—see Specifying the
Destination Format on page 135.

■ Resolution  The resolution of the selected file.

Composite guesses the image ratio, pixel ratio, and rate of the media you select
from the Import view. The image's resolution is compared with a list of
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common combinations of pixel aspect and resolution. The aspect ratio is
related to the image ratio; changing it affects the image ratio.

■ Image Ratio  The image resolution of the selected media, taking into
account the pixel ratio.

■ Pixel Ratio  The pixel ratio of the selected media. You can set the pixel
aspect ratio.

■ Rate  The frame rate of the selected media. You can set the rate.

■ Source  Indicates the source from which your composition was originally
created. In Composite, this property depends on the actual source; you
can edit the source at any time. There are four different sources.

Source Initial ValueThe composition was created

CompositeIn Composite (new)

FileFrom an import operation (not from
DND)

The value of the tape name propertyFrom Wiretap - IFFFS

WiretapFrom Wiretap - generic

NOTE When you publish to Wiretap/IFFFS, the value of Source is written out to
the Tape Name property of the IFFFS clip.

■ Channels  The channels in the selected file.

■ Depth  The bit depth of the selected file; you can modify the depth.

■ Repeat  The repeat mode when you play a composition.

■ Mark In  Set a mark in frame, the first frame to start import.

■ Mark Out  Set a mark out frame, the last frame to import.

■ Comp Start  When you create a footage composition, the start time is
set after the number of the first frame of the sequence. Sometimes you will
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want the start time to be unconditionally set to a different number, which
you can do with the Comp Start editable value field.

■ Unpremultiply  see Unpremultiply in Import Mode on page 134.

■ Motion Vectors  see Importing Motion Vectors From Maya on page 712.

Using the Image Import Tool
The Image Import tool lets you quickly build a composition by dragging files
directly into a composition from the file system. You can also drag media files
into the composition to replace a media element without having to rebuild
the dependency graph.

You can modify the following parameters in the Import Image Tool UI: Path,
Pixel Ratio, Repeat mode, Mark In/Mark Out, and Offset (on a tool). You can
also modify attributes on the Options tab.

To import an image using the Image Import super tool:

1 In the Schematic view, press Ctrl + N (Windows and Linux) or Cmd + N
(Mac OS) to create a new composition.

2 Middle-click or press the tilde key (~) to display the Gate UI. Swipe east
and select the Tools tab.

3 Drag an Image Import tool to the Schematic view and connect it to the
Output node.

4 Do one of the following:

■ Drag the media residing on the file system into the Path field in the
Image Import Tool UI. When dragging, press Ctrl + Tab to switch to
the Image Import tab.

■ Type a file path name in the Path field of the Image Import tab and
press Enter.

Using the Image Import Tool | 125



■ Copy (Ctrl + C for Windows and Linux or Cmd + C for Mac OS) a file
path, paste (Ctrl + V for Windows and Linux or Cmd + V for Mac OS)
it in the Path field of the Import Image tab and press Enter.

Log to Lin Workflows
There are several tools and controls to construct logarithmic to linear workflows
depending on your needs.

Import and Export Workflows
Since Composite processes are optimized for linear data, when you import an
image, the Import Options are in their Active state, and logarithmic data
(Cineon, DPX) is automatically converted to linear data. If you need to export
into Cineon or DPX format, the data is transformed back to logarithmic.

NOTE Since floating point formats (both 16-bit and 32-bit versions) are used, no
data is lost going from a logarithmic encoding to a linear one.

In the Active state, you can make adjustments to both the film gamma and
to the reference white of the image you are importing or exporting.

You can, however, override these settings by changing the default Active
setting on import (and export) to Inactive. You can then make modifications
to the image using the 1D and 3D LUT tools, as well as the Log and Delog
tools.

Moving Imported Compositions into Project
Folders
When you import existing compositions, the resulting compositions are
automatically created in the project's Footage folder, or the folder specified
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in the Project Preferences window (Import tab)—see Setting Project Preferences
on page 97.

To move imported compositions into project folders:

1 In the File Browser, click View and select Folders.

2 In the Folders list, expand the folders for the project so that both the
folder containing the imported compositions, and the folders where you
want to move those compositions, are visible.

3 In the Folders list, select the folder containing the imported compositions.

The contents of the folder appear to the right of the Folders list.

4 Select one or more compositions, then drag the compositions to the
destination folder in the Folders list and release. To select multiple
compositions, click the first composition, then Ctrl + click each additional
composition to add it to the selection. Ctrl + click a composition a second
time to remove it from the selection. Shift + click a composition to select
it and all compositions between it and the last composition selected.

Image and File I/O
Composite supports OpenEXR 16-bit half float, 32-bit float and integer. This
improves import workflow, footage versus composition distinction, and data
extracted from the media.

UsageDepthPixel Type

For regular image data16-bit floating-point numberHalf

Used where the range or precision of 16-
bit number is not sufficient, for example,
depth channel (Z)

32-bit IEEE-754 floating-point
numbers

Float

For discrete pre-pixel data such as object
identifiers

32-bit unsigned integersUINT

OpenEXR images can contain an arbitrary number and a combination of
image channels. For example:

■ Red, green, blue, alpha

■ Luminance and sub-sampled chroma channels (Y/C)
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■ Depth (Z), surface normal directions (XYZ), or motion vectors (XY)

Channel Assignments
Once you have imported your EXR media, you can use the Options tab to
assign and import the channels. A channel view shows the channels that are
present in the files and channel groups are defined in the project preferences.

NOTE These tools are also available when using the Image Import tool (Options
tab).

For both Channel Views and Channel Groups, the None option always exists.
Although it's not actually a group, it does allow you to assign any input
channel to any output channel. The None option is also a fallback group when
the file does not contain a channel that fits into any existing group definition.
The None option is the default group selected, and the initial assignment
always attempts to match a channel with itself, then assigns it arbitrarily by
using an alphanumeric order.

Channel Views

The available channel views are listed. You can select a channel view to be
displayed in the mini-player. Or if you are using the Import Image tool, the
channel view is displayed on the tool node.

Multi-view OpenEXR files use the convention that channel names are
composed of layer names separated by periods, with the final channel name
at the end. The view name must be the ultimate layer name, that is, the
penultimate period-delimited component in each channel name. In other
words, the view name is followed by a period and a final channel name in the
format layer.view.channel or view.channel.
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OpenEXR channels are assigned to the Composite RGBA channels according
to the following rules:

■ If the channel name part of the input channel (the string after the last
dot) is named “R”, “G”, “B” or “A” (case insensitive), then it is assigned to
its respective R, G, B or A channel.

■ If none of the input channels have an “.R”, “.G”, “.B” or “.A” suffix (case
insensitive), then they are assigned in alphanumerical order:

ResultInput ChannelsTo

RGBA image4 or moreR, G, B, and A

RGB2 or 3R, G, and/or A

A1A

Examples:

■ “.M”, “.N”, “.O”, “.P” input channels are assigned to R, G, B and A
respectively, resulting in an RGBA image.

■ ".X”, “.Y”, “.Z” input channels are assigned to R, G and B respectively,
resulting in an RGB image.

■ “.U”, “.V” input channels are assigned to R and G respectively, resulting
in an RGB image.

■ “.Z” input channel is assigned to A, resulting in an A image.

Channel Groups

In the Options tab, you can assign any channel to the R, G, B and A channel.
When the RGBA channels are available in the files, they are mapped by default
to the same channels in the composition or output channel. During import,
Composite verifies the mapping to determine that all the channels are the
same bit depth.

This list provides the user-defined channel groupings and mappings. Composite
provides a number of predefined names. Selecting a group performs the
mapping defined by the group. Channels that were identified as being part
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of a group in the preferences can be assigned to a corresponding channel
group.

Each Channel can be assigned a field from the list, or as groups when using
the buttons next to the menu.

The Channel Groups list shows only if the existing group was found in the
file. The groups are determined by your project preference—see Setting Project
Preferences on page 97.

The Channel Group options include:

DescriptionChannel Group

See Channel Assignments on page 128.None

Alpha channel onlyAlpha

Red, Blue, and Green channels onlyColors

Red, Blue, Green and Alpha channelsColors+Alpha

Z-axis onlyDepth

X, Y, and Z-axisSurface Normals

X and Y-axisVelocity

From File to Output  Maps a channel present in the file to a channel (output)
in the resulting node or composition.

You can assign a channel from the file to an output channel by clicking the
Output Channel menu and selecting the channel wanted. As shown, the
channels NX, NY and NZ have been grouped under the name Surface Normals,
and were assigned to R, G and B.

Output  Specifies the channels that will be present in the resulting node or
composition. A reasonable default is set according to the channels present in
the file. It is possible to change the output to any output of RGB, RGBA, or A.
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Reset  Resets the mapping in the File Browser to the original state, or to the
last persistent state in the Import Image tool.

Status  Verifies that the selected input channels all have the same depth. If
the depths do not match, the images will still be imported properly.

Channel Groups (Import Preferences)
In the Project Preferences window, you can define new groups in the Import
tab. A number of default channel groups and predefined assignments are
provided. Groups can be added, renamed, removed, and channel mapping
can be updated.

The predefined groups are:

MappingGroup

A to AAlpha

RGB to RGBColors

RGBA to RGBAColors + Alpha

Z to RDepth

NX, NY and NZ to R, G and BSurface Normals

velX and velY to R and GVelocity

NOTE The groups map to a subset of the channels available from the Splutter
Fish plugin used by Autodesk 3ds Max: Velocity, Depth, and Surface Normal.
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The selected group, Velocity, is predefined by Composite. It defines a mapping
of channels named velX and velY to output channel R and G respectively. No
channels are mapped to B and A.

Under From File To Output are four fields labeled R, G, B, and A. Each contains
all the channels available in the EXR file.

DescriptionChannel

Red IntensityR

Green IntensityG

Alpha OpacityA

Equivalent to X-axis in a 2D planeU

Equivalent to Y-axis in a 2D planeV

Z-axis or depth in a 3D planeZ

X-axis NormalsNX

Y-axis NormalsNY
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DescriptionChannel

Z-axis NormalsNZ

A surfaces material ID is the value that determines which sub-
material the surface will use when you apply a Multi/Sub-Object
to a material to the object to which the material belongs.

materialID

The value that determines which object will be used when you
apply it to the object.

objectID

X-axis Motion VectorvelX

Y-axis Motion VectorvelY

No channels selectedNone

Import OpenEXR File

To import all channels of an OpenEXR file, do the following:

1 From the File menu, click Import.

2 When the File Browser opens, select an OpenEXR file.

3 Right-click on the file and select “Import All Channels” from the context
menu.
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Once you have selected “all channels,” a new node will appear in the
Schematic, which displays tabs that each correspond to an output connection.
In other words, all channels are imported into different import nodes which
creates a group with multiple output connections that corresponds to each
import node’s output. The following image displays a UI with two schematics.
The Schematic on the left displays the group node, the Schematic on the right
displays the import nodes with their output connections.

Unpremultiply in Import Mode
In Composite, it is typically not desirable to work with images that have their
alpha premultiplied with the colors. If you are working with such an image,
then you should manually add an Unpremultiply node from the Image Import
tab or create a post-import script that does.

The Unpremultiply button is off by default for most formats, unless there is
information in the file that indicates the presence of an alpha channel that
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was premultiplied. OpenEXR files have their alpha channel premultiplied, so
it is set to on by default. The following table summarizes the different cases.

ValueUnpremul-
tiply

Format

--OffFormat without alpha

OffOnFormat with alpha, without premultiplied
info

Depends on infoOnFormat with alpha, with premultiplied info

Depends on conventionOnFormat with alpha, conventional premulti-
plied

Specifying the Destination Format
When importing an image sequence, Composite determines the resulting
composition properties with respect to channels and bit depth. Some controls
that let you override these default properties include:

■ Output channels RGB, RGBA, and A.

■ Bit depth either 16-bit or 32-bit regardless of the files original depth.

Your initial bit depth values can vary depending on the properties of the image
files.

■ From a jpeg file, the default proposed is 16-bit

■ From a dpx 10-bit int file, the default is 16-bit

■ From a dpx 16-bit int file, the default is 32-bit

■ From an hdr 32-bit, the default is 32-bit

You can always create an RGB, RGBA or A Output Channel composition. Any
missing channels are filled with black.

Using the Gate UI to Create Footage
When you import media directly into a Schematic view or in the Player by
dragging and dropping, a Gate UI appears with a number of choices depending
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on the context and node selected. This allows you to create a footage
composition in the Footage folder, and at the same time create a link node to
that footage in the current composition.

If you drag an image sequence to the Schematic and drop it on an input of a
node, the Gate UI does not appear. However, if you drop the sequence
anywhere in the Schematic or the Player, the Gate UI appears with several
options.

To create footage and link in the Gate UI:

 ➤ Drag and drop your first image into the Player.

Three options are available from the Gate UI.

If you drag and drop your first image directly onto an Output node, you have
a choice of four options.
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If you drag and drop your second image into the viewer (instead of an Output
node), you have a choice of five options.

Footage Role
How do you distinguish a composition representing footage from a
composition you are using for compositing? Composite has a role for a
composition named Footage.

A composition with a Footage role displays a different icon in the Tool UI.
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This role is not permanent and can be changed at any time. You can even
create a composition from scratch and assign it a Footage role. When a
sequence is imported, either by clicking the Import button or by dragging the
sequence into a library folder, a composition is created with the Footage role.
The role of a composition does not change its behavior at all in the application,
and is only used as an indicator of the intended use of the object.

Footage Composition
When an OpenEXR image is being imported, a suffix corresponding to the
Channel group is added if the selected Channel group is not a predefined
group, such as Colors or Colors+Alpha.

The name would be FileName.Alpha, FileName.Velocity. This is useful when
you need to import the same file twice, first to import the image channels
and then to import the motion vectors.

NOTE The description of the footage corresponds to the description in the
Information tab in the Tool UI—see The Information Tab on page 122.

Premultiplication
Premultiplication is the process whereby an image’s RGB channels are
multiplied by its alpha channel. Composite nodes expect unpremultiplied
images. Furthermore, if you plan to use color correction, the images must be
unpremultiplied. See the Premultiplication on page 337 chapter for a full
discussion of premultiplication.
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Getting Familiar with Your
Workspace

Topics in this chapter:

■ Working with a Task-Based UI on page 140
■ Pick List on page 141
■ Tool Presets on page 146
■ Animation Editor on page 149
■ Layer Editor on page 150
■ Player on page 153
■ View Layouts on page 153
■ Color Picker on page 154
■ Calculators on page 161
■ Hotkey Editor on page 163
■ Setting User Preferences on page 168
■ Previewing Video on page 172
■ Creating User Defined Attributes on page 176
■ Other Workspace Functions on page 187

9
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Working with a Task-Based UI
Composite provides a flexible workspace environment that lets you work
within the context of the current task at hand. You can choose from the
available task presets to populate the user interface with the views you need
to begin working immediately, or you can create your own presets, as well as
customize existing presets according to your facility's workflow. When you
are ready to begin working, you can immediately access tools and views using
the Gate UI—see The Gate UI on page 12 and The Drop Gate on page 14.

What are Presets?
A preset is a saved configuration of views and settings appropriate for a
particular task. For example, if you want to quickly assemble media and tools
into a loose composition, you would build a three-view layout that displays
a configuration that included a File Browser, a Layer Editor and a Player, as
well as the Details area for displaying information about the composition or
currently selected tool. Now, if you want to add and tweak layers in your
composition, you could then switch to an editing preset to display only the
Layer Editor and Player, and continue working.

You can also create new presets, and rename or delete existing ones as needed.

NOTE You can modify the default presets simply by selecting a different layout,
or replacing a view by dropping a different view on the viewport.

To choose default presets:

1 In the taskbar at the bottom-left, click the preset menu to display the list
of presets.

2 Select a preset from the list or use its numeric keypad hotkey.
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To select, delete, rename, set as default, or reset to a default preset:

1 Select the Edit Layout Presets and choose the New, Delete, Rename, Set
as Default, or Reset command.

2 If you chose the New or Rename command, enter a name for the
new/renamed preset and click OK or press Enter. If you chose the Delete
command, select Yes or No in the deletion confirmation dialog.

NOTE You can create up to 18 presets that will have hotkeys to access them. The
first nine will use the single number 1 through 9 on the keypad and the next nine
will use the hotkey combination of Ctrl and 1 through 9.

To change the order of the layout presets:

 ➤ Hold Ctrl and drag the name of the preset to a new location higher or
lower within the menu.

NOTE You must designate or set the default state of a preset. When you select
the Reset to Default option, the preset will return to the state that you have
designated as the default.

Pick List
The Pick List is a convenient way to access frequently used tools and other
elements. You can add tools, views, and compositions to the Pick List. For
example, if you add a Schematic view to the Pick List, then drag and drop it
into a view, a Schematic view opens in that view. This is the same behavior
that occurs when you drag the Schematic view from the Views tab into a view.

Each user has a Pick List. Its contents are independent of any project and are
persistent across sessions.

The Pick List exists as a tab in two locations: the tool UI and through the east
gate of the Gate UI.
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Pick List tab in the tool UI

Pick List tab accessed through the east gate

Working with the Pick List
You can add and remove items in your Pick List, create a new Pick List group,
delete Pick List groups you no longer use, and reorder Pick List groups. You
can color code Pick List groups for easier recognition, as well as rename them.
You can also set a Pick List as a default, reset a layout to that default, and
restore the Pick List to the factory default group layout.
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To add items to the Pick List:

 ➤ Do one of the following:

■ Drag the item to the Pick List tab and drop it into a group.

■ Right-click the item and select Add to Pick List. The Pick List group
which is currently highlighted in the Pick List tab will be the
destination Pick List group.

■ Use Ctrl + drag to copy and paste an item from one Pick List group to
another.

To use an item in the Pick List:

 ➤ Do one of the following:

■ Drag an item from the Pick List to the dependency graph or into a
view. If you add an item from the Pick List into a Player view, the
drop gate appears. Add the item as per the selections in the drop gate.
If you drag an item from the Pick List to a Schematic view, then
connect it to the dependency graph as if you were dragging the item
from the Tools or Views tab.

■ Right-click in the view (Schematic, Player, Composition Browser, or
Layer Editor) and select Add from Pick List.

To remove items from the Pick List:

1 Right-click and select the Edit Groups checkbox.

2 In the Pick List, right-click the item you want to remove and select
Remove or press the Delete key.
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NOTE You cannot undo the removal of an item from the Pick List. You can,
of course, add that item to the Pick List again at any time.

To create a new Pick List group:

 ➤ Do one of the following:

■ Right-click anywhere in the Pick List tab and select New Group.

■ Drag an item to the Pick List tab and drop it into the tab's background.

A new Pick List group is added at the end when dropping on the
background. Right-clicking and adding will add it after the currently
selected group. This will allow new groups to be placed in-between existing
groups.

To move the groups within the Pick List in the Tool UI:

1 Right-click and select Edit Groups.

2 Click anywhere in a group's window.

3 Use the right and left arrow buttons.

To delete a Pick List group:

 ➤ Right-click inside a Pick List group and select Delete Group.

The Pick List group is deleted.

To rename a Pick List group:

1 Right-click and select Edit Groups.

2 Select the name of the Pick List group in the Name field at the top of the
Pick List.

3 Select the current group name, type in a new name and press Enter.
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To color code a Pick List group:

1 Right-click and select Edit Groups.

2 Click the color pot next to the Pick List group name field.

The color picker appears.

3 Select a color from the Color Picker and press OK—see Color Picker on
page 154.

The Pick List group assumes the selected color.

To set a Pick List group as the default group:

 ➤ Right-click inside the group and select Set as Default.

To reset a Pick List group to the factory default group layout:

 ➤ Right-click inside the group and select Reset to Factory Default.

All Pick List groups are reset to their factory default states.
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Tool Presets
A tool preset is a tool you save with a customized set of properties. You can
then use the tool preset as you would any other tool in a dependency graph.
Sharing tool presets among a team is a great way to streamline a project. You
can simply email tool presets to anyone involved in a particular project.

The tool presets you create are stored in the ToolPresets folder in the following
location: <UserData>\toolPresets. When you create a tool preset, it is appended
with the following extension: .txpreset. For example, in the following
illustration, three tool presets were created from the Glow tool which reside
in the<UserData>\toolPresets\Effects\Glow folder.

Working with Tool Presets
You can create a tool preset from the current tool after customizing it for your
project. Once you create a tool preset, you can load it into the dependency
graph and starting using it. Reloading the tool preset returns it to the settings
in which you saved the tool preset.

NOTE You cannot create a tool preset from a group in the Schematic, but you
can create a tool preset from a Macro.

The controls for using tool presets are located in the Tool Options area on the
right side of the Tool UI.
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(a) Tool preset controls

To create a tool preset:

1 From the Schematic, select a tool node from the dependency graph.

2 Do one of the following:

■ Right-click the tool and select Presets > Save.

■ In the Tool options area, click the Save button.

3 Type in a name for the tool preset and click OK.

The name of the current tool preset is displayed in the Preset field in the
Tool Options area.

To load a tool preset:

1 From the Schematic, select a tool node from the dependency graph.

2 Do one of the following:

■ Right-click the tool node and select Presets > Load.

■ In the Tool options area, click the Load button.

■ Middle-click or press the tilde key (~) to display the Gate UI and swipe
east to display the Pick List, Tools, and Views tabs. Select a tool,
right-click and select Presets. Then select a preset from the list and
drag it over the selected tool node in the Schematic.

The tool preset is loaded into the tool node and becomes the current
tool.

TIP This is also a good way to reset the values of a tool preset back to its set
values.
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To reload a tool preset:

1 From the Schematic, select the tool node with the tool preset you want
reload.

2 In the Tool options area, click the Reload button.

The tool preset is reloaded into the selected tool node.

To delete a tool preset:

1 Navigate to the following folder: <UserData>/toolPresets.

2 Locate the tool preset you want to delete.

3 Select the tool preset and press Delete on the keyboard.

Using Tool Presets as a Display Modifier
You can apply any tool preset you created to a Player view or the fullscreen
Player. This affects only what that particular Player displays; it has no effect
on the composition data.

NOTE You can apply a tool preset to the fullscreen Player only if you entered it
through a Player view.

To use a tool preset as a display modifier:

1 In the Player view or fullscreen Player, middle-click or press the tilde key
(~) to display the Gate UI and swipe east to display the Pick List, Tools,
and Views tabs.

2 Select the Tools tab.

3 Select a tool preset to apply to the Player, drag it outside the Tools tab,
and do one of the following:

■ Pause over the Player view in which you want to apply the tool.

■ In the fullscreen Player, pause anywhere.

4 In the Player, middle-click or press the tilde key (~) to display the Gate
UI and go through the south gate.

The Player Options appear.

5 Position the cursor over the last tab of the Player Options and release.
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The name of the tab changes to that of the dropped tool preset. The
Player updates to reflect the result of applying the tool preset to the image.

Using Tool Presets in the Pick List
For greater workflow efficiency, you can add tool presets to the Pick List and
access your favorite or most frequently used tools—see Pick List on page 141.

Animation Editor
The Animation editor displays the animation curves and the animation tracks
of a composition. The view has the same features as the The Animation Tab
on page 661 of the Tool UI.

Setting the Animation Editor Options
You can set the way the Animation Editor is displayed, as well as the playback
options.

To set the Animation Editor options:

1 With the cursor on the Animation Editor, middle-click or press the tilde
(~) key to display the Gate UI and go through the south gate. The
Animation Editor options appear in the Tool UI.

2 Select the Display tab to set the guide options.

Pin  Lock the time of the view to either Composition or Tool. If you
lock the time to Composition, the view always displays animation curves
in global time. If you enable Tool, the view always displays the local time
of the tool node currently selected in the Schematic view.

Composition  Display animation curves or tracks in global time.

Tool  Display animation curves or tracks in the local time of the tool
node selected in the Schematic view. If you did not select the Pin option
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for a specific tool, the Animation Editor view updates each time you select
a different tool node in the Schematic view to reflect the animation curve
of that tool node

3 Select the Playback tab to set the time and frame rate.

4 Set the Viewer Time options.

Follow Master  Uses global time. Deselect to use local time.

Offset  Lets you set a frame offset for the time. The frame offset is with
respect to the time you set for the view. For example, if you set a frame
offset of 5 and selected the Follow Master option, the view always displays
the frame that is five frames ahead of the frame currently running in
global time. If you deselected Follow Master, the view always displays
the frame that is five frames ahead of the frame running in the local time
of the view.

Update on Play  Updates the proxy at each frame when you play the
composition. Deselect to update the proxy only when you stop playing
the composition, and only at the scrub frames when you scrub through
the composition.

5 Set the Frame Rate options.

Play All Frames  Plays all frames in the composition, regardless of
whether it maintains the frame rate set for the composition. Deselect to
have the view maintain the frame rate for the composition, at the expense
of dropping frames where necessary.

User  Lets you set the frame rate at which you want the view to play
the composition.

Stop on Drop  Stops playing if a tool is dropped into the dependency
graph.

Layer Editor
The Layer Editor gives you another view in which to perform compositing
tasks with Reaction. It shows all layers for the currently selected Reaction node
in your composition. Layers are displayed as rows in a table format and are
stacked in the order in which you create the layers. You can choose to show
or hide columns in the table, as well as show/ hide layers in your composition.
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The Layer Editor contains columns that you can reorder by dragging a column
heading. You can also right-click a column heading to display show/hide
options. Any hidden columns are listed in the menu. The Layer Editor includes
the following:

DescriptionColumn/But-
ton

Turns the visibility of the layer on and off. It is on by default.V (visible)

Displays a proxy of the image connected to the layer's source input.Proxy

Displays the name of the image generator connected to the layer's
source input, if applicable.

Generator

Displays the source name. You can use the F2 hotkey to edit the
source name. If you create a source without a layer, the text is red.

Source

Displays the Layer name. You can use the F2 hotkey to edit the layer
name.

Layer

Click to select the surface geometry type for the current layer: Bicu-
bic, Bilinear, Box, Frustum, Plane or Sphere. The default is Bicu-
bic—see Working with Geometric Surfaces on page 254.

Layer Type

Lets you move the selected layer up, down or to the bottom or top
of the stack.
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DescriptionColumn/But-
ton

Duplicates a layer. This is particularly useful when you want to use
the same image generator or media for multiple layers. When there
is a source in the Layer Editor that does not have a layer assigned to
it, the text is displayed in red—see Duplicating Layers on page 252.

Deletes the selected layer.

In a composition with multiple reaction compositors, selects which
reaction compositor to work with.

Compositor

Lets you modify the row height in pixels for all rows in the Layer
Editor.

Row Height

Working with the Layer Editor
You can quickly build and edit multi-layer compositions using the Layer Editor.
As in the Schematic view, you can use the Reaction drop gate to quickly build
your initial composition, and can drop tools directly onto layers.

The Layer Editor's context menu also lets you access the Pick List, select the
layer's component nodes, such as materials, and other tool nodes associated
with the selected layer. When you select a Reaction node or tool, the
appropriate panel in the Tool UI is displayed, so you can modify properties
interactively. For more information, see Creating Sources and Layers on page
248.

To add tools to a layer in your composition:

1 Do one of the following:

■ Right-click to access the Pick List, or select the Pick List tab.

■ Middle-click or press the tilde (~) key and go through the east gate
and display the Pick List, Tools, and Views tab.

2 In the Tools tab, drag the tool to the layer you want to modify.

The tool is added before the source input for the layer, and its Tool UI is
displayed.

NOTE Any tools added to a layer are added to the context menu. When you
right-click the layer, you will see any tools in its branch.
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Player
The Player lets you play or preview a composition, or preview media. There
are three different versions of the Player:

■ Player view  Lets you play compositions and view the changes you make
to compositions as you work—see Player View Default Settings on page
190.

■ Mini-Player  Lets you preview compositions located in the File view—see
Using the Mini-Player on page 212.

■ Fullscreen Player  Is useful when you want a more immersive
environment. You can use it to play compositions, work on compositions,
and preview media—see Using the Fullscreen Player on page 215.

View Layouts
You can save up to four zoom and pan settings for the Schematic and Player
viewers. These view layouts can then be recalled with a hotkey or using the
F1-F4 keys. This lets you switch back and forth between multiple areas of the
viewer and is especially useful in the Schematic view.

View layouts are stored with the version of the composition. This allows for
example, multiple Schematic viewers to share the same layouts. It also allows
the layouts to be persistent from one UI preset to another and one session to
another.

To set a view layout in a viewer:

 ➤ Do one of the following:

■ Zoom and pan to the layout you want, and press Ctrl + F1. Repeat
using F2, F3, F4 as needed. Activate the view using its corresponding
hotkey or by right-clicking and selecting Activate (corresponding view)
from the View Layout sub-menu.

■ Zoom and pan to the layout you want, right-click and select Set View
Layout (1, 2, 3, 4), then select Set from the submenu. Activate the
view using its hotkey or by right-clicking and selecting Activate
(corresponding view) from the View Layout submenu.

NOTE When a view layout is saved for a Schematic viewer, a small number (1 to
4) appears in the view. This number represents the center point of that view layout.
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To delete a saved view layout setting:

 ➤ Do one of the following:

■ Right-click in the view and select Delete (corresponding view layout)
from the View Layout sub-menu.

■ Press Ctrl + Shift + (F1, F2, F3, F4). The saved view layout is deleted.

NOTE Composite saves the zoom/pan settings for viewers that have entered
fullscreen mode so that the next time they go fullscreen, they maintain the same
zoom/pan as before. When exiting fullscreen, the viewer's zoom/pan will be reset
to the previous values.

Color Picker
There are two ways to launch the Color Picker. You can display the color
picker by pressing Alt + P, or by selecting a color for a color pot from the
screen, such as selecting a color for the Hue Shift color pot in the Color Curves
tool.

To expand the Color Picker and see more options, click the Advanced button.
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Working with the Color Picker
When working with the color picker, you can:

■ Examine the values of each component of a color that appears on screen.

■ Examine the minimum, maximum, or average color value in a selection.

■ Select and store a color without launching the Color Picker.

■ Create, delete, and rename a color palette.

■ Adjust the colors in a color palette.

■ Revert a color palette to its original colors.
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NOTE You will always be in pick mode whenever the color picker is active. You
can only pick outside of the floating window. When inside the window the cursor
will return to the normal cursor for interaction with the UI controls.

Cursor in pick mode

To select a color for a color pot from the screen:

1 Ctrl + click the color pot for which you want to select a color.

2 Position the cursor over the color you want to select and click.

The color pot updates to the selected color.

To select a color for a color pot:

1 Click the color pot for which you want to select a color.

The Color Picker appears.

2 At the bottom center of the Color Picker UI, click the bit depth button
and select a color depth for the Color Picker. Select % to work with
percentage values (0.00% to 100.00%). The default is Float.

3 Do any of the following:

■ Use any of the color model areas to select a color.

■ Click anywhere on the screen to select a color.

■ Click any of the color pots on the right of the UI to select the color
in that pot.

4 Click the OK button. That color pot now contains the color you selected.
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To examine the values of an on-screen color:

1 Start the Color Picker by pressing the Alt + P hotkey combination.

2 At the bottom center of the Color Picker UI, click the bit depth button
and select a color depth for the Color Picker.

3 Position the cursor over the on-screen color whose values you want to
examine, and click.

The HSV and RGB areas of the Color Picker tab, as well as the Current
field of the Selection area all update to reflect the values of the selected
color.

To examine the minimum, maximum, or average color value in a selection:

 ➤ Create a selection by pressing Ctrl + click, and dragging a marquis around
an area of the screen.

The fields in the Selection area update to reflect the color values in that
selection.

Displays the:Field:

Currently selected color.Current

Previously selected color.Previous

Minimum color value in the current selection.Minimum

Average color value in the current selection.Average

Maximum color value in the current selection.Maximum

To select and store a color without launching the Color Picker:

1 Press the P key to set the cursor to pick mode.

2 Click the color in the image you want to store.

The color that you picked will be stored as the current color the next
time the Color Picker is launched.

To select a color using the pop-up Color Picker without using a hotkey to
display the Color Picker:

1 Click the color pot for which you want to select a color.
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The pop-up Color Picker appears.

2 Click the Advanced button to expand the Color Picker and to display
more options.

3 If necessary use the Bit Depth button at the bottom of the Color Picker
to adjust the number of colors the Color Picker displays.

4 Do any of the following to pick a color:

■ If you want to use the RGB model, use the slider bars to adjust the
color.

■ On the HSV tab, use the HSV wheel to pick a color.

■ Use the cursor to pick an on-screen color.

■ Enter the numeric value of the color in the fields next to the RGB or
HSV color models.

The color pot you clicked to enter the Color Picker updates to reflect the
new color, as does the color pot for the currently selected color in the
Color Picker.

To exit the Color Picker and update the color pot:

 ➤ Press OK.
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To exit the Color Picker without updating the color pot:

 ➤ Do one of the following:

■ Press Cancel.

■ Press the Esc key.

■ Click the close button at the top-right corner of the Color Picker UI.

To create a color palette:

 ➤ Do one of the following:

■ Click the palette name button and select New from the menu. Enter
a palette name and click OK.

■ Open your User folder located at the top of the Library folder structure
and open the Color Palettes folder. Right-click anywhere in the view
and select New Palette. A new palette is created. Type in a name and
press Enter.
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■ Open your User folder located at the top of the Library folder structure
and open the Color Palettes folder. Right-click a palette and select
Copy. Right-click anywhere in the Color Palettes folder and select
Paste. Click the new palette, press F2, and enter a name for the new
palette. Press Enter again to complete the rename.

To delete a Color Palette:

 ➤ Do one of the following:

■ Open the Color Picker by pressing Alt + P, then click the Color Palette
name button you want to remove and select Delete from the menu.

■ Open your User folder located at the top of the Library folder structure
and open the Color Palettes folder. Right-click the palette you want
to remove and select Delete.

To modify colors in a color palette:

1 In the Color Picker UI, use the HSV and RGB areas or the color spectrum
area to set the color you want to insert into the color palette.

2 In the color palette, click in the color pot whose color you want to change,
and hold until the pot updates to the new color.

To revert a color palette to its original colors:

 ➤ Do one of the following:

■ Click the Undo button.

■ Click the name of the color palette and select Reset.
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To switch color palettes:

 ➤ Click the Color Palette button and select a color palette.

Calculators
There are two calculators available: the standard calculator that you can use
to perform calculations and enter values into fields, and the Expresso Calculator
that is displayed when you click the Expresso button or click in a numeric
field that allows expressions. The Expresso Calculator extends the standard
calculator to allow you to create expressions that generate values used in
numerical fields.

(a) Expresso button

Not all fields accept expressions. Expressions can include composition
parameters as variables.

In the Expresso calculator, you can add comments to the expression, allowing
you to document what an expression does—see Animation on page 659.

To display the calculator or the Expresso calculator:

 ➤ Do the following:

■ Press Shift + click in a numeric field to display the normal calculator
or the Expresso Calculator.

■ Press Alt + C at any point to display the normal calculator.

■ Right-click a numeric field that allows expressions and select Set
Expression.
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The Expresso Calculator appears.

■ Shift + Alt + click a field that allows expressions. The Expresso
Calculator appears.
The standard calculator appears if there is no expression.

NOTE If you use one of the last three methods and the calculator does not
appear, the field cannot accept a value from the calculator. You must use an
alternative method to enter the value.

To close the calculator:

 ➤ Click the “x” box in the upper-right corner of the calculator.

To input a value from the calculator into a numerical field:

1 Shift + click in a numerical field. The calculator appears.

2 Type a new value into the calculator.

3 Click in the numerical field again or press Enter. The value is updated.

162 | Chapter 9   Getting Familiar with Your Workspace



Hotkey Editor
The Hotkey Editor enables you to save different Hotkey Catalogs, and share
these Catalogs with other users. Use the Hotkey Editor to manage hot keys
(keyboard shortcuts).

The Hotkey Editor allows you to:

■ Quickly and easily modify the existing default hotkeys.

■ Keep a copy of your user defined hotkeys for sharing and backup or
updating your copy of Composite.

■ Regroup or Document a list of all hotkeys.

Hotkey Catalogs
Composite introduces a new Hotkeys Catalog concept. Catalogs are place
holders for user defined hotkeys. In other words, when a user modifies a hotkey
through the Hotkey Editor, the hotkey entry is added to the active Catalog,
keeping track of all customized hotkeys.

How Catalogs Work

Catalogs are stored in the Hotkey Catalogs subfolder of the user home folder.
Catalogs can be subsequently moved to the /Project folder and shared with
other users. Like Color Palettes, only one Catalog can be active at any time.
The active Catalog can be chosen through the Hotkey Editor. When modifying
hotkeys, if no Catalog exist for the current user, a new Catalog will be created
automatically.

When starting Composite, the default hotkeys are registered in the hotkey
registry and organized into the specified domains. If you have a Hotkey Catalog
active, the hotkeys in the registry will be overwritten by the hotkeys found
in the Catalog. When resetting a hotkey or a hotkey domain, Composite will
remove these hotkeys from the active Catalog, and reset the hotkeys to the
Composite defaults from the default hotkeys resource file.

Managing Catalogs

Creation and deletion of Catalogs can be done through the Hotkey Catalogs
subfolder of the user home folder found in the File Browser. However, deleting
a Catalog will not automatically reset all the hotkeys in the registry. Remember
that a Catalog is simply a place holder of your user defined hotkeys.
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Also, like any other database objects found in the user home folder, you can
move Catalogs around, copy them, and archive them for sharing.

Hotkey Editor
The Hotkey Editor allows you to modify all the hotkeys described in the default
Composite hotkey resource file.

Hotkey Editor Overview

The Hotkey Editor is a browser displaying all the hotkeys grouped into
domains. Domains act as folders, and hotkeys as leafs of these domains.
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The hotkeys displayed are those found in the default Composite hotkeys
resource file and the current active Hotkey Catalog—see Hotkey Catalogs on
page 163.

The active Hotkey Catalog is displayed in the Catalog menu at the bottom of
the Hotkey Editor.

NOTE You can manage the Catalogs from the File Browser in the hotkeys subfolder
of the user home folder, which is similar to how Color Palettes work.

The browser section of the Hotkey Editor is composed of four columns.

■ Name  Represents the name of the domain or the hotkey action. This
cannot be modified.
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■ Value  Represents the keystrokes composing the hotkey. This can be
edited by clicking the cell or by typing F2 after selecting the row.

■ Type  Represents the type (Press/Release) of the hotkey. This can be
edited by a right-click edit option on the cell or by typing F2 after selecting
the cell.

■ User  Indicates if a hotkey has been user defined. This would be indicated
by a mark icon which is read only.

Accessing the Hotkey Editor

The Hotkey Editor can be accessed through the global hotkey Ctrl + H, which
may also be changed by the user. The Hotkey Editor can also be accessed
through the Composite menu bar (Edit > Hotkeys).

Editing a Hotkey

Editing hotkeys can be done in two ways.

To edit a hotkey:

 ➤ Do one of the following:

■ Clicking on a VALUE cell representing the hotkey.

■ Clicking F2 after selecting the row representing the hotkey.

Either way the Hotkey Editor will switch to “Learn Mode”. Every key
pressed will be part of the new hotkey, see Hotkey Format on page 167,
for the hotkey rule formats.

NOTE If the user tries to set a hotkey that already exists in the current domain
or in the “Global” domain, they will be notified with a warning. The hotkey
will be set, but remember that a local hotkey has precedence over a Global
hotkey.
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Conflicting Hotkeys

Conflicting hotkey rows in the Hotkey Editor are displayed in red.

To resolve a conflicting hotkey:

1 Right-click a conflicting hotkey to see the “Go To Conflict” option.

2 Choosing this option on the menu, or pressing the F3 hotkey will take
you to the conflicting hotkey, select it, then turn the learning state ON.
This allows you to edit a conflicting hotkey on the fly.

Hotkey Format

Composite has a hotkey format standard that needs to be followed in order
for a hotkey to be valid. When creating and editing hotkeys, the following
keystroke conventions apply:

■ All modifiers Ctrl, Alt, and Shift must come before any other keystrokes.

■ Modifiers must be entered in the above order.

■ A hotkey can be composed of one to three modifiers and one normal key.

■ You are limited to four keystrokes per hotkey operation.

■ Key strokes in a hotkey operation are pressed at the same time.

■ You cannot use a combination of keystrokes more than once.

The formatting will be handled by Composite automatically, meaning that
as soon as you release the last key, the hotkey string is automatically generated,
and entered in the value editor.

Resetting Hotkeys

To reset a hotkey:

1 Right-click a hotkey in the Hotkey Editor.

2 Select Reset.

This will reset to the Composite default and remove the hotkey entry
from the active Catalog.

To reset all hotkeys:

1 Right-click a hotkey in the Hotkey Editor.
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2 Select All.

3 Select Reset.

All Composite hotkeys are reset and hotkey entries are removed from the
active Catalog.

Setting User Preferences
A user is defined as a group of settings that belong to a user. The settings
include: color palettes, hotkey catalogs, presets, and bookmarks. Preferences
are stored in a file named .txuser under your user home directory. User
preferences never need to be saved as it is done automatically any time you
make a change to your preferences.

In the File Browser, there is a bookmark set to your User data.

Each user has a set of preferences. When you login, you can set these
preferences to tailor the user interface to your liking. There are two ways to
access the user preferences: from the menu bar at the top of the Composite
application and from the taskbar at the bottom of the application.

To set user preferences:

1 To open the User Preferences window, do one of the following:

■ From the menu bar, select Edit > User Preferences.
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2 In the taskbar, click your user name.■

3 Select the Creative tab.

4 Set the Gate UI preferences.

Animate Gate  Determines the way the panels move into the interface
when you swipe through the Gate UI. Select this option to have the panels
slide into the interface. Deselect to have the panels display immediately
in their final position in the interface.

Icon  Set the transparency of the nodes in the Schematic overlay that
appears when you swipe through the north gate of the Gate UI. A value
of 100 means completely transparent and a value of 0 means completely
opaque.

Background  Set the transparency of the background of the Schematic
overlay that appears when you swipe through the north gate of the Gate
UI. A value of 100 is completely transparent; a value of 0 is completely
opaque.

5 Under Masking Menu Tools, add masking tools to the Masking tab Create
list.

6 Under Timecode/Frame, display the composition in frames or timecode.

7 Under Caching, turn on or off Image Import intermediate results,
Rendered Result intermediate results, and the Create Import Proxy option.

8 Set the Schematic preferences. Set these default values for options that
appear when you right-click outside of a node in the Schematic view:

Navigator  Disable the north gate schematic mini viewer.

Highlight  Highlight tabs and the connections between nodes when
the cursor is passed over it.

Auto Layout  Automatically organize all of the nodes in the dependency
graph.
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Auto Zoom  Automatically zoom the view to include all nodes when
you drag a node outside of the visible area.

Links  Select the style (Curved, Angled, or Straight) of the lines that
connect nodes in the

Schematic view.

2D Flow  Build the dependency graph in the Schematic view in a
left-to-right or top-down direction.

3D Flow  Build the dependency graph in the Schematic view in a
left-to-right or bottom-top direction.

9 Set the Player preferences.

Checkerboard Foreground/Background  Set the foreground and
background colors of the checkerboard pattern that appears in the Player
when you enable RGBA in the Player preferences. This pattern makes it
easier to see the alpha channel of the media. To change the color, click
the color pot and use the Color Picker that appears to select a new color.

Grid Size  Set the size (Small, Medium, or Large) of the individual
squares in the checkerboard pattern.

Fill Color  Set the color of the Player by clicking the Override button.
Click the color picker and select a color.

10 Under Selection History, set history length up to 50 selections. The default
is 10. Set the selection history preferences.

11 Under Display Tools Order, place the Comparison tool before or after the
display modifier—see Comparison Tool on page 806.

12 Select the General tab, which contains the taskbar, drag and drop, numeric
input, paint, application startup, Autosave, and tooltip preferences.

13 Set the taskbar preferences.

Menubar  Show or hide the menu bar.
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Messages  Display messages in the messages area of the taskbar. You
can click the messages area to display a list of messages received to date.

Msg Popup Level  Select the types of messages to appear as pop-ups.
The order of the types in the list is meaningful. Each type includes all
types that appear above it in the list. For example if you select
Information, a popup message appears for all information, warning, error
and fatal error messages. If you select Fatal Error, a popup message appears
only for fatal error messages.

Msg History  Set the maximum number of messages in the list that
appears when you click the message area of the taskbar.

Undo Levels  Set the maximum number of items in the Undo list that
appears when you click the Undo list in the taskbar.

14 Set the drag and drop preferences.

Visual Drag & Drop  See a ghosted image of the selected item as you
drag and drop it in the interface.

15 Set the numeric input preferences.

Linear Motion  Use a mouse or pen with a linear motion to increase
or decrease numeric inputs when in a value editor. This is the default
setting.

Circular Motion  Use a mouse or pen with a circular motion to increase
or decrease numeric inputs when in a value editor.

16 Set the paint preferences.

Commit on Pen-Up  Commit strokes when the pen is lifted from the
tablet. The default setting commits paint strokes when the curser exits
the viewer or when any key is pressed.

Brush in Screen Unit  Retain the brush when zooming in the Player
view.

17 Set the Application Startup preferences.

Project Selection Dialog  View Project Selection dialog at start-up.

18 Load  Choose to load either a default project or the most recent project.

19 Set the autosave preferences.

Destination  The location of your autosave files.

Interval  The length of time between auto saves, between 0 and
240-minute intervals.

20 Set the tooltip preferences.
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Tooltip  Turn tooltips on or off.

21 Select the Scripting tab.

Script Output  Choose to show the script output. You can also enable
the time, stream and context for the script output, and define the
maximum number of lines.

22 Select the Video Preview tab. See Previewing Video on page 172.

Device  Choose a video preview device: Mono Preview, DLP-3D preview
or Segmented Frame Preview.

Show Settings  Turn this option on or off.

23 Select the Metadata tab.

UDA  Add, modify or remove UDAs. For more information on UDAs,
see Creating User Defined Attributes on page 176.

Previewing Video
If your system has the appropriate hardware, you can preview your work on
a broadcast video monitor. Video previewing is available for Composite on
Windows 32-bit. Depending on the level of performance of the video output
card and the graphics card, as well as the host system CPU, Composite can
achieve real-time previewing of 1920x1080 24P resolutions (and below) of
8-bit RGB or RGBA material.

Composite will only display 8-bit pixel formats on the video preview device.
To display 16-bit float and 32-bit float images, you must convert them to 8
bits. You can do this by using a display modifier in the Player that converts
to 8 bits, such as the sRGB, 3D LUT, or Convert Depth tools—see About Utilities
on page 805. Or you can add and connect such a node inside your composition
to explicitly convert your material to 8 bits. Also, see Initialization Variables
on page 873 for the initialization variable for previewing video.

Setting Up Video Previewing
To preview video on a broadcast monitor, you will need the AJA Xena 2K
video card and its accompanying driver installed on your system. For more
information, refer to the Composite Installation Guide for Windows.
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To set up video previewing:

1 Open the User Preferences window by doing one of the following:

■ From the menu bar, select Edit > User Preferences.

■ In the taskbar, click your user name.

2 In the User Preferences window, select the Video Preview tab.

3 For the device, select AJA Preview and click Show Settings.
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4 In the AJA Preview Setup window, select a primary format. This should
match the resolution and update rate of the material you want to preview.
If the resolution does not match, the image will be centered in the video
preview device. If the update rate does not match, the video preview
device will not be updated with a new image at every video refresh.

5 In the Preview Options section, deselect the Auto Resize option.

6 Set any other parameters you would like and click OK. Refer to the AJA
documentation for information on the preview options and color options.

7 In the User Preferences window, click Show Settings if you want to edit
the settings the next time you select the Video Preview tab.

Previewing Video
When previewing a composition's video on a broadcast monitor, you can
work with multiple Players.

NOTE When you zoom out the Player to 0.5, the video image is resized.

To preview video on a broadcast monitor:

1 Open a composition.

2 Create, import, or link to material that is RGB or RGBA.

TIP  If the material is 16 or 32 bits, you can convert it to 8 bits by using a
display modifier in the Player or by adding a Convert Depth node to the
process.

3 Click the Player which contains the video you want to display on the
broadcast monitor.

The Player displays the image generated by the tools in your dependency
graph.

NOTE Manipulators are not shown in the video preview.

4 In the transport controls, press Play to play the composition.
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Creating User Defined Attributes
Create user defined attributes (UDAs) to let you expand the limited number
of already defined attributes associated with the different data types. There
are three types of UDAs:

■ Composition (version)

■ Project

■ User

Composition (Version) UDAs
Composition UDAs are the most important type of UDA as this allows you to
associate data you have in your facility with projects, users and versions of
compositions in Composite. This data could be used to find compositions or
help determine information about the material referenced in the setup, such
as camera setup. Composition UDAs are associated with the versions of
compositions, and can have different information in the UDAs.

Project UDAs
Project UDAs allow your facility to store job related information within the
Composite workflow. This could be used by an artist to find out who is
responsible for a given shot or it could be used to store project information
to be used in a Python script.

User UDAs
User UDAs let you store information related to a specific user in Composite.
This could be used to send a user an email as part of a Python script or to store
job information.

Scoped UDAs
A scoped UDA is a UDA that has an artificial scope defined by the user. For
instance, a UDA called Status has no scope whereas a UDA called Project:Status
has a scope. These UDAs are just a way for you to keep track of what the UDA
applies to; Status applies to all data types while Project:Status should only
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apply to the project data type (although there is nothing stopping you from
referencing a project UDA from the metadata tab in your project preferences).

Creating UDAs
Creating a scoped UDA for a project, user, or composition can be done in one
of two ways: through the metadata tab in the Tool Details, Project Preferences
or User Preferences, or with the XML editor. If you're using the XML editor,
you must specify a UDA in the XML file associated with the given data type.
Each UDA in the XML resource file will be created automatically in the
database, if not already present, when the XML file is loaded—see XML
Resource Files on page 182.
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To create a UDA using the Metadata tab:

 ➤ From the Tool Details, Project Preferences or User Preferences, select
the Metadata tab.
This will reveal a list of user defined attributes. You will now be able
to add, remove or modify UDAs in your project.

■

You can add information to each of the UDAs by clicking in the value
field next to the UDA.

NOTE The Add, Modify, and Remove buttons are disabled unless you
have read/write privileges for the project you are working in. Furthermore,
even with read/write privileges, these buttons will only be enabled when
a UDA is selected.

Add button — clicking this button reveals four selections: Toggle,
Menu, Numerical and Text.

Modify button — clicking this button modifies the information in
the UDA field.

Remove button — clicking this button disables the selected field and
removes it from the list of UDAs, but not from the Metadata tab. If
you remove a pre-created UDA, the control associated with that UDA
in the Metadata tab will be disabled.

■ Add button

Toggle: this control allow you to toggle between two states.

■ Menu: this control allows you to choose between multiple states. You
can specify the valid values by listing items separated by a comma.
You can also decide which item will be the default by clicking Default.
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■ Numerical: this control allows you to define a numerical UDA.

NOTE It is not necessary to fill out all the fields, only the ones that apply
to your project, with the exception of the name field, which must be
filled.

■ Text: this is a text field for data entry.

Create — implements the changes.
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Cancel — cancels the changes and brings you back to the list of UDAs.

Once you have completed your changes, they will be visible in the
original list of UDAs.

NOTE The metadata tab will not reflect the changes made in the manage
mode. If you delete or rename the UDA that appears in the metadata tab,
the associated control will be disabled.

Displaying a UDA
Since it is possible to have more than one data type visible in the browser,
UDAs that have the form Version:..., Project:..., User:... will not be displayed
by default as individual columns in the browser. If the UDA is created by use
of the XML resource file, it will be shown in the Metadata tab in the detail
view area of the tool UI. The UDA can be displayed by right-clicking on the
title bar and selecting the UDA if desired, but the preferred method of
displaying and editing scoped UDAs are through the Metadata tab.
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Using a UDA
When specifying, for instance, a render file name, there is an option for
entering UDAs in the string. The UDAs may be scoped or not and can be
selected from the default lists available or can be created by the user.
See—Creating UDAs on page 177.

To add a UDA to a render file name:

1 Open the Project Preferences window by clicking on the project icon in
the task bar then select the Render tab.

2 Click open the Select UDA menu and select the UDA you want to add to
the File Name string. In this example the scoped Project:Art Director UDA
is selected, loaded and ready to insert into the string.
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3 Place the cursor in the File Name string where you want the UDA to
appear and select UDA.

The UDA is added to the string.

4 Repeat steps 2 and 3 to add more UDAs to the string.

XML Resource Files
Composite is shipped with a default set of XML resources files, one for each
of the above mentioned data types; metadata.composition.xml,
metadata.project.xml, etc. These XML files can be found in the resTables
subfolder of the resources folder of the Composite application folder (udas.xml
file contains the UDAs declaration; the metadata.*.xml file contains the UI
metadata tab UI).When Composite is launched, the udas.xml file is parsed
and any UDA that does not already exist will be created.

These resource files are only used to create the layout to display and edit the
UDAs within the application. If you wish to modify these files and share them
with other workstations running Composite, there is a site preference called
Shared Settings that indicates the path to these XML files. This path, or more
specifically, directory, can be located on the network so that each workstation
uses the same resource file for displaying and creating UDAs. If the files exist
in this directory, they will be used, otherwise the resources files in the default
location will be used.

Shown below are examples of how to create a text field, value editor, menu,
and toggle button. Note the <Uda> name. To make the UDA unique, it should
be prefixed with the data type.
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UdaTextField
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UdaValueEditor

UdaMenu
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UdaPushedToggle
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UDA Declaration
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Default UDA Tag
An optional XML tag in the resource file is used to specify the default value
for each of the UDAs when a data type that has that UDA is created. If no
default tag is specified, the UDA will be empty. The XML tag is <DefaultValue>.

Read-Only UDA Tag
An optional XML tag in the metadata.*.xml resource file is used to specify
whether the UDA is read-only. If no read-only tag is specified, the UDA will
be read-write. The XML tag is <Read-Only>. For example
<Read-Only></Read-Only> or just plain <Read-Only/>. Don't forget the '/'. See
the example above. The read-only tag is only for the UI element so that the
user cannot modify its value.

Other Workspace Functions
There are additional functions available in the workspace, including hotkeys
and zooming and panning a view.

Composite Hotkeys
You can perform many operations using hotkeys—see Hotkeys on page 817 for
a complete list.
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The Player

Topics in this chapter:

■ About the Player on page 190
■ Player View Default Settings on page 190
■ Setting the Target on page 191
■ Setting Context Points on page 191
■ Playing Back in Multiple Views on page 192
■ Playback Performance on page 192
■ Setting the Target for the Player on page 194
■ Setting the Channels for the Target on page 195
■ Setting the Mark In and Mark Out Points for Playback on page 197
■ Setting the Repeat Mode on page 197
■ Setting the Frame Rate for Playback on page 197
■ Setting the Real-Time Playback Preference on page 198
■ Synchronizing or Separating Playback between Views on page 199
■ Setting the Playback Point when the Player Updates on page 200
■ Setting the Resolution for a Player on page 201
■ Setting the Grid in the Player on page 201
■ Setting a Region of Interest (ROI) in the Player on page 202
■ Displaying Masks and Guides on page 203
■ Showing or Hiding Tiles on page 204
■ Turning Hardware Rendering On or Off on page 205
■ Setting the Pixel Aspect Ratio of the Player on page 206
■ Displaying Player Option Information in the Player view on page 206
■ Displaying Manipulators in the Player on page 208
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■ PlayerIn-player pixel displayIn-player Pixel Display on page 209
■ Adjusting the Zoom or Pan on page 209
■ Applying a LUT or Color Conversion Tool to the Player on page 210
■ The Mini-Player on page 211
■ The Fullscreen Player on page 213

About the Player
As stated earlier, the Player is used to play or preview a composition, or preview
media. There are three different versions of the Player: the Player View, the
Mini-Player and the Fullscreen Player view. For more information on each of
these views, please see The Player on page 34 section in the Interface
Fundamentals chapter.

Player View Default Settings
When you add a Player view to a viewport, it has the following settings by
default. You can adjust all of these, except for the repeat mode and f-stop,
through the Player options. You adjust the repeat mode in the Player
controls—see Using the Player Controls on page 36 in the Interface
Fundamentals chapter.

■ Displays the output of the composition.

■ Follows master time.

■ Plays all frames and updates at each frame.

■ Sets the f-stop to 0.00.

■ Plays at the native rate of the composition.

■ Does not display any guides apart from the frame outline, or any masks.

■ Displays RGB.

■ Has repeat mode set to No Repeat.

■ Does not correct pixel aspect ratio.

■ Does not use a display modifier (LUT).
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Calculating Image Size in Composite

All Composite images live on a 2D plane.Composite and PXL use a Cartesian
coordinate system to identify points on the plane.This plane and reference
system are called the Image Reference Frame (IRF). This reference system has
an origin and perpendicular X and Y axes. Units along the X and Y axes have
the same length.By default, Composite images are centered at the origin of
the IRF.In Composite, pixels at the highest resolution have a height of 1 IRF
unit, and have a width equal to their pixel aspect ratio, i.e. 1 IRF unit for 1080P
HD material, 0.9 for NTSC material, and 16/15 (1.0667) for PAL material.

For images with non unit pixel aspect ratios, the height of a pixel is 1, but the
width of a pixel is equal to its aspect ratio (e.g. 0.9 for NTSC). Using IRF units
simplifies image manipulation: for example, translating an image by 10 IRF
units will move the image by the same amount, regardless of the direction of
the translation, horizontal, vertical, or any combination thereof.

Setting the Target
The target for the Player view is what it displays. You set the target for an
individual view in the Player options. The target can be the output node of
the dependency graph, the input or output of a tool node, a specific rendered
output of the composition, or a context point (the output of a specific tool
node)—see Setting the Target for the Player on page 194.

You can specify the channels of the target you want the Player view to display
(RGBA, RGB, A, or any other combination of channels)—see Setting the
Channels for the Target on page 195.

You can set the resolution you want a Player view to use for its target (full,
half, quarter, or proxy). You can use this to improve playback performance
when full resolution playback is not necessary—see Setting the Resolution for
a Player on page 201 and Playback Performance on page 192.

You can set the aspect ratio of the pixels the Player uses for the target, to either
square or non-square pixels—see Setting the Pixel Aspect Ratio of the Player
on page 206.

Setting Context Points
A context point is a specific tool node you mark as the target for a Player view.
No matter which tool node you select, the view always displays that context
point.
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Context points are especially useful when you want to see how changes to a
tool node that precedes the node with context points affect the context point.
You can have the Player view display the output from a context point. You
can set a maximum of four context points.

You set a context point in the Schematic view—see Working with Schematic
on page 50. You use Player options to set the target for a Player view to a
context point—see Setting the Target for the Player on page 194.

Playing Back in Multiple Views
You can have any combination of workspaces including the Player, Schematic,
and Animation Editor views, the three views affected by the Player controls.
You can use the Player controls to play the composition in only the view
currently in focus, or all the views simultaneously.

Master time is an abstract time you can use to synchronize playback among
two or more Player, Schematic, and Animation Editor views. You synchronize
playback between two views by setting both to follow master time. You can
also set an offset for each view, so you can see different parts of the
composition playing at the same time. For example, if you are creating a mask,
you might have two Players, one in which to create the mask, and one to
preview what's ahead, so you can take changes into account as you create the
mask.

Master time always starts at frame 0, and has a duration equal to the length
of the composition. If a composition starts at frame 215 and ends at 564,
master time starts at frame 0 and ends at frame 349.

Standalone time is the opposite of master time. In standalone time, the view
responds to the Player controls only if it currently has the focus; if another
view has focus at that time, the view set to standalone time remains static.
You can also set an offset for standalone time; in this case the offset is relative
to the composition time.

You set a view to use master or standalone time using the Follow Master
preference in the Playback tab of the view options. By default the view is set
to use master time—see Synchronizing or Separating Playback between Views
on page 199.

Playback Performance
The ability to play compositions and media in real time depends on both
hardware configuration and software optimizations.
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Internally, the two key features used to improve playback performance are
tiling and the media cache. The media cache keeps images that have been
loaded close at hand on the local drive for faster retrieval.

To improve playback performance, you can turn on hardware rendering (if
you are compositing with Reaction) and/or define a region of interest. Each
of these has trade-offs (usually between quality and speed) and therefore may
or may not be feasible in a given situation.

Tiling

Images are automatically divided into tiles and processed. Instead of processing
an entire frame, only those tiles that are part of the result of the operation
need processing.

Each tile is 512 by 512 pixels. The number of tiles loaded in the Player at any
point depends on the resolution of the image, the zoom level of the Player,
and the region of interest, if one is defined—see Region of Interest on page
194:

■ In general, a zoom level that displays only a detail of the complete image
requires fewer tiles than a zoom level that displays the complete image.
For example, if you zoom in so that the Player displays only the top-left
corner of the frame, it loads only the tiles needed to display that area of
the frame. Note that the resolution optimization performed during zooms
may have an influence on the number of tiles—see Resolution on page 193.

■ A region of interest that contains only part of the image, requires fewer
tiles than a larger one or than the complete image. Only the tiles that are
part of the region of interest are loaded. You can set the Player to show or
hide the area of the loaded tiles that falls outside the region of interest—see
Showing or Hiding Tiles on page 204.

Resolution

You can set the resolution that a Player view or the fullscreen Player uses—see
Setting the Resolution for a Player on page 201. When full resolution is not
required, working at less than full resolution can improve playback
performance.

When you change the resolution of a Player, a new copy of the image is
retrieved and added to the media cache at the new resolution and tiled for
that resolution.

NOTE When you zoom out in the Player, the resolution is automatically adjusted
to the optimal one for that zoom level. This reduces the load on the computer.
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Hardware Rendering

You can switch to hardware rendering when using Reaction to improve
playback performance when the quality of the output is secondary to the
speed of playback—see Turning Hardware Rendering On or Off on page 205.

NOTE Only Reaction nodes benefit from hardware rendering. For all other tool
nodes, switching to hardware rendering has no effect.

Region of Interest

You can define a subsection of the frame processed for playback by defining
a region of interest. This can improve playback by limiting the area of the
frame that needs to be processed for the playback.

The region of interest has no effect on rendering an output. When you render
an output, the entire frame is always rendered. The Region of Definition (ROD)
is used to determine the area to render when you render an output.

Setting the Target for the Player
You can set the target for a Player view or the fullscreen Player, as well as set
the channels of the target that the Player view or fullscreen Player displays—see
Setting the Channels for the Target on page 195.

NOTE You can set the target and channels for the target in the fullscreen Player
only if you entered it through a Player view.

To set the target for a Player:

1 Do one of the following to display the Player options:

■ In the Player view or fullscreen Player, press the tilde key (~) or
middle-click and go through the south gate.

■ In the Player view or fullscreen Player, right-click to display the Player
menu.

2 In the Player options, select the Display tab, or choose Display mode in
the menu.
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3 Select the target you want the Player view to display.

To display:Select:

The output of the node on which you have set context point 1.C1 Output

The output of the node on which you have set context point 2.C2 Output

The output of the node on which you have set context point 3.C3 Output

The output of the node on which you have set context point 4.C4 Output

The input of the tool node currently selected in the Schematic view.
When you select a tool node in the Schematic view, the Player updates
to display what that node receives as input.

Tool Input

The output of the tool node. When you select a tool node in the
Schematic view, the Player updates to display the output of that node.

Tool Out-
put

The composition as it appears in the final node of the dependency graph
(the Output node in the Schematic view).

Composi-
tion

One of the rendered outputs of the composition. You use the Results tab
of the Tool UI to select which rendered output the Player displays.

Rendered
Output

Sets the player in focus to view the output of the tool for which the mask
is being edited.

Tool Set

4 To exit the Player options, move the cursor to another area.

Setting the Channels for the Target
You can specify the channels you want the Player view or fullscreen Player to
display for its target.
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NOTE You can set the channels for the target in the fullscreen Player only if you
entered it through a Player view.

To set the channels for the target:

1 Do one of the following to display the Player options:

■ In the Player view or fullscreen Player, press the tilde key (~) or
middle-click and go through the south gate.

■ In the Player view or fullscreen Player, right-click to display the Player
menu.

2 In the Player options, select the Display tab or select View Mode in the
menu.

3 Set the channels for the target.

To display:Select:

All channels (RGBA, RGB, or A) contained in the target. For example,
if the target is the output of an RGBA composition, it displays RGBA

Chns: RGB

channels. If the target is the output of an RGB composition, it displays
RGB channels.

The red, green, and blue channels.RGB

The red, green, blue, and alpha channels.RGBA

The alpha channel.A

Any combination of RGBA channels. Enter the combination you want
as a four-character string in which you specify each channel either as

<user-
defined>

the channel letter (if you want to display it), or as a blank (if you do
not want to display it). Position is significant: the first position is R, the
second G, the third B, and the fourth A. For example if you wanted to
see only the blue and alpha channels, you would enter two spaces or
2 'Ns' followed by BA.
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Setting the Mark In and Mark Out Points for
Playback
You can set the mark in and mark out points that the Player views use to play
back a composition. By default the Player view uses the mark in and out points
set for the composition, or, if none are set, uses 0 as mark in and 1 as mark
out.

To set the mark in and mark out points:

1 Open the composition for which you want to set mark in and mark out
points.

2 In the Tool UI, select the Composition tab.

3 Edit the Mark In and Mark Out fields.

The Current Frame field in the Player controls updates to reflect the
changes you make to the fields. The area between the mark in and mark
out points (the playback area) appears in light gray.

Setting the Repeat Mode
You set the repeat mode in the Player controls—see Using the Player Controls
on page 36.

Setting the Frame Rate for Playback
You can set the frame rate that the Player view or fullscreen Player uses for
playback.

NOTE You can set the frame rate for the fullscreen Player only if you entered it
through a Player view.
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To set the frame rate for playback:

1 In the Player view or fullscreen Player, middle-click or press the tilde key
(~) to display the Gate UI and go through the south gate.

2 In the Player options, select the Playback tab and locate the Frame Rate
area.

3 Set the playback frame rate for the Player view by deselecting the User
button and specifying a frame rate in the field beside the button. Select
the User button to use the frame rate set for the composition.

Setting the Real-Time Playback Preference
In a Player view or in the fullscreen Player, you can set a Player preference
that determines whether real-time playback has priority over a playback that
includes every frame or vice-versa. Real-time playback is also influenced by
the hardware on which you are running Composite, and the load on that
machine at the time you perform the playback.

NOTE You can set the real-time playback preference for the fullscreen Player only
if you entered it through a Player view.

To set real-time playback preferences:

1 In the Player view or fullscreen Player, middle-click or press the tilde key
(~) to display the Gate UI and go through the south gate.

2 In the Player options, select the Playback tab and locate the Frame Rate
area.

198 | Chapter 10   The Player



3 Set the real-time playback preference.

Play All Frames  Select this button to play every frame, regardless of
the impact on real-time playback. Deselect to have the Player view drop
frames if necessary to perform playback as close to real-time as possible.

NOTE A busy cursor appears in the lower-left corner of the Player when
Composite is processing the composition during playback.

4 If you want the Player to stop playing if a tool is dropped into the
dependency graph, select the Stop on Drop button.

Synchronizing or Separating Playback between
Views
You can set a Player, Schematic, or Animation Editor view to use either master
or standalone time. Master time is used to synchronize playback among
views—see Playing Back in Multiple Views on page 192.

To set a view to use master or standalone time:

1 In the Player view or fullscreen Player, go through the south gate.

2 In the view options, select the Playback tab and locate the Viewer Time
area.

3 Set the time the view uses.

Follow Master  Select this button to use master time. Deselect to use
standalone time.
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Offset  Select this button to set an offset, in frames, for the time. Type
the offset in the field to the right of this button, or click and drag on the
bottom edge of the field to adjust the value. The frame offset is with
respect to the time you set for the view. For example, if you set a frame
offset of 5 and selected Follow Master, the view always displays the frame
that is five frames ahead of the frame currently running in master time.
If you deselected Follow Master, the view always displays the frame that
is five frames ahead of the frame running in the standalone time of the
view.

Setting the Playback Point when the Player
Updates
You can set the point when a Player view or the fullscreen Player updates its
display.

NOTE You can set the playback point when the fullscreen Player updates only if
you entered it through a Player view.

To set the playback point when the Player updates its display:

1 In the Player view or fullscreen Player, middle-click or press the tilde key
(~) to display the Gate UI and go through the south gate.

2 In the Player options, select the Playback tab and locate the Viewer Time
area.

3 Set the point when the Player updates its display.

Update on Play  Select this button to update the image at each frame
when you play the composition. Deselect to update the image only when
you stop playing the composition, and only at the scrub frames when
you scrub through the composition.
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Setting the Resolution for a Player
You can set the resolution that a Player view or the fullscreen Player uses. This
is useful for improving playback performance when a high resolution image
is not necessary.

NOTE You can set the resolution for the fullscreen Player only if you entered it
through a Player view.

To set the resolution the Player uses:

1 In the Player view or fullscreen Player, middle-click or press the tilde key
(~) to display the Gate UI and go through the south gate.

2 In the Player options, select the Display tab, and locate the Streams area.

3 Select the resolution you want the Player view to use.

The Player immediately updates to use the resolution you enable.

Things to Remember

■ When you launch the fullscreen Player from a Player view, it uses the
resolution set for that Player view. In all other cases it uses full resolution.

■ The mini-Player always uses proxy resolution.

■ When you zoom out in the Player, the resolution is automatically adjusted
to the optimal one for that zoom level. This reduces the load on the
computer.

Setting the Grid in the Player
See Setting the Player Settings on page 244.
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Setting a Region of Interest (ROI) in the Player
You can set a region of interest in a Player view or in the fullscreen Player.

NOTE You can set a region of interest in the fullscreen Player only if you entered
it through a Player view.

To set a region of interest in the Player:

1 Do one of the following to display the Player options:

■ In the Player view or fullscreen Player, middle-click or press the tilde
key (~) to display the Gate UI and go through the south gate.

■ In the Player view or fullscreen Player, right-click to display the Player
menu.

2 In the Display tab of the Player options, click the ROI button to enable
a region of interest. Or, in the Player menu, select ROI.

The Player view updates to display a yellow box with resize handles.
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3 Use the resize handles to adjust the region of interest.

You can resize the box to adjust the region of interest at any point. It
remains visible as long as ROI is enabled.

Things to Remember

■ When you define a region of interest (ROI), you can choose to show or
hide the areas of the loaded tiles that fall outside the ROI—see Showing
or Hiding Tiles on page 204 and Tiling on page 193.

Displaying Masks and Guides
You can use masks to preview the target of the Player view or the fullscreen
Player in different film format aspect ratios. You can use guides to show the
frame outline, as well as the safe areas within the frame for titles and action.

NOTE You can display masks and guides in the fullscreen Player only if you entered
it through a Player view.

To display masks/guides in the Player:

1 In the Player view or fullscreen Player, middle-click or press the tilde key
(~) to display the Gate UI and go through the south gate.
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2 In the Display tab of the Player options, locate the Masks and Guides
areas.

3 In the Masks area, select the mask you want the Player to display, or select
None if you do not want to display a mask. Each mask represents the
aspect ratio of a specific film format.

The Player updates immediately to reflect the mask you select.

4 In the Guides area, enable the guides you want the Player to display.

The Player updates immediately to reflect the guides you enable or disable.

To display the:Select:

Safe title guide. This guide indicates the area of the frame in which it
is safe to place titles and graphics (i.e. in which there is no risk of having

Safe Title

titles or graphics cropped by the device on which the shot is viewed).
The safe title area is inside the safe action area.

Safe action guide. This guide indicates the area of the frame within
which there is no risk of having any of the image cropped by the device

Safe Action

on which the shot is viewed. The safe action area is larger than, and
encloses, the safe title area.

Frame guide. This guide indicates the edges of the frame.Frame Out-
line

Showing or Hiding Tiles
When you define a region of interest (ROI), playback performance can be
improved by loading only the tiles required to display that ROI. You can
choose to show or hide the areas of the loaded tiles that fall outside the ROI.

You can show or hide tiles in a Player view or the fullscreen Player.
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NOTE You can show or hide tiles in the fullscreen Player only if you entered it
through a Player view.

To show or hide the area of the tiles that fall outside the region of interest:

1 In the Player view or fullscreen Player, middle-click or press the tilde key
(~) to display the Gate UI and go through the south gate.

2 In the Player options, select the Display tab.

3 Under Interaction, select Mask Tiles.

NOTE Show or hide tiles is only available if you defined a region of interest
in the image.

Turning Hardware Rendering On or Off
If you are compositing with Reaction, you can turn hardware rendering on
or off for a Player view or the fullscreen Player. For all other tool nodes,
switching to hardware rendering has no effect.

NOTE You can turn hardware rendering on or off in the fullscreen Player only if
you entered it through a Player view.

To turn hardware rendering on or off in the Player:

1 In the Player view or fullscreen Player, middle-click or press the tilde key
(~) to display the Gate UI and go through the south gate.

2 In the Player options, select the Tools tab and locate the Reaction area.

3 Select Interactivity to use hardware rendering.
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Deselect Interactivity to have the view use software rendering. Note that
the Reaction tool disregards any display modifier set for the Player when
Interactivity is enabled. Recall that you set a display modifier for a Player
in the third tab of the Player options—see Applying a LUT or Color
Conversion Tool to the Player on page 210.

4 Select View Name to display the name of the Reaction view currently
being shown (reference or camera).

Things to Remember

■ Hardware rendering is only used with Reaction nodes.

Setting the Pixel Aspect Ratio of the Player
You can set the aspect ratio of the pixels that the Player view or fullscreen
Player uses, either square and non-square pixels.

NOTE You can only toggle the pixel aspect ratio in the fullscreen Player if you
entered it through a Player view.

To set the pixel aspect ratio in a Player view:

1 In the Player view or fullscreen Player, middle-click or press the tilde key
(~) to display the Gate UI and go through the south gate.

2 In the Player options, select the Display tab.

3 Under Interaction, select Aspect Ratio to use non-square pixels. In this
case the Player displays the image using the pixel aspect ratio defined for
the composition. You can examine this ratio in the Pixel Aspect Ratio
field in the Composition tab of the Tool UI. Deselect Aspect Ratio to use
square pixels.

Displaying Player Option Information in the
Player view
You can set the Player view or the fullscreen Player to display information in
a bar at the bottom of the Player. This is a convenient reminder of the options
set for that Player, and can be particularly useful when you using more than
one Player view.
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NOTE You can display target information in the fullscreen Player only if you entered
it through a Player view.

To display information about the target, in the Player:

1 In the Player view or fullscreen Player, middle-click or press the tilde key
(~) to display the Gate UI and go through the south gate.

2 In the Display tab of the Player options, locate the Information area.

3 Set the information you want the Player to display.

To:Select:

Display the name of the composition followed by a colon and the
name of the target set for the Player. Remember, you set the target

Target

for the Player view in the Display area of the Display tab of the
Player options. Targets are represented as follows:

■ Output indicates that the target is a composition.

■ <toolname> Out indicates the target is a Tool Output.

■ <toolname> In indicates the target is a Tool Input.

■ A context point is represented as the name of the context
point, followed by the name of the tool node on which it is
set, followed by either In for Input or Out for Output.

Display the position within the composition, of the frame that
currently appears in the Player. The position is represented as a
frame number.

Time

Display the frame rate of the target.Frame Rate

Display the resolution and pixel aspect ratio of the target.Format

Display the name of the tool(s) used in this composition.Display Tools
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To:Select:

Display the channels (RGB, RGBA, A, or another combination of
these) that appear in the Player. You set the channels you want

View Mode

the Player to display in the View area of the Player options—see
Setting the Target for the Player on page 194.

Display the bit depth of the target.Depth

Display the current zoom level of the Player.Zoom

Display the time offset set for the Player. Recall that you set the
time offset in the Playback tab of the Player options—see Synchron-
izing or Separating Playback between Views on page 199.

Offset

Offset  Display the time offset set for the Player. Recall that you set the
time offset in the Playback tab of the Player options—see Synchronizing
or Separating Playback between Views on page 199.

Displaying Manipulators in the Player
You must enable the display of manipulators in the Player view or in the
fullscreen Player to see manipulators related to individual tools. Manipulators
for individual tools include the eyedropper for the Color Picker, axes in the
Reaction tool, and control points in the Garbage Mask tool.

NOTE You can enable the display of manipulators in the fullscreen Player only if
you entered it through a Player view.

To display manipulators in the Player:

1 In the Player view or fullscreen Player, middle-click or press the tilde key
(~) to display the Gate UI and go through the south gate.

2 In the Display tab of the Player options, select Manipulators (at the
bottom of the Guides area).
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In-player Pixel Display

To display positional and color value information about a particular pixel in
an image:

1 Zoom the Player to view the pixel.

2 Place the cursor in the player over the pixel and press Z.

Adjusting the Zoom or Pan
You can zoom or pan in the Player view, the fullscreen Player, or the
mini-Player.

To zoom in the Player:

 ➤ Do one of the following:

■ In the Player, press Up Arrow to zoom in or Down Arrow to zoom
out.

■ Press Ctrl + Spacebar(for Windows and Linux) or Cmd + Spacebar(for
Mac OS) and drag right to zoom in or left to zoom out.

■ To zoom a region Region zoom; User drag out a box, and the view is
zoomed (uniformly or not, depending on the viewer) to fit the viewer
extents. You can also use the Shift + Spacebar + drag hotkey
combination.

■ Press Home to reset the zoom factor to 1. Pressing Home again will
set zoom to previous zoom factor. This is not available in all viewers.
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To pan in the Player:

 ➤ In the Player, press Spacebar and drag.

Things to Remember

■ When you zoom out in the Player, the resolution is automatically adjusted
to the optimal one for that zoom level. This reduces the load on the
computer.

Applying a LUT or Color Conversion Tool to the
Player
You can apply any LUT or color conversion in the Tools tab to a Player view
or the fullscreen Player. This affects only what that particular Player displays;
it has no effect on the composition data. You can also apply a tool preset as
a display modifier in the Player—see Using Tool Presets as a Display Modifier
on page 148.

NOTE You can apply a LUT or color conversion tool to the fullscreen Player only
if you entered it through a Player view.

To apply a LUT or color conversion tool to the Player:

1 In the Player view or fullscreen Player, middle-click or press the tilde key
(~) to display the Gate UI and swipe east to display the Pick List, Tools,
and Views tabs.

2 In the Tools tab, select a tool to apply to the Player. Drag it outside the
Tools tab, and do one of the following:

■ Pause over the Player view in which you want to apply the tool.

■ In the fullscreen Player, pause anywhere.

3 In the Player, middle-click or press the tilde key (~) to display the Gate
UI and go through the south gate.

The Player Options appear.

4 Position the cursor over the last tab of the Player Options and release.

The name of the tab changes to that of the dropped tool. The Player
updates to reflect the result of applying the LUT or color conversion tool
to the image.
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To remove a display modifier from the Player:

1 In the Player, middle-click or press the tilde key (~) to display the Gate
UI and go through the south gate.

The Player Options appear.

2 Select the Display tab.

In the Tool Options area on the right, click Delete.

Things to Remember

■ You can display the name of the tool you use, in the information bar at
the bottom of the Player view—see Displaying Player Option Information
in the Player view on page 206.

■ The Reaction tool disregards any display modifier set for the Player when
the Interactivity option is selected.

The Mini-Player
The mini-Player appears on the left in the Information tab area when you
select a media file or composition in the File Browser. The mini-Player lets
you preview compositions, as well as media prior to importing. You must have
the Information tab selected to see the mini-Player.

The mini-Player contains a limited subset of the Player controls available for
Player views. This reflects the context in which you use the mini-Player (to
browse compositions in the project folders or preview media prior to
import)—see Using the Mini-Player on page 212 for help using the controls.

The mini-Player
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Using the Mini-Player
The mini-Player lets you preview media compositions in project folders and
lets the project administrator preview media prior to import—see The File
Browser on page 41. The mini-Player includes controls to play the composition
or media. You can also scrub or move to a specific frame of the composition
or media.

To display a composition or piece of media in the mini-Player:

 ➤ In a File browser, select a composition.

The composition is loaded in the mini-Player.

To play the composition or media in the mini-Player:

 ➤ Use any of the playback controls.

To:Click:

Play the composition forward.

Display the fullscreen Player.

Step backward one frame.

Step forward one frame.

Move to mark in frame.

Move to mark out frame.

To scrub through the composition or media in the mini-Player:

 ➤ Click and drag in the Current Frame field.
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(a) Current Frame field

To move to a specific frame of the composition or media:

 ➤ Click in the Current Frame field, enter the frame number to which you
want to move, and press Enter.

(a) Current Frame field

The Fullscreen Player
The fullscreen Player occupies the entire screen (the taskbar is also hidden)
and is available from any Player view, as well as from the mini-Player.

When you enter the fullscreen Player, it plays the composition or media
forward from the frame at which you entered the fullscreen Player.
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The fullscreen Player

Fullscreen Player and the Gate UI
When you enter the fullscreen Player through a Player view, the Gate UI is
available. You can thus add tools to a composition by going through the east
gate, display and work in the Schematic overlay by going through the north
gate, set Player options by going through the south gate (or from the context
menu), or use the composition browser by going through the west gate.

NOTE When you set Player options in the fullscreen Player, they are saved and
applied to the Player view you were in when you entered the fullscreen Player. For
example, if you set a region of interest while in the fullscreen Player, when you
exit, that region of interest appears in the Player view.

Player Controls in the Fullscreen Player
The fullscreen Player occupies the entire screen and does not, by default,
display any Player controls. You can access the Player controls by displaying
the Player options from within the fullscreen Player (go through the south
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gate). The Player controls appear at the bottom of the Player options. You use
them as you would in the Player view—see Using the Player Controls on page
36.

You can also use the Player hotkeys to navigate frames, set in and out marks,
set a region of interest, and so on—see Player on page 829.

Using the Fullscreen Player
You can enter the fullscreen Player from either the Player view or the
mini-Player. If you enter the fullscreen Player from a Player view, you can add
tools to the composition, either directly from the Views tab, or by dropping
the view from the Views tab into the Schematic overlay. If you enter the
fullscreen Player from the mini-Player, you can only access the Player options
from the Gate UI.

To enter the fullscreen Player:

 ➤ In the playback controls, click the Fullscreen button or press F.

To exit the fullscreen Player:

 ➤ Press F.

To control the fullscreen Player:

1 Press L to play forward, press L again to stop.

2 Press J to play backward, press J again to stop.

NOTE When you enter fullscreen mode, the Player plays forward by default.

To add a tool to the composition in the fullscreen Player:

1 In the fullscreen Player, middle-click or press the tilde key (~) to display
the Gate UI and swipe east to display the Pick List, Tools, and Views tabs.

2 In the Tools tab, drag the tool you want to add to the composition, and
drop it in the fullscreen Player. A drop gate appears and you can specify
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where to add it in the dependency graph (the options that appear depend
on the current tool node selected when you perform the drop).

To add a tool to the Schematic overlay in the fullscreen Player:

1 In the fullscreen Player, middle-click or press the tilde key (~) to display
the Gate UI and swipe right to display the Pick List, Tools, and Views
tabs.

2 In the Tools tab, drag the tool you want to add to the composition outside
the Tools tab, but do not release it.

3 Go through the north gate to display the Schematic overlay, and drop
the tool in the position in the dependency graph you want it to occupy.

To Navigate Views:

 ➤ Press Ctrl + Tab.
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Working with
Compositions

Topics in this chapter:

■ Creating Compositions on page 217
■ Rendering, Caching and Versioning on page 224
■ Linking Compositions on page 234
■ Closing a Composition on page 236

Creating Compositions
A composition is a file that contains both the current work and the different
versions, if any, of that work. Compositions are stored in your file system.

What's in a Composition File?
A composition is stored as a file or a group of files, depending on its state. For
a newly created composition, a file named <compname>.txcomposition will exist
on the file system. Within Composite, you will see only the name part of the
file, not the extension. Whenever a new version is created, a new directory
named <compname>.txversions is created and contains additional files, one for
each version. Also, if you happen to have some Raster Paint nodes in your
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composition, another directory, named <compname>.txpaintstrokes is created
to store the paint strokes. By default, the browsers in Composite do not show
the versions and paint strokes directories. To see them, you must deselect the
Collapse Compositions option.

Creating a New Composition
You can create a new composition and have it open automatically.

To create a new composition:

1 Do one of the following:

■ Select File > New or press Ctrl + N (for Windows and Linux) or Cmd
+ N (for Mac OS). Type in a name for your composition.

■ In a browser, right-click an empty area and select New Composition.
Type in a name for your composition. Open your new composition
by double-clicking it, or by selecting it and clicking Open.

An Output node appears in the Schematic view (if you have one
visible).

2 In the Composition tab of the tool UI, update the properties for the
composition. Some properties are editable.

Name  The name of the composition.

Type  Designate the composition as footage or as a composition—see
Footage Role on page 137.

Created  Date the composition was created.

Modified  Date the composition was last modified.

Owner  User name associated with the composition.

Source  Identifies the source application from which the composition
media is derived. Usually it is Composite, but if you are using files
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generated by another application, such as Maya, the source would be set
accordingly. You can edit this field.

Path  Location of the composition.

Description  Information you can enter about the composition.

Primary Output  Select the output to use as the principal output of the
composition. The format, width, height, image aspect ratio, pixel aspect
ratio, and rate settings are those of the primary output—see Primary
Output on page 58.

Format  Set the resolution of the composition by specifying a known
film or video format. The format you select is linked to the following:
width, height, image and pixel ratio, and rate. Select Custom to define a
non-standard format.

Width, Height  Width and height (in pixels). These values, together
with ratios and rate, may correspond to a predefined format, in which
case the format is automatically selected. Otherwise, the format selected
is Custom.

Image Aspect Ratio and Pixel Aspect Ratio  The ratio is expressed as a
fraction representing the proportion, width:height, of the image. This
value, together with width, height, pixel ratio and rate, may correspond
to a predefined format, in which case the format is automatically selected.
Otherwise, the format selected is Custom. Image and pixel ratio are linked;
changing one updates the other.

Rate  Frame rate expressed as frames per second (fps). For a given
format, a limited number of rates are available. To set a non-standard
rate for a given format, change the format to Custom.

Channels  Set the image channel for the primary output: RGB, RGBA,
A.

Depth  Select the bit depth (8, 16, or 32 bits) for the primary output.

Start, End, Duration  Set the start, end, and duration of the primary
output. End is exclusive, so Duration = End - Start. Example Start=0,
End=30, Duration=30. Start=1, End=31,Duration=30. And so on.

Poster  Frame used for proxies, defaults to start value.

Mark In/Mark Out  Set the in point and out point for the primary
output.

Repeat  Select the default repeat mode (Hold, Loop, Ping-Pong, No
Repeat) for primary output when you play it.
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Opening and Viewing Compositions
There are two modes in which you can load a composition into Composite:
Open and View. The Open mode allows you to modify the composition
(read/write mode). The View mode allows you to view the dependency graph
and all attributes in the tool UI, but without being able to modify anything
(read-only mode). There is a circumstance where a composition can only be
viewed, and that is whenever another user has already opened the same
composition for modification. This is indicated in the browser by a yellow
read-only icon.

(a) Read-only icon

To open a composition:

1 Select File > Open or press Ctrl + O (for Windows and Linux) or Cmd +
O (for Mac OS).

2 In the File Browser, do one of the following:

■ Double-click a composition.
The composition is opened in Open mode (read/write). If the
composition is in use by another user, it will open in View mode (read
only).

■ A more advanced technique would be to right-click a composition
and select Open. If the composition has more than one version, they
are displayed in a list. Select a version to open.
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The version of the composition is opened in read/write mode. If the
version is in use by another user, it will open in View mode (read
only).

■ Select a composition and drag it to the Schematic or Player. In the
Gate UI that appears, swipe east to open the composition.
If the composition is not in use and there is no composition currently
open, the following Gate UI is displayed. Swipe through the east gate
to open the composition.

If the composition is not in use and there is already an open composition,
the following Gate UI is displayed. Swipe through the east gate to open
the composition.

The composition opens in Open mode or View mode. In the tool UI, the
Composition tab is displayed.

3 The name of the currently open composition is displayed in the taskbar.
Click beside the Composition icon to view the list of open compositions.
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(a) Composition icon

To view a composition:

1 Select File > Open or press Ctrl + O (for Windows and Linux) or Cmd +
O (for Mac OS).

2 In the File Browser, do one of the following:

■ Select a composition, then right-click and select View.

NOTE Advanced technique: if the composition has more than one version,
they are displayed in a list.

You can view any of these versions.

■ Select one or more compositions, and drag them to the Schematic or
Player. In the Gate UI that appears, swipe north to view the
compositions.

The name of the composition you are viewing is displayed in the taskbar.

3 Click the composition icon to view the list of opened or viewed
compositions.

(a) Composition icon (b) List of opened or viewed compositions
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Saving Compositions

To save a composition:

 ➤ Select File > Save or press Ctrl + S (for Windows or Linux) or Cmd + S (for
Mac OS).

To save a composition with a different name:

1 Select File > Save As.

2 In the Save Composition As browser that opens, enter a different name
for the composition and click Save.

Inserting a Composition
When inserting a composition, you are actually copying its nodes into the
currently open composition. The composition being inserted is not affected
by the insert operation.

To insert a composition:

1 Select File > Open or press Ctrl + O (for Windows and Linux) or Cmd +
O (for Mac OS).

2 In the File Browser that opens, select a composition and drag it to the
Player or Schematic view.

3 In the Gate UI that appears, swipe west to insert the selected composition
in your current composition. All nodes from the selected composition
are inserted, except its output nodes.
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Checking the Status of Compositions
You can check whether a composition is open or whether it is view-only.

To check the status of compositions:

1 In the taskbar, click beside the composition icon to display the list of
compositions.

2 Look at the version icon for each item in the list. A yellow icon indicates
a view-only composition. Icons that are not colored indicate compositions
you have open for modification.

Rendering, Caching and Versioning
The following is a description of rendering, caching and versioning techniques.

Rendering a Composition
You can render a composition at any time, to save the final output of a
composition. When you render a composition, you choose the output(s) you
wish to render, and the way in which they will be rendered, which is called
the render action, as either the foreground or one of the many background
actions. A progress bar displays the rendering of frames for all outputs. The
outputs are rendered in parallel, one frame index after another alternating
between each output. This can speed up the rendering process because some
intermediate results are reused.

To render a composition:

1 Go to the File menu and click Render or click Alt+R. The Render dialog
will display.
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2 Click the Select All or Deslect All button to enable or disable rendering
for all outputs.

3 Click the Output button to enable or disable the render for an individual
output.

4 Click the Edit button to map the UI for this node. This will dismiss the
Render dialog.

5 Click the Action button to select the way in which you want to render
your composition. By default, Composite has three render actions, to the
foreground, background or backburner.

Foreground will perform the render while blocking further interaction
with the Composite UI. It will only use the local machine, but is the
fastest single-machine rendering option. Its disadvantage is that you
cannot use Composite while rendering proceeds.

Background will also perform the render on the local machine, but allows
you to continue using Composite during rendering. It is slower than
Foreground rendering.

Rendering a Composition | 225



Backburner dispatches rendering to Autodesk Backburner(TM), Autodesk's
distributed network rendering solution. As for Background rendering,
you can use Composite while rendering proceeds. When you choose
Background or Backburner rendering, the render is done on a copy of the
composition: modifying the composition while it renders will not affect
the result of the rendering.

6 Click the Render Actions button to dismiss the Render dialog, and display
the Render Actions tab in the Project Preferences dialog. This allows you
to edit the existing render actions, or define new ones.

7 Set the Start and End values to set the start and end frames for this render.

8 Click the Reset button if you wish to modify the Start and End frames to
include frames of all the currently selected outputs.

9 Finally, click the Start button to begin rendering, or click the Cancel
button.

To display the list of background tasks:

 ➤ In the taskbar, click the number representing the number of ongoing
render tasks.

(a) Number of ongoing render tasks

Caching
Composite can keep track of previously-computed images through an image
cache, called the media cache. While building your composition, you will
frequently connect new nodes to the output of existing nodes. It is beneficial
for performance to avoid re-computing the image results of existing nodes,
and rather read previously-computed results from a cache.

Composite supports this through its media cache, which features two caching
levels: an automatically managed in-memory cache, which is limited by the
size of available memory, and a disk-based cache that you can turn on per
node.
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Disk cached results are called intermediate results. It is counter-productive to
enable intermediate results at every node in your composition: the increased
disk usage in reading and writing to the disk cache will negate the gains from
caching. Instead, try to identify the subgraph parts of your composition that
are costly to compute and are heavily used, and cache only the outputs of
those subgraphs.

For example, if you have nine subgraphs connected to nine different image
sources of a single Reaction node, you can cache the outputs of those nine
subgraphs. In this way, working in Reaction will only involve reading disk
cached results for the nine subgraphs, rather than re-computing each one of
them at potentially very high cost.

Intermediate results are the results rendered at the output of any node, other
than the output nodes, in the dependency graph. When you set a node to
create intermediate results, the frames displayed in the Player when you
preview the results are saved to your local media cache. These frames do not
need to be reprocessed as you continue adding tool nodes and viewing the
results.

For example, you can add a glow tool to your composition and set it to create
intermediate results. As you play the composition (or scrub through the
frames), the glow is displayed as it processes. At the same time, the result is
stored in your local media cache. If you add another node after the glow,
Composite will not reprocess the frame.

Intermediate results are stored in the media cache as long as there is room.
When the media cache is full, Composite will start discarding the images that
are least recently used. You should consider this and the type of work you are
doing when you turn on intermediate results for a node.

Because intermediate results are disk-based, they are available from one
Composite session to the next: closing a composition (or closing Composite
itself) does not clear the media cache. In contrast, memory cached results are
discarded when a composition is closed (or Composite itself is closed).

Composite’s in-memory cache is read before attempting to read from the
intermediate results. If a frame is generated and reused before the memory
cache is exhausted, there won't be any need to visit the IRs in the media cache.

To create intermediate results on a node:

 ➤ Do one of the following:

■ In the Schematic, click the orange IR tab at the lower-right of a node.

■ Select a node from the dependency graph and click the IR button in
the Tools Options area.
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To clear the media cache of intermediate results:

 ➤ Open a File Browser (Ctrl + O for Windows and Linux, Cmd + O for Mac
OS), right-click a composition and select Clear Cache.

The intermediate results for all nodes of all versions of the composition
are cleared.

Creating Versions of a Composition
You can create as many versions of your composition as you like, to facilitate
creative decisions, to preserve a composition in a given state for later reference,
or to track changes you have made.

To create a new version of a composition:

1 In the Tool Details area, click the Versions tab.

2 Click the New button, located in the bottom-left corner of the tab. You
can then see the new version in Versions tab window.

3 Compositions always contain a working version and a primary version.
The working version is the one that is edited by default. The primary
version is other one that is linked to by default, for compositions that
link to this one.

Select any version in the Version browser to display its outputs and their
rendered status in the Output browser at the right of the Version browser.
You can also open, view, delete, and revert the selected version from the
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Version browser. See the Viewing Rendered Versions of a Composition
on page 230subsection.

When you revert to a previous version of a composition, the contents of that
version are copied over to the working version.

Rendering Results over a Network
The Render Actions tab in the Project Preferences dialog allows you to edit
existing render actions, and define new ones. To define a new render action,
right-click in the render actions browser at left, and select "New". Select an
existing render action to edit it. Render actions use variables, or tokens, that
are replaced with actual values when the action is run.

DescriptionVariable

Composite root installation folder.<InstallDir>

Points to the \resources\bgTasks folder of the Composite in-
stallation.

<BgTaskDir>

Points to the Python executable used by Composite.<PythonExec>

Folder on the network where shared data files are stored.<SharedDataDir>

The destination folder specified in the current project's
Rendered settings.

<DestinationPath>

The current user.<CurrentUser>

The current project.<CurrentProject>

The path to the current composition.<CompositionPath>

The path of the current project.<ProjectFolder>

The current composition name.<Name>

The current date.<Date>

The current time.<Time>

The file name pattern specified in the current project's Rendered
settings.

<FilenamePattern>
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DescriptionVariable

The custom string associated with the current composition.<Custom>

The current frame number (only available in the file name
Rendered setting).

<FrameNo>

The number of frames in the current composition.<NbFrames>

The start frame index for the current composition.<StartFrame>

The end frame index for the current composition.<EndFrame>

The current rendered result name.<RenderedResult>

For network rendering:

1 Ensure Composite is installed in the same path on every workstation that
is part of the render farm, for example: C:\Program Files\Autodesk\Autodesk
Composite 2011\Composite\

2 Ensure the rendering application is installed on every workstation that
is part of the render farm.

NOTE If you are using the Autodesk Backburner network rendering
application, ensure that one Backburner Manager is running on one
workstation and one Backburner Server is running on each workstation that
is part of the render farm. In addition, each Backburner Server should be
connected to the Backburner Manager.

Viewing Rendered Versions of a Composition

NOTE This procedure is aimed at advanced Composite users.

In the Versions tab, you can view the list of all versions for a composition
when you have that composition open. Once you have rendered versions of
a composition, you can open and view any of them, as well as revert and
render any unrendered compositions you may have.

To view different versions of a composition:

1 Open a composition—see Opening and Viewing Compositions on page
220.
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2 In the tool UI, select the Versions tab.

The Versions tab displays all existing versions of the composition. The
working version of a composition is always listed first, followed by the
most recently created versions.

3 To view a version, double-click any entry in the list.

The read-only version is opened. If the version of the composition is
already open, then Composite switches to display it. If you double-clicked
the working version, it is opened in read/write mode.

To view the list of all rendered results for a composition to which you are
linking:

1 In the Schematic view, right-click the Link Image node for the
composition you are linking to, and select Open. The linked composition
is opened.

2 In the tool UI, select the Versions tab.

The left side contains the list of all versions for the composition. The
right side shows the result of the selected version.

To open a version:

 ➤ In the Versions tab, select a version to open and do one of the following:

■ Click the Open button.

■ Double-click the selected version.

To delete a version:

 ➤ On the left side of the Versions tab, select a version to delete and do one
of the following:

■ Click the Delete button.

■ Right-click and select Delete.

■ Press Delete on the keyboard.
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Reverting a Composition

Reverting to a previous version of a composition lets you replace the working
composition by the previous one.

To revert the working version:

 ➤ In the Versions tab, select a version to revert and do one of the following:

■ Click the Revert Working To button.

■ Right-click and select Revert Working To.

In the message box that appears, click OK to confirm the reversion.

Rendering to Wiretap
The Wiretap protocol allows some degree of data exchange between Autodesk
Composite and Autodesk editing and effects products, such as Autodesk Smoke
®, and Autodesk Flame®. In a facility where Composite is used with one of
these Wiretap-compatible products, rendering to Wiretap is an easy way for
you to quickly make available the rendered result of a composition to the
Flame or Smoke user—see Navigating and Browsing on page 40.

Rendering to Wiretap

To set the Wiretap mode for new compositions:

1 In the menu bar, select Edit > Project Preferences.

2 In the Project Preferences window, select the Render tab.

3 Click the Wiretap button.

232 | Chapter 11   Working with Compositions



4 In the text field next to the Wiretap button, do one of the following:

■ Type in the path.

■ Using the File Browser, navigate to a Wiretap folder, right-click the
item in the right pane, and select Copy Path. Paste the contents in
the Wiretap field (Ctrl + V for Windows and Linux or Cmd + V for
Mac OS).

■ Using the File Browser, navigate to a Wiretap folder, select the path
in the browser path text field, copy it (Ctrl + C for Windows and Linux
or Cmd + C for Mac OS), and then paste it in the Wiretap field (Ctrl
+ V for Windows and Linux or Cmd + V for Mac OS). Either one of
the following forms are acceptable:

■ Wiretap:<servername>/…
or

■ <servername>/…

The server specified corresponds generally to an IFFFS server. In the text
field, the prefix “Wiretap:” is stripped off if present, because it is implicit.
For IFFFS, the path must specify a writable folder, which is either a library
or a reel. For example:
Wiretap:/belgium/stonefs/myProject/myLibrary/myReel/. The trailing
slash is optional.

You can also set Wiretap rendering on existing compositions, for each
output. Select an output node in the composition, and click on the Render
tab in the UI. The same Wiretap controls as described above are available
for the output.

Troubleshooting Wiretap

If the clip is not rendering to Wiretap, it may be for one of the following
reasons:

■ The Wiretap server on the destination host is down.

■ The destination folder is not a library or a reel.

■ The library is already opened by a Smoke or Flame user on the remote
machine which will only allow the read only mode.

■ A composition name contains parentheses.
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Linking Compositions
By linking other compositions with your working version, you can create a
more complex composition. You can link to as many compositions as you
need. You can link to a specific output of a composition, as well as specify the
mark in, mark out and offset times, and the repeat mode.

When you link to a composition, you are by default linking to the primary
version which is read-only. The Link Image tab in the tool UI displays all the
outputs associated with the version to which you are linking. When you
attempt to link to a composition that is outdated, the link node turns red to
indicate that it is out of date.

There are many advantages to linking compositions:

■ Keeps the tool pipelines of individual compositions separate from each
other. You see only your own tool pipeline. This eliminates the risk of
inadvertently deleting or modifying tools added to the pipeline by another
composition and can also make it easier to identify the different segments
in the production pipeline.

■ Makes it easy to review different possibilities for a shot. You can link to a
composition and then choose the output you want to see.

■ Linking makes dependencies easy and efficient. If your work depends on
the result of another composition, you can link to that composition and
work on the composition that contains the link. However, you may be
working on multiple compositions independently and each one will stay
up-to-date or will detect if a more recent version is available. This is
controlled by the Link type list in the link node UI which lets you specify:
primary, latest, working and explicit. For example, when linking to the
Latest version, the link node will realize if it is outdated with respect to
this selection. How the link node reacts to this out-of-date condition is
controlled by the On Load button. When it's on, the link node will update
to the proper version at load time (when the composition is open in
read-only). When On Load is off, it is up to you to visit the link node and
click the Update To button to link to the proper version.

■ Makes it easy to apply your tool pipeline to a different rendered result.
You just select the result.

To link to a composition:

1 In a File Browser (Ctrl + O for Windows and Linux or Cmd + O for Mac
OS), select a composition and drag it into the Schematic view.
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2 In the gate that appears, swipe south through the Link option.

The linked composition appears in the Schematic. If this is the first time
you are linking to a composition from this composition, the Link Image
tab appears in the tool UI. If a Link Image tab already exists for this
composition, its contents update to reflect those of the composition to
which you just linked.

3 Select the Link Image tab.

4 Each version may have multiple outputs. The link node will have as many
output sockets as there are output nodes in the currently linked version.
If necessary, change the version to which you are linking, by selecting
one from the Version list:

Primary  Link to the primary version of the composition.

Latest  Link to the most recently created version of the composition.
This is a common choice at the beginning of a project when compositors
are experimenting with ideas and nothing is locked down yet; you want
to see the latest idea for a shot.

Working  Link to the working version of the linked composition.

Explicit  Link to any result. Click the Browse button beside the text
field. In the Version browser that opens, select the output to which you
want to link.

5 The Update To button is highlighted to indicate a discrepancy between
the currently linked version and the Link mode being used. This option
is also available when you use the “Primary” link mode and the Primary
version is changed (i.e. version 2 becomes primary, whereas version 1
was primary beforehand). This option is not available if you are using an
explicit version.

6 When using the Primary or Latest mode, click the On Load button to
automatically update the link node when the composition that contains
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the link node is opened. The update will not occur if you are viewing a
version as viewed versions are read-only.

7 Set the mark in, mark out, offset, and repeat times by editing the
respective fields. Or you can select the As Comp option to use the linked
composition's times.

NOTE If there are further updates that occur while the composition is open, you
must update them manually.

Things to Remember

■ The Player Display preference determines what the Player displays (tool
input, rendered result, etc.).

Determining the Status of a Linked Composition
You can determine whether the composition to which you are linking is
up-to-date by checking the linked node's tool UI (Link Image tab). The Link
Image tab is common to all linked compositions; you must click the node of
a linked composition to see its information in the Link Image tab.

Linking to a Composition

NOTE This procedure is aimed at advanced Composite users.

When linking to a composition, you are actually linking to the primary version
of the composition. You can use the result of any output of any version of
the linked composition—see Linking Compositions on page 234.

Closing a Composition
When you're finished working on a single composition, you can close it.

NOTE If there are multiple versions of the same composition open, there is no
way to close them all in one operation.
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To close a composition:

1 If the composition is not selected, in the taskbar, click the name of the
current composition (to the right of the composition icon) and then
select the composition you want to close.

(a) Name of the current composition in the taskbar

Alternatively, in a File Browser, click the composition you want to close.

2 Select File > Close or press Ctrl + W (for Windows or Linux) or Cmd + W
(for Mac OS).

Things to Remember

■ All open compositions are automatically closed when you exit. You cannot
keep a composition open between sessions.
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Multilayer Compositing
and 3D Effects

Topics in this chapter:

■ Reaction Compositing and Effects on page 240
■ Compositing Workflow on page 242
■ Basic Compositing in Reaction on page 243
■ Working with Maya Pre-Comps on page 250
■ Working with Layers on page 251
■ Working with Geometric Surfaces on page 254
■ Using Parenting Axes on page 256
■ Working with Materials on page 257
■ Working with Lights on page 268
■ Working with Cameras on page 274
■ Camera Mapping on page 281
■ 3D Displacement on page 283
■ Transforming Objects on page 288
■ Reaction Rendering Effects and Output Results on page 290
■ Setting up a Stereo Camera Rig on page 293
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Reaction Compositing and Effects
The Reaction super tool provides a complete multilayer compositing and 3D
effects environment. You can use Reaction to quickly composite and output
numerous images that are already processed using other tools, as well as cross
over into a 3D environment where you can apply lighting, spatial,
visualization, and rendering effects to your scene. You can then use your
Reaction output to render your final composition, or use it as an input to
other tools in your dependency graph, including another Reaction.

What is a Reaction Super Tool?
A Reaction tool is considered a “super tool” because it contains a set of tools
that you can use to create 3D compositing effects on your composition. All
individual tools contained in Reaction can be accessed by opening the Group
Schematic. Reaction is used like any other tool, but can also be used in tandem
with the Layer Editor to build and edit compositions interactively. You can
use as little or as much of the available functionality as needed to get your
job done. You may want to simply create a few layers where one layer is
repositioned to place a character in a scene, or create a 3D scene with lighting
and texture effects. Regardless, the Reaction tool behaves like any other tool
in Composite; you can delete and connect a Reaction tool to other output
nodes in the same manner. As always, the universal Tool Options panel is
located at the right of the Tool UI—see The Tool UI on page 23.

Reaction Concepts
The following terms and concepts are used when working in Reaction.

Object

An object is any element in a 3D scene. Lights, cameras, and surfaces are
typically referred to as objects when working in Reaction.

Source

A source is an input node to the Reaction tool. You can assign a source
composition or image generator to a layer in your composition, or use the
source as an input to a texture channel in a material node or image channel
in a light node. When you add a Reaction tool to your dependency graph, its
initial input is designated as the background for your composition. You can
then add as many source nodes and layers to the Reaction tool as needed.
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Layer

When performing multilayer compositing using Reaction, you typically set a
background, although you are not required to, then assign source inputs to
layers. A layer is composed of three separate components: a surface (3D
geometry) object and local axis, a multi-channel material object, and a layer
element. When viewing the Reaction node in the Group Schematic, you can
see each component—see Working with Layers on page 251.

Material

A material defines how a layer interacts with lights to define how a scene is
rendered. Each layer must have a material associated with it, but many layers
can share a single material—see Working with Materials on page 257.

Surface

A surface is a geometric object onto which a source is mapped to create a layer
for your composition. Available geometric types are bicubic, bilinear, frustum,
box, geometry, plane, and sphere. Each surface has a local axis that you can
use to transform the layer—see Working with Geometric Surfaces on page 254.

Camera

Each Reaction node includes a camera for viewing and rendering the scene.
By default, the camera is set to perspective, and positioned, so that you can
view your layers in 2D and immediately perform standard multilayer
compositing, although you may want to set the camera to orthographic. You
can add several cameras to a scene, but you can only choose one to render,
called the render camera—see Working with Cameras on page 274.

Axis

Each layer has its own axis, or center, that you can use to perform
transformations locally. You can also add axes to your scene to apply
transformations to several objects at once, or to create more complex
transformation effects. When you add an axis object to a Reaction tool, you
can then parent it to one or more objects or layers—see Using Parenting Axes
on page 256.

Light

Lights are used to illuminate your scene and apply lighting effects to surfaces.
You can choose omni, directional, or spotlights and set lighting color, intensity,
and decay, as well as create shadows and apply transformations to the light
itself. Lights also have a Projector Image channel that you can connect to a
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source to project an illuminated image onto a layer or the scene—see Working
with Lights on page 268.

Shader

Shaders are programs that help define the look of objects in your scene. They
can be considered a part of the rendering pipeline.

Compositing Workflow
The Reaction tool lets you create 2D multilayer compositions and perform 3D
compositing with applied transformations and other effects.

NOTE You can also use the 2D Compositor tool to create multilayer 2D
compositions, but without integrated transformations—see 2D Compositor on
page 339.

Basic and Advanced Workflows
The following shows examples of a typical workflow you might follow when
working with Reaction to perform multilayer compositing, or to create and
integrate compelling 3D effects into your compositions.

Basic Multilayer Compositing in Reaction

1 Add a Reaction tool to your composition and set the composition
background (optional).

2 Add sources and create layers.

3 Set layer priority and modify their properties.

3D Compositing in Reaction

1 Add a Reaction tool to your composition and set the composition
background, which is optional. An empty background is set by default.

2 Add sources and create layers.

3 Modify or enhance the scene by:

■ Adding objects, such as lights, cameras, and material nodes, and edit
their properties.
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■ Selecting and manipulating objects. You can transform (scale, rotate,
and translate) any surfaces, cameras, and lights in your scene using
the 3D manipulators and icons. You can also organize objects into
hierarchies for easy manipulation.

■ Working with cameras. You can add cameras, transform cameras, and
define other properties, such as depth of field and field of view.

■ Working with lights. You can add different types of lights and place
them in your scene. Then you can set the color and falloff, and define
different types of shadows.

■ Animating properties. Move a camera, dim a light, or change the color
of a material over time. All properties in Composite can be animated.

■ Setting visibility properties. All objects, geometric objects, lights, and
cameras are defined by their visibility and rendering properties. For
example, you can determine whether a geometric object is visible,
whether it casts shadows, and whether its reflection is visible.

■ Working with materials and shaders. You can use the hardware
renderer for fast results, or use software shaders to create special
rendering effects, such as flares, fog, and flames. A shader modifies
the behavior of the renderer while rendering an object in a scene.

Basic Compositing in Reaction
Whether you want to quickly perform straightforward 2D compositing or
create 3D effects, the first thing you'll do is set your composition background
to define the rendering plane, then you'll create layers in Reaction.

NOTE You do not have to connect an image generator to set the background;
you can work on an empty background. You'll see that when you build a
composition using the Layer Editor; the background appears automatically when
you add a Reaction tool to your composition.

Building a Composition Using the Layer Editor
The Layer Editor is designed to work with Reaction and lets you quickly build
and edit your composition while maintaining a clear view of the layers in
your Reaction composition. As in the Schematic view, you can work with the
Gate UI to create layers and perform other tasks. Then you can set the layer
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priority, create, and access tools that affect the selected layer—see Layer Editor
on page 150.

Setting the Player Settings
Before you do anything in Reaction, be sure to verify that your Player settings
are set properly.

To set the Player display settings for Reaction:

1 With the cursor over the Player, press the tilde key (~) or middle-click to
display the Gate UI. Swipe south to display the Player Options.

2 Under Display, select Tool Output to view the results of your Reaction
composition in the Player.

NOTE When you are working with a default Compositing task group preset,
Tool Output is enabled.

TIP You can set a context point for the Player to display the Reaction output.
This is useful when you are working with more than one player, or you are
editing a composition with Reaction using the Layer Editor and you always
want to see your Reaction output—see Setting Context Points on page 191.

3 Under Guides, select Manipulators to view transformation and object
icons. Manipulators is enabled by default.

244 | Chapter 12   Multilayer Compositing and 3D Effects



4 Under Reaction, select a plane (XY, XZ, or YZ) for the grid, adjust the size
of the grid and the distance between grid lines. The grid helps you place
elements in 3D space.

NOTE To work with grids, you must select the Interactivity option (under
Reaction).

5 Under Reaction, select a Highlight option for displaying objects:

■ Coverage: Display the pixels of selected layers that contribute to the
final composition. Adjust the transparency of the pixels by entering
a value in the Threshold field.

■ Object: Displays an object's geometry with a colored outline.

6 Under Reaction, select Interactivity to use the hardware renderer and
achieve dynamic results while you work. The results you see when working
with the hardware renderer may differ slightly from the results achieved
using the software renderer.

NOTE If you are planning to quickly composite a series of 2D layers without
manipulating or transforming layers or adding 3D effects, you do not need
to enable Interactivity.

NOTE To work with lights and cameras, you must also select Icons (under
Rendering) in the Render tab of the Reaction tool.

Adding a Reaction Tool and Setting the Composition
Background
When you perform multilayer compositing in Composite, you typically create
a new composition, then add a Reaction tool to start building from scratch.
However, you can also connect Reaction to any composition or tool output
in an existing dependency graph in the Schematic view. This automatically
sets the background for the composition.
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NOTE You can add, connect, and delete a Reaction tool as you would any other
tool.

To add Reaction to a new composition:

 ➤ In the Tools tab, drag the Reaction tool to the Player, Layer Editor, or
Schematic.

If you dropped Reaction on a Player or an empty Layer Editor view, the
composition drop gate appears. You can link Reaction to the composition
Output node, or add it to the current composition without connecting
it to anything.

To add Reaction to the current composition:

 ➤ In the Tools tab, drag the Reaction tool to Schematic.

The background for the Reaction node is set.

Setting the Background
Before you composite or add effects to a composition in Reaction, you typically
set the background. The background is the rendering plane for your
composition and sets the format. If you connect a Reaction tool to an image
or to a tool output in an existing dependency graph, the background is set
automatically. You can change the background at any time.

To set the background automatically in the Layer Editor:

1 In the Tools tab, drag the Reaction tool to the Layer Editor.

The composition drop gate appears. Depending on your dependency
graph, you will see some or all of the following choices:
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2 Decide where to add Reaction in your dependency graph.

The background is set accordingly, and appears in the Layer Editor.

To set the background automatically in the Schematic view:

 ➤ Drop the Reaction tool onto an existing tool or image output connection
in the Schematic view.

To set the background manually in the Schematic view:

 ➤ Connect a media or tool node output to the background input connector.

To set or replace the background using the drop gate:

1 Select the desired Reaction tool in the Schematic or Layer Editor.

In the Schematic view, the Reaction tool is highlighted.

2 Select the composition to use as the background and drag it to the
Schematic, Layer Editor, or Player.

The Reaction drop gate appears.

3 Swipe through Set Background.
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NOTE You cannot delete a background input connector.

Creating Sources and Layers
You can composite as many layers as you want using Reaction, but first you
must create the layers. A layer in Reaction is composed of a source input that
you assign to a geometrical support, or 3D geometry, and a material node that
is automatically generated—see Working with Geometric Surfaces on page
254.

NOTE To view the Material and geometrical support nodes that are generated
with a layer, you must be in the Group Schematic.

If you want to perform basic multilayer compositing, where you work with
bilinear geometric surfaces only, you can quickly create a layer in a single step
in the Layer Editor or Schematic by using the Reaction drop gate. To substitute
a 3D geometric surface as your layer support, you can then simply choose a
different geometric surface. After creating the sources and layers, you can
publish a 2D composition if you are satisfied with the results.

To create one or more sources and layers in a single step:

1 In the Schematic view, select the Reaction node.

2 Select images or footage from the File Browser or desktop, and drop (or
stick) them onto the Schematic, Layer Editor, or Player.

The composition drop gate appears.

3 Swipe through Create Layer.

The sources and layers are added in the order in which you selected the
images/footage (from first to last) and labeled accordingly in the Layer
Editor.
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To add a layer:

 ➤ Do one of the following:

■ At the bottom of the Layer Editor, select a surface geometry type and
click Create.
A layer with the surface you chose and a source are created.

■ In the Schematic view, right-click the Reaction node and select Add
Layer.
A layer and a source are created. By default, the Bilinear surface is
assigned to the layer.

To add a source:

1 In the Schematic view, right-click the Reaction tool and select Add Source.

2

A source input connector appears in the Schematic view. You can connect
media or a tool node to it.

To add a layer and link to its source:

 ➤ In the Layer Editor, right-click a layer and select Add Linked Layer.

A layer is created and linked with its source.
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To add one or more source compositions to Reaction in a single step:

1 Select the Reaction tool in the Schematic view or select the desired
Reaction in the Layer Editor.

2 Select one or more compositions from the File Browser or Desktop and
drop (or stick) them onto the Layer Editor, Schematic, or Player.

The drop gate appears.

3 Swipe through Create Source.

The sources are added in the order in which you selected the compositions
(from first to last) and are labeled accordingly in the Layer Editor.

To create a layer using a source:

 ➤ In the Layer Editor, right-click a source and select Create Layer Using
Source.

A layer is created in the Layer Editor.

NOTE You can immediately change the surface geometry of the layer using
options in the Type column of the Layer Editor.

NOTE You can add more than one layer to a source if you want to create multiple
layers using the same source image. If you have applied effects to the source image,
they will be propagated to the layers to which they are linked.

Working with Maya Pre-Comps
Once created, you can automatically generate and update compositions based
on Maya render layer and pass setups. This accelerates and streamlines the 3D
to 2D workflow by allowing the 3D artist to pre-visualize a scene in the form
of the final composite while continuing to iterate on and refine only required
elements. The format supports different passes per layer and per camera; passes
from pairs or sets of cameras can be imported side-by-side within a
composition, allowing their dependency graphs to be manipulated in tandem,
and making it easy to select pairs of nodes for viewing as stereoscopic output.
For more information, see FBX Import Limitations on page 329.
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Working with Layers
When you create a layer, it is automatically added to the top of the Layer
Editor. The source name is displayed along with the name of the node to
which it is connected. Also, each layer is numbered, so you can easily identify
it. After creating layers, you can use the arrow buttons in the Layer Editor to
quickly reorder layers. From the tool UI, you can interactively apply 2D and
3D transformations, as well as set global layer properties and visibility options.
And because layers are discrete objects, you can also parent layers to axis
objects in the Group Schematic.

Renaming Sources and Layers
Renaming sources and layers lets you quickly identify a layer and its source
in the Group Schematic. You can rename sources and layers in the Layer Editor
or the Tool Options at the right of the tool UI.

To rename a source or layer:

1 In the Layer Editor, click the name of a source or layer.

2 Press F2 and type in a new name.

Selecting Layers
You can select a layer in several ways: through the Layer Editor, from the
Group Schematic, or by clicking a layer in the Player.
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To select a layer:

 ➤ Do one of the following:

■ In the Layer Editor, click to select a layer.

■ In the Schematic view, double-click the Reaction node to open the
Group Schematic. Click a Layer node.

■ In the Player, select a layer.

The selected layer is shown with the manipulator icon that represents
the three axes.

NOTE To view the manipulator icon, make sure you have selected Manipulators
in the Player Options.

Duplicating Layers
Duplicating a layer gives you an identical layer that includes the source,
material, and surface type.

To duplicate a layer:

 ➤ Select a layer from the Layer Editor and do one of the following:

■ At the bottom of the Layer Editor, click the Duplicate Layer button.

■ Right-click a layer and select Duplicate Layer.

Reordering Layers
You can reorder layers interactively using the arrow buttons in the Layer
Editor. Layers are composited in the order in which they appear in the list.
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To reorder layers:

1 Select a layer from the Layer Editor.

2 Use the arrow buttons at the bottom of the Layer Editor to reorder the
layer.

Modifying Motion Blur on Individual Layers
You can modify the motion blur applied to your composition on individual
layers, so that each layer appears to be moving at a different speed than other
layers—see Adding Motion Blur and Depth of Field to a Scene on page 292.

To modify the motion blur on a layer:

1 Select a layer from the Layer Editor.

2 Enter a value in the Time Dilation field. A higher value speeds up the
blur effect for the layer; a lower value slows it down.

Setting Layer Visibility Properties
You can set layer visibility properties to specify how the layer is rendered or
“seen” by the camera.

To set the visibility options:

 ➤ Select any of the following in the Reaction tab.

Size (in pixels):Thumbnails:

The layer is visible to the camera. If you hide the layer from the
camera, the layer may still cast a shadow and can be seen by a light.

Visible to Camera

The layer can cast shadows.Cast Shadow

The layer receives shadows cast by itself and by other layers in the
composition.

Receive Shadow

The front faces of the layer will be rendered.Front Face
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Size (in pixels):Thumbnails:

The back faces of the layer will be rendered.Back Face

Modifies the motion blur that affects layers animated in the scene.
You can give the layer the appearance of moving at a different speed
than is set for Motion Blur in the Render tab.

Time Dilation

Working with Geometric Surfaces
When you create a layer, you are assigning a source input to a geometric object
that defines the surface on which the source is mapped. You can replace the
assigned surface object with a different one, as well as disconnect a surface
object in the Schematic and replace it with another. By default, when you
create a layer, the surface type is determined by the last geometric setting
chosen in the Layer Editor.

NOTE When you create a layer in the Schematic view, the default surface is Bilinear.

There are seven surface types available in Reaction: bicubic, bilinear, box,
frustum, geometry, plane, and sphere. The bilinear surface is a planar surface
with four vertices, one at each corner. The vertices are joined by straight line
segments using linear interpolation. The box, frustum, and sphere surfaces
are 3D primitives meshes with no control vertices.

Modifying Surface Shape and Geometry
You can change a surface's shape by scaling it using the transformation tools.
You can also modify a surface's base geometry from the Surfaces tab in the
Reaction tool UI. You can increase or decrease the number of segments to
change the number and shape of the surface's polygons, which may affect its
shape, how it reacts to lights in the scene, and how texture maps are displayed.

TIP You can toggle the display of the icons that represent the camera, lights, axis,
and transformation by selecting Icons on the Render tab.

To modify a surface's geometry:

1 Select the Surfaces tab.

2 Select a layer from the Layer Editor.
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3 To change the surface, select a surface type under the Type column.

4 In the Surfaces tab, adjust the properties to modify the surface's geometry.

DescriptionSurface
Type

Bicubic

You can change the number of segments to increase or decrease the
number of polygons, and change their shape. You can also move corner

Bilinear

points in X, Y, and Z to create a variety of 4-sided shapes. Because you
can also move corners in Z, you can create warped effects.

You can change the number and size of segments to increase or decrease
the number of polygons, and change their shape.

Box

You can change the geometry of the top, bottom, and height, as well
as the number of segments to increase or decrease the number of
polygons.

Frustum

Geometry

You can change the number of segments to increase or decrease the
number of polygons, and change their shape.

Plane

You can change the number of segments to increase or decrease the
number of polygons, and modify the smoothness of the sphere, or

Sphere

change its shape. When you reduce the number of segments, you will
create a more faceted appearing sphere that will also affect how it reacts
to lights. You can also modify the radius to change the size of the sphere.

To modify a bilinear surface interactively:

1 In the Layer Editor, select a layer with a Bilinear surface.

2 Select the Surfaces tab.

In the Player, manipulators appear at each corner of the surface.
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3 Adjust the manipulators to modify the surface.

TIP You can also select a bilinear surface by opening the Group Schematic.

Using Parenting Axes
You can add axes to a 3D scene and parent them to cameras, lights, layers,
and other axes in the Group Schematic. This lets you control the movement
of one or more child objects by transforming the parent axis.

You can transform axes interactively using the transformation buttons in the
Axes tab, where you can also set values for the axis position, rotation, scale,
and pivot. You can animate and set expressions for all transformation values,
as well as assign them to a tracker. The axis is represented by a white cross in
the Player, which you can select and interactively move with the manipulator.

NOTE The axis icon is visible only if you have selected Icons in the Render tab of
Reaction.

To add an axis from the Axes tab:

1 In the Schematic view, select the Reaction node and then select the Axes
tab.

2 From the Axes list, click Add.

An axis is added to the Axes list.

3 In the Schematic view, double-click the Reaction node to display the
Group Schematic.

4 Parent the axis to a layer, camera, or light.
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To add an axis from the Tools tab:

1 In the Schematic view, double-click the Reaction node to display the
Group Schematic.

2 From the Tools tab, drag the Axis tool from the Reaction folder to the
Group Schematic.

3 In the Schematic view, parent the axis to a layer, camera, or light.

To set the visibility of an axis:

1 In the Schematic view, select the Reaction node.

2 Select the Axes tab.

3 From the Axes list, click the white square beside an axis.

Working with Materials
When you create a layer, a separate material node is automatically generated
and linked to the layer. Every layer must be associated with a material, but
many layers can share a single material. Because the material node is separate
from the layer and surface, you can easily propagate material properties to
several layers from a single source, instead of duplicating effort by having to
assign the same material attributes to several surfaces. You can quickly connect
materials to layers from the Reaction Group Schematic and see which layers
share materials.

About Materials, Shaders, and Textures
A material defines how the layer and its associated surface object appears. It
defines how it interacts with lights, how it reflects light back to the view, and
how it blends in with the rest of the scene. You can choose one of four shader
types to set the basic material properties for a given layer and choose from a
wide selection of blending modes to define how the current layer is blended
with the scene element lying behind it (with respect to the view).

In addition, each material node has five input tabs, or channels, that you can
use to assign one or more sources to apply textures to an object. The main
material channel defines a layer's base material and texture mapping, and is
always used. You can optionally connect sources to the other inputs on the
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material node to define a bump map, as well as radiosity, reflection, or
refraction environment maps, depending on the shader type selected.

Textures are 2D images that can be wrapped around an object's surface, much
like a piece of paper wrapped around an object. The information displayed
on the object's surface depends on the type of texture map used. In bump
maps or normals maps, RGB or luminance values are used to give the surface
the illusion of peaks and valleys. In radiosity maps, the object appears to blend
in the source image's radiosity. This is useful for creating realistic lighting
effects without the high rendering cost associated with raytracing or radiosity.

Setting Material Properties
When you create a layer, a material is associated with it automatically. By
default, the material displays the source image on the layer surface using the
Standard shader, which gives you immediate access to the full range of
parameters in the Materials tab.

To access the Materials UI:

 ➤ Do one of the following:

■ In the Layer Editor, select a layer and then select the Materials tab.

■ In the Schematic view, right-click the Reaction node and select Edit
Group to display the Group Schematic, and then click a material node
to select it.
The Materials UI displays the properties for the selected material node.

Materials UI
The Materials UI contains a comprehensive set of options and controls for
setting the shader type, blending mode, shading parameters, color factors,
and texture mapping and blending.

Shader Types

There are four shader types: Standard, Simple, Shadow Matte, and No Shade.
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To select a shader type:

 ➤ In the Materials UI, select a shader:

■ Standard  The full range of parameters for creating diverse 3D effects
using lights and cameras.

■ Simple  A subset of Standard shader parameters. It does not consider
lights in the scene, but you can create lighting effects using environment
maps.

■ Shadow Matte  Used to blend shadows into a scene. By adding objects
to a scene, you can create realistic shadow effects.

■ No Shade  Lets you set parameters and texture mapping for the main
material channel only. You rely on the lighting effects in the source image
to provide illumination.
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Blending Modes

Blending modes are available with all shader types. A blending mode defines
how the color of one layer is blended with the color of the layer or part of the
scene lying behind it (relative to the Player). You can animate and apply
expressions to blending modes—see Animation on page 659 and Expressions
on page 719.

There are two categories of blending modes:

Software  Lets you select the blending mode used by the software renderer.
If you selected Interactivity in the Player Options to enable the hardware
renderer for fast results while you work, you can set the Software blending
mode to Follow HW. This ensures that the software and hardware renderer
produce almost exactly the same results. The Follow HW option is selected
by default.

NOTE Because the hardware and software renderer use different methods to
calculate results, it is recommended that you perform all transformations using
the hardware renderer, but verify your results using the software renderer.

Hardware  Lets you select the blending modes used by the hardware renderer,
which can only reproduce a subset of the blending mode effects available to
the software renderer.

HWSWDescriptionBlending Mode

XSet results to follow the hardware renderer.Follow HW

XXMaintains the normal colors for the layer.Normal

XXMultiplies the colors of the current layer with the alpha
of the layer behind it.

Premultiplied

XRandomly dissolves pixels of the current layer over the
layers behind it.

Dissolve

XXAdds the Red, Green, and Blue values of the current
layer's pixels to the layers behind it. The resulting

Add

composite can make the layer's pixels appear very
bright, especially over a bright background.

XXSubtracts the Red, Green, and Blue values of the cur-
rent layer's pixels from the layers behind it. The result-

Subtract

ing composite can make the layer's pixels appear very
dark.
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HWSWDescriptionBlending Mode

XXMultiplies the pixel values of the current layer with the
pixels in the background, and clips all RGB values at

Multiply

255. The overall effect is similar to drawing with a
colored marker over an image: it darkens and colorizes
at the same time using the current layer imagery.

XXShines a spotlight uniformly on the current layer.Spotlight

XXShines a spotlight on the layer and blends with the
layer behind it.

Spotlight Blend

XXCombines the pixels in the current layer with the pixels
in the background so that the current layer is compos-

Screen

ited over the layers in the background with lighter
pixels than before. The effect is similar to the photo-
graphic technique of combining two slides in a slide
“sandwich” and then reshooting them. Screen mode
is the inverse of Multiply mode.

XDisplays the image through a gel of the current layer.
It combines the colors of the current layer with those

Overlay

of the layers behind it to create new tints based on
these results. It boosts contrast and color saturation at
the same time.

XShines a soft, diffuse light associated with the current
layer onto the layers behind it. It reduces the contrast
levels in the image.

Soft Light

XShines a harsh light associated with the current layer
onto the layers behind it. It primarily affects areas of

Hard Light

detail, and greatly reduces the contrast levels in the
image.

XXComposites only the pixels of the current layer that
are darker than the pixels of the layers behind it.

Darken

XXComposites only the pixels of the current layer that
are lighter than the pixels of the layers behind it.

Lighten

XDisplays the difference between the pixels in the cur-
rent layer and the pixels of the layers behind it. When

Difference

a brighter pixel is subtracted from a darker pixel, the
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HWSWDescriptionBlending Mode

positive value of the color is used and results in bright
color shifts. The layer order is not significant, as both
layers contribute nearly equally to the result.

XXCreates an effect similar to Difference, but lower in
contrast and resulting in a grayer image. The layer or-

Exclusion

der is not significant, as both layers contribute nearly
equally to the result.

XChanges the hue of the current layer to the hue of the
layers behind it. This effectively makes the current

Hue

layer take on the “tint” of the elements in the back-
ground of the composite.

XChanges the saturation of the current layer to the sat-
uration values of the layers behind it. (This differs from

Saturation

Saturate, which uses the saturation of the current layer
to increase that of the layers behind it.)

XChanges the hue and saturation of the current layer
to the hue and saturation values of the layers behind
it.

Color

XChanges the luminance of the layers in the background
of the composite to the luminance value of the current
layer.

Luminance

Basic Shading Parameters

The basic shading parameters let you set a layer's opacity. Depending on the
shader type selected, you can also set the refractive index and surface glossiness.

NOTE Basic shading parameters do not apply to the Shadow Matte shader—see
Using the Shadow Matte Shader on page 268.

To set basic shading parameters:

 ➤ Enter a value for the object's opacity, refractive index, and glossiness.

Opacity  Sets the transparency for the layer. Values are measured in percent.
A value of 100 is opaque, a value of 0 is transparent. If you want to create a
transparent surface, such as glass, a low value (10) will yield a more convincing
result than 0.
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NOTE Transparency affects the visibility of a layer's other attributes.

Glossiness  Sets the level of glossiness for the layer, which affects the specular
highlights created when a light shines directly on a layer. A glossier, more
reflective surface yields a smaller, sharper highlight. A less glossy surface has
a highlight that is more diffuse or blurry. Glossiness is available with the
Standard shader only. Values range from 0 to 1, with a value of 1 being
completely reflective. In this case, you would not be able to see any of the
objects other surface properties, so glossiness should be set to less than 1.

Setting Material Colors

You can set color factors for each texture channel available for the type of
shader you select. If you are working with a Standard shader, you can also set
color factors for ambient and specular lighting effects. The colors you set are
multiplied with the colors of the input source image connected to that channel.
The Shadow Matte shader has no color factors.

NOTE You can choose to add a layer without a source to your composition. For
example, if you want to add a colored ball to your scene, you can simply create
a layer and set its color in the Materials tab. In this case, the main color would be
the color you set.

DescriptionColor

Sets a color to modulate the main material color. The Main color is a
diffuse color that the light scatters in all directions, so that the layer

Main

surface appears to have the same brightness from all viewing angles.
Available for all Shaders except for Shadow Matte.

Sets a color to modulate the color of areas of the object that are shielded
from direct light sources, but are still visible, due to non-directional

Ambient

ambient lighting that exists in the scene. Available in the Standard shader
only.

Sets the color of shiny highlights on the layer surface. It is usually set to
white or a brighter shade of the main color. Available in the Standard
shader only.

Specular

Sets a color to modulate the color emitted from an object in the scene.
Available in the Standard shader only.

Emitted
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DescriptionColor

Sets a color to modulate the color of layer surfaces with reflective
properties and/or reflection maps applied. You typically set a grayscale
value, with white being reflective, and black having no reflectivity.

Reflective

Sets a color to modulate the subtle changes in color that occur as light
passes through an object where transparency or translucency is incor-
porated. Black has no refractive properties.

Refractive

Sets a color to modulate radiosity effects applied to your scene. Radiosity
effects add a high degree of realism to images as it considers all light

Radiosity

in an entire environment and simulates what happens when rays of light
hit an object. Some stick (where a surface is opaque and absorbs the
light), and others are reflected and refracted. These rays then go on to
illuminate other surfaces before reaching the human eye. This yields
indirect lighting and color bleeding effects ideal for global illumination.

To set material color values:

 ➤ Click the color pot of the channel that you want to set a color.

The Color Picker is displayed, so you can set color values—see Color
Picker on page 154.

Using Texture or Environment Maps to Control Surface Attributes

The Main texture channel defines the surface's general appearance, but if your
main texture is not enough to give you the look you want, you can add more
texture maps. Each Material node has five texture channels that you can use
to apply texture and environment maps to refine the appearance of an object's
surface. You can set parameters for each channel.

The Main and Bump texture channels let you wrap and position a texture on
the surface. By default, the image is clamped to the surface. You can then use
placement parameters to position the source image on the surface and apply
tiling effects.

The Radiosity, Reflection, and Refraction channels let you apply environment
maps to your surface object. The environment maps use their source image
to surround the surface with a virtual sphere to simulate an environment,
which shows up as reflections on the surfaces of objects with reflective
properties. The environment map always covers the sphere exactly once. You
can transform your object and see the effects of the environment map change
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dynamically. Using environment maps is a fast and inexpensive way to achieve
highly realistic lighting effects.

NOTE Material nodes in the Group Schematic always show all five input tabs.
However, the number of active input tabs depends on the channels available for
the selected Shader type.

To connect a source image to a texture or environment map channel:

1 Do one of the following to display the Group Schematic:

■ In the Schematic view, double-click the Reaction tool.

■ In the Schematic view, right-click the Reaction node and select Edit
Group.

2 Connect a source image node to a channel tab on a Material node. To
identify the nodes, pause over a material node to see a tooltip with the
node name.

DescriptionMaterial Texture
Channel

The main channel is used to apply a source image as a texture
map on a selected object's surface. You can position the ma-

Main

terial on the surface using the UV placement controls, and
tile the image in U and V.

A reflection map uses the source image to create realistic re-
flections. You can use the color factor to set areas and the

Reflection

degree of reflectivity for the material. You typically set a
grayscale color value, with white being completely reflective,
and black having no reflectivity. You can, however, achieve
tinted reflections by set setting a color.

A refraction map is an environment map that can be used to
simulate how light traveling through a refractive, transparent
material is distorted.

Refraction

The radiosity map uses the source's color and luminance val-
ues to add radiosity effects to the layer surface.

Radiosity

A bump map is usually a different image that you specify as
a source for a bumpy or textured appearance on a surface. It

Bump

is sensitive to light sources. Its RGB (when using an RGB im-
age, it is a normals map) or luminance values are used to
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DescriptionMaterial Texture
Channel

simulate relief on objects by perturbing the surface shading
according to an image map. The geometry is not affected.

3 To exit the Group Schematic, double-click anywhere in the Schematic.

NOTE When using an RGB image as an input to the Bump channel, the RGB values
map to XYZ when calculating the effects of light on the surface normals.

TIP Black and white or grayscale images are easy to work with when adding a
bump map, as you can quickly identify how the bump map will appear on the
target surface. Black areas create ridges, and white areas create indentations.

Things to remember

■ Only the Standard Shader considers lights in the scene.

■ Using environment maps adds lighting effects to the associated objects
only.

To set texture and environment map parameters:

1 In the Materials UI, select a layer from the Layer Editor.

2 Select the Simple or Standard shader.

3 Under Channels, select a channel: Main, Radiosity, Reflection, Refraction,
or Bump.

4 Adjust the parameters to control image brightness and texture quality,
and in the case of the Main and Bump textures, specify how the texture
is positioned on the object.

The following parameters are available depending on the channel you
selected:

DescriptionProperty

Uniformly scales the brightness of the image texture up or down.
This is useful for setting the amount that a given texture affects the

Multiplier

object's overall look. The default value is 1, but you can overdrive
the brightness to achieve specific effects.
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DescriptionProperty

Sets the quality of the texture image. When a texture is stretched
onto an object, it may, depending on the camera position, lose

Filtering

some of its crispness. The rendered can compensate for this, but it
may slow the process. Filtering options include:

■ Nearest  A box filter and the fastest way to resample an image
since it only samples a single pixel of the input image to determ-
ine the value of a given pixel in the result image. Produces sig-
nificant amount of aliasing.

■ Bilinear  A separable triangular filter that takes into account
more area when resampling.

■ Mitchell  Considered one of the best magnification filters for
images; has a good balance between ringing and sharpness.

■ Gaussian  Good magnification and magnification filter with
no ringing, but introduces noticeable softness to the result im-
age.

■ Jinc 2  Offers better sharpness than the Gaussian filter, but
at the expense of ringing. Similar to the sinc filter, but with
better isotropic qualities, less ringing, and same sharpening and
anti-aliasing.

■ Jinc 3  Offers better sharpness than the Gaussian and Jinc 2
filters but at the expense of even more ringing. Similar to the
Lanczos filter but with better isotropic qualities, less ringing,
and same sharpening and anti-aliasing.

Lets you adjust the trade-off between anti-aliasing and blurriness.AA Factor

Sets the amount of refraction for the current layer when using a
refractive texture. The higher the value, the greater the amount of

Refract Inx

light The higher the value, the greater the amount of light dispersion
(splitting), which increases the object's brilliance.

Set the repeat mode. Choose from; Transparent, Edge, Repeat, and
Mirror.

Tiling X, Tiling
Y

Translates the texture in U and/or V.U Offset,V Off-
set

Lets you specify the number of times a texture is repeated over a
surface. You can use a non-integer value, such as 2.35.

U Scale, V
Scale
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DescriptionProperty

Rotates the texture over a surface.Rotation

Using the Shadow Matte Shader
The Shadow Matte shader lets you capture shadows created by using 3D objects
as proxies. This creates the illusion of shadows cast from objects or image
elements onto 2D images where none exist. The resulting output using this
shader is a black and white image that shows the shadows in black, and
everything else in white.

For example, if you have an image of a cityscape, and you want to have a red
balloon fly overhead, casting a shadow as it travels, you could create your
balloon using a sphere, add a light source to illuminate it, and then add a
planar surface parallel to the ground to receive the shadow. You would then
select the Shadow Matte shader to use on the plane, and set the Blending
Mode to Multiply to mask out the plane, except for the shadow. You can then
animate the sphere, and the shadow will follow it.

To set Shadow Matte parameters:

1 Select the Materials tab.

2 Select a layer from the Layer Editor, and then select the Shadow Matte
shader.

3 Set parameters to control how light or dark the shadow should look, and
to invert the shadow.

DescriptionParameter

Uniformly scales the lightness or darkness of the shadow up or down.Multiplier

Flips the shadow inside out to reveal the background in the shadow
regions and mask the illuminated areas.

Invert Shadow

Working with Lights
Light is a basic geometric 3D scene element. Each light in a scene contributes
to how a scene is illuminated. Lights affect the way all object's surfaces appear
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in the rendered scene. You can dramatically change the nature and mood of
your compositions by modifying lights and their properties.

NOTE You can animate lighting parameters using keyframes and by applying
expressions—see Animation on page 659 and Expressions on page 719.

Adding Lights to a Scene
You can add one or more lights to your scene and set their properties to achieve
a variety of lighting effects. There are two ways to add lights to a scene: the
Lights tab in the Reaction node or the Tools tab.

When you add a light to Reaction, you must be in the Reaction Group
Schematic to view the light(s) in your scene. The light you add is positioned
at 0, 0, 0, so you may need to zoom out to view the light icon.

You can also set the light type and parameters, as well as parent a light to an
axis, and animate its properties.

NOTE The light icon is visible only if you have selected Icons in the Render tab of
Reaction.

To add a light from the Lights tab:

1 Select the Lights tab.

2 Under the Light list, click Add.

A light is added to the Group Schematic and the Lights list.

3 To view the light, double-click the Reaction node in the Schematic view.

The Group Schematic appears.

To add a light from the Tools tab:

1 Do one of the following to display the Group Schematic:

■ Double-click the Reaction node in the Schematic view.

■ Right-click the Reaction node and select Edit Group.

2 From the Tools tab, select the Light tool from the Reaction folder and
drag it to Schematic.
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Choosing the Type of Light
When you add a light to your scene, an Omni light is added by default. You
can change the light type and its properties, and add as many lights to your
scene as needed.

You can define physical properties for your light, depending on the type of
light you selected. There are three types of lights available.

Omni  Simulates a point light source that casts rays in all directions from
the position of the light. Similar to a light bulb, where the light rays emanate
in all directions from the bulb.

Spotlight  Casts rays in a cone, or four-sided pyramid, simulating a real
spotlight. This is useful for lighting a specific object or area and creating
sharp-edged shadows.

Directional  Casts rays in a single direction, from a geometric area and is
useful for creating soft-edged shadows with both an umbra (a full shadow
where an object blocks all rays from a light) and a penumbra (a partial shadow
where an object blocks some of the rays).

To set attributes for a Spotlight:

1 Select the Lights tab.

2 Under Light Type, select the Spotlight light type.

3 Set the Spotlight properties.

DescriptionProperties

The shape of the light can be a circle or rectangle.Shape

The angle where the solid cone of full intensity light ends and a gradual
fading begins.

Hot Spot
Angle

The angle at which the light ends.Cutoff Angle

The aspect ratio of the spotlight shape.Aspect
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To set properties for a directional light:

1 Select the Lights tab.

2 Under Light Type, select the Directional light type.

3 Adjust the Radius field to set the radius of the light. This value is also
used to delimit the size of the shadow map.

Setting Basic Lighting Properties
You can set basic lighting properties for all light types.

To set basic lighting properties:

 ➤ On the Lights tab, under Basics, enter values to define the light.

DescriptionProperties

Sets the color for the light. Click the color pot to display the color picker,
choose a color, and click Set—see Working with the Color Picker on
page 155.

Color

Sets the amount of light emitted by the source light.Intensity

Sets the light's intensity to diminish gradually using a linear or quadratic
function.

Decay

Represents the distance at which the light's intensity is reduced by half.1/2 Distance

Modifies the motion blur that affects lights animated in your scene. You
can set the Time Dilation factor to give the light the appearance of

Time Dila-
tion

moving at a different speed than is set for Motion Blur in the Render
tab.
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Setting Shadow Properties
You can enable shadows and set their properties and parameters to achieve
the results that you want.

To enable shadows and set their properties:

 ➤ On the Lights tab, under Parameters, select Shadows.

DescriptionProperty

Sets the type of shadow created. There are four types:Type

■ Normal: The default shadow.

■ Mid-Depth: Uses a mid-depth z-buffer to compute a shadow
that usually yields fewer artifacts.

■ Deep: Allows a transparent object to color light as it passes
through.

■ None: The light does not cast a shadow.

Select the map size. The default is 256 x 256.Map Size

Experiment with self-shadowing effects. The default value is 1.00
and is intended to reduce self-shadowing artifacts.

Offset

Set the transparency of the shadows. By default shadows are opaque.Opacity

Set the softness for the shadow.Softness

Click the color pot to display the color picker, choose a color, and
click Set—see Working with the Color Picker on page 155.

Color

Determining How a Light Affects Shading
You can choose the shading properties a light affects. By default, a light affects
the ambient, diffuse, and specular components of shading.
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To choose the shading properties that a light affects:

1 On the Lights tab, under Parameters, select the Affects option.

2 Under Light Affects, select the shading properties you want the light to
affect.

Adding a Projector Texture to a Light
A projector texture is created when you connect an image to a light node in
the Reaction Group Schematic. The Projector Texture is applied in the same
way as a material texture.

To add a projector texture to a light:

 ➤ On the Lights tab, under Parameters, select Projector.

DescriptionProperty

Uniformly scales the brightness of the image texture up or down.
This is useful for setting the amount that a given texture affects the

Multiplier

object's overall look. The default value is 1, but you can overdrive
the brightness to achieve specific effects.

Sets the quality of the texture image. When a texture is stretched
onto an object, it may, depending on the camera position, lose

Filtering

some of its crispness. The rendered can compensate for this, but it
may slow the process. Filtering options include:

■ Nearest  A box filter and the fastest way to resample an im-
age since it only samples a single pixel of the input image to
determine the value of a given pixel in the result image. Pro-
duces significant amount of aliasing.
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DescriptionProperty

■ Bilinear  A separable triangular filter that takes into account
more area when resampling.

■ Mitchell  Considered one of the best magnification filters
for images; has a good balance between ringing and sharpness.

■ Gaussian  Good magnification and magnification filter with
no ringing, but introduces noticeable softness to the result im-
age.

■ Jinc 2  Offers better sharpness than the Gaussian filter, but
at the expense of ringing. Similar to the sinc filter, but with
better isotropic qualities, less ringing, and same sharpening and
anti-aliasing.

■ Jinc 3  Offers better sharpness than the Gaussian and Jinc 2
filters but at the expense of even more ringing. Similar to the
Lanczos filter but with better isotropic qualities, less ringing,
and same sharpening and anti-aliasing.

Lets you adjust the trade-off between anti-aliasing and blurriness.AA Factor

Set the repeat mode. Choose from; Transparent, Edge, Repeat, and
Mirror.

Tiling X, Tiling
Y

Translates the texture in U and/or V.U Offset,V Off-
set

Lets you specify the number of times a texture is repeated over a
surface. You can use a non-integer value, such as 2.35.

U Scale, V
Scale

Rotates the texture over a surface.Rotation

Working with Cameras
The camera in Reaction is analogous to a physical camera in the real world.
Each Reaction node has a camera that outputs a result; this is the render
camera. The camera through which you are currently viewing through is
displayed in the upper-left corner of the Player.

NOTE When using the orthographic camera, you cannot set certain basic camera
properties.
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Adding a Camera to Your Scene
You can add as many cameras to a scene as you like, and you can view and
render your scene from any camera. There are two ways to add cameras to a
scene: through the Cameras tab in a Reaction node or through the Tools tab.

Once you've added cameras, you can indicate which camera(s) to use as the
render, or active, camera(s). You can designate any number of cameras as
active. Active cameras contribute to the composition's output, and is indicated
by the white square under the “A” (active) column of the Cameras tab. You
can also set the visibility of each camera.

NOTE The camera icon is visible only if you have selected Icons in the Render tab
of Reaction.

To add a camera from the Cameras tab:

1 In the Schematic view, select the Reaction node.

2 Select the Cameras tab.

3 At the bottom of the Cameras list, click Add.
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A camera is added to the Cameras list.

To add a camera from the Tools tab:

1 In the Schematic view, display the Group Schematic by double-clicking
the Reaction node or right-clicking the Reaction node and selecting Edit
Group.

2 From the Tools tab, select Camera from the Reaction folder and drag it
to the Group Schematic.

A camera is added to the Group Schematic and the Cameras list.

NOTE In the Group Schematic, you can parent a camera to an axis, animate
its properties using keyframes or expressions, as well as apply tracking and
stabilization.

To set the render camera(s):

1 In the Schematic view, select the Reaction node.

2 Select the Cameras tab.

3 From the Cameras list, click the white square under the A (active) column
beside the camera(s) you want to designate as the render camera(s).

To set the visibility of a camera:

1 In the Schematic view, select the Reaction node.

2 Select the Cameras tab.

3 From the Cameras list, click the square beside the camera and under the
V (visible) column.

Setting Camera Properties
Once you've selected a camera, you can set the properties for each camera in
your scene.

To set a camera's properties:

1 In the Schematic view, select the Reaction node.

2 Select the Cameras tab.
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3 From the Cameras list, select a camera.

4 In the Cameras tab, you can set the properties for the selected camera.

DescriptionParameter

Type ■ Perspective (default)  This projection simulates a real phys-
ical camera.

■ Orthographic  With this projection, all camera rays are par-
allel, and objects do not appear to change size as they change
distance from the camera. Field of view settings and depth of
field settings available from the Render tab have no effect with
this projection.

Sets the distance for the camera's focal point. As the focal distance
increases, the field of view decreases, and vice versa.

Focal Length

Sets the minimum viewable distance from the camera. By default,
the near clipping plane is close to the camera. Setting the near
plane farther back will hide objects very close to the camera.

Near Plane

Sets the maximum distance from the camera. By default, the far
clipping plane is very far away, so that you can see the entire scene.

Far Plane

Setting the far plane closer to the camera will hide objects farther
away.

Modifies the motion blur that affects layers animated in the scene.
You can give the layer the appearance of moving at a different
speed than is set for Motion Blur in the Render tab.

Time Dilation

Lets you frame the scene, making objects appear larger or smaller
in the frame.

Angle of View

The input stream selector controls which streams of the Reaction
sources are used when rendering through the given camera. You

Input Stream

can specify an explicit stream index (Manual mode) or let the order-
ing of the camera in the camera list control the selection of the
stream (Match Out).

Film Back ■ Film Gate The format of the film gate.

■ Horizontal/Vertical Aperture  The height and width of the
camera's aperture or film back, measured in inches. The Camera
Aperture attribute determines the relationship between the
Focal Length attribute and the Angle of View attribute. The
default values are 1.417 and 0.945.
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DescriptionParameter

■ Film Aspect Ratio  When the aspect ratio of the film is
modified, the horizontal camera aperture is modified. X = Y
multiplied by the aspect ratio. The ratio of the camera aperture
width divided by the camera aperture height. When changed,
it dynamically adjusts the camera aperture width.

■ Lens Squeeze Ratio The amount the camera's lens com-
presses the image horizontally. Most cameras do not compress
the image they record, and their Lens Squeeze Ratio is 1. Some
cameras (for example, anamorphic cameras), however, com-
press the image horizontally to record a large aspect ratio (wide)
image onto a square area on film. The default value is 1.

■ Fit Resolution Gate  Controls the size of the resolution gate
relative to the film gate. If the resolution gate and the film gate
have the same aspect ratio, then the Film Fit setting has no ef-
fect.

■ Film Fit Offset  Offsets the resolution gate relative to the film
gate either vertically (if Film Fit is Horizontal) or horizontally (if
Film Fit is Vertical). Film Fit Offset has no effect if Film Fit is Fill
or Overscan. Film Fit Offset is measured in inches. The default
setting is 0.

■ X & Y Film Offset Vertically and horizontally offsets the
resolution gate and the film gate relative to the scene. Changing
the X and Y Film Offset produces a two-dimensional track. Film
Offset is measured in inches. The default setting is 0.

Translates the selected camera about the X, Y, or Z axis.Position

Rotates the selected camera about the selected axis and changes
its orientation. Angles of rotation are measured in degrees.

Rotation

Moves the selected camera's center along the X, Y, or Z axis.Pivot

Accessing Cameras and Camera Views
You can see your scene through different cameras and from different points
of view. To see different views, you can use the predefined orthographic views
or the perspective view. You can also dolly, truck, or zoom those views without
affecting of the contents in the scene, including the render camera.
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NOTE When using any camera, other than the render camera, zooming and
panning in the Player is equivalent to dollying and trucking the camera.

The View From menu lets you access each camera and camera view, and is
available from both the hardware and software renderer.

To access the camera(s):

 ➤ Right-click the Player and select View From > Camera (Shift + 1). If there
is more than one camera, each one is listed. To cycle through each camera,
press Shift + 1.

To access the camera views:

 ➤ Right-click the Player, select View From and one of the following:
Perspective (Shift + 2), Front (Shift + 3), Back, Left (Shift + 4), Right, Top
(Shift + 5), or Bottom.

Transforming Cameras
You can transform cameras interactively in the Player or set values in the
transformation fields in the Cameras tab—see Transforming Objects on page
288.

NOTE The camera is initially positioned in Z according to the composition's format.

NOTE Interactive transformations are applied using the camera's local axis, but
its position is recorded using global coordinates.

Dollying, Trucking, and Orbiting the Camera

You can dolly, truck, and orbit any camera to view your scene from different
angles.

NOTE Camera movements are not the same as zooming and panning the Player.
For example, if you need to view the pixel output of Reaction up close, you should
zoom in. But if you want to move the camera itself, you should dolly.

To dolly the camera:

 ➤ Hold down the E key and drag up to move the camera into the scene.
Drag down to move the camera out of the scene.
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To truck the camera:

 ➤ Hold down the W key and drag up, down, left, or right to position the
camera.

To orbit the camera:

 ➤ Hold down the Q key and drag in any direction to position the camera.

Modifying Motion Blur for the Render Camera(s)
You can modify the motion blur applied to the render camera(s) in your
composition. This gives the appearance of movement in the scene relative to
the camera—see Adding Motion Blur and Depth of Field to a Scene on page
292.

To modify the motion blur:

1 Select the Cameras tab.

2 From the Cameras list, select the render camera(s).

3 Under Motion Blur, modify the Time Dilation. A higher value increases
the blur effect giving the impression of faster motion, and vice versa.

Resetting the Camera
You can easily reset the camera to its default.

To reset the camera:

1 In the Schematic view, select the Reaction node.

2 Do one of the following:

■ Press Shift + Home to reset the camera in the current Player.

■ Right-click the Player and select Reset Camera.
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Camera Mapping
Camera mapping lets you add depth and perspective to a matte painting or
rendered image by allowing it to be projected onto geometry from the point
of view of the camera. In this way, you can add the illusion of 3D movement
to a 2D scene. This facilitates the creation of virtual set extensions, and is also
used as part of the process of converting 2D material to stereoscopic imagery.

Using the Camera Mapping tool, which you can place between the geometry
generator and the Layer node, you can generate UV coordinates. UV
coordinates are 2D coordinates that you can apply to an object; they are
generated by the camera connected to the Camera Mapping tool. UV
coordinates are affected by the camera's parameters, such as the field of view,
distance, and so on.

To use the Camera Mapping tool:

1 Create a new composition.

2 From the Tools tab, select Reaction and drag it to the Schematic view

3 Select a layer type from the Layer type menu and click Create to add a
new layer.

4 Open the File browser and drag the image you want projected into
Schematic and attach it to the new layer you created.

5 Display the Group Schematic by double-clicking the Reaction node or
right-clicking the Reaction node and selecting Edit Group.
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6 Temporarily disconnect the layer type (bicubic in this case) node from
the sub-graph.

7 From the Tools tab, select Camera Mapping from the Reaction folder and
drag it to the Group Schematic.

8 Connect the Layer Geometry output to the Camera Mapping input.

9 Connect the Camera Mapping Geometry output to the bicubic node.

282 | Chapter 12   Multilayer Compositing and 3D Effects



10 From the reaction folder, drag a second camera to the sub graph and
connect its camera output to the Camera Mapping node's Camera output.

11 Adjust the Camera's Film Back, Position, Rotation and Pivot parameters.

3D Displacement
The 3D Displacement tool lets you add depth to meshes created in or imported
into Composite. The pixel values in an image are used to displace vertices.
This allows the illusion of perspective to be maintained as the camera is moved
in 3D space. You can also create a displacement that converges on an object,
such as a light. Once created, you can blur the displacement, as well as set the
tiling.
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(a) Image before displacement. (b) Image after displacement. (c) Displacement targeted
towards and converging on an object. In this case, a light.

NOTE The 3D Displacement tool can only perform displacement on images with
sufficient geometry. If the image you are using does not contain sufficient
geometry, you can increase it by adjusting the width and height of segments in
the Surfaces tab of Reaction.

To use the 3D Displacement tool:

1 Select File > New or press Ctrl + N (for Windows and Linux) or Cmd + N
(Mac OS) to start a new composition.

2 From the Tools tab, select Camera from the Reaction folder and drag it
to the Schematic view.

3 You will need two sources, one for the image to be displaced and another
for the image that will do the displacing. Right-click the Reaction node
and select Add Source. Repeat to add another source.
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4 Select the Reaction node. In the tool UI, select the Render tab and click
Z-Buffer—see Enabling Z-Buffer Effects in Your Scene on page 292.

5 Add the two images you want to use to the Schematic view, connecting
one to each source. In the following example, the Noise image generator
is used to displace the character.

6 Display the Group Schematic by double-clicking the Reaction node or
right-clicking the Reaction node and selecting Edit Group.

7 From the Tools tab, select 3D Displacement from the Reaction folder and
drag it to the Group Schematic.

8 In the Layer Editor, click Create to add a new layer.

9 Delete the Source node and arrange the nodes as follows:
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10 Select the 3D Displacement node. In the tool UI, you can adjust the
following parameters:

DescriptionParameter

Amount of displacement in the image. Positive values make
the displacement protrude and negative values invert the
displacement.

NOTE The displacement occurs in Reaction units
(Amount times the displacement image values minus
the Offset).

Amount

The value that is subtracted from the displacement image
values before it is interpreted as a displacement. It is used to

Offset

determine the value of the displacement image that yields
no displacement.

Type ■ Surface Orients the displacement towards the surface
normal.

■ Toward Target Orients the displacement towards a
target which can be a light, locator, axis, camera, layer,
or 3D object.

■ RGB > XYZ  Specifies the displacement by using the
explicit XYZ components of the displacement in the RGB
channels of the image.

286 | Chapter 12   Multilayer Compositing and 3D Effects



DescriptionParameter

Set the channel for displacement: Luma, Red, Green, Blue,
Alpha.

Channel

Used with the Toward Target type. The displacement con-
verges or is parallel to the target.

Convergence

Set the amount of blur to apply in the X or Y direction.X Radius, Y Radius

Couple the X and Y Radius so that when you change the X
Radius or Y Radius, the other changes in the same proportion.

Link

Set the repeat mode: Transparent, Edge, Repeat, and Mirror.Tiling X, Tiling Y

11 To make the displacement point towards a target, set the Type to Toward
Target. Set Convergence parameter; the displacement can converge on
the target or be parallel to it.

12 From the Tools tab, select the Reaction folder and drag one of the
following to the Group Schematic: Axis, Camera, Layer, Light, or Locator.

13 Connect the target to the Target tab of the 3D Displacement node. In
the following example, a light was added as the target.

14 Select the Light node. In the Lights tab, adjust the light to your liking—see
Working with Lights on page 268.

15 Select the 3D Displacement node and adjust the Amount until you have
the desired result.
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The image is starting to displace towards the light object.

Transforming Objects
You can transform an individual layer, axis, light, or camera along a specific
axis to achieve the effects you want. You can transform objects interactively
in the Player, or by setting values in the transformation fields in the Reaction
tool UI.

NOTE When transforming lights, you may need to zoom out to view a light's icon.
Also, interactive transformations are applied using a light's local axis, but its position
is recorded using global coordinates.

To transform objects interactively:

1 In the Schematic view, display the Group Schematic by double-clicking
the Reaction node or right-clicking the Reaction node and selecting Edit
Group.

2 Select a layer, axis, light, or camera by doing one of the following:

■ Click an object in the Group Schematic.

■ In the Reaction tool UI, select the appropriate tab and select an item
from the Layer Editor, Axes, Lights, or Cameras list.

The Reaction tool UI displays the tab associated with the selected object.
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3 Click a transform button.

To:Click:

Translate an object along the selected axis. When you move an object,
its coordinates are displayed and update dynamically.

Rotate an object about the selected axis and change its orientation.
Angles of rotation are measured in degrees.

Scale an object in X, Y, or Z according to the selected axis. An object is
scaled from its center. Scaling uses a multiplication factor. Negative
values yield an inverted object.

NOTE When a layer is created, its scale is automatically set to
1.0.

NOTE Cameras cannot be scaled.

To transform objects using the tabs:

1 In the Reaction tool UI, select the tab of the object you want to transform,
and then select an item from the Layer Editor, Axes, Lights, or Cameras
list.

NOTE If you selected a light, select Transform in the Lights tab (under
Parameters) to display the fields.

2 Transform objects by adjusting the Position, Rotation, and Scale values
(X, Y, and Z).

NOTE To scale a layer, light, or axis uniformly, click the Link button below
the Scale fields.

NOTE Cameras cannot be scaled.

3 Move the object's center by adjusting the Pivot values (X, Y, and Z).
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Reaction Rendering Effects and Output Results
Because Reaction provides a 3D environment, it has its own rendering and
output options that you can use to specify an output format, set certain
rendering features to quickly render draft results, or set rendering effects such
as anti-aliasing or motion blur and depth of field.

Setting the Reaction Composition Format
The Reaction Render tab contains the same composition format options
available from the Composition tool UI.

By default, the Reaction tool inherits the format settings specified for the
project. You can set them as desired for your Reaction output.

Setting Rendering Options
Depending on whether you are using the hardware or software renderer, you
can set some rendering options and effects. When you use the software
renderer, you can set the Depth of Field and Motion Blur effects, and specify
the number of samples to take, and select a filter for anti-aliasing.

To set Rendering and Effects Options:

1 With the cursor over the Player, press the tilde key (~) or middle-click to
display the Gate UI. Swipe through Player Options.

2 Under Reaction, select Interactivity to use the hardware renderer to
preview results in Reaction. Deselect Interactivity if you want to use the
software renderer.

NOTE The hardware preview in Reaction does not affect the Reaction output
to any tools downstream, and does not affect the published results.

3 In the Reaction UI, select the Render tab.
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4 Under Rendering, set rendering options.

DescriptionParameter

Applies filter effects on your composition. Choices are listed in order of
speed and quality: Box, Conic, Max, Quadratic, Narrow Gaussian, Me-

Filter

dium Gaussian, Wide Gaussian, Cubic, Cook, and Mit-Net Noch. The
Box filter is ultra-fast, but low quality. The Gaussian filters give more
blur. The choice you make also depends on the number of samples
used.

Sets the number of samples. A larger sample gives higher quality but
slower speed. This is used with the software renderer only.

Samples

Turns on/off shading. You may want to disable shading for generating
a draft result.

Shading

Turns on/off shadows.Shadows

Applies image filtering.Image Filter-
ing

Enables surfaces to render in wireframe.Wireframe

Displays light, camera, and axis icons. You must also enable Interactivity
in the Player options to view the icons.

Icons

5 Under Fx, set the effects options.

NOTE You must have software rendering enabled. To enable software
rendering, deselect Interactivity in the Player options.

DescriptionParameter

Smooths the edges of rounded surfaces and diagonal lines.Anti-aliasing

Includes DOF in your scene. This effect simulates a plane of maximum
sharpness and blurs objects close to or beyond this plane.

Depth of
Field

Adds motion blur to your scene.Motion Blur

Uses the Z-buffer in your composite. The Z-buffer works with hardware
and software rendering.

Z-Buffer
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Adding Motion Blur and Depth of Field to a Scene
When the Motion Blur and Depth of Field (DOF) effects options are enabled,
you can set parameters to define how they will appear in your scene.

NOTE The software renderer must be enabled to apply Motion Blur and Depth
of Field effects.

To add Motion Blur to your scene:

1 Under Fx, select Motion Blur.

2 Under Rendering, enter the desired number of samples. A greater number
of samples gives a more realistic effect, but requires more processing time.

3 Set a value for Camera Shutter.

To add depth-of field to your scene:

1 Under Fx, select Depth of Field.

2 Set a value for Camera Aperture.

Description:Property:

Used with motion blur. The software calculates which sample
should be considered most important and makes it appear
brighter.

Importance
Sampling

Used with motion blur. Sets the length of time the shutter is open.
A larger number yields a slower shutter speed and a greater
amount of motion blur.

Camera Shutter

Used with DOF. Sets the size of the camera “lens” opening. In-
creasing the size of the aperture increases the zone of sharpness
in front of and behind the plane that the lens is focused on.

Camera Aperture

Enabling Z-Buffer Effects in Your Scene
You can enable the Z-buffer for your scene to create realistic spatial depth
effects. The Z-buffer calculates the spatial depth for each pixel in an image to
define which pixels are hidden by others.
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To enable the Z-buffer:

 ➤ Under Fx, select Z-buffer.

Setting up a Stereo Camera Rig
You can use Reaction to render a stereo scene from two cameras, or vastly
different viewpoints from an arbitrary number of cameras.

To set up a stereo camera rig in Reaction:

1 Select the Reaction node in the Schematic view and then select the
Cameras tab.

2 Create three cameras and Rename them: Center, Left, and Right.

3 Make the Center camera parent of the Left & Right cameras by
double-clicking the Reaction node in the schematic to access the Reaction
sub-schematic then connect the Center camera 3D Object input to the
Left and Right cameras Output 3D object output.
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4 From the Tool UI, set the Left & Right cameras Translation Z parameter
to 0.

5 From the Tool UI, set the Left camera Input Stream parameter to 0.

6 From the Tool UI, set the Right camera Input Stream parameter to 1.

7 From the Reaction Cameras list, set the Left & Right cameras to active by
enabling the square button under the A column. Set the Center camera
as inactive by disabling the square button under the A column.

8 From the Composition Browser, drag & drop the Left camera folder on
the Right camera folder to link them together with expressions.
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9 From the Tool UI, right-click on the Right camera X Film Offset parameter
and choose Edit Expression option.

10 In the text field, type a minus sign in front of the expression and press
Apply.
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11 From the Tool UI, right-click on the Right camera X Translation parameter
and choose Edit Expression option.

12 In the text field, type a minus sign in front of the expression and press
Apply.

296 | Chapter 12   Multilayer Compositing and 3D Effects



The stereo rig is ready to use. You can adjust left and right eye
convergence.
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Pre-Compositing

Topics in this chapter:

■ About Pre-Compositing on page 299
■ The Pre-Compositing Import Options on page 306
■ About Anchors on page 307
■ Using Pre-Compositing Templates on page 310
■ Pre-Comp File Creation and Updates on page 313

About Pre-Compositing
Composite 2011 allows you to import a render layers and passes setup exported
as a pre-comp (.precomp) file by 3D applications that support this file format,
such as Autodesk Maya and Autodesk 3ds Max. Once imported into Composite,
a set of compositions is automatically created, representing the render layer
setup. For example, the left side of the following illustration shows the structure
of a Maya scene and its render layers, cameras, and render passes. The right side
shows the corresponding compositions that are created after it has been imported
into Composite.
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3D applications are render layer centric because it suits 3D artists. However,
once you import a pre-comp file into Composite, it becomes camera centric
because it is more suitable for the 2D artist. Now you can perform any
compositing work needed on the pre-comp file, and go back and forth between
Composite and the 3D application.

The Composite pre-compositing interoperability supports having a different
set of render passes for each render layer. In our example, Render Layer 1 has
more passes than Render Layer 2. Render Layer 1 only has an Ambient pass
and Render Layer 2 only has a Reflection pass.

For a given render layer, the set of render passes produced by each camera can
be different in a pre-compositing setup. For example, Maya cameras can decide
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whether to contribute to a pass or not (compare the Mono camera against the
Right and Left cameras on Render Layer 1 in our example).

■ A render pass composition imports render pass file sequences; it's a footage
composition.

■ A render layer composition assembles the render passes for a given render
layer. A render layer composition is basically a representation of the 3D
application shading/rendering network that produced the set of passes for
a layer.

■ A scene composition assembles (stacks) the render layers in the scene for
a specific camera view point.

Sets or pairs of cameras are also supported by the pre-compositing workflow
(for stereoscopy purposes).

■ Render passes produced by cameras of a set (Right and Left cameras in our
example) are imported in the same render pass composition in Composite.

■ Dependency graphs of render passes produced by camera pairs are also
created in the same render layer composition.

■ Finally, render layers produced by camera pairs are stacked in the same
scene composition.

This classification facilitates stereoscopic compositing once in Composite. The
dependency graph of the left camera can be manipulated next to the
dependency graph of the right camera in the same composition, allowing
expressions to be set between the two dependency graphs. Or, if you import
in Multi-Stream mode, images from the left and right camera views can be
merged and processed by a multi-stream dependency graph—see Working
with Stereoscopic Compositions on page 319.

TIP Pre-comp files are actually Python modules that you can read and edit with
any text editor. Just be sure to conform to the Python syntax if you choose to edit
your pre-comp file. Otherwise, Composite will encounter an error and display a
dialog box highlighting the problem.
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Pre-Compositing Import
You can either import render passes from a pre-comp file generated by any
3D application or import Maya passes directly from the Maya (.ma or .mb)
file.

A Maya pre-comp file contains the same information as the corresponding
.ma or .mb file of the 3D scene. However, pre-comp files are faster to import
into Composite and more stable to use. An advantage of using pre-comp files
is that they are self-contained. That is, you don't need to have Maya installed
and licensed on your system like you do for importing Maya files. Before
importing a Maya file, see To Import an FBX File on page 324.

To import a pre-comp or Maya file:

1 Select File > Import or press Ctrl + I(for Windows and Linux) or Cmd +
I(for Mac OS).

The File Browser is displayed.

2 Locate the folder that contains the pre-comp file.

3 Right-click the pre-comp (.precomp) file and select Import or press the
Import button.

NOTE Pre-comp and Maya files can only be imported in Composite one at
a time.
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The Script Output floating window displays the progress of the import,
and the Pre-Compositing Import Options dialog box displays. See Viewing
Output and Error Messages on page 871.

4 Set parameters for the pre-comp file—see The Pre-Compositing Import
Options on page 306.

If images are missing, you are prompted to locate the folder that contains
the images.

NOTE The Browse button does not work when importing Maya files, because
the import is performed in a background process.

NOTE For Maya files, by default, Maya expects the render files to be in the
default location for the Maya project. Place them there to avoid having to
input the location or add the correct path in the dialog box. On Windows,
the location is C:/My Documents/maya/projects/default. You will need to
locate the My Documents folder as it could at a different location, depending
on where it was installed. On Linux and Mac OS, the location is:
${HOME}/maya/projects/default.

If Composite cannot find a pre-compositing template referenced by the
pre-comp file, the following dialog box is displayed:

Pre-Compositing Import | 303



5 Do one of the following:

■ If you have a template you want to use, locate it.

■ If you want to use the default template provided by Composite, click
Default Template.

NOTE The Browse button does not work when importing Maya files,
because the import is performed in a background process.

■ If you do not want to use a template, click No Template.

For more information, see Using Pre-Compositing Templates on page 310.

The render layers and passes are imported. The scene composition, named
after the scene anchor and camera(s) anchor, is created in the folder you
specified during import. This folder contains a Layers folder and a Passes
folder, unless you specified a different name during import. Render layer
compositions are named after the scene anchor, the camera(s) anchor,
and the layer anchor. Render pass compositions are named after the scene
anchor, the camera(s) anchor, the layer anchor, and the pass anchor.

6 When the imported composition has opened.

The composition and associated render layer compositions are opened,
and the chain of Blend & Comp nodes in the scene composition matches
the order and blend modes in the render layers.
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7 To view a layer composition, do one of the following:

■ Double-click a link node.

■ Right-click a link node and select Open.

■ In the File Browser, open it from the Layers folder.

8 To view a render pass composition, open it from the Passes folder in the
File Browser. Click the Import Image node.

In the tool UI, select the Import Image tab.
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Notice that the Path field displays path of the image sequence that is
imported for that render pass. And, the image format, pixel format, rate,
frame range and pre-multiplication import options are properly set.

The Pre-Compositing Import Options
When you import pre-comp files and render layers and passes, you can set
the following options in the Pre-Compositing Import Options dialog box. You
can also set these options in your project preferences—see Setting Project
Preferences on page 97.

DescriptionParameter

The folder in which imported Composite compositions are created
or updated.

Destination Folder

Specify how to handle existing compositions during import. You
can update or recreate the working version, overwrite all versions,

Update Mode

skip existing compositions (no update), or asked to be prompted
for each composition.

Back up the working version of the composition when an update
is required.

Backup Working
Version

Whether the default composition template should be used when
no template is specified.

Default Template

Specifies how to create stereoscopic compositions—see Working
with Stereoscopic Compositions on page 319.

Multi-Stream

Increases pre-compositing import script verbosity.Verbose

Determines whether the pre-compositing options dialog is shown
on import.

Show Options

Adds a subfolder (named after the pre-compositing anchor) to
the destination folder.

Scene Subfolder
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DescriptionParameter

The name of the subfolder in which the render pass compositions
are stored.

Passes Folder

The name of the sub folder in which the render layer composi-
tions are stored.

Layers Folder

Merges the content of all render layer compositions into the
scene composition—see Merging Layers on page 321.

Merge

The location of the scene composition template to use for mer-
ging compositions—see Using Pre-Compositing Templates on
page 310.

Template Path

The root folder of the rendered image files hierarchy. It is used
to locate the rendered image files.

Render Directory

Saves the current pre-compositing import options in your project
preferences—see Setting Project Preferences on page 97.

Save to Project Set-
tings

About Anchors
In a scene, there are unique anchors for the following elements: render layers,
render passes, and cameras. Anchors identify these elements in the resulting
Composite composition that is created after importing a 3D scene.

One or more anchors can be associated with any node in a dependency graph.
You can add, remove, and edit anchors. You can also view a node's list of
anchors. When a node has an associated anchor, the anchor tab at the
upper-left of the node turns blue.

NOTE An anchor name does not have to be unique within the dependency graph.
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Pre-Compositing Anchors
In a pre-compositing scene, each render pass is uniquely identified by a render
pass anchor. The same applies to render layers/render pass anchors and
cameras/camera anchors.The various anchor names in the 3D application are
used by Composite during the import of pre-comp files. The anchors are used
to locate the entry points for each type of 3D asset in the resulting Composite
compositions.

Camera anchors are specifically set on composition output nodes and on the
output socket of link nodes identify each camera view of a stereo setup.Also,
anchors are crucial to the update process, so they should not be changed. It
is also important to have properly defined anchors in the composition
templates—see Using Pre-Compositing Templates on page 310.

To view a node's anchor:

1 Place the cursor over a node or an output socket that has an anchor,
which is indicated by blue anchor tab, and press the d (lowercase) key to
turn on the Details mode. Now you can place your cursor over any node,
as well as its output socket to view its details. Press d again to turn off
the Details mode or if you have tooltips turned on, simply hover over
the node.

Details of a link node with anchors.a)

Details of the output socket of a link node.b)

2 To view the details of all nodes in the dependency graph, press Shift +
D. Press Shift + D again to turn off the Details mode.
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To add an anchor to a node:

1 Right-click the node on which you want to add an anchor and select
Add.

2 In the Add Anchor dialog box, type in a name for the anchor.

3 Do one of the following to specify the type of anchor:

■ In the Type field, type in the kind of anchor you are adding. It can
be anything you want.

■ Click the button below the Type field and select an anchor type:
Custom, Render Pass, Render Layer, or Render Camera.

4 Click OK.

5 To view the anchor, place your cursor over the node and press the d
(lowercase) key.
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The new anchor was added to the bottom of the list of anchors. The type
of anchor is indicated in parentheses.

To remove anchors:

 ➤ Right-click the node on which you want to remove an anchor and select
Anchors and one of the following:

■ Remove All: To remove all the anchors associated with the node.

■ Remove: To select a specific anchor to remove from the list.

To edit an anchor:

1 Right-click the node on which you want to edit an anchor and select
Anchors > Edit Anchor and select the anchor you want to edit.

The Edit Anchor dialog box displays.

2 Edit the anchor name and type and click OK.

Using Pre-Compositing Templates
A pre-compositing template is a Composite composition, a .txcomposition file.
There are three types of templates: layer, scene, and merged. A template
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contains an arbitrary number of anchor link nodes that source an arbitrary
dependency graph.

The anchor link nodes in a template can be unconnected or linked to existing
compositions; the link is simply replaced when the template is used to create
a composition.

A template has at least one output (the primary) which is typically the final
look of the render layer or scene. However, you can add an arbitrary number
of secondary outputs to the template.

Template Types
There are three types of templates that you specify in the Pre-Compositing
Import Options dialog box during import: layer, scene, and merge.

Layer Template

The layer template assembles passes from a single layer. This is the default
template provided with Composite. For example, the following shows the
default Maya 2011 layer template provided with Composite. Its link nodes
have render pass anchors that match the default name of the standard render
passes in Maya 2011.

Because the layer template assembles passes from a single layer, the render
layer template composition must contain link nodes with a render pass anchor
on them—see Pre-Compositing Anchors on page 308. On render layer templates,
the render passes are assembled to reflect the shaders network in the 3D
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application. The render layer template can be different on each layer. If no
render layer template is specified, the default layer template for the given 3D
application is used.

NOTE In Maya, the path to the render layer template composition can be specified
on the render layer node.

The name of the default template is based on the application name and its
version, such as Maya2011_LayerTemplate.txcomposition. The script uses the
template file that is closest to the version that the application used to generate
the pre-comp file.

Default pre-compositing templates are located in:

■ Windows: C:\Program Files\Autodesk\Autodesk Composite
2011\resources\precomp\templates

■ Linux:
/usr/autodesk/Autodesk_Composite_2011/resources/precomp/templates.

■ Mac OS:
/Applications/Autodesk/Composite/2011/AutodeskComposite.app/Contents/Resources/precom/templates.

Scene Template

The scene template stacks the layers using Blend & Comp nodes and assembles
the layers in the same order as in the 3D scene. This template assembles layers
in the scene for a given camera view, so the scene template composition must
contain link nodes with a render layer anchor on them—see Pre-Compositing
Anchors on page 308.The scene template can be different for each camera view.
If no scene template is specified, the layers are stacked using Blend & Comp
nodes and the layers are assembled in the same order and blend modes as in
the 3D scene.

NOTE In Maya, the path to the scene template composition can be specified on
camera node.

Merge Template

The Merge template assembles all passes of all layers, so the merged template
composition must contain link nodes with both Render Pass and Render Layer
anchors on them—see Pre-Compositing Anchors on page 308.
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Creating a Pre-Compositing Template
You can create your own template for pre-compositing.

To create a template:

1 Import a pre-comp file without specifying a template—see
Pre-Compositing Import on page 302.

If you are creating a render layer template, the render layer composition
contains a number of link nodes to render pass footage compositions.
The render pass anchors are already set on the link nodes—see Render
Layer Composition Creation on page 316.

If you are creating a scene template, the scene composition contains a
number of link nodes to render layer compositions. The render layer
anchors are already set on the link nodes—see Scene Composition
Creation on page 317.

2 Build the dependency graph.

3 If needed, edit the render pass or layer anchors—see Pre-Compositing
Anchors on page 308.

4 (Option) Clean up the template by selecting Composition >
Pre-Compositing and one of the clean-up options. When cleaning up the
template, link nodes are reset, their name is changed to match the
anchors, and unused anchors are removed from nodes and output sockets.

5 Provide the pre-comp file (.txcomposition) to the 3D artist as the render
layer template.

Pre-Comp File Creation and Updates
The creation and update of pre-comp files always starts with the scene
compositions, working its way down to the render layers and finally the render
pass compositions.

The scene/layer/pass compositions are named accordingly: <scene anchor>
<camera anchor> <layer anchor> <pass anchor>.

WARNING  Renaming compositions will impair the update process.

All nodes, including output nodes, in each type of composition can be
renamed, since node anchors are used to keep track of the topology during
import.
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Non-Destructive Updates
Pre-comp import updates are completely non-destructive. When an update is
needed on a composition of any type (render layer, render pass, or scene),
modifications are applied to a new version of the composition (if you turned
on the Backup Working Version option in the Pre-Compositing Import Options
dialog box or project preferences), which could be a clone of the working
version or a new version recreated from scratch.

Moreover, when an update is applied on a clone of the working version, none
of the existing nodes in it are deleted (only new content is added) and existing
connections are preserved.

Partial updates are also supported. That is, only some cameras or some render
layers and passes could be modified during a pre-composition update.

A scene, render layer, or render pass composition is not updated if it doesn't
need to be. You can re-export the entire contents of the scene and only the
content that needs to be updated will be.Changing the path or the content
of a pre-compositing template will not trigger an update as the Composite
application does not detect when the template has changed. In this case, you
should use the Recreate Working Version update mode in the Pre-Compositing
Import Options dialog box or project preferences.

Frame Rates
Since Composite does not support all frame rates, there may be cases where
the time units in the 3D application, such as Maya, may correspond to an
unsupported rate in Composite. During import of the pre-comp file, Composite
finds and uses the closest supported rate. However, a warning is displayed
which applies to all types of compositions (render layer, render pass, or scene).

Render Pass Compositions

Render Pass Composition Creation

The render pass image files are imported in a new footage composition. If the
files are in OpenEXR format, the appropriate channels are selected.

The render pass files don't need to be on disk for them to be imported by
Composite in the correct image and pixel format and time range because all
of this information can be queried by Composite through the pre-comp file.
Also, pre-multiplication with the proper background color is handled correctly.
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If the render pass file names do not have extensions or if the extension does
not correspond to an image file format that Composite can import, a warning
is issued, but the render pass composition is still created and its Import node
holds the specified sequence path, however, it produces a red X frame.

The render pass footage can be anywhere on disk, organized in an arbitrary
folder hierarchy. The files can be in any format that Composite supports
during import—see Supported Media Formats on page 116. If rendered to
OpenEXR, the render passes can be stored in any file channel. The
pre-compositing import is totally independent from the way images are
organized on disk.

If the render pass was rendered from many cameras of a camera set
(stereoscopy), the file sequences of each render camera are imported in the
same render pass composition, each with it own Import node and output
node. The name of the output nodes is suffixed by its corresponding camera
name. The camera anchor is set on the output node.

NOTE Unlike other footage compositions which have an Original Footage and a
working version, a render pass composition initially has only one version, the
working version.

Render Pass Composition Updates

A render pass composition update can be started when there is a new version
of the rendered files on disk (includes changes to the rendered files path, the
frame range, their image format, the OpenEXR channels the pass is stored in
if any, etc.).

When updating a render pass composition, a new empty version of the render
pass composition is created if you turned on the Backup Version option in
the Pre-Compositing Import dialog box, and the new render pass file sequence
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is imported the same way it is done in the creation process—see The
Pre-Compositing Import Options on page 306.

Note that the primary version of a render pass composition is never changed
by the pre-compositing update. It is up to you to decide which one is the
primary—see Working with Compositions on page 217.

Render Layer Compositions

Render Layer Composition Creation

Before the render layer composition is created, render pass compositions for
the given render layer are created or updated.

With a Template If a template is specified for the render layer, its content
is copied into the render layer composition and the rest of the operations
applied to it are quite similar to what happens during an update.

The dependency graph is reviewed to find all the render pass anchor link
nodes which are updated to link to their associated render pass composition,
which was previously created or updated.

If some render pass anchor link nodes are missing in the template, new
unconnected render pass anchor link nodes are automatically added to the
render layer composition (in the same way as when no template is specified).

Without a Template If no template is specified, the render layer composition
is created with a single unconnected output node. For each render pass
composition, there is an unconnected link node that points to it.

The render pass link nodes have their anchors automatically set to their
corresponding render pass anchor name and the nodes are initially named
after their linked render pass compositions (their names are not changed by
further updates).

What Happens Next?  By default, a render pass anchor link node points to
the Latest version. This is because a new render pass composition version was
added during a pre-comp file update is not automatically tagged as the primary
version. Choosing the primary render pass version is up to you. If you want
the render layer composition to be updated automatically when new Maya
render passes are imported in Composite, the render pass anchor link nodes
must point to their latest version by default—see Working with Compositions
on page 217Working with Compositions on page 217.

The image format, pixel format and rate of the render layer composition are
set according to the information contained in the pre-comp file.
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The time range (start, end) of the render layer composition is then set to the
union of its render pass compositions time ranges.

Render Layer Composition Update

A render layer composition is updated when a new pass is added to the scene.
Deleting a pass will not trigger an update because it's non-destructive.
Renaming a pass is equivalent to adding a new pass.

The working version of the render layer composition is backed up if you set
the Backup Version option. Then, in Update mode, the working version is
updated. otherwise it is recreated from scratch (Recreate mode).

Updating the render layer composition is then quite straightforward. Existing
render pass anchor link nodes are left unchanged because they point to the
latest version of the render pass composition by default. The ones that are
missing are created (but are unconnected) and linked to their respective render
pass compositions.

If an existing render pass is no longer in the render layer (which could be
because it was removed from the 3D scene or because the pre-comp file update
is partial), its anchor link node is not deleted; the render layer composition
update is non-destructive—see Non-Destructive Updates on page 314.

The format and rate of a render layer composition is not modified on update.
However, the start/end of the render layer composition is updated to be the
union of its current time range and the time ranges of all its linked render
pass compositions.

Scene Compositions

Scene Composition Creation

Before the scene composition is created, render layer compositions in the
scene composition are created or updated.

With a Template If a template is specified for the scene, its content is copied
into the scene composition and the rest of the operations applied to it are
quite similar to what happens during an update of the scene.

The dependency graph is reviewed to find all the render layer anchor link
nodes which are updated to link to their associated render layer composition,
which was previously created or updated.
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If some render layer anchor link nodes are missing in the scene template, new
unconnected render layer link nodes are automatically added to the scene
composition (in the same way as when no template is specified).

Without a Template  If no scene template is specified, render layer anchor
link nodes are created with their proper anchor name set and point to their
respective render layer composition. Render layers are then stacked in a chain
of Blend and Comp nodes, respecting the compositing order and blend modes
used in the 3D scene.

What Happens Next? The render layer link nodes have their anchors
automatically set to their corresponding render layer anchor name and the
nodes are initially named after their linked render layer compositions (their
names are not changed by further updates).

The image format, pixel format, and the rate of the scene composition are
then set according to the default render settings of the 3D scene. The time
range (start, end) of the scene composition is then set to the union of its render
layer compositions time ranges.

Scene Composition Update

A scene composition is updated when a new layer is added to the scene.
Deleting a layer will not trigger an update because it's non-destructive.
Renaming a layer is equivalent to adding a new layer.

The working version of the scene composition is backed up if you set the
Backup Version option. Then, in Update mode, the working version is updated.
otherwise it is recreated from scratch (Recreate mode).

Existing render layer anchor link nodes are left unchanged because they point
to the latest version of the render layer composition by default. The ones that
are missing are created and linked to their respective render layer compositions.

If an existing render layer is no longer in the scene (because it was removed
from the 3D scene or because the pre-comp file update is partial), its anchor
link node is not deleted; the scene composition update is non-destructive—see
Non-Destructive Updates on page 314.

If the layer ordering or the blend modes between layers have changed, a new
stack of Blend & Comp nodes is created within a visual group next to the old
stack. In the following example, the tire and tire label layers were added during
update.
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The format and rate of a scene composition is not modified on update.
However, the start/end of the scene composition is updated to be the union
of its current time range and the time ranges of all its linked render layer
compositions.

Working with Stereoscopic Compositions
In a stereoscopic scene, rendered files produced by each camera of the stereo
rig are imported and composited in the same composition at all levels (pass,
layer and scene). There are two modes in which you import a stereo scene,
either in multi-stream mode or not—see The Pre-Compositing Import Options
on page 306.

In single stream, the graph of the template is duplicated for each camera and
placed within a group node to avoid name and expression clashes. The left
and right of the output link nodes feed the corresponding dependency graph.
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For example, if you double-click the left group, you'll see the default render
layer template in the following dependency graph.

In Multi-Stream mode, the left and right outputs of each link node are merged
together, feeding only one instance of the dependency graph. At the end,
each stream is extracted—see Multi-stream Compositing on page 371.
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Merging Layers
By default, each layer of a scene is imported into a different render layer
composition. For greater compositing freedom and to set expressions, you
must have all the dependency graphs of each layer in one scene composition.

To merge layers during import, click the Single Composition button in the
Pre-Compositing Import Options dialog box. The following shows what a
scene composition would look like after merging layers. Notice that each layer
is represented by the same dependency graph because they all use the same
default template.
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You can also specify a template to handle all passes from all layers—see Using
Pre-Compositing Templates on page 310.

You can replace a link node by the content of its linked composition.

To merge in a composition:

 ➤ In the Schematic view, right-click a Link Image node and select Merge
and one of the following:

■ Non-Recursive: Bring in one level of the linked composition.

■ Recursive: Apply the merge recursively on all link nodes found in the
linked composition version.

■ Recursive Except Footage: Stop recursion at footage compositions.
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Importing FBX Files

Topics in this chapter:

■ Importing FBX Files on page 323
■ FBX Import Limitations on page 329

Importing FBX Files
You can import all renderable cameras, camera planes, lights, geometry and
locators. When you import a scene, a new composition is created within a
Reaction node with all 3D data.

The name of the created composition (the one that contains the Reaction node)
is based on the name of the FBX file. However, 3D updates are not supported;
you can only overwrite the existing composition. To update a composition, you
can transfer objects from one Reaction node to another by copying and pasting.

NOTE All FBX Geometry is imported in a single layer.
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To Import an FBX File

To import an FBX file into Composite:

1 Select File > Import or press Ctrl + I(for Windows and Linux) or Cmd + I(
for Mac OS).

The File Browser is displayed.

2 Locate the folder in which the FBX file (.fbx) resides.

3 Right-click import or click the Import button to import and select Import
3D Scene.

NOTE Multiple FBX files can be imported into Composite at the same time.
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The Embedded Script Console displays the progress of the import.

4 Open the File Browser using the The Gate UI on page 12 or by pressing
Ctrl + O (for Windows and Linux) or Cmd + O (for Mac OS).

5 Open the imported composition. The composition name is based on the
FBX file name but without its extension.

6 Select the Reaction node to view the layers.
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WARNING There is currently no mechanism in Composite that locks imported
objects to their original values. If an object's values are changed by mistake, use
the undo feature or Ctrl + Z (for Windows and Linux) or Cmd + Z ( for Mac OS).
Pressing Reset will reset the values to the default settings of the identity matrix,
not to the original values of the object.

To view the imported objects in the Player:

1 Right-click and swipe south to display the Player options.

2 Under the Reaction label, select Interactivity. Under the Display label,
select Tool Output.

Imported objects are now visible in the Player.
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To view the camera image plane and its properties:

1 In the Layer Editor, select the camera image plane layer.

Its properties are displayed in the Reaction tab.

2 In the Player, right-click and select View From > Perspective or press Shift
+ 2 to view from the perspective camera.

To view locators and their properties:

 ➤ Select the Reaction node in the Schematic view and then select the
Locators tab.
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To view the imported FBX transforms:

 ➤ In the Tool UI, select the Axes tab and select an axis to view.

The imported FBX transforms are displayed in the Player and their
properties displayed in the Axes tab.

To view the camera(s):

1 In the Tool UI, select the Cameras tab.

2 From the Cameras list, select Camera01.

The camera is selected in the Player and its properties are displayed in
the Cameras tab.

To view the camera animation:

1 In the Tool UI, select the Animation tab.

2 In the Composition Browser, select the Reaction node, which is named
after the FBX file. Select Camera > Transform.

The Animation Editor displays the animation curves of the camera
transformation. To accurately represent the animation that was created
in the FBX file, a keyframe is set at each frame.
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FBX Import Limitations
The Composite 3D workflow lets you import scenes into Composite. The
following tables show which node attributes are brought over to Composite
(indicated by an “S” for supported) and whether the attributes can be edited
(indicated by a “E”) in Composite or whether it's recalculated into some other
attributes or Composite paradigms.

Transformation Attributes
CommentsESAttributesGroup

XXTranslateTransform

XXRotate

XXScale

Shear

Recalculated in Composite trans-
form. Expressions set on those will

XRotate Order

interfere with the recalculation
process.

XRotate Axis

Inherits Transform

Recalculated in Composite trans-
form. Expressions set on those will

XRotate PivotPivots

interfere with the recalculation
process.
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CommentsESAttributesGroup

XScale Pivot

Display Rotate Pivot

Display Scale Pivot

In Composite, it affects only Axis
visibility (not whole hierarchy).

XXVisibilityObject Display

Locator
CommentsESAttributesGroup

XXPositionLocal Trans-
form

XXScale

XXVisibilityObject Display

Camera
CommentsESAttributesGroup

Only free cameras in Composite.XControls (Aim, Aim-Up)Camera Attrib-
utes

XXFocal Length (Horizont-
al Angle of View)

Camera Scale

Auto Clip Planes

XXNear Clip Plane

XXFar Clip Plane

XXFilm Gate PresetsFilm Back

XXCamera Aperture
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CommentsESAttributesGroup

XXFilm Aspect Ratio

XXLens Squeeze Ratio

XXFilm Fit ModeFilm Fit On
Resolution
Gate

XXFilm Fit Offset

XXFilm Offset

Pre ScaleFilm Back 2D
Transform

Film Translate

Film Roll Pivot

Film Roll Value

Film Roll Order

Post Scale

Camera is imported if renderable.XRenderableOutput Set-
tings

Mask of the “render” (current)
camera translates to Alpha chan-

XMask

nel in Reaction output format.
Affects all cameras.

Image Z channel not supported
in Composite.

Depth

Background ColorEnvironment

Display Film GateDisplay Op-
tions

Player setting.XDisplay Resolution Gate

Display Field Chart
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CommentsESAttributesGroup

Display Safe Action

Player setting.XDisplay Safe Title

XDisplay Film Pivot

Display Film Origin

Overscan

XXOrthographic ModeOrthograph-
icView

Can not be set in Composite. Or-
thographic height is always 100

Orthographic Width

and width is set according to
output pixel aspect ratio.

XXVisibilityObject Display

Camera Image Plane
Once imported into Composite, an FBX image plane loses part of its
relationship with its camera. It is imported as a normal plane layer parented
to the camera transformation, but it does not rescale itself automatically when
its depth or the camera view frustum changes.

CommentsESAttributesGroup

Display Mode (RGB,
RGBA, A, Luminance,
etc.)

Image Plane
Attributes

Color Gain

Color Offset

Alpha Gain

Always attached to camera.Attached to Camera vs.
Fixed
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CommentsESAttributesGroup

Always Image File (Texture not
supported).

Type

In Image Import node feeding the
Reaction source.

XXImage Name

Can be controlled through Image
Import node mark in/out.

XUse Image Sequence

In Image Import node feeding the
Reaction source.

XXFrame Offset

Always “To Size”.Fit ModePlacement

Recalculated into plane layer
transformation according to
Depth and camera Focal Length.

XSize

Offset

Recalculated into plane layer
transformation.

XDepth

XRotate

Recalculated into plane layer
transformation (inverse of camera
Lens Squeeze Ratio).

XSqueeze Correction

Could be translated into a chain
of Composite Crop and Resize
nodes at the Reaction source.

Coverage WidthPlacement Ex-
tras

Coverage Height

Coverage Origin

Irrelevant since Fixed camera im-
age plane is not supported.

Center

Width

Height
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Current Limitations
The following list outlines the current limitations for FBX import:

■ Password protected FBX files cannot be imported in Composite.

■ You cannot selectively import assets from the FBX file; Composite imports
everything it recognizes.

■ By default, the geometry import tool imports all meshes of the scene into
a single layer. However, you can select which geometry to import.

■ The geometry tool imports the global transformation of the geometry in
Composite; its bakes the transformation of its parent hierarchy into the
mesh.

■ Composite doesn't support multiple UV coordinate on a vertex,; it only
imports the first (index 0) diffuse set of coordinates.

■ FBX animation curves are recalculated into a Composite animation with
one keyframe at each frame.

■ If the FBX scene contains more than one camera, the format of the resulting
composition (and the Reaction node) is based on the render settings of
the default camera.

■ The camera image plane distance, its size on aperture, the camera focal
length and the horizontal scale are all animatable values in FBX, but the
transformation of the imported plane layer in Composite is not animated.

■ The image plane offset values which controls how much the center of the
image plane is offset from the centre of the viewing frustum of the camera
are not supported by the FBX import.

■ The camera image plane layer cannot be created correctly if Composite
doesn't have access or cannot import the asociated image files, because it
needs to know the image resolution to scale the plane layer in Reaction.
Also, the Image Import tool cannot store the path of an image sequence
that doesn't exist.

■ Parameters that control the amount of the source image that is used in
the camera image plane are not supported.

■ Target cameras are not supported.

■ Once the Maya camera image plane is imported in Composite, it is no
longer a “camera” image plane (one that automatically rescales itself to fit
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the cam¬era view), just a simple image plane parented by the camera and
properly scaled for the current depth of the plane.
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Premultiplication

Topics in this chapter:

■ Premultiplied Images on page 337
■ When to Premultiply on page 337
■ Common Problems with Premultiplication on page 338
■ Premultiplication Tools on page 338

Premultiplied Images
A premultiplied image is one where the RGB channels have been multiplied by
the alpha channel. In other words, it is a four-channel image in which the red,
green and blue channels have already been multiplied by the integrated matte
channel.

Typically, images from a 3D renderer are premultiplied, which means that the
transparent areas are black in both the RGB channels and the alpha channel.
As such, in premultiplied images, the RGB channels never have a higher value
than the alpha channel.

When to Premultiply
You should consider premultiplying an image if you have to modify a foreground
element and composite over a background image. Furthermore, you should also
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consider premultiplying two or more images whenever you have to perform
a color correction or use filtering nodes.

When you premultiply an image by a matte, you should be aware that there
is a very specific brightness relationship between the pixels in the color
channels and the pixels in the matte. Since certain systems that will assume
that you are working with unpremultiplied systems, will also assume this
brightness relationship. As such, the brightness of any color channel cannot
be modified without also impacting the alpha channel.

There are two general rules to remember when considering premultiplication:

1 Only color correct unpremultiplied images.

2 Only apply filter and transform nodes to premultiplied images.

Common Problems with Premultiplication
There are certain problems that can occur when the rules of premultiplication
are ignored. These can range from problems with edges to raised global levels.
Additionally, when the premultiplied state of an image is ignored, there may
also be unwanted fringing around a masked object or the unwanted side effects
that may occur when a node affects parts of an image that it should not.

A possible result of compositing with a premultiplied image would be slight
lightening or darkening of the composite areas where the foreground matte
is semitransparent.

Another common problem is when color correction has been applied to a
foreground premultiplied image. This could result in the blacks in the scene
being elevated above the value of 0, which means that even though the matte
channel may still specify that the surrounding field is in black, the RGB
channels may have some small, often visually undetectable value.

Premultiplication Tools
Composite includes two tools for the purpose of premultiplication functions:
the Premultiply tool and the Unpremultiply tool. The Premultiply tool
premultiples an input image (see Premultiply Tool on page 413). The
Unpremultiply tool unpremultiplies an input image (see Unpremultiply Tool
on page 414).
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2D Compositing

Topics in this chapter:

■ About 2D Compositing on page 339
■ 2D Compositor on page 339
■ Alpha Tools on page 342
■ Channel Processing Tools on page 361
■ Composition Tools on page 365
■ Multi-stream Compositing on page 371
■ Stereo Viewing on page 374

About 2D Compositing
This chapter describes the 2D compositing tools available to you in Composite.
They are described in the order in which they appear in the Tools tab.

2D Compositor
The 2D Compositor tool lets you create multilayer compositions. It allows you
to stack four layers over a background. Each layer becomes the foundation for
the subsequent layer, starting with the background, and moving up the stack.
You must use a Matte image with an alpha channel between layers to expose
what lies beneath the top layer.
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NOTE If the top layer has an embedded alpha channel, it is shown as black. You
can connect the same composition to the Matte channel to achieve the desired
result.

The 2D compositor is a “super tool” because it contains a separate 2D
Compositor Layer tool inside the tool. A “super tool” is identified in the Tools
tab by a spherical icon—see Tools, Views & Pick List tabs on page 30.

To composite two or more layers:

1 Drag the 2D Compositor tool to the dependency graph in the Schematic
view and connect an image or tool output to the Layer 1 Back input tab.
This is the background for the first layer.

NOTE If you drop a 2D Compositor tool onto an existing connection between
two nodes, the existing composition becomes the Layer 1 background input.

2 Connect a composition to the Layer 1 Front input. This is the image you
want to have on top of the background.

3 Connect a composition to the Layer 1 Matte input. This image will
determine what portions of the background are visible if the image does
not have an embedded alpha channel.
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4 Add more layers as desired. If a composition has an embedded alpha
channel, the alpha channel will appear black. You can connect the same
image to the associated Matte input to achieve the desired result.

Adjusting the Matte's Luminance Curves
You can adjust the luminance curves of the front and back mattes of your
composite by selecting the layer from the 2D Compositor tool.

The 2D Compositor tool UI is divided into four areas:

(a) Layer Browser (b) Layer tools (c) Blending modes (d) Luminance curve controls
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To adjust the matte's luminance curves:

1 In the Layer Browser, select the composite layer to adjust. You can mute
or solo the layer.

2 Use the Layer Tools to navigate through the 2D Compositor's layers.

3 Select mathematical blending operations from a context menu.

4 Once a layer is selected from the Layer Browser, click a curve to select it.
Adjust the luminance curve by clicking a point to display its tangent
handle and drag the handle to adjust the curve. Using hotkeys, you can
add and delete control points, break or unify tangent handles—see
Animation Editor on page 662.

Alpha Tools
The Alpha tools let you control the look of your alpha:

DescriptionTool

For matte cleanup tasks during the keying process—see Alpha Levels
on page 343.

Alpha Levels

Blends two mattes together under the optional control of a third
matte—see Blend Alpha on page 344.

Blend Alpha

Softens the alpha channel of its primary input—see Blur Alpha on
page 348.

Blur Alpha

Brings the alpha channel of the primary input within a predeter-
mined range—see Clamp Alpha on page 349.

Clamp Alpha

Lets you remove gray details from white and/or black regions of the
alpha channel—see Cleanup Alpha on page 349.

Cleanup Alpha

Composites two mattes together—see Comp Alpha Tool on page
350.

Comp Alpha

Allows edges in the matte to be moved, stretched, and softened—see
Control Edge on page 352.

Control Edge

Replaces the source alpha channel with an edge map of the source
alpha—see Detect Edge on page 354.

Detect Edge
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DescriptionTool

A simple matte modifier that drops the alpha channel from its
primary input—see Drop Alpha on page 356.

Drop Alpha

Lets you refine the edges of a matte—see Edge Tool on page 356.Edge

Extracts the alpha channel from its primary input—see Extract Alpha
on page 357.

Extract Alpha

Lets you modify the transparency of an image—see Fade Tool on
page 357.

Fade

Inverts the alpha channel of its primary input—see Invert Alpha on
page 358.

Invert Alpha

Excellent for removing impulse noise—see Median Alpha on page
358.

Median Alpha

Remaps the alpha—see Remap Alpha on page 358.Remap Alpha

Create an alpha channel for an image based on a component from
a second image—see Set Alpha Tool on page 360

Set Alpha

Alpha Levels
The Alpha Levels tool is one of the tools used for matte cleanup tasks during
the keying process. When used as a tool defined by the keyer tool's dependency
graph, the Alpha Levels tool applies its effect to the alpha component of the
keyer's output. You can clean up the matte by manipulating the input/output
luma remapping curve, by adjusting the input and output luma fields or sliders,
or by adjusting the lift and gain. The Alpha Levels tool also allows you to
invert the matte. The Alpha Levels tool is located in the Alpha tools folder in
the Tools tab.

The histogram indicates the distribution of luma values in the input source
alpha channel with gray vertical bars along the X-axis. The curve illustrates
the resulting luma value. For example, if you drag the part of the curve that
represents the darker input grays upwards, the curve over that region becomes
lighter.

Since the Alpha Levels tool affects the alpha and is typically applied to the
output of a keyer tool, such as the Luma Keyer or the Diamond Keyer, your
dependency graph should include, as a minimum, one source and a keyer.
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The Alpha Levels tool UI has the following parameters.

(a) Lift/Gain fields (b) Minimum Output slider and field (c) Minimum Input slider and
field (d) Luma Remapping Curve (e) Maximum Input slider and field (f) Maximum
Output slider and field

■ Lift  Adjust the Lift to add an overall offset to the matte.

■ Gain  Adjust the Gain to adjust a scaling factor for the matte. Lift, Gain,
Input and Output are animatable attributes—see Marking Attributes for
Keyframing on page 674.

■ Minimum Output slider  Drag to remap input blacks to dark gray.

■ Minimum Input slider  Drag to the right to remap dark grays as black.

■ Luma remapping curve  View the changes you make in this curve.

■ Maximum Input slider  Drag to the left to remap light grays as white.

■ Maximum Output slider  Drag to the left to remap output whites to light
gray.

Blend Alpha
The Blend Alpha tool is used to blend two mattes together under the optional
control of a third matte. It has front, back, and matte inputs. It extracts a
matte from the front image and composites it over the alpha channel of the
back input using a choice of blend modes. The coverage of the front can be
controlled by the matte input. The back is the primary input; the output
inherits the format of the back input; this tool only affects alpha; if the back
is an RGBA image, the color part is simply copied to the output.

NOTE The alpha output of this tool is always clamped to the [0,1] interval.

The Blend Alpha tool has the following parameters:
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■ Front Channel  Selects which channel to use for the front. Channel
selections include Luma, Red, Green, Blue, and Alpha (default is Alpha).

■ Front Invert  Inverts the front before using it (default is off).

■ Front Intensity  Specifies the intensity of the front layer (default is 100%;
range is [0,10]).

■ Front Opacity  Controls the opacity of the front in the blending. If a
matte image is also used to control the blending, the two are multiplied
together. This parameter is never ignored (default is 100%; range is [0,1]).

■ Back Channel  Selects which channel to use for the back. Channel
selections include Luma, Red, Green, Blue, and Alpha (default is Alpha).

■ Back Invert  Inverts the back before using it (default is off).

■ Back Intensity  Specifies the intensity of the back layer (default is 100%;
range is [0,10]).

■ Matte Channel  Selects which channel to use for the matte. Channel
selections include Luma, Red, Green, Blue, and Alpha (default is Alpha).

■ Matte Invert  Inverts the matte before using it (default is off).

■ Matte Ignore  Determines whether or not the matte input is used to
modulate the blend. The default is false (meaning that the matte input
will be used in the blending equations). Note that if the Matte Input is not
chain connected, it will be automatically ignored (no feedback needs to
be provided in the UI).

■ Blend Mode  Determines which blend mode will be used (the default is
Normal).
Click the Blend button to view other available modes.

Blend Modes

The following tables (grouped by type) list the available blend modes and
describe the resulting blend effect.
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NOTE The Blend Alpha tool has four fewer modes than the Blend & Comp and
Glow tools, because the Blend Alpha tool affects only the alpha channel.

Basic blend modes

Blend ResultMode

This is the default setting and displays the front inputNormal

Adds the front and back, then divides by 2.Average

Adds the front and back.Add

Subtracts the front from the back.Subtract

Blend modes that darken

Blend ResultMode

Compares the pixels of the front and back inputs at a given location
and selects the darker of the two.

Darken

Multiplies the color values of the back input pixels and the front input
pixels, producing a darker color.

Multiply

Colorizes darker back input pixels with the front input color.Color Burn

Same as Color Burn but with less contrast.Linear Burn

Blend modes that lighten

Blend ResultMode

Compares the pixels of the front and back inputs at a given location
and selects the lighter of the two.

Lighten

Makes the light areas much lighter, darker areas somewhat lighter.Screen

Colorizes lighter pixels with the front input color.Color Dodge

Same as Color Dodge but with lower contrast.Linear
Dodge
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Modes based on lighting

Blend ResultMode

Like Multiply but with 2 X the brightness.Spotlight

Same as Spotlight but also adds ambient illumination to the back input.Spotlight
Blend

Darkens or lightens the pixels depending on the back color.Overlay

If the front color is lighter than mid-gray, the image is lightened. If the
front color is darker than mid-gray, the image is darkened.

Soft Light

If the front colors are lighter than mid-gray, screen mode is applied. If
the front colors are darker than mid-gray, multiply mode is applied.

Hardlight

Replaces the back colors depending on the brightness of the front color.
If the front color is lighter than mid-gray, back colors darker than the

Pin Light

front color are replaced. And vice versa; if the front color is darker than
mid-gray, back colors lighter than the front color are replaced.

Produces either white or black depending on similarities between front
and back.

Hard Mix

Difference Modes

Blend ResultMode

Looks at the front and back inputs, and subtracts the less bright from
the brighter one.

Difference

Similar to Difference but with less contrast.Exclusion

Blending Curves

Blend curves are used to adjust the blend of the front and back elements by
adjusting the amount of fractional opacity (pixel area) for the front, and one
minus front. The latter gives more importance to the back. Blend curves is
useful for controlling the blend along the edges of a matte by adjusting
fractional values, not 0 and 1 values. Because mattes have fractional values
along the edges, the blend curves affect the edge blending.
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To blend curves:

 ➤ Select and drag a control point on the curve.

To add a control point to the curve:

 ➤ With the cursor in the curve window, press + (plus sign) and click the
curve at the location in which you want to add a control point.

To delete a control point from the curve:

 ➤ With the cursor in the curve window, press - (minus sign) and click the
control point you want to delete from the curve.

To remove the Add or Delete control point mode:

 ➤ Press Esc.

To reset a single curve:

 ➤ Select the curve and click Reset.

To reset both curves at the same time:

 ➤ Hold down the Ctrl key and select both curves then select Reset.

NOTE Blend Curves can be animated.

Blur Alpha
The Blur Alpha tool lets you soften the alpha channel of its primary input.
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The Blur Alpha tool has the following parameters:

■ X Radius  Change this value to blur horizontal pixels.

■ Y Radius  Change this value to blur vertical pixels.

■ Link  Select to link X and Y values.

NOTE X and Y Radius are animatable attributes—see Marking Attributes for
Keyframing on page 674.

Clamp Alpha
The Clamp Alpha tool is used to bring the alpha channel of the primary input
within a predetermined range. You can use clamp alpha values outside of the
[0,1] range in order to prepare the alpha channel for use in compositing
operators. This is necessary because Composite does not force alpha values to
be in the [0,1] range.

The Clamp Alpha tool contains the following parameters:

■ Minimum Alpha  Set Largest negative float point. By default, Min is 0.

■ Maximum Alpha  Set Largest positive float point. By default Max is 1.0.

NOTE Min and Max Alpha are animatable attributes—see Marking Attributes for
Keyframing on page 674.

Cleanup Alpha
The Cleanup Alpha tool lets you remove gray details from white and/or black
regions of the alpha channel. You can choose to remove holes in black regions,
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white regions, or both. You can specify what range of values is black and what
range is white. In addition, you can control the maximum number of pixels
of edges to preserve and the softness controlling the blend between the
preserved edge region and the interior filled-in region. The specified edge
preservation width is considered to be a maximum limit; for instance, when
removing holes in white regions, all pixels that are connected to black regions
and within the specified distance from black regions will be considered part
of the edge and preserved. Essentially the black region fills into the edges until
it hits the white region or its maximum width limit, and then this is used as
a mask to preserve input values in the filled region.

The Cleanup Alpha tool has the following parameters:

To:Use:

Enable the black or white (or both) clean up controls.Enable

Control the number of pixels of edges to preserve.Edge Width

Control the blend between the preserved edge region and
the interior filled-in region.

Edge Softness

Specify black or white (or both) thresholds.White/Black Threshold

Gesturally manipulate the alpha remapping.Curve

Reset the remapping curve.Reset

Comp Alpha Tool
The Comp Alpha tool lets you composite two mattes together. It has front
and back inputs, and works by extracting a matte from the front image and
compositing it over the alpha channel of the back input using a choice of
compositing operators. The back is the primary input and the output inherits
the format of the back input.
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This tool only affects alpha. If the back is an RGBA image, the color part is
simply copied to the output.

NOTE The alpha output of this tool is always clamped to the [0,1] interval.

The Comp Alpha tool has the following parameters:

■ Front Channel  Selects which channel to use for the front (default is
alpha).

■ Front Invert  Inverts the front before o using it (default is off).

■ Front Intensity  Specifies the intensity of the front layer. Default is 100%
and range is [0,1].

■ Front Opacity  Controls the opacity of the front in the compositing. If
the opacity is less then one, the front will get more transparent and you
will start seeing the back through it. Default is 100%; range is [0,1].

■ Back Channel  Selects which channel to use for the back (default is alpha).

■ Back Invert  Inverts the back before using it (default is off).

■ Back Intensity  Specifies the intensity of the back layer. Default is 100%;
range is [0,1].

■ Comp Mode  Determines which compositing mode will be used (default
is Over)—see Compositing Operators on page 352.

■ Correlation  Specifies how the two input mattes are correlated. This can
be used to improve the quality of the composite in special cases. For
example, if you composite two mattes that share a good portion of their
outline, you should indicate if they are Adjacent or Superposed. By default,
the correlation mode is None, assuming that normally, the input mattes
are not correlated.
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Compositing Operators
The following table lists the compositing operators applicable between front
and back input images:

Result:Operator

Composites the front over the back. The output will cover any area covered
by either the front or the back. Where the front and back overlap, the
output will show the front.

Over

Completely replaces the back image with the front image.Replace

Similar to the Over operator, but the output will cover the same area
covered by the back.

Atop

Composites the front over the back, but the output will cover only the
area covered by both front and back.

Inside

The output will be equal to the front except that the part of the front
overlapping the back image will be missing. No part of the back will be
visible in the output in any case.

Outside

The output will be equal to the back except that the part of the back
covered by the front image will be missing. No part of the front will be

Cutout

visible in the output in any case. Basically this operator is equal to the
Outside operator with the front and back roles reversed.

Both front and back are copied to the output except for the part where
they overlap.

Xor

Control Edge
The Control Edge tool lets you move, stretch, and soften the edges of a matte.
You can widen an edge, offset it toward the interior or exterior, and blur its
inner and outer extremities separately.

352 | Chapter 16   2D Compositing



(a) Original matte (b) Modified with Control Edge (c) Alpha Remapped

NOTE This tool can be masked and animated.

The Control Edge tool has the following parameters:

To:Use:

Control the width and offset of the outer edges.Outer Dis-
tance

Control the width and offset of the inner edges.Inner Dis-
tance

Link the Outer and Inner Distance sliders so that the alpha edges are
thickened by an amount of twice the slider value, centered about their

Link Distance

original position in the input image. By default, the Link button is en-
abled.

Add blur to the outside extremities of edges.Outer soft-
ness

Add blur to the inside extremities of edges.Inner Soft-
ness
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To:Use:

Link the Outer and Inner Softness sliders. By default, the Link button is
enabled.

Link Softness

Remap the alpha as the last step in the internal pipeline.Remap Alpha
Curve

Reset the alpha remapping curve.Reset

Detect Edge
The Detect Edge tool lets you create an image composed of the edges in an
image. The resulting grayscale image can be used as a matte or to produce
special effects. You can apply the Detect Edge tool to a color or monochrome
image. This tool has many applications, the most useful include:

■ Delimiting a portion of the matte to perform color corrections on the front
image.

■ Creating special effects by using it directly on the front or back image.

The Detect Edge tool replaces the source alpha channel with an edge map of
the source alpha.

The Detect Edge tool has the following parameters:

To:Use:

Control the width and offset of the outer edges.Outer Dis-
tance

Control the width and offset of the inner edges.Inner Dis-
tance
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To:Use:

Add blur to the outside extremities of edges.Outer soft-
ness

Add blur to the inside extremities of edges.Inner Soft-
ness

Link the Outer and Inner Distance sliders so that the alpha edges are
thickened by an amount of twice the slider value, centered about their

Link Distance

original position in the input image. By default, the Link button is en-
abled.

Link the Outer and Inner Softness sliders. By default, the Link button is
enabled.

Link Softness

Create negatives of Edge Mattes, by simply inverting the output alpha.Invert

Remap the alpha as the last step in the internal pipeline.Remap Alpha
Curve

Reset the alpha remapping curve.Reset

(a) Front input Image (b) Alpha (c) Detect Edge applied

(a) Outer edge distance increased (b) Inner and outer softness added (c) Alpha
remapped towards 1.0
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Drop Alpha
The Drop Alpha tool is a simple matte modifier that drops the alpha channel
from its primary input. This tool has no control parameters but always outputs
an RGB image.

NOTE This implies that if the input is an alpha-only image, the output will be a
black RGB image.

Edge Tool
The Edge tool is one of the tools used for matte cleanup tasks during the keying
process. It lets you shrink, erode, or blur the edge of the matte, as well as
isolate the edge of the matte, or invert the matte.

Because the Edge tool affects the alpha and is applied to the output of a keyer
tool, such as the Luma Keyer or the Diamond Keyer, your dependency graph
should include, as a minimum, a source and a keyer.

The Edge tool contains the following parameters:

To:Use:

Isolates the edge of the key. The numeric field takes values representing
the width of the detected edge based on a 0% to 100% float. Edge
width can depend on image size.

Edge Detect

Invert the matte.Invert

Reduce the edge width. The numeric field takes values representing the
pixel width of the shrink filter (from 0.000 to 30.000 float).

Shrink

Blend (soften) the light and dark edges. The numeric field takes values
representing the pixel width of the erode filter (from 0.000 to 30.000
float).

Erode
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To:Use:

Reduce the edge width. The numeric fields take values representing the
pixel width of the blur filter along the X-axis and the Y-axis (from 0.000
to 30.000 float).

Blur

■ Link: Blurs the width and height proportionally. Default is on.

■ Gaussian: Default is on, but can be changed to a box blur filter.

Extract Alpha
The Extract Alpha tool lets you extract the alpha channel from its primary
input and has no control parameters. This tool always outputs an alpha-only
image, implying that if the input is an RGB-only image, the output will be a
constant 1.0 alpha image.

NOTE The Extract tool will extract a selected channel into an alpha-only image.
The Extract Alpha tool is just a more convenient and readable tool to use when
the selected channel is always the input alpha channel.

Fade Tool
The Fade tool provides a convenient way to modify the transparency of an
image. The usual case will be to fade an image without having to do it at the
same time as compositing. This tool fades an image by reducing the value of
its alpha channel, making it transparent.

The Opacity parameter controls the fading effect; at 100% (the default value)
the image is unchanged; smaller values fade more; at 0% the image is
completely transparent.

This tool in an image modifier; it restricts processing to the masked region
and propagates it to the output. The Fade tool can be muted, as well as
animated and masked; it affects the alpha channel only.
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NOTE If the input image has no alpha channel, one will be added. This is consistent
with Composite's general behavior with respect to missing channels. A missing
alpha channel is interpreted as a virtual solid opaque alpha channel.

Invert Alpha
The Invert Alpha tool inverts the alpha channel of its primary input and has
no control parameters. The Invert tool is already capable of inverting the alpha
channel of its primary input. However, Invert Alpha can achieve this without
the need to select the proper affect target and makes the Schematic easier to
understand.

Median Alpha
The Median Alpha tool is almost identical to the Median Tool (see Median
Tool on page 406) and is excellent for removing impulse noise, but is designed
to operate on the alpha channel of the input image.

It has all the parameters of the Median tool except for the Criteria parameter,
which is not needed because this tool always computes the median value by
ranking the alpha value of each pixel.

NOTE This tool affects only the alpha channel.

Remap Alpha
The Remap Alpha tool lets you remap the alpha using a single curve
manipulation interface similar to Blend Curves. The curve defaults to the
identity mapping.
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Original matte

Alpha remapped

Alpha inverted

An invert button provides inversion of the alpha after the curve mapping.
This tool affects alpha only; the RGB channels, if present, are passed through
unchanged. The pixel format of the output is the same as the pixel format of
the image input. If the image has no alpha, then the output will have an alpha
channel, properly modified by the curve remapping.

For more detailed curve manipulation, control points can be added to, or
deleted from the curve.

To add a control point to the curve:

 ➤ With the cursor in the curve window, press + (plus sign) to enter a mode
where each click on the curve creates a control vertex at that location.

To delete a control point from the curve:

 ➤ With the cursor in the curve window, press - to enter a mode where each
click on a control vertex deletes the control vertex at that location.

Remap Alpha | 359



To exit the Add or Delete control point mode:

 ➤ Press Esc.

NOTE This tool can be masked.

The Remap Alpha tool has the following parameters:

To:Use:

Invert the alpha after the curve mapping.Invert

Gesturally manipulate the alpha remapping.Curve

Reset the remapping curve.Reset

Set Alpha Tool
The Set Alpha tool lets you create (or replace, or add to) an alpha channel for
an image (image A) input based on a component from a second image (image
B). The selected component from image B may also be blended with the alpha
component from image A.

To set a new, or replace an existing, alpha channel in an image:

1 To view the results of this operation, set the Channels selection to RGBA
in the Composition tab of the Tool UI, or in Player Display Options, select
Tool Output in the Display field and Channels: RGB in the View field.

2 Drag the Set Alpha tool from the Tools tab onto the dependency graph
in the Schematic view.

3 Connect the images to the node (image A and image B).
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4 Select the component from image B that you want to add to the alpha
component from image A.

5 Blend the components until you are satisfied with the result.

NOTE The Set Alpha tool's Blend attribute is animatable—see Animation Concepts
on page 660.

Channel Processing Tools
You can modify the individual color channels of an image using channel
processing tools. These tools are in the Channel folder.

There are five channel processing tools:

Description:Tool:

Remove the red, blue, green, or alpha channel from an image—see
Channel Extract Tool on page 362.

Channel Extract

Analyze the channels of an image based on a specified
thresholds—see Out of Range Tool on page 362.

Out of Range

Remap the channels in one image by those in another image—see
Channel Replace Tool on page 363.

Channel Replace

Copy component values of an image to component values of an
output image—see Channel Rewire Tool on page 364.

Channel Rewire
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Channel Extract Tool
The Channel Extract tool lets you to remove a channel from an image. You
can remove the red, green, blue, or alpha channel.

To extract a channel from an image:

1 Drag the Extract tool from the Channel folder on the Tools tab onto the
dependency graph in the Schematic view.

2 Click the channel list button and select the channel you want to extract
from the image.

NOTE The Channel Extract tool has a masking input—see Pixel Masking on page
560.

Out of Range Tool
The Out of Range tool uses pseudo colors to display pixels above or below
user specified threshold. It is also capable of outputting a mask of the
out-of-range pixels or its inverse, so that corrective action can be taken by
other tools downstream. The Out of Range tool is in the Channel folder in
the Tools tab.

The Out of Range tool has the following parameters:

362 | Chapter 16   2D Compositing



■ Channel  Select the source image channel to analyze.

■ Minimum  Set the minimum value threshold of the source image channel.

■ Maximum  Set the maximum value threshold of the source image
channel.

■ In Range RGB  Select the source image channel to display as the “In
Range” color or deselect to use arbitrary color.

■ In Range Alpha  Select the source image alpha channel to display as the
“In Range” alpha or deselect to use arbitrary alpha value.

■ Below Range  Select color to display pixels below the specified threshold.

■ In Range  Select color to display pixels within the specified threshold.

■ Above Range  Select color to display pixels above the specified threshold.

Examples

The following examples show you how the Out of Range tool can be used.

■ Viewing out of range alpha in a player  Set the display modifier as a
range display tool. An alpha below range will show up as opaque blue, an
alpha above range will show up as opaque red, and all others will have
their original alpha value.

■ Generating a matte from out of range alpha  Using the range display
tool, take the matte from the output image. Out of range pixels will have
alpha of 1.0, all others will have alpha of 0.0.

Channel Replace Tool
The Channel Replace tool lets you remap the red, green, blue, or alpha channel
values in one image by those of another image.
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To remap the channel values of one image to a different image:

1 Drag the Replace tool from the Channel folder in the Tools tab to the
dependency graph in the Schematic view and connect the images to the
tool node (one image for input A and one image for input B).

2 In the Tool UI, click the channel you want to replace and select values;
A or B for Red, Green and Blue or A, B, or None for the Alpha channel.

NOTE The Channel Replace tool has a masking input and its attributes are also
animatable—see Pixel Masking on page 560 and Animation Concepts on page 660.

Channel Rewire Tool
The Channel Rewire tool lets you create an output image that is generated by
copying component values of the input image to (possibly different)
component values of the output image. For each component of the output
image, a selection list is used to choose the component of the input image.

To rewire an image:

1 Drag the Rewire tool from the Channel folder in the Tools tab to the
dependency graph in the Schematic view.
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2 Select the input component(s) from the selection list.

NOTE When Alpha is selected, a sixth choice, None, is available.

NOTE The Channel Rewire tool has a masking input and its attributes are also
animatable—see Pixel Masking on page 560 and Animation Concepts on page 660.

Composition Tools
Use the Composition tools to combine front, back, and matte images using a
combination of blending modes and compositing methods.

There are five composition tools:

Description:Tool:

Blend two images using a simple blend factor—see Blend on page 366.Blend

Composite front and back RGBA images with blend modes and compos-
iting operators—see Blend & Comp on page 367.

Blend &
Comp

Combine two images using a matte to define visibility—see Blend Matte
on page 368.

Blend Matte
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Description:Tool:

Apply compositing operators to two source images—see Comp Ops on
page 369.

Comp Ops

Apply mathematical compositing operators to the RGBA values of two
source images—see Math Ops on page 370.

Math Ops

Blend
The Blend tool lets you blend two images by applying a blend factor. The
image connected to the A input is displayed when the Blend Factor is set to
0; the image connected to the B input is displayed when the Blend Factor is
set to 100. The Blend factor, like all parameters, can be animated, making it
easy to use this tool to create a blending transition between compositions.

To blend two images:

1 Drag the Blend tool from the Composition folder in the Tools tab to the
dependency graph in the Schematic view.

2 Connect the A and B images to the tool.

3 Set the Blend factor. If you set a value of 0, you see 100 percent of the
image connected to the A input. If you set a value of 100, you see one
hundred percent of the image connected to the B channel. In the
following example, the blend factor is set to 46 percent.

NOTE The Blend tool has a masking input and its attributes are also
animatable—see Pixel Masking on page 560 and Animation Concepts on page 660.
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Blend & Comp
The Blend & Comp tool is used to composite front and back RGBA images.
While most compositing tools composite a front layer over an opaque
background under the direction of a matte image, this tool offers full support
for RGBA images, both for the front and back inputs, and computes an RGBA
result.

You can specify a compositing operator to control the shape of your output
and a blend mode to determine how the front and back are combined in the
areas where they overlap.

The Blend & Comp tool is in the Composition folder in the Tools tab, and
has the following parameters:

To:Use:

Multiply the front by a color factor prior to using it in the blend. The
default is 100%; the range is [0,10].

Front Gain

Control the opacity of the front in the compositing. If the opacity is less
than one, the front will be more transparent and you will start seeing
the back through it. The default is 100%; the range is [0,1].

Front Opa-
city

Multiply the back by a color factor prior to using it in the blend. The
default is 100%; the range is [0,10].

Back Gain

Control the opacity of the back in the compositing. If the opacity is less
than one, the front will be more transparent and you will start seeing
the back through it. The default is 100%; the range is [0,1].

Back Opacity

Determine which compositing mode will be used (the default is
Over)—see Compositing Operators on page 352.

Comp

Determine which blend mode will be used (the default is Normal). Click
the Blend button to view other available modes—see Blend Modes on
page 345.

Blend
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To:Use:

Specify how the two input mattes are correlated. This can be used to
improve the quality of the composite in special cases. For example, if

Correlation

you composite two mattes that share a good portion of their outline,
you should let the system know if they are Adjacent or Superposed. By
default, the correlation mode is None, assuming that, normally, the input
mattes are not correlated.

The blend mode is applied to every pixel in the image and the alpha
channels are completely ignored. The output alpha is simply a copy of
the alpha of the back input. By default, this option is false.

Ignore Alpha

Resets the Gain settings to default values.Reset

NOTE The Blend and Comp tool also has a Blend Curves tab—see Blending Curves
on page 347.

Blend Matte
The Blend Matte tool lets you mix two images using a matte image to define
the areas of visibility between the front and back images.

To blend two images using a matte:

1 Drag a Blend Matte tool from the Composition folder in the Tools tab to
the dependency graph in the Schematic view.

2 Connect the front, back and matte images to the tool.

3 Select the Blend Matte Channel: Alpha, Red, Green, Blue, or Luma, as
appropriate for the image you are using as the matte. The default choice
is Alpha.

Select Invert if you want to invert the result.

4 Select the tool output: Composite, Front, or Front and Matte.
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NOTE The Blend Matte tool has a masking input and its attributes are also
animatable—see Pixel Masking on page 560 and Animation Concepts on page 660.

Comp Ops
The Comp Ops tool lets you apply a variety of compositing operators to two
source images.

To apply Comp Ops operations:

1 Drag a Comp Ops tool from the Composition folder in the Tools tab to
the dependency graph in the Schematic view.

2 Connect a source image to input A and another source image into input
B of the Comp Ops node.

3 Click the Operator button and select a compositing operator.

To:Select:

Place input A on top of input B according to the alpha of the foreground
image.

A over B

Place input B on top of input A according to the alpha of the foreground
image.

B over A

Place the RGBA of input A into the alpha of input B.A in B

Place the RGBA of input B into the alpha of input A.B in A

Place the RGBA of input A into the invert alpha of input B.A out B

Place the RGBA of input B into the invert alpha of input A.B out A
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To:Select:

Place the RGBA of input A over the RGBA of input B but through the alpha
of input B.

A atop B

Place the RGBA of input B over the RGBA of input A but through the alpha
of input A.

B atop A

Create the union of the RGBA of inputs A and B minus the intersection of
the RGBA of inputs A and B.

A xor B

NOTE The Comp Ops tool has a masking input and its attributes are also
animatable—see Pixel Masking on page 560 and Animation Concepts on page 660.

Math Ops
The Math Ops tool lets you apply mathematical blending operations to the
RGBA values of two source images.

Use the following procedure to apply mathematical blending operations.

To apply mathematical blending operations to an image:

1 Drag the Math Ops tool from the Tools tab to the dependency graph in
the Schematic view.

2 Connect a source image to input A and another source image into input
B of the Math Ops node.
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3 Click the Operator button and select a math operator.

To:Select:

Add to the RGBA of input A, a percentage (using the Blend value) of the
RGBA of input B.

Add

Divide the RGBA values of input A by the RGBA values of input B.Div

Create a composite image where the final output will be the maximum
RGBA values of either input A or input B.

Max

Create a composite image where the final output will be the minimum
RGBA values of either input A or input B.

Min

Mix the RGBA values of input A with the RGBA values of input B: 0% =
completely A, 100% = completely B.

Mix

Multiply the RGBA values of input A by the RGBA values of input B.Mult

Mimic the effect of combining two film negatives together. Both layers are
inverted, then multiplied, and finally the results are inverted back.

Screen

Subtract from the RGBA of input A a percentage (using the Blend value) of
the RGBA of input B.

Sub

4 Blend the images. The blend factor controls the blend between the result
of the math operation and the original input.

NOTE The Math Ops tool has a masking input and its attributes are also
animatable—see Pixel Masking on page 560 and Animation Concepts on page 660.

Multi-stream Compositing
Use the Streams tools to perform identical processing on multiple image
streams avoiding the creation of identical sub-graphs to process a number of
images in the same way. The Streams tools can also be used to support a stereo
workflow in Composite —see Stereo Viewing on page 374. There are three
Streams tools:

To:Use:

merge multiple single-stream image inputs into a single multi-
stream output. It has a single multi-valued image input socket,

Merge Streams

Multi-stream Compositing | 371



To:Use:

and a single output socket. You can connect as many inputs as
you like to the Merge Streams tool.

extract single-stream image outputs from the Merge Stream node
using the Selector value editor.

Extract Streams

input left eye and right eye image streams to create a 2-stream
stereo image. The Stereo Streams tool takes two single-stream

Stereo Streams

inputs and combines them into a single dual-stream output, pla-
cing the left image in stream 0, and the right image in stream 1.

In the application, the default stream is stream 0. For example, if a color picker
is used in the player, it will pick stream 0. If you pick a color in the Keyer, it
will pick the color from stream 0. If you click Fit to Source in a warp tool, it
will fit to stream 0.

NOTE Paint strokes will only be applied to stream 0.

Performing Multi-stream Processing
You can perform identical processing on multiple image streams. The following
example workflow applies a blur to five imported layers.

To apply a blur to multiple layers:

1 Import multiple layers into Composite. Composite creates a composition
per layer.

2 Perform a multiple selection of the imported layers, drop them into a
new composition and swipe through the Link option. Composite creates
a link node per layer in the new composition.
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3 Drag a Merge Streams tool from the Streams tool folder and drop it into
the composition.

4 Connect all layers to the inputs of the Merge Streams node.

5 Drop a Blur tool into the composition and connect the Merge Streams
output socket to its input then change the blur parameters.

The blur is applied identically to all five streams.

Performing Multi-stream Processing | 373



NOTE To view the individual streams, use the Player 0, (next stream) and
Shift + 0 (previous stream) to cycle to the next and previous streams produced
by the Player target. You can also view a stream by swiping through the
Player south gate, opening the Streams tab and selecting the stream you
want to view from the Stream value editor.

Stereo Viewing
Viewing stereo image pairs in Composite is supported through an anaglyph
display mode in the player, and by quad-buffered, 3D DLP, and left/right
segmented frame plug-in video preview devices.

If you do not have stereo footage available, you can use the Reaction tool to
create new footage by rendering a scene using a stereo camera rig—see Setting
up a Stereo Camera Rig on page 293.

An anaglyph is a stereoscopic motion or still picture in which the right
component of a composite image usually red in color is superposed on the
left component in a contrasting color to produce a three-dimensional effect
when viewed through correspondingly colored filters in the form of glasses.
Anaglyph mode is applied after the display modifier. For example, if the display
modifier performs gamma encoding, or tone mapping, the result is encoded
for stereo display using an anaglyph after the gamma encoding or tone
mapping.

To view a stereo image pair in stereo anaglyph mode in a player view:

1 Swipe south in a Player view and select the Streams tab.

2 Select Anaglyph from the Stereo Mode menu.

3 From the Tools tab, select Stereo Streams from the Streams folder and
drag it to the Schematic view.

4 Connect the stereo image pair left image to the left input of the Stereo
Streams node and the right image to the right input of the Stereo Streams
node.
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The stereo image pair is displayed in anaglyph mode in the player. You
can view the image with inexpensive tinted glasses.

Composite 2011 supports special-purpose stereo viewing hardware, such as
quad-buffered stereo monitors, or 3D DLP (TM) monitors. These stereo viewing
devices are supported through Composite video preview devices. You must
select a video preview device that matches your stereo viewing hardware from
the Video Preview device list in the User Preferences window. The default
video preview device is None.

To:Select:

keep the default setting. Use None when you do not want a video
preview device to be active.

None

view a video preview device that is just a window that shows one
stream. You can put the window on another monitor if you have

Mono

one. You can then view the contents of a player in a window on
a second monitor. If you only have a single monitor, use Alt +
Tab to view it.
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To:Select:

view stereo pairs using DLP -3D monitors that support active
shutter glasses—see Active Shutter Glasses on page 378.

DLP-3D Preview

view stereo pairs using circular polarization monitors with passive
polarizing glasses—see Polarizing Glasses on page 377.

Segmented Frame
Preview

view stereo pairs with polarizing glasses using monitors based on
linear polarization —see Polarizing Glasses on page 377.

Quad-buffer

NOTE Quad-buffer will only appear in the Device list if you have a second graphics
card to output the left and right streams.

To view stereo pairs in video preview devices other than the Player:

1 Select the Video Preview device from the Device list from the User
Preferences tab. If your video preview device is None, a Stereo video
preview device will show nothing.If you switch to a stereo video preview
device and you don't have a stereo pair, the stereo video preview device
will show the same image in the left and right eyes.

2 Change the stereo mode to Segmented Frame Preview

3 Click in a Player view to make it current. The stereo pair is displayed.

4 Select a node in the dependency graph and change its parameters.
Changes are made in the 3D scene both in the Player and in the video
previewing device.
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Supported Stereo Output Graphics Hardware
The following section describes some of the multiple display configurations
possible on a Composite workstation.

Composite supports systems with standard graphics cards with DVI outputs.

■ Single graphics card, single DVI output  This configuration implies that
stereo will be shown in the Composite UI. Therefore, stereo display is
restricted to anaglyph in the Player view.

■ Single graphics card, dual DVI output  A typical configuration would be
one DVI output to drive the Composite UI, and another to drive a
single-input stereo display as a Composite stereo video preview device.

■ Dual DVI output plus single DVI output graphics cards  The single DVI
output card drives the Composite UI, and the dual output card drives a
dual DVI input stereo display as a stereo video preview device.

■ Dual dual DVI output graphics cards  As per the Dual DVI output plus
single DVI output graphics cards descriptions above.

Supported Technologies
The following section describes both the viewing glasses and type of
stereoscopic display monitors used with the glasses that are supported by
Composite.

NOTE If your stereo video preview device only support 8 bits per color component,
consider using a player view display modifier that can provide 8 bit output.
Examples include the 1D LUT, 3D LUT, and Convert Depth tools.

Polarizing Glasses

Passive polarizing glasses are worn by the viewer. The display device shows
left and right images simultaneously. Devices that use this technology include
projectors and monitors. Examples of these devices are:

■ Circular polarization  Segmented Frame Preview mode monitors that use
circular polarization. Its disadvantage is half vertical resolution in 3D
(1920x600).

■ Linear polarization  Quad-buffered stereo mode displays use two monitors
and linear polarization to create a full-resolution stereo image. In such
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systems, the observer head orientation is important to avoid ghosting
artifacts.

Active Shutter Glasses

The viewer wears LCD glasses that open the left or the right eye in
synchronization with left and right images shown by the display device. The
synchronization signal is broadcast by an emitter to the LCD glasses. Devices
that use this technology include projectors and monitors. Examples of these
devices are:

■ DLP monitors  DLP monitors that support active shutter glasses. The left
and right images are shown at double update rate (120 Hz), using a
checkerboard pattern. Their disadvantage is half horizontal resolution.

Passive Colored Glasses

■ Anaglyph  Left and right images are tinted red and cyan, and viewed
using inexpensive tinted glasses. An important disadvantage is poor color
reproduction.
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Image Processing Tools

Topics in this chapter:

■ About Image Processing Tools on page 379
■ Filtering Tools on page 379
■ Formatting Tools on page 409
■ Image Generation Tools on page 419
■ Transform Tools on page 431

About Image Processing Tools
This chapter describes the image processing tools available to you in Composite.
They are described in the order in which they appear in the Tools tab.

Filtering Tools
You can use Filtering tools to apply a range of looks, feels, and transitions to
your composites.

Description:Tool:

Removes dust, dirt, hair and scratch artifacts from sequences of im-
ages—see Remove Dust Tool on page 380.

Remove Dust

17

379



Description:Tool:

Applies a blur to an image—see About Blurs on page 385.Blur

Accurately simulates the defocus effect of a real camera on an HDR im-
age—see Lens Blur Tool on page 400

Lens Blur

Removes impulse noise with an edge-preserving smoothing filter—see
Median Tool on page 406.

Median

Increases clarity of an image—see Sharpen Tool on page 408.Sharpen

Provides more sharpening control of fine detail in an image—see Unsharp
Mask on page 408.

Unsharp
Mask

Remove Dust Tool
Use the Remove Dust tool to remove dust, dirt, hair, and scratch artifacts from
sequences of images. Dust removal, encompassing what is sometimes called
dust-busting, dust repair, scratch removal and scratch repair, is traditionally
a time-consuming task, requiring visual inspection and manual correction
steps for each frame of film or video. This tool provides you with a means to
automate this task as much as possible, and to easily tweak the results
manually. The tool automatically detects dust and scratches, and automatically
repairs them. You can view the results of the detection phase and easily correct
anything using a simple mouse stroke.

The Remove Dust tool detects dust in images and removes the dust from the
images. The tool has a primary color image input and outputs two images,
the repaired color image and a mono-channel defect matte. An optional second
input can be used to specify the defect matte as a mono-channel image, and
any dust detected by the tool is added to the dust supplied by the defect matte.
If the defect matte input is not present, the tool initializes the defect matte
to empty. Optional third and fourth inputs supply forward and/or backward
motion vectors to the tool which it can use for the detection and/or the
correction phase.
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Dust Removal Workflow

The dust removal workflow can be divided into three steps:

■ Dust Detection  This automatically creates the defect matte by examining
the images, using motion vectors if available. This step is optional, as the
defect matte may be supplied to the tool as the second input. Even if no
defect matte is supplied, you may choose to bypass detection and perform
all labeling by hand. A single tolerance parameter controls the dust
detection, where a value of 0 means no dust is detected, and a value of
100 means all pixels are dust. You can tweak the value slightly from its
default of 50 to get a reasonable set of dust pixels. Two other parameters
control the expansion of the dust to make sure the whole dust object is
covered, not just the center.

■ Manual correction of the defect matte  If any pixels have been incorrectly
labeled as dust or not dust in step 1, manual correction of the defect matte
can be performed by drawing appropriate shapes on the dust matte. These
locally change the detection and repair parameters within the geometric
region of the shape. Each object drawn has its own dust detection
parameters, which overrides the global (automatic) values used in step 1.
In addition, each object has other parameters to control how correction
is performed. Of course, drawing shapes is optional.

■ Defect repair  Using the final defect matte, an image processing operation
is performed to fill in the corresponding pixels in the output image with
corrected pixels. This process uses motion vectors if they are available.
Your can choose between a spatial repair, which uses only the current
frame, or a temporal repair, the default, which uses neighboring frames
and motion vectors. Spatial repair should only be used in areas of the image
where the motion vectors are inaccurate or there are occlusions making it
difficult for the algorithm to find the corresponding correct pixel on
neighboring frames.
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Global Detection and Repair

The Global Detection UI has the following parameter controls:

To:Use:

calculate forward and backward motion vectors.Calculate Motion

control the quality of the motion vectors by applying the motion
analysis only to lower-resolution versions of the input image, up
to the resolution specified by the quality parameter.

Quality

determine how many pixels are classified as dust. If the Tolerance
is set to 0, then no dust is detected, effectively disabling the dust

Tolerance

detection. If a dust channel from a film scanner is applied, the
Tolerance can be set to 0 to avoid dust detection. Otherwise, the
dust channel will be the union of the scanner matte and the de-
tected matte. If the Tolerance is set to 100, then all pixels are
dust. A value of 100 might be used with a shape to label all pixels
within a small region as dust.

control into which regions the dust is expanded. A value less than
or equal to Tolerance means do not expand.

Size Tolerance

control how expanded the detected dust is expanded. A value of
0 means do not expand.

Size

control the smoothing effect on the first step of dust detection
where every pixel is assigned a likelihood of being dust.

Detection Radius

remove false dust in areas of motion, as its value is raised.Motion Threshold

The Global Correction UI has the following parameter controls:
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To:Use:

select either the Temporal or Spatial repair method. The default
method is temporal repair. This means to replace a dust pixel with

Repair Method

the average of the corresponding pixels in the previous 2 and
next 2 frames. If motion vectors are supplied on the 3rd or 4th
input, they will be used to define the correspondence; otherwise,
the corresponding pixel on another frame is just the pixel at the
same position as the dust pixel. Spatial repair is used in areas
where the motion vectors are incorrect or the previous and next
frames do not contain the corresponding pixel needed (due to
occlusion or intensity changes). In this case, the dust is filled using
texture infilling and copies reasonable pixels from other places
within the same frame. Note that there are no parameters for the
Temporal repair method. When the Temporal repair method is
selected, the Radius, Distance and Smoothing parameters will be
grayed out.

set how large a texture patch to use for matching areas around
the dust.

Spatial Radius

set how far to search from the dust to find a pixel to put in place
of the dust.

Spatial Distance

set how smooth to make the infilling of the dust.Spatial Smoothing

Per-Shape Detection and Repair

Occasionally there will be parts of the image where some of the Global
(automatic) parameters need to be changed locally to improve the dust
detection and repair. For this, you can use a shape drawing facility based on
the Garbage Mask tool. The UI is very similar to the Garbage Mask but does
not have the mask list user settings or edge gradients, however all Garbage
Mask hot keys affecting control points are the same—see Masking on page
537. The objects that are drawn are non-animated and appear only on one
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frame of the composition. You can select and edit the objects only by direct
manipulation on the image wireframe overlays.

When in creation mode (either Rectangle, Ellipse, or Spline is selected) you
can set the Detection and Correction values that will apply only within the
shape to be drawn. When in selection mode (either Select or Transform), the
UI looks the same as in creation mode, except that the values are for the
currently selected shape. The two garbage can buttons provide deletion of
selected shapes, and all shapes on the current time frame, respectively.

Each drawn shape has several values associated with it, the first 3 of which
override the corresponding global (automatic) parameter in the area of the
shape:

To:Use:

override the global detection tolerance.Tolerance

override the global size tolerance.Size Tolerance

override the global dust expansion amount.Size

override the global repair method. The default is Temporal. You
would only switch to Spatial Repair in areas where the motion is

Repair Method

so complicated that the motion vectors are incorrect. Note that
there are no parameters for the Temporal repair method. When
Temporal repair method is selected, the Radius, Distance and
Smoothing parameters will be grayed out.

set how large a texture patch to use for matching areas around
the dust.

Spatial Radius

set how far to search from the dust to find a pixel to put in place
of the dust.

Spatial Distance

set how smooth to make the infilling of the dust.Spatial Smoothing
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(a) Tolerance and Size Tolerance raised to label more dust in this area. (b) Tolerance
and Size Tolerance of 100, to label the entire interior as dust. (c) Tolerance and Size
Tolerance of 0, to label the entire interior as not dust.

Defect Matte Viewing

The defect matte is output on the second output, thus allowing the use of
context points—see Setting Context Points on page 191 to view the input defect
matte and the defect matte after dust detection has been applied. You can get
the second output node from the Utilities folder in the Tools tab.

About Blurs
Use the Blur tool to finish shots that require directional, radial, modulated,
and vectors blurs. This includes shots that require some amount of depth of
field or motion blurs. In modulated blurs, you can vary the amount of blur
from pixel to pixel. The ability to vary the amount of blur applied at each
pixel is sometimes useful to model specific physical processes or be used for
purely artistic goals.

Blur Tool UI

The Blur tool UI is composed of five tabs:
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ControlsTab

Settings for the directional Gaussian blur and the
Radial blur—see Directional Gaussian and Radial
Blur on page 386.

Blur

Settings for the Modulated blur—see Modulation
Blur on page 391.

Modulation

Settings for the Vectors blur—see Vectors Blur on
page 395.

Vectors

Settings affecting the image output by the tool—see
Output Controls on page 399.

Output

Directional Gaussian and Radial Blur

The Directional Gaussian blur filter lets you scale and rotate its elliptical shape.
This allows you to blur an image by a certain amount in a given direction,
and by a different amount in a direction perpendicular to it. Each pixel is
blurred by the same amount.
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To:Use:

Set the amount of blur to apply in direction of the X axis (before
taking into account the rotation parameter).

X Radius

Set the amount of blur to apply in direction of the Y axis (before
taking into account the rotation parameter).

Y Radius

Couple the X Radius and Y Radius so that when you change the
X Radius or the Y Radius the other changes in the same proportion.

Link

Rotate the X and Y axis of the Gaussian by a given angle. The
angle is specified in degrees.

Rotation

Mute the Directional Gaussian Blur contribution of the Blur tool.
The other blurs are still applied (if not also muted).

Mute

The Radial Blur simulates the effect of motion blur that would be generated
by the movement of the camera due to zooming and spinning around a given
point. The zooming and spinning movements are simply converted into
motion vectors representing the local displacement at each pixel. These motion
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vectors are then used to construct blur ellipses aligned with each vector. The
size of the major axis matches the length of the displacement vector. The size
of the minor axis is kept fixed at a small value. That value is chosen to keep
aliasing artifacts at an acceptable level while not introducing too much
blurriness.
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To:Use:

Set the amount of blur to apply in the radial direction (before
taking into account the rotation parameter). The amount of blur

Zoom

is specified in degrees; the further a pixel is located from the
center of the radial blur, the more it is blurred. Expressing the
Zoom parameter in degrees allows it to share the same units as
the Spin parameter. This lets you express a given amount of blur
in either the radial or the tangential direction.

Set the amount of blur to apply in the tangential direction (before
taking into account the rotation parameter.) The amount of blur

Spin

is specified in degrees; the further a pixel is located from the
center of the radial blur, the more it is blurred.

Controls how the strength of the blur relates to distance from the
center of the effect. Increasing the amount of focus keeps the

Focus

center of the effect in focus at the expense of the outer rim. With
a Focus value of zero, the strength of the blur increases linearly
with distance from the center.
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To:Use:

Rotate the radial and tangential direction by a given angle. The
angle is specified in degrees. This causes the blur effect to spiral.

Rotation

Specify the center of the radial blur. You can also click and drag
the red manipulator in the player to set the location of the center
of the blur.

X,Y Position

Mute the radial blur contribution of the Blur tool. The other blurs
are still applied (if not muted then themselves).

Mute

Modulation Blur

A particular color channel (red, green, blue, alpha or luminance) of the
modulation input image can be used to modulate a modulated motion blur.
The end effect is that the modulation image will apply a varying amount of
scaling at each pixel. The elliptical shape of the blur filter is scaled uniformly
by this modulation amount.

The Modulation blur tool has the following parameters:

To:Use:

Set the amount of blur to apply in direction of the X axis (before
taking into account the rotation parameter).

X Radius

Set the amount of blur to apply in direction of the Y axis (before
taking into account the rotation parameter).

Y Radius

When enabled, changing the X Radius or the Y Radius causes the
other one to change in the same proportion.

Link

Rotate the X and Y axis of the Gaussian by a given angle. The
angle is specified in degrees.

Rotation

To specify which channel of the “Modulation Image” is used to
control the modulated blur. The valid channels are: Red, Green,

Channel
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To:Use:

Blue, Alpha, Luma and None. When None is selected, the image
is blurred as if the Modulation Channel had a constant value of
1. Note that this behavior is different than muting the entire
modulated blur. This is an aid for trying to figure out what the
various parts of the tool contribute.

To offset the selected modulation channel before it affects the
modulated blur. The offset is subtracted from the channel. The

Offset

output image will be in focus where the modulation channel is
equal to the modulation offset; it will be progressively blurrier for
values of the modulation channel above and below the modulation
image. When the modulation tab is displayed and the Player is in
Display Tool output mode, selecting the offset picker tool then
clicking anywhere in the player will set the Offset parameter to
the value of the selected modulation channel under the pointer.
This is useful for selecting the in-focus object in a scene.

View from top showing relative positions of objects in the scene.
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Image with no modulated blur.

Z Depth modulation image - closer objects appear as lighter shades of gray; farther
objects appear darker.

Luma channel offset value of sphere is 0.011 and matches that of the modulation image
retaining focus.
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Luma channel offset value of column is 0.704 and matches that of the modulation
image retaining focus.

Although the Modulation Blur tool can simulate depth of field, artifacts may
appear for a number of reasons and are inherent 2.5D motion blur and depth
of field.

Depth of field is a process that occurs in 3D. Out-of-focus objects blur on top
of objects that stand further away. They never blur on top of objects in front
of them. The modulated blur does not make this distinction about objects
that are in front or behind thus causing artifacts every time a silhouette edge
appears in an image. Rendering depth of field therefore requires segmentation
of the image along the silhouette edges. Please note that it is not always
possible to partition a scene into separate objects using silhouette edges.

Anti-aliased images also cause some problems in that the Z-channel cannot
be used to determine which portion of the pixel belongs to the background
object and which part belongs to the foreground. When an object becomes
out of focus, one starts to see parts of the scene that were not visible before
through the blurred edge. To replicate that effect as a 2D post-process, the
depth of field tool must guess what the background pixels might look like
behind foreground objects. To do this, segmenting and matting out foreground
objects and then reconstructing the background using in-filling techniques
become necessary, which can be a difficult task.

To correct some of the Z-channel problems, the 3D elements of a scene can
be rendered as separate layers. The scene would be manually segmented into
objects all having approximately the same Z. A single layer would not have
any significant Z discontinuities. Each layer can be properly anti-aliased. The
Z-information of the foreground element and the background element would
be available at partially covered edge pixels and the color of the background
objects behind foreground elements would also be available. However, the
Z-information is not defined at the transparent pixels of each layer. A renderer
is likely to assign them some very far-away value. To the modulated blur tool,
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this represents a huge discontinuity in its blur modulation and the
Z-discontinuity ends up as a discontinuity in the blurred image. To help
remove the resulting artifacts, the parameters (Min. Alpha and Max Radius)
under the Extend label can be set to generate the missing Z information.

To:Use:

Select at which alpha value to start generating the
missing modulation values. Anything opaque is un-
affected up to the Min. Alpha value.

Min Alpha

Increase the radius (in pixels) of the modulation
value generation. Increase this value until the arti-

Max Radius

facts are removed. Note that increasing the Max
Radius value beyond the point where the artifacts
are removed will result in slower processing.

Vectors Blur

Use the Vector Blur tool to specify the length and the width of the blur ellipses.
The blur ellipses are then oriented independently for each pixel in the direction
of the vectors of the Forward Vector input image and uniformly scaled by the
length of the vectors. You can also apply an extra constant rotation to all the
blur ellipses.

Using this definition of vector blurs you can blur only in the direction of the
vector field. To do this, set the amount of blur in the perpendicular vector
direction to zero. No matter how much it is scaled, it will always stay null.
Then, use the minimum blur radius control to clamp to a finite value to avoid
sampling aliasing.

NOTE If the ROD of the Forward Vectors image is smaller than the ROD of the
image produced by the Blur tool, the pixels lying at the edge of the Forward
Vectors image are repeated to cover the missing region.

The Vectors blur tool has the following parameters:
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To:Use:

Set the amount of blur to apply in direction of the forward
vectors (before taking into account the rotation parameter).

Length

The amount of blur applied per pixel is also modulated by the
length of the vectors.

Set the amount of blur to apply in a direction perpendicular
to the forward vectors (before taking into account the rotation

Width

parameter.) The amount of blur applied per pixel is also
modulated by the length of the vectors. It would often be left
at 0, so that the vector length would not affect it.

When enabled, changing the Length or Width parameter
causes the other one to change in the same proportion.

Link

Set the amount of vector rotation around their own origin.Rotation

Enable the reference vector offset. If reference is set, the vector
at the Reference Position is subtracted from all forwards vectors

Reference

in the image. The result is that the pixel at the reference pos-
ition will not be blurred, and so will pixels with similar forward
vectors.

Set the amount of blur to apply at the reference position. A
value of zero means that no blur should be applied. This is

Weight

the default. A value of one means to blur by the same amount
as the forward vectors at the Reference Position. This is equi-
valent to disabling the use of a reference vector offset. A value
of one half means to blur half as much as the forward vectors
at the Reference Position.

Set the nominal coordinates of the reference position. When
the reference is enabled, a manipulator is displayed in the

Reference Position X
and Y

player to allow the user to interactively set the reference pos-
ition by simply dragging the manipulator (click-drag-release).
The reference position can also be set using the Tracker.
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To:Use:

Mute the Vector Blur contribution of the Blur tool. The other
blurs are still applied (if they are not themselves muted).

Mute

Using the Modulation blur tool to simulate motion blur can be difficult due
to some of the same inherent issues as when trying to simulate depth of field
using the Modulation blur tool;

■ Need to segment out at silhouette edges.

■ Can not deal with anti-aliased images at silhouette edges.

■ Needs the background pixels behind foreground elements.

■ Discontinuity in the motion vector field ends-up as discontinuity in the
blurred image.

■ Need to out-fill motion vectors over transparent region.

These limitations can be worked around, if the 3D department has already
partitioned the image into layers of constant movement. You can then use
the Min. Alpha and Max Radius parameters of the Vectors blur tool to extend
the motion vectors field to get more realistic motion blur effects.

To:Use:

Select at which alpha value to start generating the missing vector in-
formation.

Min Alpha

Increase the radius (in pixels) of the vector field generation. Increase
this value until the artifacts are removed. Note that increasing the Max

Max Radius

Radius value beyond the point where the artifacts are removed will
result in slower processing.

Toggle the vector view.View Vectors

Set the interval between shown vectors. By default, this value is 16 (i.e.
show a vector every 16 pixels). This controls the density of the displayed
vectors.

Interval

Set the display Scale of the shown vectors. By default, this value is 1.0
(i.e. show a vector with its original length). This controls the displayed

Display Scale

length of the vectors. These values only control the player display. They
have no influence on processing.
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To:Use:

Set the color of displayed vectors. Click on the color pot to display the
color picker—see Color Picker on page 154.

Color

NOTE The Blur tool has a masking input—see Pixel Masking on page 560. The Blur
tool's X and Y attributes are both animatable by setting keyframes or using
expressions—see Setting Keys Manually on page 676 and Validating and Applying
the Expression String on page 729.

Vector Motion Blur with Extended Alpha

The extended functionality of the Blur node requires an alpha channel on its
motion vector input. Since Maya does not allow you to generate motion
vectors with an alpha channel, you should copy it from your diffuse/beauty
pass in Composite using a SetAlpha node. This should give you the desired
result.

You can see the effect of extending the motion vectors outside of the moving
object by turning on the view vectors option in the Vectors tab of the Blur
tool.

The Blur node interprets the alpha channel of the Input Image input differently
than the alpha of the motion vectors. This allows you to selectively motion
blur objects of an opaque RGB image. Ensure that OpenEXR files are used
when rendering motion vectors in Maya.

The first of the following two images displays the Blur node without the Alpha
Extend, the second is with the Alpha extend.

NOTE To extend the vectors beyond the edge, you must increase the Max Radius.

398 | Chapter 17   Image Processing Tools



Output Controls

The Output UI allows you to control the following parameters:
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To:Use:

Specify a minimum of blur to apply in any direction. This is useful to
minimize aliasing artifacts that might occur when performing blurs that
exhibits a high degree of directionality.

Min Radius

Specify how the input image should be extended outside its region of
definition (ROD). This is important for two reasons. First, the convolution

Tiling X and
Y

kernel of the Blur tool might need to access source pixels outside the
ROD to produce pixel falling inside the source ROD. Secondly, the Blur
tool allows the output image to be uncropped arbitrarily. The supported
tiling modes are Edge (default), Transparent, Repeat, and Mirror.

Crop (and uncrop) the image produced by the Blur tool. The cropping
controls work exactly like the ones found in the Crop tool with the ex-

Crop

ception of the addition of an Auto Crop mode. When in Auto Crop
mode, the Left, Right, Bottom and Top controls are greyed out. Instead
the output ROD is computed automatically based on the following as-
sumptions; only the parameters of the Gaussian Blur are used to determ-
ine the output ROD. This includes the Gaussian X radius, Y radius and
Rotation; the Input ROD is enlarged by an amount proportional to the
rotated” X and Y radius. It is enlarged sufficiently so that the profile of
the Gaussian filter drops sufficiently close to zero at the boundary of
the enlarged kernel. This behavior is especially useful when the X and
Y Tilling modes are set to Transparent. The supported crop modes are
Relative (default), Window, Absolute, and Auto Crop.

Lens Blur Tool
The Lens Blur tool allows you to simulate rack defocus and add photographic
effects to 3D rendered scenes or live footage. You can also create lens flares,
streak lines, and halos around bright lights and reflections.
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Lens Blur UI

The Lens Blur UI is composed of four tabs: Lens Blur, Modulation, Output,
and Masking.

The Lens Blur tab consists of a set of parameters for setting the main blur
effect, as well as controls to create bloom, flares, and halos.

To create the main blur effect, use the controls on the left side of the UI.

To:Use:

Set the amount of blur to apply in the direction of the X axis.X Radius

Set the amount of blur to apply in the direction of the Y axis.Y Radius

When enabled, changing the X Radius or the Y Radius causes the
other one to change in the same proportion.

Link

Set the aberration. Setting the aberration parameter to greater
than 0 will make the radius different for each of the three color
planes, introducing color fringes.

Aberration

Set the radial aberration. Setting the radial aberration greater than
0 will scale the image about the center differently for each color

Radial Aberration

plane, producing color fringes that are offset radially, simulating
transverse aberration.

Select either regular polygon shapes or ellipses.Aperture Shape

Set the number of sides of the polygon blur shape.Number Sides

Set the rotation of the shape (in degrees).Rotation

Extend the blur outward from the edge of the polygon with an
exponential falloff curve. Softness is specified as a distance (the
same as the radius).

Softness

Turn on and off the higher quality rendering of the polygon/ellipse
blur.

Antialias
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The following images show the types of effects you can generate using the
main blur controls.

Input image (some single pixels not visible)

Pentagon blur with softness set at 2 pixels

Pentagon blur with softness set to 20 pixels
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Pentagon blur with aberration

Radial chromatic aberration

The Bloom controls let you remap the higher luminance range to increase the
bloom appearance of the blur. This is especially useful for 8-bit images which
cannot represent values greater than 1. With bloom, you can remap the values
to make it seem like an HDR image, giving you more realistic blooms around
bright light sources and reflections.

Lens Blur Tool | 403



Original image

The Flares parameters let you add lines and streaks emanating from bright
lights and reflections. You can set the intensity of the flares, as well as the
number of flares. An intensity of 0 (the default) will disable flare generation.
The rotation of the lines can be animated to simulate flares that seem to rotate
as the camera moves relative to the light sources. The Randomness parameter
controls how evenly distributed the lines are. A value of 0 makes the flare
lines uniformly distributed around a circle, while a value of 1 makes them
completely randomly distributed. You can also set a seed value to choose a
particular sequence of lines. The effect of adding flares will be somewhat like
the linear patterns in the right image below.

Original image

The halo is a ring of brightness of a specified radius from the center of bright
lights, and with a specified width. If the radii differ among the color channels,
the effect is a rainbow halo like in the following right image. This is controlled
by the Aberration parameter. There is also an intensity parameter to adjust
the strength of the halo; the default value of 0 disables the halo creation.

The Grating is a set of lines of random intensity, uniformly distributed around
the circle. Increasing the Grating Density parameter increases the number of
lines, and the smoother it appears.
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Original image

Modulation Tab

The Modulation tab looks just like that of the Blur, including the extrapolation
(extending) capability—see Modulation Blur on page 391. You can choose what
channel of the modulation image is used and apply an offset to the modulation
image. The modulation can affect the X and Y radius, or the rotation of the
polygonal or ellipse shape.

Output Tab

The Output tab is the same as that of the Blur tool, but without the Min Radius
parameter—see Output Controls on page 399.
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Masking Tab

The Lens Blur tool has a masking input and a Masking tab—see Pixel Masking
on page 560.

Median Tool
The Median tool is an edge-preserving smoothing filter that works particularly
well for removing impulse noise.

For grayscale images, the median filter works by ranking the pixels under the
kernel according to their value and selecting the median to replace the pixel
at the center of the kernel. This approach effectively removes spikes in the
original image without the blurring typically introduced by common
smoothing kernels (e.g. Gaussian).

For color images, there is no single concept of ranking, so several different
criteria are supported. Component-wise ranking computes the median of each
color component independently, however, this can result in pixel colors that
did not belong in the original image. Luminance ranking computes the median
of the luminance of each pixel under the kernel. This approach is fast and
does not introduce new colors in the original image, however, luminance is
not the best criteria for similarity in a color image. RGB Vector does not really
rank the pixels under the kernel, but rather it chooses as the median the one
pixel with the smallest sum of square distances (in RGB space) to all the other
ones under the kernel. It selects the pixel that is closest to the center of the
point cloud obtained by looking at the pixels under the kernel as points in
3D space. This approach is computationally intensive, but can yield better
results than either of the other ranking criteria.

The median filter uses a square neighborhood and can round the corners of
axes-aligned rectangular objects in an image.

As any noise reduction filter, the median filter may also affect the sharpness
of small details in the input image. When this problem arises, the result of
the median filter can be blended with the original image to decrease its effect.
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Finally, the median filter can be applied recursively. Repeated applications
using a small kernel size yield better results than a single application using a
large kernel.

NOTE When using the filter recursively, the blending described above is applied
at each iteration.

The Median tool has the following parameters:

To:Use:

Control the choice of filter used:Filter

■ Median (default)

■ Hybrid Median

Control the size of the filter:Size

■ 3x3 (default)

■ 5x5

■ 7x7

■ 9x9

■ 11x11

Control how the median value is chosen:Criteria

■ Component-wise

■ Luminance

■ RGB Vector (default)

Control how the result of one median iteration is combined with the
original input. This parameter can vary between 0 and 100% (default).

Blend

Control the number of times that the filter is applied recursively. This
parameter can vary between 1(default) and 9.

Iterations
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Sharpen Tool
The Sharpen tool lets you increase the clarity and focus of an image. The
Sharpen tool applies a sharpening filter to a number of adjacent pixels in the
input image and increases their contrast.

To apply sharpening modifications to an image using the Sharpen tool:

1 Drag the Sharpen tool from the Tool tab to the dependency graph in the
Schematic view.

2 Adjust the sharpen amount by dragging the value slider, or by typing in
a value.

NOTE The Blur tool has a masking input—see Pixel Masking on page 560. The
Sharpen tool's Amount value is animatable by setting keyframes or using
expressions—see Setting Keys Manually on page 676 and Validating and Applying
the Expression String on page 729.

Unsharp Mask
The Unsharp Mask tool lets you sharpen the edges and other fine details in
the input image.

Unsharp masking provides more control on the sharpening process and will
generally produce better results than the Laplacian filter, but at a higher
computational cost.

Unsharp masking works by removing the low frequency spatial information
from the image and emphasizing the high frequency details. The algorithm
basically uses a Gaussian filter to produce a smooth version of the original
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image, called unsharp mask. The unsharp mask is then subtracted from the
original image, removing low frequencies.

The Unsharp Mask tool has the following parameters:

■ Unsharp Mask Radius X, Radius Y, and Link  Control the radius of the
blur (just like in the Blur tool). By default, the X and Y radii are linked and
set to 1.20; otherwise, their range is the same as that of the Blur tool.

■ Strength  Controls the strength of the effect of masking that is added.
Basically, the output image is computed as I+s*(I-M) where I is the original
image, M is the unsharp mask, and s is the strength parameter (in 0 to 500
percent; default 100%).

■ Threshold  Defines how large the difference between the original image
and unsharp mask must be before the original pixels are changed. A pixel
is changed if the difference in any of its components is larger than or equal
to the threshold (in 0 to 100%; default is 0%).

NOTE This tool can either affect the RGB components or the Alpha component,
but not both at the same time.

Formatting Tools
In some cases you will be working with images of different sizes and color
depths. Use Formatting tools to change these parameters.

There are five image formatting tools:

Description:Tool:

Changes an image's color depth—see Convert Depth Tool on page 410.Convert
Depth

Removes rows or columns of pixels next to the edges of the input im-
age—see Crop Tool on page 410.

Crop
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Description:Tool:

Floating
Windows

Premultiplies an input image—see Premultiply Tool on page 413.Premultiply

Unpremultiplies an input image—see Unpremultiply Tool on page 414.Unpremul-
tiply

Changes the resolution of an image—see Resize Tool on page 415.Resize

Convert Depth Tool
The Convert Depth tool lets you change the color depth of an input image.

To change the color depth of an image:

1 Drag the Convert Depth tool from the Tools tab to the dependency graph
in the Schematic view.

2 Select the target color depth from the color depth list.

Crop Tool
The Crop tool lets you change the size of an image. When you perform a crop,
adjacent rows or columns of pixels next to the edges of the input image are
removed. You can crop an image relative to its input size or perform an
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absolute crop if you want to retain certain portions of the image. To assist in
cropping, you can keep a fixed image size regardless of input dimensions.

Cropped imageOriginal image

You can also animate the Crop tool's parameters by setting keyframes or using
expressions—see Setting Keys Manually on page 676 and Validating and
Applying the Expression String on page 729.

To crop an image:

1 Drag the Crop tool from the Tools tab to the dependency graph in the
Schematic view.
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2 Select a crop type: Relative, Window, or Absolute.

To:Use:

Crop an image relative to the size of the input image. The default
value for all parameters (left, bottom, right, top) is zero. All para-

Relative Crop

meters have a range of zero to the respective size (width and
height) of the image being cropped. Cropping more pixels than
an image has results in an invalid image size of zero.

Crop an image using absolute values. You can set values for
Center X, Center Y, Width, and Height.

Window Crop

Crop an image using absolute values. You can set values for Left,
Right, Bottom, and Top.

Absolute Crop

Specify how the input image should be extended outside its region
of definition (ROD).The supported tiling modes are Transparent
(default), Edge, Repeat, and Mirror.

Tiling

3 Crop the image by doing any of the following:

■ Enter values in the Crop fields.

■ Manipulate the crop box in the Player by dragging it.

■ Adjust the red crop lines or crop handles in the Player.

■ Resize the image symmetrically by using the Ctrl key and dragging
until you get the desired image size.

4 Reset the values, if needed, to that of the input image by clicking the Fit
Source button.

Tools that can change the resolution of an image (Garbage Mask, Lens Distort
and 2D Transform) have extra controls to manage the crop.
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The Auto Crop feature computes a fit-all region where the entire distorted
image fits into the output without losing any part of the image. When you
set the crop mode to Auto Crop, the output region at each frame will
automatically be computed. The region is automatically resized and all crop
fields except the mode are disabled.

Floating Windows
The Floating Windows tool allows you to...

Premultiply Tool
The Premultiply tool allows you to take an input image and create an image
where each pixel’s color component is multiplied by the pixel's alpha
component. The multiplication result is clamped to the color range of the
output image.

To premultiply an image using the Premultiply tool:

 ➤ Drag the Premultiply tool from the Formatting folder into the dependency
graph in the Schematic view.

The image is premultiplied.
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NOTE When using the Premultiply tool, make sure the output image is never
processed by a tool that produces incorrect results while operating on an
image with premultiplied data. Tracking of whether images are stored in
premultiplied format or not, does not occur.

Unpremultiply Tool
The Unpremultiply tool lets you recover an alpha-unpremultiplied foreground
image from an alpha-premultiplied image whose foreground may have been
composited on a solid color other than black.

The Unpremultiplied tool takes an alpha-premultiplied image as its input and
outputs a corresponding alpha-unpremultiplied image. It assumes the input
image consists of a foreground composited over a solid color background; if
the background is a color other than black, you can explicitly specify this
background color so that the tool can correctly separate the foreground layer
from this background and output the foreground layer alone. Optionally, your
can ask the tool to guess the background color.

The Unpremultiplied tool has a single parameter:

To:Use:

Specify the background color so that the tool can
correctly separate the foreground layer from the
background and output the foreground layer alone.

Background

Have the tool analyze the input image and guess
the background color and set the color widget to
that color.

Guess

To unpremultiply an image:

 ➤ Drag the Unpremultiply tool from the Tools tab to the dependency graph
in the Schematic view.
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The image is unpremultiplied.

NOTE When using the Unpremultiply tool, make sure the output image is
never processed by a tool that produces incorrect results while operating on
an image with unpremultiplied data. Tracking of whether images are stored
in premultiplied format or not, does not occur. All tools except this one
assumes unpremultiplied data.

Resize Tool
The Resize tool lets you change the resolution of an image and its frame bit
depth when working with images of different resolutions.

Resize Tool UI

The Resize tool UI is divided into three areas:

■ Destination settings area.

■ Reference area (to modify crop box properties).

■ Resize area.

Destination Settings Area

Use this area to select format, resolution, image and pixel aspect ratios, as well
as bit depth of the destination image.
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To:Select:

Select from a list of many standard resolutions, as well as a
Custom option that you can use to specify non-standard resolu-
tions.

Format

Display the frame width and height of the selected resolution
preset. If you select Custom from the resolution presets box, use

Width and Height

these fields to enter the frame width and height values you want
to use.

Change the image aspect ratio.Image Aspect Ratio

Change the pixel aspect ratio.Pixel Aspect Ratio

Select the output depth.Depth

Reference Area

Use the Reference area to set crop box properties.

To:Select:

Change the color of the crop box. By default, the crop box is red. If
there is a lot of red in the image you are resizing, you may want to

Color

change the color of the crop box to see it better. Clicking the color
pot will take you to the color picker where you can set desired color
for the crop box.

Change the X and Y position of the crop box.X and Y
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To:Select:

Change the width and height of the crop box. You can either type
the dimensions into the respective Width and Height attribute value

Width and
Height

fields, or you can grab the edges of the crop box with the cursor and
resize.

Fit the crop box to the source image.Fit To Source

Resize Area

Use the Resize area settings to define the destination format into which the
source sample is fit.

The Resize area has the following parameters:

Pictures often appear fuzzy when scaled to a different size. The fuzziness of
an image is controlled by two processes: resampling and filtering.

The filtering processes attempt to smooth the transformed pixels. When an
image is being resampled to a different resolution, the old pixel map needs
to be interpolated to a new one. This requires some form of image interpolation
and a number of interpolation methods can be used.

To:Use:

Select a filter type. You can choose from; Box, Triangle, Bell, B-spline,
Lanczos3, or Mitchell. These filters range in quality from the Box filter

Filtering

being of the lowest (unsuitable for further processing, but with the least
amount of processing time), to the Mitchell filter producing the best
possible results.

Select a fit method. You can choose: Fill, Crop, Letterbox, or Crop Edges.
If you select Letterbox or Crop Edges, you can also select or deselect
the Keep Aspect parameter.

Fit Methods

Select to center the destination resolution.Center
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Animate Resize Settings

Animate the position of the crop box to pan and scan a 16:9 composition to
a 4:3 format. Pan and scan is a technique widely used for resizing 16:9
compositions to a 4:3 resolution when the area of interest in the shots is to
one side of the 16:9 frame. You can follow the area of interest in the shot by
animating the crop box along the X-axis.

To pan and scan a 16:9 composition to a 4:3 composition:

1 Drag the Resize tool from the Tools tab to the dependency graph in the
Schematic view, and connect it to the composition.

2 From the Destination settings area, select the 4:3 resolution to which you
want to resize the source.

3 Select a filter from Filtering.

4 Select the Crop Edges fit method.

5 Select Center and Keep Aspect buttons.

6 Select the Fit To Source button (in the Reference area) to make the crop
box the same size as the source frame.

7 Go to the first frame.

8 Make sure Autokey is selected so you can create position keyframes for
the crop box automatically.

9 Scrub through the clip to identify areas where the area of interest includes
the left and right edges of the clip outside the crop box.

10 Animate the position of the crop box accordingly by dragging the crop
box. You may also type the values into the respective X, Y, Width, and
Height attribute value fields—see Setting Keyframes Automatically on
page 680.

11 Play the resized composition.

Resizing a Composition using the Letterbox Fit Method

In this procedure, resize a 16:9 composition to a 4:3 destination resolution
using the Letterbox fit method.
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To resize a 16:9 composition from source to a 4:3 destination resolution using
the Letterbox fit method:

1 Drag the Resize tool from the Tools tab to the dependency graph in the
Schematic view, and connect it to the composition.

2 From the Destination settings area, select the 4:3 resolution to which you
want to resize the source. You can also set custom width and height in
the W and H fields.

3 Select the Letterbox fit method. By definition, when using the Letterbox
fit method, black bars appear above and below the destination
composition. However, the fill color in Composite is already black and
these bars get cropped from the destination resolution.

4 Select a filter from Filtering.

5 The composition is resized.

Image Generation Tools
There are seven image generation tools that let you create images with a wide
range of properties:

Description:Tool:

Creates a multi-color, four-quadrant image based on RGBA values— see
Bilinear Ramp Tool on page 421.

Bilinear
Ramp

Creates a multi-color checkerboard image based on RGBA values— see
Checkerboard Tool on page 423.

Checker-
board

Creates a single color image based on RGBA values— see Color Source
Tool on page 424.

Color Source

Creates a multi-color, two-quadrant image based on RGBA values— see
Linear Ramp Tool on page 425.

Linear Ramp

Simulates or matches film grain—see Noise Tool on page 427.Noise

Creates a multi-color, radially-ramped image based on RGBA values—
see Radial Ramp Tool on page 426.

Radial Ramp

Lets you add production information over an image or clip — see Slate
Tool on page 429.

Slate

Image Generation Tools | 419



NOTE All image generation tools are output tools and therefore, have only an
output node connector and no input connector. All image generating tools can
be used to generate masks with those tools that have masking inputs—see Pixel
Masking on page 560.

Setting Image Generation Properties and Formats
Each of the image generating tools has a common UI area where properties
can be applied.

The following table lists the common property controls and their function.

DescriptionProperty

Provides a selection of film formats.Format

Sets the width and height of the image produced by the generator
node.

Image
Width/Height

Sets the image aspect ratio of the image produced by the generator
mode.

Image As-
pect Ratio

Sets the pixel aspect ratio of the image produced by the generator
mode.

Pixel Aspect
Ratio

Sets the rate of the stream produced by the generator node.Rate

Sets the number of channels of the images produced by the generator
node. Possible channel combinations are:

Channels

■ A

■ RGB

■ RGBA

Sets the depth per channel (in bits) of the images produced by the
generator node. Possible image depths are:

Depth

■ 8-bit
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DescriptionProperty

■ 16-bit

■ 32-bit

Determines how the generator node outputs its result outside its source
time range. Possible modes are:

Repeat

■ No Repeat: There is no repetition at all, the generator outputs black
frames outside its time range.

■ Hold: First and last frames are repeated.

■ Loop: Repeats the entire sequence.

■ Ping-Pong: Repeats the sequence from beginning to end, to begin-
ning, and so on.

Defines the total number of frames the node generates for the image.Mark
in/Mark out

Defines the time range (and any offset required) where the generator
node is to output a result. It follows global time.

Start
Time/End
Time/Offset

Locks the Start/End time values.Lock Dura-
tion

NOTE Height and Width are animatable attributes—see Setting Keys Manually
on page 676 and Validating and Applying the Expression String on page 729.

Bilinear Ramp Tool
The Bilinear Ramp tool lets you create images with a variety of properties and
in several formats. The Bilinear Ramp tool is comprised of five sets of color
channel value fields that let you to generate a multi-color image based on
RGBA values. One set of values is for generating the fill color, and four sets
are for generating start and end ramped colors residing in a four-quadrant
region of definition (ROD). The fill color is defined as those pixels residing
outside the ROD. Two other controls let you to position the X and Y axes of
the ramps at any location in the image.

NOTE The following procedure assumes that you have a Schematic view and a
Player view open.
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To create a bilinear ramped image:

1 Drag the Bilinear Ramp tool from the Tools tab to the dependency graph
in the Schematic view and attach it to the Output node.

2 Apply image properties—see Setting Image Generation Properties and
Formats on page 420.

3 Adjust the color values in the Fill, Lower Left, Lower Right, Upper Left,
and Upper Right.

4 Modify the location and direction of the X and Y ramps.

NOTE You can also manipulate the linear ramp by clicking and dragging the
horizontal and vertical bars.

NOTE You can also type values directly into the value fields and press Enter.
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NOTE The Bilinear Ramp tool's Fill, Lower Right, Lower Left, Upper Right, Upper
Left, and Center X and Center Y parameters are animatable by setting keyframes
or using expressions—see Setting Keys Manually on page 676 and Validating and
Applying the Expression String on page 729.

Checkerboard Tool
The Checkerboard tool lets you create images with a variety of properties and
in several formats. The Checkerboard tool is comprised of three sets of color
channel value fields and X and Y Period fields. One set of values is for
generating the fill color, and two sets are for generating X and Y colors residing
in the region of definition (ROD). The fill color is defined as those pixels
residing outside the ROD. Two other controls let you adjust the size and look
of the checkerboard in the X and Y directions.

To create an image using the Checkerboard tool:

1 Drag the Checkerboard tool from the Tools tab to the dependency graph
in the Schematic view and attach it to the Output node.

The Checkerboard tool UI appears.

2 Apply image properties—see Setting Image Generation Properties and
Formats on page 420.

3 Adjust the Fill, Color values, and Period values by dragging inside the
value fields.

NOTE You may also type values directly into the value fields and press Enter.
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Color Source Tool
The Color Source tool lets you create images with a variety of properties and
in several formats. The Color Source tool is comprised of two sets of color
channel value fields that allow you to generate a single color image based on
RGBA values. One set of values is for generating the fill color and the other
set is for generating the color residing in the region of definition (ROD). The
fill color is defined as those pixels residing outside the ROD.

NOTE The following procedure assumes that you have a Schematic and a Player
view open.

To create an image using the Color Source tool:

1 Drag the Color Source tool from the Tools tab to the dependency graph
in the Schematic view and attach it to the Output node.

The Color Source tool UI appears.

2 Apply image properties—see Setting Image Generation Properties and
Formats on page 420.

3 Adjust the Fill and Color values by dragging inside the value fields.

NOTE You may also type values directly into the value fields and press Enter.

NOTE The Color Source tool's Fill and Color parameters are animatable by setting
keyframes or using expressions—see Setting Keys Manually on page 676 and
Validating and Applying the Expression String on page 729.
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Linear Ramp Tool
The Linear Ramp tool lets you create images with a variety of properties and
in several formats. The Linear Ramp tool is comprised of three sets of color
channel value fields that allow you to generate a multi-color image based on
RGBA values. One set of values is for generating the fill color, and two sets
are for generating start and end ramped colors residing in the region of
definition (ROD). The fill color is defined as those pixels residing outside the
ROD. Two other controls allow you to position the center of the ramp at any
vertical or horizontal point in the image.

NOTE The following procedure assumes that you have a Schematic and a Player
view open.

To create a linear ramped image:

1 Drag the Linear Ramp tool from the Tools tab to the dependency graph
in the Schematic and attach it to the Output node.

The Linear Ramp UI appears.

2 Apply image properties—see Setting Image Generation Properties and
Formats on page 420.

3 Adjust the Fill, Start, and End color values by dragging inside the value
fields.

4 Modify the location and direction of the linear ramp.

NOTE You can also manipulate the linear ramp by clicking and dragging the
vertical bar.
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NOTE You can also type values directly into the value fields and press Enter.

NOTE The Linear Ramp tool's Fill, Start, End, and Ramp Center parameters are
animatable by setting keyframes or using expressions—see Setting Keys Manually
on page 676 and Validating and Applying the Expression String on page 729.

Radial Ramp Tool
The Radial Ramp tool lets you create images with a variety of properties and
in several formats. The Radial Ramp tool has three sets of color channel value
fields that allow you to generate a multi-color image based on RGBA values.
One set of values is for generating the fill color, and two sets are for generating
start and end radially ramped colors arranged around a central axis region of
definition (ROD). The fill color is defined as those pixels residing outside the
ROD. Other controls let you to position the X and Y axes of the central ramp
at any location, stretch the ramp vertically or horizontally, and define the
falloff center point and range.

NOTE The following procedure assumes that you have a Schematic and a Player
view open.

To create a radially ramped image using the Radial Ramp tool:

1 Drag the Radial Ramp tool from the Tools tab to the dependency graph
in the Schematic view and attach it to the Output node.
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2 Apply image properties—see Setting Image Generation Properties and
Formats on page 420.

3 Adjust the color values in the Fill, Start, and End fields.

4 Modify the location and direction of the X and Y ramps.

5 Adjust the middle and falloff ranges.

NOTE You can also manipulate the radial ramps by left-clicking and moving
them.

NOTE You can also type values into the value fields and press Enter.

NOTE The Radial Ramp tool's Fill, Start, End, and all associated Radial Ramp
parameters are animatable by setting keyframes or using expressions—see Setting
Keys Manually on page 676 and Validating and Applying the Expression String on
page 729.

Noise Tool
The Noise generating tool lets you add realism to computer-generated images,
or to simulate or match film grain. The generator creates an image of random
pixels. The Noise generating tool is comprised of three sets of color channel
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value fields that allows you to generate a multi-color image based on RGBA
values. One set of values is for generating the fill color, and two sets are for
generating start and end color values. You can also adjust the level and seed
(the method used to generate the noise).

NOTE The following procedure assumes that you have a Schematic and a Player
view open.

To create an image using the Noise tool:

1 Drag the Noise tool from the Tools tab to the dependency graph in the
Schematic view and attach it to the Output node.

2 Apply image properties—see Setting Image Generation Properties and
Formats on page 420.

3 Adjust the color values in the Fill, Start, and End fields.

4 Adjust the noise seed.

NOTE You can also type values into the value fields and press Enter.

NOTE The Noise tool's Fill, Start, End, and associated Seed parameters are
animatable by setting keyframes or using expressions—see Setting Keys Manually
on page 676 and Validating and Applying the Expression String on page 729.
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Slate Tool
The Slate tool lets you add production information over an image or clip,
which is useful during the review/approval stage of a project. Although Slate
is not a full text tool, you can adjust the size, color, opacity, position, and
duration of the text, as well as add a drop shadow. You can also animate the
attributes of the text.

When adding information to a composition, you can use variables for the
composition's name, date, time, frame number, timecode, and length. You
can also enter your own information about the composition, such as the
project title, camera, lens, film stock, and so on.

NOTE The following procedure assumes that you have a Schematic and a Player
view open.

To add production information to a composition:

1 Drag the Slate tool from Image Generation folder in the Tools tab to the
dependency graph in the Schematic and attach it to the Output node.

2 Apply image properties—see Setting Image Generation Properties and
Formats on page 420.
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3 To add a variable to your composition, select a variable from the list, and
click Add. You can add multiple variables.

The composition's name appears in the Player.

4 To enter information about your composition, select the type of
information you want to add and click Add UDA. You can add as much
or as little information as needed.

The field appears in the text box, but not in the Player.

5 Place the cursor inside the text field and edit the information.

6 Format the text and modify its location.

TIP To scroll the list of fonts, use your mouse wheel or the scroll bar beside
the list.
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7 Add a drop shadow to the text by clicking Drop Shadow and setting its
position, color, and opacity.

8 Add a background behind the text by clicking Box and setting the color,
opacity, and margin.

Transform Tools
Use the Transform tools to move, reorient, and animate images.

There are four image transformation tools:

Description:Tool:

Apply chains of 2D transformations on images—see 2D Transform Tool
on page 432.

2D Trans-
form

Flips pixels left-to-right, top-to-bottom, or both—see Flip Tool on page
435.

Flip

Rotates an image—see Orient Tool on page 436.Orient

Repositions an image in the X and Y directions—see Panner Tool on
page 437.

Panner
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2D Transform Tool
The 2D Transform tool lets you apply arbitrary transforms on an image and
lets you add camera jitter, motion blur, or stabilizing to the image. You can
also move, scale, rotate, and shear images in 2D with high quality filtering as
well as concatenate transforms to avoid re-filtering.

The 2D Transform tool has the following parameters:

Transform generator

To:Use:

Create, delete, order, mute, solo and reset transforms. Solo (S)
takes precedence over Mute (V) (a transform that's both soloed

Transform generator

and muted is visible) while soloing a transform does not affect
the muteness of other transforms, thus soloing a transform then
un-soloing it does not lose state.

■ The main reset button (in the Tools Options) is the equival-
ent of deleting and re-adding the tool (all values are reset,
and additional transform generators are deleted).

■ The tool maintains the selection of the transforms.

■ Adding a new transform selects the new transform and
deselects the rest.

Set the type of transform. You can choose from 1 point, 2 point,
4 point, or scale, rotation, and translation and set source and

Transform Type

destination values, as well as adjust offset parameters for tracking
or stabilizing purposes—see Tracking and Stabilizing on page
753.

Set the values of your transforms, you can also use the direct
manipulators in the Player to transform the image—see 2D
Transforms on page 478.

Transform value edit-
ors
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To produce an affine transformation on an image:

1 Add a Transform 2D tool at the desired point in the dependency graph
(if one is not already there). One transform is automatically added. You
can add additional transforms using the New button.

2 Use the controls that appear in the UI to the right of the super tool
controls or the direct manipulators that appear in the Player. The direct
manipulation controls are the same as those found in the Warps—see
2D Transforms on page 478.

3 To shear an image, press the Insert key while the focus is in the player
(this toggles the transform manipulator and the pivot manipulator), then
using the rotate widget, set your pivot angle.

4 Press the Insert key again and use the scale widgets to shear the image.

NOTE Each transform influences transforms which follow it. The more it influences,
the more 'global' it is, or conversely, the fewer it influences, the more 'local' it is.
The pivot is independent within each transform.

Adding Motion Blur and Filters

Controls on the 2D Transform tool Output tab lets you add motion blur,
filtering, and cropping to your image.

The Output tab has the following parameters:

To:Use:

Add motion blur to the result image. Motion blur can be on or
off; when on, there are controls for shutter speed and offset; the

Motion Blur

time interval over which the shutter is open is centered at the
current frame time by default; the offset can be used to move it
elsewhere.

Filter the output image—see Cropping and Filtering the Output
on page 482.

Filtering
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To:Use:

Crop the output image—see Crop Tool on page 410.Crop

Simulating Camera Jitter Using the 2D Transform Tool

NOTE The following example describes one way to simulate camera jitter using
the 2D Transform tool combined with a Noise or Rand expression—see Random
Number Functions on page 749.

To simulate camera jitter using the 2D Transform tool:

1 Place a Transform 2D tool at the desired point in the dependency graph
(if one is not already there).

2 Select the 2D Transform tool.

3 Right-click in the X (or Y) value editor and select Set Expression. The
Expresso calculator appears.

4 Select Random, then Noise, and type the following expression:
noise(t*50)*15. This expression can be broken down as follows:

Returns:Where:

A value between -1 and 1.noise (t)

A value between -1 and 1 and where “50" represents frequency. The
larger the value, the longer the frequency of the resulting noise.

noise (t * 50)

Values between -100 and 100, where 100 represents amplitude.noise (t * 50) *
100
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NOTE You may also want to add motion blur to the output for a more realistic
effect.

Flip Tool
The Flip tool lets you take an image and flip the pixels left-to-right,
top-to-bottom, or both when the Link button is enabled. The default setting
is vertical flip.
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To modify an image using the Flip tool:

1 Drag the Flip tool from the Tools tab to the dependency graph in the
Schematic view. The image will be vertically flipped.

2 Select the desired flip parameters: Vertical, Horizontal, or both.

NOTE The Flip tool's Vertical and Horizontal attributes are both animatable by
setting keyframes or using expressions—see Setting Keys Manually on page 676
and Validating and Applying the Expression String on page 729.

Orient Tool
The Orient tool lets you rotate its input by 0, 90, 180, and 270 degrees (with
the rotation parameter being an enumeration) and further flip the result
vertically and/or horizontally.

The vertical and horizontal directions refer to the image after the rotation has
been applied.

NOTE When possible, use this tool in lieu of more general transform tools because
no resampling the input image required resulting in no loss of image quality.
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Panner Tool
The Panner tool lets you reposition the image in both the X and Y directions,
as well as to reposition the image using the X and Y offset created when used
with Tracker tool data inside an expression—see Validating and Applying the
Expression String on page 729 and About Tracking and Stabilizing on page 754.

To reposition an image using the Panner tool:

1 Drag the Panner tool from the Tools tab to the dependency graph in the
Schematic view.

2 Select the desired reposition parameters: X, Y, or both, and select the
desired offset of the X and Y axes.

3 Select the filtering option.

4 Select the anti-aliasing factor.

NOTE The Panner tool's X and Y axes attributes are both animatable by setting
keyframes or using expressions—see Setting Keys Manually on page 676 and
Validating and Applying the Expression String on page 729.
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Pixel Expressions

Topics in this chapter:

■ About Pixel Expressions on page 439
■ PXL Tool on page 440
■ CTL Tool on page 463

About Pixel Expressions
Use one of Composite's pixel expression tools to create customized effects and
apply color management solutions. There are two pixel expression tools:

Description:Tool:

Use the powerful PXL language to create your own
plug-in tools—see PXL Tool on page 440.

PXL Tool

Use the CTL tool to facilitate color transforms and
other pixel-based procedures—see CTL Tool on page
463.

CTL Tool

18
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PXL Tool
The PXL tool provides the ability to write a C-like program to control the
creation of its output image. The program executed by the PXL tool is written
in a new language called PXL, the Pixel eXpression Language (pronounced
“pixel”). The PXL language offers a rich set of features like conditionals,
looping, and numerous built-in functions. The PXL tool offers users the ability
to create new effects by writing a PXL language program. The PXL tool can
be used to implement any point or gather operator, as it can read any pixel
in its input images.

The PXL tool's primary use cases are two-fold. One use case is for quick creation
of a short, non-reusable PXL program, for simple image generation or
transformation. Another will be to write longer scripts to create customized
effects that are not supplied by Composite, which will be shared by many
users. Examples might include:

■ Image generators

■ Warping

■ Transitions (fade & dissolve)

■ Blur & convolution

■ Tone mapping

■ Noise generators

■ Filters

■ Masking

■ Convert color spaces

■ Compositions

■ Color correction

PXL Tool Inputs and Outputs
The PXL tool has a single image output. It has a single, fixed primary input
(which can be unconnected, when used as an image generator). Further image
inputs can be added to the tool, which allows for an arbitrary number of
secondary image inputs to the tool. These secondary inputs can also be

440 | Chapter 18   Pixel Expressions



removed from the tool. Because it supports masking, the PXL tool also has a
standard masking image input.

The PXL tool allows the user to create an arbitrary number of animated scalar
float inputs, to be used as parameters to the PXL script. Because of UI space
restrictions, only the first ten scalar parameters will be shown in the UI;
however, all parameters can be seen in the composition browser. These
parameters are passed as arguments to the main() function of the PXL script.

PXL Tool UI
The PXL tool UI has 3 tabs: the main UI tab, the Output tab, and the Masking
tab. The main tab supports two main modes, Develop mode and User mode.

User mode is meant to address the needs of users of the PXL script, who are
interested in changing the parameters to the script, but not necessarily the
script itself. Develop mode also has parameter controls as in User mode, but
has a UI to edit the script using the Composite internal editor, or read the
script directly from a file (to support a developer who wishes to edit the script
using an external editor), and view script compilation errors.

The PXL User mode UI is shown below. It shows a PXL tool where two
parameters have been added, here named Gain and Rotation. The Develop
functionality is muted, so its UI is not shown. The Reset button under the
parameters is used to reset only the parameters, not the whole tool, which is
done with the Reset button in the General Tool UI.

One of the UI layouts of the PXL Develop mode is shown below. In Develop
mode, Develop is un-muted, so that developer functionality is exposed in the
UI.
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The area on the left displays the same parameters that are shown in User mode,
as well as two buttons to add and delete parameters. Parameters cannot be
edited, only added and removed.

Clicking the Add button pops up a modal dialog where the user types in the
name of the parameter, its minimum, maximum, and default values, as well
as the minimum increment to be used when changing the value in the UI.
Additionally, clicking the Hidden button means that a particular parameter
will only appear in Develop mode. This modal dialog also includes a Cancel
button.

Clicking the Delete button pops up a menu where you select the parameter
to be removed.

The Develop controls are to the right of the Parameter controls. The File and
Edit radio buttons control whether the PXL script source is read from an
external file, or from the Composite internal editor.
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The above graphic shows Edit mode, where the PXL script developer is editing
the script inside the Composite internal editor (titled Script), which is displayed
to the right of the develop controls.

To:Select:

compile the edited script and, if successful, applies it as the new image
processing script.

Apply

display a modal dialog to read an external file into the Composite in-
ternal editor. The contents of the external file replace the contents of
the Composite internal editor.

Import

display a modal dialog to write the contents of the Composite internal
editor to an external file.

Export

replace the contents of the Composite internal editor with the currently-
applied script, thereby reverting the edited script back to what it was
when previously applied.

Revert

The script status and the applied script display share the right portion of the
PXL UI. Push toggle buttons on the top of that column to determine which
text viewer is shown. Both text views are read-only views. The status text
viewer shows compilation errors from the latest applied script, if any. If there
are no errors, the display shows a success message. The applied script viewer
shows the currently-applied script. This can be useful as a reference, when the
PXL script is actively undergoing editing, and you want to know what the
currently-applied script is.
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The other option while in Develop mode is File mode where the PXL script is
being read from an external file. In this mode, the PXL file is edited with an
editor external to Composite, then saved to disk. You will then click on the
Apply button to have Composite read the script from the file and apply it. In
File mode, the Import, Export, and Revert buttons of the Develop controls are
not relevant, as they pertain to the Composite internal editor, and are therefore
not shown.

Output Tab

Because the PXL tool can be an image generation tool, it requires an Output
tab to define the output properties. To define output properties, it uses the
same tab as found in Composite image generators. If the primary input is
connected, all options in this tab will be greyed-out and disabled, as is the
case with the Slate tool—see Slate Tool on page 429.
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Masking Tab

The PXL tool has the same masking capability that is available on other image
modifier tools, in the standard Masking tab—see Creating Masks on page 540.

Sharing PXL Tools
An important use case of the PXL tool is that even if you are not an experienced
PXL script writer you can still use the PXL tool to quickly write a simple
expression to create a basic effect. Use cases might be multiplying one of the
pixel channels by a constant, or multiplying two input images together, or a
simple conditional test to reveal out of gamut pixels as a false-color image.
Typically, these PXL tools will not be reused.

Another important use case is where a PXL script will be written by an
experienced developer, and distributed to others to be used in User mode. In
such a case, an easy means of distribution is important. Distributing the PXL
script alone is insufficient, as parameter names and min, max, default values
will not be available. Tool presets allow users to name, save persistently, and
distribute presets for any given Composite tool. This is exactly the functionality
required for you to develop custom tools written with the PXL tool. You can
write your own color corrector, keyer, or any other effect using a PXL script.
You can then package it as a PXL tool preset.

You can load and save PXL tool presets using the Preset controls in the Tools
Options area located at the far right of the tool UI—see Tool Presets on page
146.
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PXL Presets
There are several PXL tool presets installed with Composite and they are
described below:

■ Blur 5 x 5  A simple 5 x 5 blur kernel with hard coded weights.

BlurredOriginal

■ Clouds  Creates a cloud texture.
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■ Corner Pin  Provides eight parameters to control the four corners of the
image, and computes a perspective transformation to place the image based
on the corners. By setting expressions to link the eight parameters to a
garbage mask rectangle, a simple interactive corner pinner can be made.

■ Directional Blur  Performs an anti-aliased blur using a rotated rectangle
to achieve a blur in a particular direction.
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BlurredOriginal

■ Emboss  Simple emboss, based on gradients of luminance.

EmbossedOriginal

■ Erode Alpha  Erodes alpha using a simple square kernel.
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Eroded Alpha with a 10 pixel radiusOriginal

■ Gamma  Applies a simple gamma exponential to all channels.

Gamma correction appliedOriginal

■ Lattice  Adds a lattice of shaded tubular bars to the image channels.

■ Lens Flare  Provides 1 to 5 lines of flares centered on bright points on
the image. You can control the weight of the lines relative to the weight
of the source pixel at the center of the blur. There is also a falloff gamma
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factor for the weight of the lines as they get more distant from the centre
of the blur.

Lens flare appliedOriginal

■ Marble  Creates a marble texture.

■ Mandelbrot  Generates a mandelbrot fractal image.
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■ Noise Wipe  Performs a wipe transition between two images where each
pixel switches at a random time.

■ Noise  Creates a pattern of random noise.
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■ Num Colors  A preset that reduces the number of colors to create images
with banding. It can also add dithering noise to reduce the banding.

NumColors = 2, Dither = 1NumColors = 6, Dither = 0

■ Out of Range  Marks pixels outside of a specified range with a specified
color, such as red in the following image.
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■ Polygon Blur  Performs a simple anti-aliased polygon blur, to simulate
a lens effect. You can choose the number of sides, the radius, and rotation
angle.

Polygon Blur appliedOriginal image

■ Ripple Twirl  A twirl effect with some extra ripples.
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Ripple Twirl appliedOriginal image

■ Sharpen 5 x 5  A simple 5x5 sharpening kernel with hard coded weights.

SharpenedOriginal image

■ Spherical Mapping  Applies spherical mapping to the current selection.
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Spherical mapping appliedOriginal image

■ Stereo Anaglypha  A preset that provides two methods of combining
colors into a single Red/Blue glasses image (left image) and one method
for cross-eyed viewing (right image).

Cross-eyed viewingRed/Blue glasses

■ Wood Frame  Creates a wood frame. You can specify the frame's thickness
and lighting qualities.

■ Wood  Creates a wood texture. You can specify the scale, size, and
fineness of the grain.
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PXL, the Pixel eXpression Language
The following section outlines the traits inherent to the PXL language.

Example Script and Procedure

The following example PXL script and procedure multiplies the input pixel
R, G, and B components by 3.

To multiply the input pixel R, G, and B components by 3:

1 Add a PXL tool to the dependency graph.

2 Click the Edit button and type the script into the script editor.

The pixels in the image are multiplied by a factor of 3.
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Image Processing Algorithm Categories

There are three types of image processing operators: the point operator, the
gather operator, and the scatter operator. They are based on a workflow in
which there are one or more input images and a single output image:

■ Point operator  Image processing operation that only reads pixels from
the input images at the current position, and only writes one pixel to the
output image, at the same position.

■ Gather operator  Image processing operation that reads pixels from the
input images from any position, and only writes one pixel to the output
image, at the current position.

■ Scatter operator  Image processing operation that reads pixels from the
input images from any position and writes one or more pixels to the output
image at any position.

NOTE The PXL tool can perform point and gather operations, but not scatter
operations.

Fundamental Types

PXL supports a specific set of fundamental types. It is case sensitive. Like C,
all the variables must be declared before they can be used in an expression
statement, unless the variable is a built-in variable, or a function argument.
Unlike the C++ language, it is not possible to define new types with objects
or structures. Here is the list of supported fundamental types:

■ image

■ float

■ color/vec4

The color and vec4 types are aliases of one another, and are provided for
convenience and readability. Otherwise, they are syntactically identical for
PXL, and can be used interchangeably. Any reference in the documentation
to type color can be understood as vec4, and vice versa.

NOTE PXL does not support vectors, arrays, or matrices.

The color / vec4 type is a quadruplet of floating point values for R, G, B, and
A (or equivalently, X, Y, Z and W). These values are unclamped (even for A),
which fully supports high dynamic range scene-referred color manipulation.
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No explicit type casting or type conversion is supported. However, many
mixed-type assignment operators and functions are provided.

If a variable of image type is used where type rules would require a color type,
the language automatically calls the built-in single-argument sample (image)
function. This is provided as a convenience.

As PXL has no Boolean type, the float type is used to represent Boolean values.
Any value that is different from 0.0. PXL Boolean operators return 1.0 as a
true value.

Qualifiers

A variable can be defined as const. In this case, the variable cannot be modified
after his initialization. An error will be issued if a const variable is modified
after initialization.

As previously described, function arguments can be qualified as input or
output. These are currently only used by the PXL tool to pass in data to the
main() function and read out the output pixel value. The initial value of an
output argument is undefined.

Comments

Comments use the same syntax as C. Two consecutive slashes (“// Comment”)
are used for starting a single line comment. The slash-star (“/*”) is the
beginning token for multi-line comment, while the star-slash (“*/”) is used to
stop the multi-line comment.

Control Statement

PXL supports the “if” statement, the “while” statement and the “for” statement.
They also use the same syntax as in the C language. The only exceptions are
that PXL has no break or continue statements to affect looping.
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Operators

PXL supports the following operators, which are a subset of those found in
C. Of note are the lack of bitwise manipulation operators, as well as the lack
of a modulo operator, however the modulo is available through the built-in
mod() function—see Built-in Functions on page 460.

NOTE Operations on color / vec4 are done on a per-channel basis.
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Variable Declarations

The naming of variables uses the same rules as C. A variable name must begin
with an alphabetical character, followed by none or more alphanumeric
characters or underscore character. It must not contain any white spaces.

All variables are initialized by Composite upon declaration, depending on
type:

■ Float variables are initialized to 0.

■ Color / vec4 variables are initialized to (0, 0, 0, 1).

■ Image variables are initialized to an uninitialized image. An uninitialized
image will return (0, 0, 0, 1) on sample(), has a pixel aspect ratio of 0, and
has a size of (0, 0).

Numeric Constants

Built-in Variables

PXL has built-in variables to ease script writing. These variables are “x”, “y”,
and “t”. The first two are the floating-point normalized image reference frame
(x, y) coordinates of the pixel being computed—see Calculating Image Size in
Composite on page 191. “t” is the floating-point current time, in seconds. All
built-in variables are declared constant by the system, so they cannot be
assigned to. PXL exposes the IRF coordinates of each pixel in its x and y built-in
variables. This means that in PXL horizontally adjacent pixels will have a
value of the x built-in variable that differs by 0.9 for an NTSC image. Thus,
an NTSC image (with 720x486 pixels) is actually 648x486 IRF units (720 * 0.9
= 648), which represents a 4:3 image aspect ratio (648/486 = 4/3), as expected.

Built-in Functions

PXL provides a number of built-in functions. Functions can return any of the
PXL fundamental types, or can return void. Built-in function argument
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overloading is supported by the sample() function to provide two
implementations, one with a single argument, the other with 3 arguments.

NOTE In the following table, all references to type color also refer to vec4, and
vice versa.
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Interface with Composite Executable

The Composite executable interfaces with the PXL script in the following way:

■ The function declaration is optional. If present, it must be called “main()”.

■ Function arguments can be any of the PXL basic types. Arguments to
“main()” of type “image” with the “input” qualifier are the PXL tool image
inputs, and must match the name of the input image socket. This implies
that accessing the primary image input must be done with an input image
argument named “In”. Arguments to “main()” of non-image type with the
“input” qualifier are PXL tool parameter inputs, and are matched by name
and type with the input parameters of the PXL tool. For example, a float
parameter named “Gain” would be passed in the “main()” function as
“input float Gain”. Arguments to “main()” of type “color” with the
“output” qualifier are the pixel outputs. The first version of the PXL tool
supports a single pixel output, which must be called “Out”.

■ The return type is limited to void and the return statement is not supported.

If no function header is present for main(), Composite will create one
automatically. It will include all defined image inputs, and all defined
parameter inputs.

No warning is given if main() function arguments are not referenced by the
function. However, a reference to a non-existent parameter or input image is
an error.
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All images read by the PXL script are read at the current time t. There is no
way to read images at a time different from t within a PXL script. To do so, a
user must use external Composite Retimer or Time Offset tools before inputting
images to the PXL tool.

CTL Tool
Use the CTL tool to write a color transformation language (CTL) expression
to control the resulting color of a pixel.

NOTE The CTL tool can only perform point operations—see Image Processing
Algorithm Categories on page 457.

The CTL tool uses the same UI as the PXL tool—see PXL Tool UI on page 441.

The CTL tool supports every feature of CTL except print statements. For a
more complete list, refer to the CTL manual:
http://ampasctl.sourceforge.net/CtlManual.pdf. The main function of the script
will be called for each pixel of the output image.

Before applying a script, several conventions must be respected:

■ The entry point of the script is the “main” function. This function must
be present in every script.

■ The main function return value is ignored.

■ The main function must have four parameters for each input image. They
correspond to the RGBA channels of the pixel of the input image. They
must be of type float, and be qualified as “input varying”. The name of
these parameters must be the component letter in lower case (i.e. “r”, “g”,
“b”, and “a”), concatenated with the name of the input image. Because
the primary input of the CTL tool is called “In”, the corresponding
arguments to the main() function for that input image will be:

■ input varying float rIn

■ input varying float gIn

■ input varying float bIn

■ input varying float aIn
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■ Additional images (if any) follow the same convention: for an additional
input image Bg, the corresponding arguments to main would be:

■ input varying float rBg

■ input varying float gBg

■ input varying float bBg

■ input varying float aBg

■ 4 parameters of the main() function must be present to define the output
pixel color. They correspond to the RGBA channels of the output pixel.
They must be of type float, and must be qualified as “output varying”. The
name of these parameters must be the component letter in lower case
concatenated with the literal string “Out”:

■ output varying float rOut

■ output varying float gOut

■ output varying float bOut

■ output varying float aOut

■ 1 parameter of the main function must be present for each input parameter.
They must be the same name and type as the parameter of the UI. Ex:

■ input uniform float P1

The following is a sample script and procedure that blends two images.

To blend two images:

1 Connect a CTL tool node into an output node in the Schematic view.

2 Connect image 1 to the In input of the CTL tool.

3 Create a second input for the CTL tool by right-clicking on the node and
selecting Add input from the menu.

4 Name the new input Img1 when prompted.

5 Connect a second image to Img1 input.

6 Select the CTL tool node and click the Edit button to open the Composite
internal editor.
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7 Type the following script into the editor or copy then paste it in using
Ctrl + C (for Windows and Linux) or Cmd + C (for Mac OS) and Ctrl + V
(for Windows and Linux) or Cmd + V (for Mac OS):

The two images are blended.

NOTE Composite fully supports the CTL import statement and the
CTL_MODULE_PATH environment variable used to search for CTL programs
in a set of directories on disk. As such, it can be convenient to structure CTL
code in Composite such that the main() function above is used simply as the
entry point that calls other CTL functions defined in separate files that are
imported with the import statement. You may set the CTL_MODULE_PATH
in the Tool panel of the Project Preferences panel.

Accelerating CTL Transforms
Because CTL is an interpreted language, the performance may be slow.
Composite gives you the option of accelerating a CTL program by converting
it to a 3d-lut.This will be faster but may contain errors relative to the original
CTL program.

To enable acceleration, click the 3D LUT Enable switch in the CTL tool's
Processing tab. The Pre-conditioning option allows you to adjust the
distribution of grid points in the 3d-lut. If the input image is in scene-linear
color space, setting the Pre-conditioning to Log will arrange the grid points
in a roughly logarithmic manner which will help distribute the approximation
errors in a more perceptually uniform way.
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Warping

Topics in this chapter:

■ About Warping on page 467
■ Warp 2D on page 467
■ 2D Transforms on page 478
■ Cropping and Filtering the Output on page 482
■ Warping Tools on page 484

About Warping
The Warping tools let you distort the physical shapes and contours of images.

Warp 2D
The Warp 2D tool lets you:

■ Warp an image to change the geometry of some elements.

■ Correct slight perspective errors in shots.

■ Provide customized stylistic distortion effects like twirl or ripple, but with
much more control over the animation of the geometry.
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The basic operation of the Warp 2D tool involves drawing source and
destination shapes and linking pairs of these together. The correspondence
between points on the source and destination shapes defines constraints on
the transformation of the image.

Another type of shape constraint is a fence shape which functions like a pair
of source and destination shapes that are constrained to always be equal,
keeping a part of the image from moving from its source position. The resulting
transformation tries to make a deformation of 2D space that warps the image
to satisfy the specified shape positions, while automatically repositioning the
unconstrained parts of the image to make the overall warping as smooth as
possible.

The types of shapes supported include those in the Garbage Mask and Remove
Dust tool: Splines (open or closed), Rectangles, and Ellipses.

After drawing the shapes which define the transformation, you can set or
animate an interpolation parameter which controls the amount of warping.To
create a static warp of an image you will just set this to 1.Sometimes you may
want the image to smoothly change from its original shape to a warped shape
and will animate the interpolation parameter from 0 to 1.There is also a control
to use a per-shape interpolation amount to have various features deform at
different times.

Warping Workflow
The warping of a single image involves a multi-step process. You first work in
source space (by viewing the input image by pressing the 5 hotkey while
focused in the viewer) drawing several shapes which define the important
features that will be deformed and the fence shapes which will lock parts of
the image in place (like the dog's left eye down to its nose).
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You will then switch out of source space into destination space (by pressing
the 6 hotkey while focused in the viewer) and begin editing the destination
shapes.

As you drag around a destination shape, the image underneath is warped
accordingly. Once you have dragged all the destination shapes to their desired
final positions, you may want to add another shape pair or fence shape to
refine the warp. You will have to switch to source space to draw the starting
position, then back to destination space to move the shape around and see
the result.

Warp 2D UI
The Warp 2D UI consists of three tabs: Shape Drawing, Output, and Options.
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Shape drawing closely mimics that of Garbage Mask and Remove Dust tools.
The types of objects that can be created are:

■ Splines, open or closed

■ Freehand shapes.

■ Rectangles

■ Ellipses

■ Points (just a spline with a single vertex)

Like the Garbage Mask, there is a list box with the named shapes and
individually editable parameters. The Warp UI also has all the components
of the Garbage Mask for transforming shapes, setting drawing options for
rectangles and ellipses and for loading and saving user settings—see Garbage
Mask Controls on page 539.

Each shape has a parameter which controls the smoothing across its
boundaries, named Smoothing. For open shapes, this can have one of two
values: None or Bidirectional. The setting None means that each side of the
shape is smoothed independently and there can be discontinuities in the warp
across the shape. The setting of Bidirectional means that smoothing is applied
across the shape and there will be no discontinuity in this region. If the shape
is closed, then in addition to these two values, there are two other possible
values: Inside and Outside. A value of Outside means that the inside of the
shape is smoothed independently of the outside, but the outside is smoothed
to match the inside. A value of Inside is the opposite of this.

Smoothing = None
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Each shape also has a Boolean parameter, Fence. When this is enabled, this
shape acts like a pair of source and destination shapes which are constrained
to be equal. This holds the image under the shape in place. When the Fence
parameter is enabled, the destination shape and link points disappear. Fence
shapes are treated differently from regular shapes. Fence shapes have their
own visibility, and the link lines and link editing manipulations do not apply
because the correspondence is defined to be the identity along the curve.
However, each shape has a toggle to determine if it is a Fence or not, so you
can always change a fence shape back to a regular pair of shapes.

NOTE When you create Fence shapes, you will usually want to set the Smoothing
attribute of the Fence shape to None, to ensure that there is no motion crossing
the border of the fence.

Each shape has an Interpolation parameter which is only relevant if the Timing
mode is set to Shape (described in the Output tab section). Each shape also
has a Mute switch to disable its effect on the warp, and a Lock switch that
locks the points, shape, edges, and tangents of the shape.

You can change the name of a shape under the Name heading in the shape
list. With the cursor in the text field, press F2, type in a new name and press
Enter. You can also assign a name to a shape once you have selected what
type of shape you want to draw. Under the Create Shape label, select the
default shape name and type in a new one then press Enter or click outside
the text field.

(a) Source and Destination shapes (b) Warp result
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(a) Fences added to limit warp to the right eye (b) Warp result

The Warp 2D tool will have two outputs:

■ Result (warped by the amount of the interpolation parameter)

■ Input image warped by 100%

While editing, you can use the standard hotkeys (5 and 6) to switch between
the input image and the second output, in order to view the source and
destination spaces.

Shapes are displayed in the viewer with a color that depends on its type, e.g.,
source, destination, fence, links, or interpolated shapes.

ColorShape

RedSource

BlueDestination

GreenFence

CyanLinks

MagentaInterpolated

You can distinguish between and edit source and/or destination shapes by
toggling on/off the visibility of each of the following classes of shapes:

472 | Chapter 19   Warping



■ Source shapes

■ Destination shapes

■ Fence shapes

■ Links (defines correspondences between the source and destination shapes)

■ Interpolated shapes (viewable only, these cannot be edited, but show the
interpolated position of the shapes based on the current interpolation
parameter)

Other controls on the Shape Drawing tab include:

To:Use:

Give the selected shape a name. Select the default name in the text
field and type in a new name then either press Enter or click outside
the text field to apply the name.

Name

Control how much warp is applied to the image—see Output Tab on
page 475.

Interpolation

Enable/disable the shape as a fence.Fence

Apply smoothing across the shape's boundaries.Smoothing

You can also adjust control points of the shape using the same controls the
Garbage Mask uses—see Editing Masks on page 543. You can also copy and
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paste a selected source or destination shape either in the same Warp 2D tool
or from another.

To copy and paste a source or destination shape:

1 Select a source or destination shape to copy.

2 Use the Ctrl + C (for Windows and Linux) or the Cmd + C (for Mac OS)
hotkey combination to copy the shape.

3 Use Ctrl + V (for Windows and Linux) or Cmd + V (for Mac OS) to paste
the entire animation of the shape points and tangents.

NOTE The transform, and other properties are not copied.

Curve Correspondence
In addition to the usual spline editing interactions, you can also edit the
correspondence between two linked shapes. In the image below, red curves
depict source shapes, blue curves depict destination shapes, and cyan lines
represent the correspondence between the pairs of linked curves. These lines
show the direction the warped image will move as the interpolation parameter
is animated from 0 to 1. You can add link points on either curve (using the
Ctrl key) which can then be dragged along the curve to change the directions
of the lines. Adding a point on one curve will also create a corresponding
point on the opposite curve. Dragging one of these points sideways along the
curve will skew the correspondence directions. Correspondence positions are
animatable.
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Output Tab
There are several parameters which control how the warped image is rendered
and are located under the Warp label.

To:Use:

Set the timing of the deformation. The default state
is Global where all shapes deform at the same time

Timing

based on the interpolation you set (see below), or
you can select the timing to be on a per shape basis
allowing you to deform various features on differing
schedules.

Define how much of the warp is applied in the final
rendering. A value of 0 means that the image is

Interpolation

passed through unchanged. A value of 50 means
that the image is deformed 50% of the distance
toward the destination shapes.

Send the warp backwards. Used in the morphing
workflow—see Morphing Between Two Images on
page 478.

Warp Invert
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There are several parameters which control how the image warp transformation
is computed and they are located under the Render label.

To:Use:

Control the quality versus speed of the deformation as higher
quality warping takes more computation time. If you experience

Quality

discontinuities or warps that are not smooth, or if the animation
has regions that do not warp smoothly over time you should in-
crease the Quality setting.

The warp of the image is computed to satisfy the constraints defined by the
drawn shapes, and still be as smooth as possible. The choice of smoothing
criteria is Rigid or Skew.

To:Use:

Select the smoothing criteria; skew is a mode where the image
transformation is locally constrained towards a 2D affine transform-

Smoothing

ation, and the image is allowed to skew as it tries to find the
smoothest warp. In Rigid mode, the image is locally constrained
to an angle preserving similarity transformation where skew is
discouraged but not impossible.
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(a) Skew (b) Rigid

To:Use:

Set the image boundary to either Fixed or Free. Fixed holds the
border of the image in place while Free lets the image expand
beyond the image border.

Boundary

(a) Fixed (b) Free

Like the Garbage Mask, the Warp 2D tool's Output tab contains a crop tool
and user settings controls—see Output Tab Settings on page 558.

Options Tab
The Options tab contains the same options and User Settings as the Garbage
Mask Options tab—see Options Tab Settings on page 559, with the exception
of the Links View parameter which allows you to change the spacing of the
links between source and destination shapes.
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Links spacing = 30

Morphing Between Two Images
Although the Warp 2D tool warps a single image, you can morph between
two images using the following workflow:

To warp between two images:

1 Add a Warp 2D tool node to image A.

2 Place all your source shapes onto image A.

3 Change the viewer to be viewing image B using a context point, and align
all the destination shapes on the corresponding features of image B.

4 Animate the Warp from 0 to 1 interpolation, which warps image A toward
B.

5 Copy the Warp tool, select the Invert-Warp button and connect Image
B as its input.This will warp Image B backwards towards A.

6 Add a Blend tool node between the two warp outputs and animate it
from 0 to 1.

2D Transforms
With the exception of Lens Distort and the Warp 2D tool, all warping tools
let you translate, rotate, scale and change the center of the input, effect and
output image. Transformations on the input image will be done before applying
the effect and its transforms. The transformations on the output image will
be done after applying the effect and its transforms—see 2D Transform Tool
on page 432.
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Affine transforms can be applied for free performance-wise, i.e. they can be
applied at the same time as the warps without slowing down the tools. By
combining transforms into a single resampling operation, the produced image
has less degradation than if separate transform and warp tools were used. In
addition, the combined transforms/warps approach is not susceptible to the
bottleneck issue. For example, specifying an Output transform that enlarges
the output image would give a completely different result that putting a resize
tools afterward. In the former approach, the image would be directly computed
at the final resolution, while in the latter approach the intermediate image
would be at a lower resolution and the lost information could never be
recovered.

Affine transforms allow integration with the tracker because the affine
transforms are expressed using socket names that the tracker recognizes. The
tracker can be accessed by right-clicking on the value editors or the
Input/Output/Effect UI Container label.

Since Warping tools can be keyframed, you can create dramatic changes in
image shapes when animated over time.

All Warping tools have masking inputs so you can limit the effect of the warp
to a precise area of the image.

All Warping tools have the following common parameters:

To translate the input image, warp effect, or output image:

 ➤ Do one of the following:

■ Type values into the X or Y Translation value editors and press Enter.

■ Drag the square found at the bottom left of the direct manipulator
along the X and Y axes. Note that you must have Manipulators selected
in the Display tab in Player Options.
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The image can be moved along the Y or X world axis, respectively by
dragging either the vertical or horizontal arrow protruding from the
square.

The vertical and horizontal arrows extending further from the square
act on the Y and X image axis respectively.

To rotate the input image, warp effect, or output image:

 ➤ Do one of the following:

■ Type values into the Z Rotation value editors and press Enter.

■ Move the curve at the upper right of the direct manipulator.
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Note that the world and image axes are equivalent when there is no
rotation.

To scale the input image, warp effect, or output image:

 ➤ Do one of the following:

■ Type values into the X and Y Scale value editors and press Enter.

■ Move the right angle in the centre of the direct manipulator. The
arrowheads at each end restrict the scale to the respective axis.

To set the pivot point:

 ➤ Press the Backspace key to activate the pivot manipulator then do one
of the following:

■ Type values into the X and Y Pivot value editors and press Enter. Note
that the scale manipulator is not available. The rotation manipulator
is used to shear an image.
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NOTE You can use the following hotkeys to quickly select a manipulator; press
M to select the Input manipulator, press comma (,) to select the Effect manipulator,
or press period (.) to select the Output manipulator.

Cropping and Filtering the Output
The Crop allows you to change the size of an image. Crop manipulators are
visible when selecting the Output tab—see Crop Tool on page 410.

The filtering processes attempt to smooth the transformed pixels. When an
image is being warped, there is a need to interpolate the old pixel map to a
new one. This requires some form of image reconstruction and a number of
resampling methods can be used.

All Warp tools have common filtering parameters:

DescriptionFilter

A box filter and the fastest way to resample an image since it only
samples a single pixel of the input image to determine the value of a
given pixel in the result image. Produces significant amount of aliasing.

Nearest

A separable triangular filter that takes into account more area when
resampling.

Bilinear (de-
fault)

Considered as one of the best magnification filters for images; has a
good balance between ringing and sharpness.

Mitchell

Good magnification and magnification filter with no ringing, but intro-
duces noticeable softness to the result image.

Gaussian

Offers better sharpness than the Gaussian one, but at the expense of
ringing. Similar to the sinc filter, but with better isotropic qualities, less
ringing, and same sharpening and anti-aliasing.

Jinc 2

Offers better sharpness than the Gaussian and Jinc2 filters but at the
expense of even more ringing. Similar to the Lanczos filter, but with

Jinc 3
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DescriptionFilter

better isotropic qualities, less ringing, and same sharpening and anti-
aliasing.

The next example illustrates the sharpening and ringing effects of the six
filters.

The next example illustrates the anti-aliasing and blurring effects of the six
filters. These examples were created with a checkerboard and polar tool to
provide variance in frequencies in all directions.
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Other common output parameters:

To:Use:

Adjust the trade-off between anti-aliasing and blurriness.AA Factor

Set the repeat mode. Choose from; Transparent (default), Edge,
Repeat, and Mirror.

Tiling X/Y

Control whether the mapping is stretched to cover the entire
image region of definition (ROD) while in Image mode, or

Aspect

whether the mapping is only uniformly stretched to fit the height
of the image (Circular mode). Note that in image mode, the
mapping will be non-uniformly stretched. Particular mappings
might be more suited to one aspect ratio mode or the other. Each
tool specifies the proper default aspect ratio mode.

Warping Tools
There are 10 Warping tools that let you distort the shape of your images:

DescriptionTool

For creating creases, kinks, and wrinkles in an image—see Crumple
on page 485.

Crumple

Offsets pixels in an image using pixel values of another image—see
Displace on page 485.

Displace

Rectifies or creates lens distortion—see Lens Distort on page 487.Lens Distort

Enlarges a portion of an image in either the X, Y, or both axes—see
Magnify on page 491.

Magnify

Creates a mirror effect in an image—see Mirror Tool on page 492.Mirror

Compresses an image inward or outward—see Pinch Tool on
page 492.

Pinch

Changes the pixel definition of an image from Cartesian to the
Polar coordinate system or vice versa—see Polar Tool on page 493.

Polar

Creates ripple effects in an image—see Ripple Tool on page 494.Ripple

Rotates and twists an image—see Twirl Tool on page 495.Twirl
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DescriptionTool

Creates a wave effect in an image—see Wave Tool on page 496Wave

Crumple
The Crumple tool lets you create an image which appears crumpled like a
piece of paper.

Original image

The Crumple tool has the following parameters:

To:Use:

Control the overall strength of the filter.Amplitude

Make modifications to the fractal patterns yielding
random results.

Time Slice

Control the turbulence. Increase the octaves to get
more iterations, therefore, a more turbulent
crumpling effect.

Octaves

Displace
The Displace tool lets you use a control image to drive the displacement used
to warp the primary input image. There are two ways to displace a primary
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image: Modulation and Vectors. Both ways can be combined together by
specifying the Modulation Image and a Forward Vectors image.

Displacing with Modulation
You can use a single channel to modulate the displacement along a fixed
direction. You can define the fixed distance and angle and the displacement
increases or decreases by the intensity of the channels (Red, Green, Blue, Alpha
or Luma) of the modulation image.

To:Use:

Specify the distance of displacement in pixels.Distance

Specify the angle of displacement all pixels in the image will be rotated
by in degrees.

Angle

Select which channel from the modulation image will be used to displace
the image in a fixed direction as specified by the distance and angle.

Channel

Input image
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Displacing with Forward Vectors
You can use a forward vector image to define the displacement of the primary
input image. Each pixel can be moved in a different direction. The red
component of the image represents the X direction of the motion vector and
the green component the Y direction. The vectors can be scaled and rotated
before applying the result on each input image pixels.

To:Use:

Scale all motion vectors of the forward vectors image.Scale

Apply a rotation to all motion vectors of the forward vectors image. The
rotation is expressed in degrees.

Rotation

Input image

TIP Decreasing the opacity of the Modulation or Forward Vectors image will
decrease the distance of the displacement.

Lens Distort
The Lens Distort tool lets you create or correct lens distortion that may be
present in image sequences.

Barrel distortion is associated with wide angle (or minimal zoom) lenses. It
causes the images to appear slightly curved outward like a barrel. You can
notice this when you have straight features close to the image's peripheral
sides.

The Lens Distort tool has the following parameters:
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To:Use:

Select either lens correction or distortion. This affects all other
parameters. The other parameters will be considered either in a

Mode

distortion or in a correction work flow. The distortion transforma-
tion is exactly the inverse of the correction, so keeping the same
parameters and putting back to back distortion plus rectification
will give back the original result, but filtered twice at each trans-
formation resulting in possible degradation in image quality.

Set the first parameter (k1) of the lens distortion equation: rd = r
+ k1 * r^3 + k2 * r^5.

Magnitude

Set the second parameter (k2) of the lens distortion equation: rd
= r + k1 * r^3 + k2 * r^5.

Adjustment

Characterize anamorphic asymmetry. Note that this has nothing
to do with the pixel aspect ratio of the captured image.

Anamorphism

Set the X and Y coordinates of the center of the distortion. Those
parameters are expressed in pixels. The lens center can also be

Center

changed by clicking directly in the player. The center manipulator
is always active in the player. The look of the manipulator is a
cross. The cross can be manipulated by selecting it and moving
it.

To determine the region where the lens distortion or correction
is applied. This parameter is initialized to the composition height.

Height

To set the height input to the input height.This parameter is
needed to be able to perfectly inverse a lens correction.

Fit Source

Expected Workflows

The following are common use cases for lens distortion or correction:

■ Footage to be used as a background layer has noticeable lens distortion
and footage to be composited over the background does not. The Lens
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distort tool would be added to the dependency graph and used (in Correct
mode) to rectify the distortion before compositing the new layer over it.
The composite will then be made (any compositing operation) and a second
instance of the correcting Lens Distort tool would be added after the
compositing operation has taken place using the same values but in Distort
mode applying the original distort to both layers.

■ Applying lens correction on multiple compositions before compositing
them together.

■ Reproduce the lens distortion of one composition on another composition.

■ Using the tracking data from one composition and applying it to the center
of another distorted composition, or composited layers, producing
interesting animated effects.

Analysis of Radial Distortion

Analysis of radial distortion computes the magnitude and adjustment
parameter from a three point spline created in the player to identify distortion.
The analysis is only available when the lens mode is set to “Correct”. All
parameters except the magnitude and adjustment are used to compute the
new magnitude and adjustment. The magnitude input will be set at the current
frame when the analysis is finished. Note that only one spline can be created
at the time. The spline is not animatable.

To analyze radial distortion with the spline tool:

1 Set the Mode to Correct.

2 Draw a three point spline along edge of any distorted features within the
image that should be straight. When three points are drawn, the select
tool will be activated.
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3 Modify the existing spline.

4 Click the Analyze button to analyze radial distortion from the created
spline. The image is corrected and the Magnitude and Adjustment fields
are updated.
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5 To remove the spline, click Clear. Note that this removes the editable
spline only, but does not remove the correction. If you add a new spline,
corrections will be additive.

6 To begin a new analysis, click the Reset button in the Tools Options.

7 To correct an analysis, use Undo (Ctrl + Z for Windows and Linux or Cmd
+ Z for Mac OS).

Output
The Lens Distort tool has an Output tab with the following parameters:

To:Use:

Change the size of an image—see Cropping and
Filtering the Output on page 482.

Crop

Smooth the transformed pixels—see Cropping and
Filtering the Output on page 482.

Filtering

Magnify
The Magnify tool lets you magnify a region of an image.

Original image

The Magnify tool has the following parameters:

To:Use:

Control the power of the magnification. Default setting is 1.00000.Amount
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To:Use:

Set the direction of the magnification. Setting to Horizontal results
in a rectangular magnification region, enlarged in the horizontal

Direction

direction. It can also be set to Vertical which enlarges the image
in the vertical direction. Or it can be set to Both resulting in a
circular magnification region, such as a magnifying glass. Default
setting is Both.

Mirror Tool
This tool mirrors the image along the Y=0 axis. There are no additional controls
in this tool beyond the standard warping controls.

Original image

Pinch Tool
The Pinch tool lets you pinch or squeeze an image either inward or outward
from a defined center point.

Original image

The Pinch tool has the following parameters:
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To:Use:

Control the severity of the pinch. Positive pinch pulls the image
inside the cone, making it appear to recede. Negative values

Amount

stretch the image over the cone, moving the center point closer
to your point of view.

Polar Tool
The Polar tool lets you transform the input image from Cartesian coordinates
to Polar coordinates or vice versa. When using Polar to Cartesian, the effect
stretches a round object so that it appears to straighten out. When using
Cartesian to Polar, the effect bends an image around its center so that it appears
round.

An option menu is used to choose if the transformation is from Cartesian to
Polar or Polar to Cartesian.

Original image

The Polar to Rectangular tool has the following parameters:

To:Use:

To switch between Polar to Cartesian and Cartesian to Polar (de-
fault is Cartesian to Polar).

Mode

Rotate the result of the Cartesian to Polar conversion and offset
the result of the Polar to Cartesian conversion. The value is ex-

Offset

pressed as an angle that represent a circular offset in Cartesian
To Polar and an horizontal offset Polar to Cartesian mode.
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Ripple Tool
The Ripple tool lets you create ripple-like effects from the center of the image
outward.

Pond Ripples

The Ripple tool has the following parameters:

ToUse

Determine the ripple effect.Mode

■ Pond Ripples create ripples with a 45 degree offset.

■ Out from Center pushes the ripples away from the center,
extending the first half, and compressing the second half of
each ripple.

■ Around Center rotates the crest of each ripple in a clockwise
direction around the center.

To:Use:

Scale the amount of warping distortion. Increase for more severe
distortion.

Amplitude

Set the number of waves per frame.Frequency
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To:Use:

Control the total number of ripples that can be generated. For
example, set Max Ridges to 5 to create 5 rings of distortion; the
area inside and outside of the rings are unaffected.

Max Ridges

Set the distance between the ripples and the center. Animate the
spread to create continuous rippling of the image.

Spread

Control how the ripple amplitude is decreased over distance.Damping

■ Use None so all the waves have the same amplitude specified
by the amplitude parameter.

■ Use Linear so the amplitude of the waves at the center has
the specified amplitude and decrease linearly to 0 at the image
extremities.

■ Use Quadratic so the amplitude of the waves at the center
has the specified amplitude and decrease quadratically to 0
at the image extremities.

Twirl Tool
The Twirl tool lets you spin, twirl and rotate the image.

Original image

The Twirl tool has the following parameters:

To:Use:

Control the severity of the twirl. Positive twirls the image clock-
wise. Negative values spin the image counter-clockwise. The twirl

Amount
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To:Use:

angle can also be changed with a rotation manipulator in the
player.

Twirl the rotation.

Wave Tool
The Wave tool lets you simulate waves in a single direction (as opposed to
circular waves as found in Ripple).

Original image

The Wave tool has the following parameters.

To:Use:

Scale the amount of warping distortion. Increase for more severe
distortion.

Amplitude

Warp pixels parallel to the wave direction.Compression

Set the number of waves per frame. Increase for more waves,
decrease for fewer.

Frequency

Shift the position of the waves along the direction of wave motion.Phase
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Effects Tools

Topics in this chapter:

■ About Effects Tools on page 497
■ Drop Shadow on page 497
■ Glow on page 498

About Effects Tools
Effects tools let you add lighting and shadow effects to your images.

There are two effects tools available:

DescriptionTool

Adds a drop shadow to an image—see Drop Shadow on page 497.Drop Shadow

Generates subtle gradations of light in your composition—see Glow
on page 498.

Glow

Drop Shadow
The Drop Shadow tool takes an input image and adds a drop shadow to it by
taking the alpha channel of the input image, blurring it, offsetting it, and
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coloring it; the resulting shadow can then be sent to the output or composited
under the original input image.

The Drop Shadow tool has the following parameters:

■ Output  Controls whether to output the shadow alone or composited
under the input image. The UI will present a pull-down menu with
Composite and Shadow Only items. By default, the output mode is
Composite.

■ Color  Controls the color of the shadow; by default, the shadow color is
black.

■ Feather Radius X, Radius Y, and Link  Controls the radius of the blur (just
like in the Blur tool). By default, the X and Y radii are linked and set to 0;
otherwise, their range is the same as that in the Blur tool.

■ Offset X and Offset Y  Controls the offset of the shadow with respect to
the input image; by default, the offsets are 0. The Drop Shadow tool
supports non-integer shadow offsets so that animating those parameters
will still produce a smooth result. The offsets can be controlled using direct
manipulation.

NOTE This tool always outputs an RGBA image. Its only affects mode is RGBA.

Glow
The Glow lets you generate subtle gradations of light in your composition.

The Glow tool has the following parameters:
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■ Threshold  Lets you determine which parts of the image (usually the
brightest) you want to apply the glow to. You can base the threshold either
on a channel; Red, Green, Blue or Alpha, or Luma, or on a color component
of the image (R,G,B or overall luminance). Values that fall above the set
threshold will have a glow applied and values that fall below the threshold
will be set to black.

■ Gain  Colors the glow you apply to an image.

■ X Radius and Y Radius  Applies a blurred edge to the glow. Using the
Master slider will apply a blurred edge to both the X and Y radii uniformly.
You can also select a single color component or select just the X or Y
parameter to apply the blur to by deselecting the Lock button located at
the right of the button.

■ Output Mode  Choose between working with either the composite of
the image you are working with or just the glow applied to it. If you select
Composite, it applies the blend mode selected.

■ Blend  Select the blend mode you want to apply to the glow. Select Blend
to display available blend modes.

To set the threshold:

 ➤ Do one of the following:

■ Drag the trackball towards the color you want to set as the threshold.

■ Drag any of the red (R), green (G), or blue (B) channel fields to the
right to increase, or to the left to decrease the threshold uniformly
on all three channels. Alternatively, you can also drag the luminance
(L) field to achieve the same result. Select the Reset button to return
all values to 0.

■ Select a single channel that you want to modify by deselecting the
Lock button to the right of the channel, then increase or decrease the
threshold. The other channels are not affected. However, the overall
luminance field updates to reflect the change. Select the Reset button
to return all values to 0.
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■ Type values into the channel fields and press Enter. In the case of
modifying all channels uniformly, when values are typed into any
field, the other fields update. The luminance field will update
regardless of which method is used to modify the values. Select the
Reset button to return all values to 0.

To set the gain on a glowed portion of an image:

 ➤ Do one of the following:

■ Drag the trackball towards the color you want to add or decrease gain
to.

■ Drag any of the red (R), green (G), or blue (B) channel fields to the
right to increase, or to the left to decrease the gain uniformly on all
three channels. Alternatively, you can also drag the luminance (L)
field to achieve the same result. Select Reset to return all values to 0.

■ Select a single channel that you want to modify by deselecting the
Lock button to the right of the channel, then increase or decrease the
gain. The other channels are not affected. However, the overall
luminance field updates to reflect the change. Select the Reset button
to return all values to 0.

■ Type values into the channel fields and press Enter. In the case of
modifying all channels uniformly, when values are typed into any
field, the other fields update. The luminance field will update
regardless of which method is used to modify the values. Select the
Reset button to return all values to 0.

To set the X or Y Radius to the edge of a glow:

 ➤ Do one of the following:

■ Drag any of the red (R factor), green (G Factor), or blue (B Factor)
channel fields to the right to increase, or to the left to decrease the
radius uniformly both the X and Y radii. Alternatively, you can also
drag the Master field to achieve the same result on all color factors.

■ Type values into the channel fields and press Enter. To deselect the
lock on any parameter, click the Lock button.
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Managing Film Grain

Topics in this chapter:

■ About Managing Grain on page 501
■ Adding Grain to a Composition on page 502
■ Removing Grain from a Composition on page 504
■ Fine-tuning the Grain on page 505
■ Saving and Loading Grain Profiles on page 507

About Managing Grain
Grain is a basic characteristic of film. Film grain consists of individual silver
halide crystals that are randomly distributed across an image. The random
distribution of the crystals creates the visual impression of graininess. Grain
adds a distinctive look to film, and different film stocks have different grain
signatures.
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Grain added to composition.

The grain management tools let you create convincing composites with film
material. You may want to add grain to clips that originate from video to give
them a film look.

The grain management tools are useful when:

■ Mixing film clips originating from different film stocks; you may want to
match the grain in the clips to make your results more consistent.

■ Working with footage originally shot on film that was transferred to video,
you may want to remove the grain if you want to mix film material with
video material.

■ Working with CG-generated elements, you may want a film look result.

Adding Grain to a Composition
The Add Grain tool lets you sample the grain from one image (the reference
image) and apply it to another image (the input image) or sequence. In the
following example, a CG character is used as the input image and the mountain
background is used as the reference image (the grain will be analyzed from
this image).
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(a) Input image of CG character on which grain will be applied. (b) Panner tool to place
the CG character at the desired location in the reference image. (c) Add Grain tool
(d) Comp Ops tool to composite the CG character over the background(A over B).
(e) Reference image from which the grain is sampled.

Once the dependency graph is built, you can decide which area of the reference
image to sample. You can select samples from multiple areas of the image.
You should use an area of the image that just contains grain, avoiding areas
with image or edge detail. Once you have positioned the sample area, you can
apply grain to the input image. After adding grain to the input image, you
can manually adjust the response curves for the gain and size of the grain.

To add grain to a composition:

1 From the Tools tab, drag the Add Grain tool from the Grain Management
folder to the dependency graph in the Schematic view.

2 Connect a reference image and an input image to the Add Grain tool.

3 (Optional) Add a mask to your input image to restrict the grain to a
portion of the image—see Creating Masks on page 540.

4 In the Add Grain tab, do one of the following:

■ Click the Analyze button.
Regions of the reference image that are appropriate for analysis are
analyzed and grain is applied over the entire composition.

■ Click the Selection button and drag to define an area to analyze. For
best results, define multiple regions of uniform color, avoiding areas
that may resemble grain such as gravel, sand, or a forest. Click the
Analyze button to create the grain. Click Clear to clear any areas you
defined and start again.
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(a) Selection button

The regions you defined are analyzed and grain is applied over the entire
composition. Response curves are generated and displayed in the
Animation Editor. You can now fine-tune the resulting curves—see
Fine-tuning the Grain on page 505.

Removing Grain from a Composition
Removing grain from a composition allows you to composite two grainy clips
that don't match, or simply to clean up a clip. The Remove Grain tool lets
you remove as much grain as possible while minimizing damage to the image.
You can specify how many forward and backward frames to include when
removing grain from a composition. These frames can be warped by motion
vectors to remove motion and improve the grain removal process. Increasing
the number of frames will improve grain removal performance, but adds
processing time. In some cases, it may also introduce motion artifacts if used
without motion vectors or with bad motion vectors, especially in scenes with
a lot of non-uniform motion.

The Remove Grain node has two secondary inputs for receiving forward and/or
backward motion vector data. When motion vectors are connected to these
inputs, the forward and backward frames are first warped appropriately to
remove motion before being used in the remove grain process. Also, you can
automatically compute the motion vectors if they are not connected—see
About Motion Vectors on page 711.

To remove grain to a composition:

1 From the Tools tab, drag the Remove Grain tool from the Grain
Management folder to the dependency graph in the Schematic view.

2 Connect a reference image and an input image to the Remove Grain tool.

3 (Optional) Add a mask to your input image to restrict the grain to a
portion of the image—see Creating Masks on page 540.

4 In the Remove Grain tab, do one of the following:

■ Click the Analyze button.
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Regions of the reference image that are appropriate for analysis are
analyzed and grain is applied over the entire composition.

■ Click the Selection button and drag to define an area to analyze. For
best results, define multiple regions of uniform color with no features.
Click the Analyze button to create the grain. Click Clear to clear any
areas you defined and start again.

(a) Selection button

■ Enter the number of forward and/or backward frames you w ant to
use, and click Calculate Motion.

The motion vectors in the forward and backward frames is used to analyze
the type of grain present in the composition. Grain is removed from the
composition. Response curves are generated and displayed in the
Animation Editor. You can now fine-tune the resulting curves—see
Fine-tuning the Grain on page 505.

Fine-tuning the Grain
Once you have generated or removed grain using the Add Grain or Remove
Grain tools, you can manually adjust the response curve for the gain and size
in the Animation Editor. The solid curve represents the gain and the dotted
line curves represent the size of the grain.
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To fine-tune the grain:

 ➤ Use any of the following controls on the Add Grain or Remove Grain UI:

To:Use:

Adjust the values of the RGB channels for the gain and size of the
grain.

Red, Green, Blue

Link the R, G, and B channels of the gain or size, so when you
change the value of one channel, the others change as well.

Link

Save a grain profile for use in other compositions—see Saving and
Loading Grain Profiles on page 507.

Save

Load a grain profile you previously saved—see Saving and Loading
Grain Profiles on page 507.

Load

Specify correlations between the grain present in different color
channels. There may be some statistical correlations between the

Correlations

grain present in different color channels depending on the film
properties and development process.

Adjust the discrepancies between pixel aspect ratio and grain aspect
ratio.

Pixel Ratio

Viewing the Response Curves
You can determine how to display the response curves in the Animation
Editor.

To view the gain or size:

 ➤ Click the first button under Curves, and select Gain or Size.

To view the red, green, or blue curves:

 ➤ Under Curves, click the second button and select Red, Green, Blue, or
RGB.

To display the response curves as generated by the Grain tool:

 ➤ Under Curves, click the Home button.
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To frame the response curves:

 ➤ Under Curves, click the Frame button.

To reset the Animation Editor:

 ➤ Under Curves, click the Reset button.

The currently selected curve is set to 0.

Saving and Loading Grain Profiles
A grain profile is a set of parameters that describes grain appearance. Once
you create a grain profile through the Add Grain or Remove Grain tool, you
can save it and reload it for use in other compositions. If one or more of the
grain parameters are animated, only the parameters at the current time are
saved in a grain profile.

When saving or loading a grain profile using the Remove Grain tool, the
number of forward and backward motion vectors and the state of the automatic
motion vector computation are saved. The Add Grain tool does not use these
values when you load a grain profile, but does put in some reasonable values
when you save a grain profile.

To save a grain profile:

 ➤ In the Add Grain or Remove Grain UI, click the Save button and give a
name to your profile.

To load a grain profile:

 ➤ In the Add Grain or Remove Grain UI, click the Load button and select
a grain profile.
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Pulling Keys and Creating
Mattes

Topics in this chapter:

■ Keying Concepts on page 509
■ Keying Workflow on page 512
■ Extracting a Key Using the Diamond Keyer on page 514
■ Creating a Difference Matte Using the Difference Tool on page 517
■ Extracting a Key Using the Luma Keyer on page 518
■ Removing Color Spill with Color Curves on page 519
■ Keyer Super Tool on page 522

Keying Concepts
Understanding the concepts that are fundamental to the workflow and tools
used for keying will help you work efficiently and effectively, producing the
cleanest, most convincing result.

You can create composites by defining transparent regions in a foreground
image, based on a specific range of color, to reveal a background image. This
keying process is usually performed on footage with a subject in front of a blue
or green screen. When you key out a color, you generate a matte: a black and
white template indicating which parts of the image are transparent (black), and
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which are opaque (white). Using techniques, such as softening the edge of
mattes, you can refine the results to create realistic composites.

Keying
Keying is the process of isolating a region of an image by selecting pixels of a
particular color and making those pixels transparent, or creating an alpha
channel where those pixels are located. The main purpose of using the keyer
tools in Composite is to generate mattes and remove color spill from a shot.

The two basic approaches to creating an alpha channel are based on:

■ Pixel color  The removal of pure green pixels for example.

■ Luminance  The removal of pixels that are very light.

You can also use garbage masks to key out undesired elements in an image.
However, garbage masks will be discussed in a later section as creating garbage
masks are a manual operation that involves creating paint objects or the
creation and manipulation of splines (rotoscoping)—see Masking Concepts
on page 538.

Mattes
A matte is an image used to define or control the transparency of another
image. When you pull a key, you generate a matte that defines the transparency
of the front source. There are several types of mattes.

Articulate matte  A matte whose shape changes over time and is designed
to accurately follow the contours of the object to which it corresponds.

Complementary matte  The matte that results when the primary matte is
inverted.

Difference matte  A matte created by subtracting an image in which the
subject is present from an otherwise identical image in which the subject is
not present.

Edge matte A matte that includes only the outlines or borders of an object.

Fixed or static matte  A matte that does not change position or shape over
time.

Garbage matte  A matte that isolates unwanted elements from the primary
element in an image. Garbage mattes are also referred to as garbage masks.

510 | Chapter 22   Pulling Keys and Creating Mattes



Hold-out matte  A matte that prevents a foreground element from completely
obscuring an object in the background.

Traveling matte  A matte that changes position or shape over time.

Color Models
A color model is a means of identifying colors in a source according to its
component parts.

RGB  A color model that defines pixels according to red, green, and blue
channel values.

Hue
A specific color from the color spectrum, disregarding its saturation or value.

Saturation
The brilliance or purity of a given color. For example, the difference between
a pastel and a pure color is defined by the amount of saturation.

Chrominance
Chrominance is an image processing property that defines the hue and
saturation of a pixel.

Luminance
Luminance is an image processing property that defines the brightness of a
pixel. Expressed in percentages, 0% luminance is black and 100% luminance
is white. Values between 0 and 100% define a range of grays. Colored pixels
have a luminance value equivalent to the mean of their RGB values.

Sharpness
Sharpness can be defined as the visual sense of the abruptness of an edge. It
highlights the detail in an image or image sequence.
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Softness
Colors that fall within the softness range are partially transparent. These areas
appear gray (a dark gray to light gray range) in the matte. For example, softness
makes the transition between the foreground and background of a composition
more convincing by softening what would otherwise look like an abrupt
cutout. Softness can also be used to retain transparent key-in materials or
shadows that you want to appear in the result composition.

Tolerance or Threshold
The colors that fall within the tolerance or threshold range are transparent.
These areas appear black in the matte.

Computer Generated Imagery
Images created or generated with a computer are referred to as Computer
Generated (CG) images.

Keying Workflow
The procedures and tools used to pull a key depend on the source material
you are working with, and on the complexity of the task. For example, sources
shot under ideal lighting conditions with good contrast between the key-in
and key-out content can be done very quickly. Other sources, with varying
lighting conditions, fine detail at the edges of the key, dramatic camera
movement, and other problem areas can take much longer to produce a clean
result. Make sure you understand what keying task, or keying tasks, need to
be performed so you can select the keying tools and the order of the keying
tasks that will produce the best result.

This chapter provides some keying scenarios using different keying tools to
help you understand how to use the tools. When you pull a key, you may not
necessarily need to perform all the keying scenarios in the order presented.
Moreover, there will be instances where one tool may provide you with a
clean key, and other times where a combination of keying tools will be needed
to generate the desired keying result.
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Selecting Keying Tools
When you key an image or an image sequence, you can use a keyer or a
collection of keying tools to generate a matte or remove color spill from a
shot. You may also need to generate more than one key to achieve the desired
result.

To access the Keying tools:

1 Press the tilde key (~) or middle-click to display the Gate UI.

2 Swipe through the east gate to display the Tools tab.

3 Expand the Keying tool folder to access the Keying tools.
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The Keying tools include Color Curves, Diamond Keyer, the Difference
tool, and Luma Keyer.

To add a keying tool to the process tree:

1 From the Tools tab, drag a keying tool to the process tree in Schematic.

2 Drag the Keying tool over the output of a node that you wish to key.
When the connection is highlighted, release the mouse.

The keyer tool is added to the process tree.

Extracting a Key Using the Diamond Keyer
The Diamond Keyer lets you extract keys in several different ways. You can
pull a key based on:

■ Pixel luminance values

■ Shadows, midtones, or highlights

■ Color channels

■ Pixel color

The Diamond Keyer
The Diamond Keyer tool is divided into four areas:

(a) Keyer Tools (b) Channel/Range Definition (c) Hue Cube (d) Luminance settings

The Keyer Tools area contains the following parameters:
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To:Use:

Plot a pixel or range of pixels to key in an image.Plot Color

Set tolerance range based on current value of a sampled pixel or range of
pixels.

Tolerance

Set softness (of the matte edge) range based on current value of a sampled
pixel or range of pixels.

Softness

The Define area contains the following tools:

(a) Color Channels select (b) SMH select

To:Click:

Remove that color from the image.RGB or CMY but-
tons

Key a luminance range. Use these controls to extract a key based
on an element's Z-depth information (grayscale value).

Shadows,
Midtones or High-
lights buttons

The Hue Cube allows you to visualize and manipulate color tolerance and
softness.
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(a) Plotted color within tolerance range (b) Softness wireframe diamond (c) Tolerance
wireframe diamond

You can drag the three control points of the tolerance wireframe diamond to
cover more or less of the hue spectrum.

To solve problem areas, use the Key Color eyedropper to plot a color in the
image. The sampled color is indicated by an orange dot in the hue spectrum.
By moving the control points of the tolerance line, you can add the plotted
color to, or remove the plotted color from, the tolerance range.

To increase the softness click the +eyedropper next to the softness parameter
and sample the image. To decrease the softness, click the – eyedropper next
to the softness parameter and sample the image.

In all cases, the values sampled are added to the current softness range. The
corresponding hue and luma ranges are sampled. This range is indicated by
yellow wireframe lines in the hue spectrum.

You can adjust the softness in the hue spectrum by dragging the three control
points of the softness line to cover more or less of the hue spectrum.

To solve problem areas, use the same method as you would for tolerance
problems. Use the Key Color eyedropper to plot a color in the image. The
plotted color is indicated by an orange dot in the hue spectrum. By moving
the control points of the softness line, you can add the plotted color to, or
remove the plotted color from, the softness range.

The luminance Settings area contains the following parameters:
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(a) Tolerance sliders (b) Tolerance and Softness value fields (white range) (c) 1.0 white
indicator (d) Softness sliders (e) 0.0 black indicator (f) Sharpness value field
(g) Tolerance and Softness value fields (black range)

To:Use:

Change the tolerance's luma range (drag the cursor or enter a value in
the Tolerance value field).

Tolerance

Change the luma range of the softness (drag the cursor or enter a value
in the Softness value field).

Softness

Change the sharpness of a key. Sharpness filters the softness range in-
dependently of the pixel sampled from the key-in composition. There-

Sharpness

fore, the softness range is filtered according to its luma values in the
generated matte. Increasing sharpness reduces softness, decreasing
sharpness increases softness.

NOTE Tolerance, Softness and Sharpness are animatable attributes—see Marking
Attributes for Keyframing on page 674.

Creating a Difference Matte Using the
Difference Tool
The Difference tool lets you generate a matte image from two source images
with the same background, but different foreground elements. This allows
you to remove an image from one context and add it to another. You can
even generate a composite image while creating the difference matte.

When you generate a difference matte, the difference between corresponding
pixels of the two source images is calculated. The value of the pixel in the
back image is subtracted from the value of the corresponding pixel in the
front image, and the resulting value is used in the difference matte.
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The Difference tool contains the following parameters:

(a) Channels (b) Tolerance value fields for RGB channels (c) Softness fields for RGB
channels (d) Gain and Lift adjustment

The matte is created using Tolerance and Softness values. The Tolerance value
specifies the difference level that is considered black. A high Tolerance value
includes more black in the matte. The Softness value is used to soften the
transition between the light areas and the dark areas of the matte by adjusting
the amount of gray at its edges. Gray information is not included in the matte
when the Softness is zero. Use a high Softness value to increase the gray.

Choose one or more color channels to use for the difference matte, and then
set the tolerance, softness, gain and lift.

Extracting a Key Using the Luma Keyer
The Luma Keyer computes the luminance of the image and removes pixels
based on a threshold value, affecting the alpha channel. The softness value
can be added to set some fall-off for the key. When the softness is 0, only the
pixels that fall within the tolerance range are keyed out. The luminance keyer
can either output a matte or a pixel selection.

The Luma Keyer UI has four controls.

To:Use:

Select the luma or the color channel luminance that will be used to pull
a key.

Channel
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To:Use:

Set the range of pixels to key based on the threshold range.Key

Set the range of the pixels to key. Increasing the threshold removes less
prevalent pixels from the composition.

Threshold

Soften the edge of the key.Softness

NOTE Key, Threshold, and Softness are animatable attributes—see Marking
Attributes for Keyframing on page 674.

Removing Color Spill with Color Curves
Color Curves lets you remove color spill by either suppressing a sampled color,
by modifying the red, green, blue, or hue, by modifying the saturation or by
modifying the luminance of the selected color, or by shifting the hue of a
color range to a sampled hue shift target. Each curve in Color Curves is a hue
gradient. When you change the shape of a curve, the colors along the curve's
gradient change to reflect the result. For example, if your hue shift target is
magenta, as you raise the green portion of the default hue shift curve, it
gradually becomes magenta, becoming fully magenta when you reach the full
value (75%).

Because the Color Curves affects the RGB and is applied to the output of a
keyer tool, your process tree should include as a minimum, a source and a
keyer.

While working on RGB, you can:

■ Shift the hue of a color range to a sampled hue shift target.

■ Suppress a sampled color.

■ Modify R, G, B, saturation, and luma.

The Color Curves UI is divided into three areas.
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(a) Channels (b) Curves window (c) Color Targets

To:Use:

Select which color curve you want to manipulate.Channels controls

Adjust the curve by manipulating its control points and tan-
gents. For more precise work, add and delete control points by

Curves window

using the + and - hotkeys when your cursor is in the Curves
window.

Plot the target color for a hue shift or a color suppression. Use
the Plot color pot to reference any color in the image.

Color Targets color
pots

NOTE Color Target color pots are only used with the Hue and Suppression
channels.

Shifting the Hue of a Color Range to a Sampled Hue
Shift Target
You can use Hue Shift to compensate for colors in an image that are too hot
or too cool, or to correct undesired tones present in the image.

Shift the Hue of a Color Range to a Sampled Hue Shift Target by using the
Hue toggle button in the Channels area to activate the hue shift curve. Use
the Hue Shift color pot in the Color Targets area to set a hue shift target color
using the color picker.

With the hue shift target set, modify the shape of the hue shift curve along
the hue range that you want to shift by selecting and manipulating the curve's
control points and tangents—see Hotkeys on page 817.
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Suppressing a Sampled Color
Unwanted color can be caused by factors such as inconsistent lighting
conditions during a shoot. This can result in images that contain unnatural
looking colors or one predominant color, which gives the image an unwanted
color cast. You can suppress the unwanted color using the Suppression feature
in the Color Curves.

Use the Suppress toggle button to activate the color suppression curve. Use
the Color Suppression color pot next to the Suppress button to set a color
suppression target using the color picker.

With the color suppression target set, modify the shape of the color suppression
curve along the hue range that you want to suppress.

Modifying the R, G, B, Saturation, and Luma
To increase the probability of pulling a good key, you can modify the levels
of the RGB channels, saturation and luma.

Toggle the Red, Green, Blue, Saturation, and Luma buttons to activate their
corresponding curves. Manipulate the shape of each curve over the source
hue range that you want to affect. The value of the parameter that corresponds
with the curve changes relative to the height of the point along the curve in
the curve editing area.

Each curve is a hue gradient and as the shape of the curve changes, the colors
along the curve's gradient change to reflect the result. For example:

■ Raising the luma curve over the green hue range, the green curve along
that range becomes brighter—the luma value increases (RGB values increase
together).

■ Lowering the blue curve over the magenta hue range, the blue curve over
that range becomes red—the blue (B channel only) value decreases.

Modifying Luma
While working on luma, you can modify the R, G, B, saturation, and luma
along the luma range.

You can toggle the Red, Green, Blue, Saturation, and Luma buttons to activate
their corresponding curves. Manipulate the shape of each curve over the luma
range that you want to affect. The value of the parameter that corresponds
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with the curve changes relative to the height of the point on the curve in the
curve editing area.

Each curve is a hue gradient and as the shape of the curve changes, the colors
along the curve's gradient change to reflect the result. For example:

■ Raising the blue curve over the darker luma range, the curve along that
range becomes bluer (for all pixels with a lower mean luma value, the blue
channel value increases—the result in the image is that blue is added to
the shadows)

■ Lowering the saturation curve over the lighter luma range, the saturation
curve over that range desaturates (for all pixels with a higher mean-luma
value, the saturation value decreases—the result in the image is that
highlights wash out).

Keyer Super Tool
The Keyer super tool provides you with an envelope to perform all keying
tasks. The Keyer super tool also provides increased flexibility with the option
of adding more tools (or removing existing ones) from the super tool
schematic.

About the Keyer Super Tool
The Keyer is a super tool that combines a Screen Degrain, Master Keyer matte
generator, Cleanup Alpha tool, Edge tool, Garbage Mask, and a Spill & Blend
operator in one tool.

Using the Master Keyer matte generator, you can make parts of an image
transparent by selecting and isolating regions of color. This process creates an
alpha channel matte, which is then used to composite the image over a new
background.

With the Master Keyer matte generator, you can refine the key by gesturally
modifying the matte, removing color spill, blending edges, applying patches,
and removing grain.

The following are examples of typical uses for the Keyer supertool:

■ Pulling a rough matte

■ Refining a matte
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■ Refining the edges of a matte

■ Degraining a key in image

■ Spill suppression

■ Improving the blend between the front and back images.

■ Compositing using a matte

Supported Features
The Keyer supertool supports the following features and functionality:

■ Quick selection of Keyer nodes

■ Adding and changing tools in the Keyer schematic

■ Master Keyer matte generator with on-screen manipulation

■ Unlimited patches

■ Screen Degrain

■ Spill suppression and Blend

■ Compositing of foreground and background via generated matte

Inputs and Outputs
The Keyer super tool has three image inputs and three outputs.

Double-click the Keyer super tool node, or right-click the node and select Edit
Group to expand the Keyer.
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The Front input image is despilled by the Spill & Blend tool node. The result
is sent to the Result node (an instance of the Set Alpha tool) to become the
RGB channels of the RGBA Output Image output.

The Front input image is processed first by the Screen Degrain tool node, then
by the Master Keyer matte generator. The resulting matte is then sent to the
Cleanup Alpha node, then to the Edge node, and that result to the Garbage
Mask node. The output of the Garbage Mask node is sent to the input of the
Result node to become the alpha channel of the RGBA Output Image output,
to the Comp tool as the matte input, and is also outputted directly as the A
Output Image.

The Back input image is sent to the Back input of the Comp tool node (an
instance of the Blend & Comp tool). The Comp tool node provides a composite
of the spill-suppressed front over the back, through the processed matte, both
as a user convenience, and also as output on the Comp Output Image output.

Workflow
The following sequence of actions is a recommended workflow for keying an
image with the Keyer supertool. You may not need to complete all the
procedures. You may also revisit procedures as you develop the key.

■ Generate and refine a matte using the Master Keyer matte generator
controls.

■ Create any necessary patches to remove unwanted gray areas from the
matte.

■ Refine the matte using the Edge and Cleanup Alpha tools.

■ If the image is grainy, apply the Screen Degrain algorithm.

■ Remove any color spill.

■ Improve the blend between the front and back images.
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In the most common use case, the key color you sample will be the one used
for screen degraining and spill and blend adjustments. To provide quick
workflow, the Master Keyer, Screen Degrain and Spill & Blend initially created
by the Keyer super-tool all share the primary and secondary key colors, and
mix values of these samples.

If you don't like this key color sharing, the Master Keyer, Screen Degrain and
Spill & Blend are all available as separate tools, and there you can set colors
separately for all three.

Keyer Supertool UI
The Keyer super tool UI is composed of five areas:

(a) Quick Selection of Keyer nodes (b) Master Keyer matte generator controls and
Sample menu (c) Patch controls (d) Screen Degrain controls (e) Spill and Blend controls

To reset the Keyer tool:

 ➤ Click on the Reset button in the Tool Options area located on the far
right of the Tool UI.

Node Select
A set of user-definable radio buttons is presented at the left of the Keyer UI.
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The first four buttons are pre-defined to select the Keyer itself, the Clean Up
Alpha, the Garbage Mask, or the Edge tool respectively. Selecting the node
button will display the UI of the given tool, as well as set the display of the
Animation editor, and the composition browser. All buttons except the first
can be defined or redefined to select other nodes (and their UIs) in the Keyer
schematic by clicking them with the Control key pressed. This will assign the
button to the currently-selected node.

For example, if you selected the CC Basics node, you would then CTRL-click
the node select button you wish to assign to it.

Generating a Matte with the Master Keyer
Using the Master Keyer controls, you can generate and refine a matte for your
chroma key.
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To generate and refine a matte with the Master Keyer:

1 Set a Player view to Tool Output and, with the selection on the Keyer
super tool node, cycle to the Comp Output of the Keyer—see Cycling
Through Inputs and Outputs on page 71.

2 Select Matte from the Sample menu or press M.

(a) Primary sample color pot (b) Mix field (c) Secondary sample color pot (d) Patch
list (e) Mode menu (f) Range/Softness sliders (g) Reset button (h) Sample menu

3 Click the Primary Sample color pot and sample the image. Click the image
to sample a single pixel, or use Ctrl + drag to sample a larger area.

4 Click the Secondary Sample color pot and then sample the image. Sample
an area where you do not want any softness in the matte.

5 Drag in the Mix field to adjust the mix between the primary and
secondary sample. Drag right to include more of the secondary sample
or left to include less.

6 Gesturally refine the matte. In the image window, click an area of the
matte that you want to refine; only those parameters that pertain to the
area you click appear. Parameters are displayed in order of importance,
from top to bottom (those that are brightest and at the top have the
greatest effect on the image). You can then modify a parameter by
dragging its highlighted slider.
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■ To add softness, drag a slider to the right.

■ To remove softness, drag a slider to the left. The red indicator shows
the original value and the yellow indicator shows the current value.

7 To modify more than one parameter, move the mouse between the
parameters until the cursor changes to a double arrow, or drag vertically.
When you highlight the parameter you want to adjust, drag the slider.

8 When you are finished modifying the displayed parameters, click another
area of the image without highlighting a parameter to hide them.
Alternatively, you can press Esc. The parameters are no longer displayed.

9 Repeat steps 6 to 8 in other parts of the matte to further refine it. Only
the parameters that apply to the problem area will appear.

10 To scroll through the image and display the pertinent parameters, use
Alt+ drag the image without clicking it. The parameters update as you
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drag. You can then modify the displayed parameters by clicking the image
and dragging the highlighted slider.

NOTE To reset Matte parameters, click the Reset button under the Master
Keyer UI. All matte parameters are reset, except the Mix field and the key
colors.

Removing Unwanted Grays Using Patches
If you have unwanted gray areas in the matte, you can use patches to isolate
a range of colors to be included in, or excluded from, the key.

NOTE Patch parameters are animatable.

To remove unwanted grays using patches:

1 Set a Player view to Tool Output and, with the selection on Keyer super
tool node, cycle to the alpha output—see Cycling Through Inputs and
Outputs on page 71.

2 Select Patch from the Sample menu or press Shift + the number associated
with the patch. For example, Shift + 1 for Patch 1.

3 Select Patch 1 or create a new patch from the Patch menu.

Removing Unwanted Grays Using Patches | 529



NOTE You can create an arbitrary number of matte generator patches. The
number of patches starts at one, and new patches can be created. Although,
in theory, there is no limit to the number of patches, in practice, there are
diminishing returns in terms of matte quality when adding new patches.

4 Sample the image where you want to apply the patch. To sample a single
pixel, click the image. To sample an area of the image, Ctrl + drag a
selection box.

When you Ctrl + drag to sample, the Patch button is selected and the
appropriate patch mode appears in the Patch box and is applied to the
image.

Is applied to:Selected
Patch:

Areas of the image to be included in the black part of the matte.Black

Areas of the image to be included in the white part of the matte.White

Areas of the image that are along the edge of the key. Edge Analysis is
useful when there is a specific edge you want to erode but cannot do

Analysis

so with the Matte parameters. You can then increase or decrease the
softness of this patch using the Softness slider.

5 To add more color to the patch, resample the image.
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6 To use the same patch but start with a new sample, press Ctrl + Alt + drag
the image.

7 To manually select a patch type, select it from the Patch box.

NOTE If you want to reset the patch, so you can automatically select the
patch type, you must disable the patch and set the patch type to Off. You
can then resample an area in the image and generate a patch type.

8 To improve the patch, use the Patch controls.

To:Drag:

Increase or decrease the color range that is included in the patch.Range

Soften the edge.Softness

NOTE To reset Patch parameters, click the Reset button under the Master
Keyer UI.

Degraining the Key In Image
Graininess can make it difficult to pull a clean and effective key. With the
Screen Degrain controls you can remove film grain, modify the size of the
grain, and desharpen the edges of the key. The front image is not affected
when you apply Screen Degrain to the Front input image.

NOTE Screen Degrain parameters are animatable.

To remove grain from the key in image using Screen Degrain:

1 Set a Player view to Tool Output and, with the selection on the Keyer
super tool node, cycle to the A or Comp Output—see Cycling Through
Inputs and Outputs on page 71.

2 Select Degrain from the Sample menu, or press D.
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3 Sample a grainy area of the image. To sample a single pixel, click the
image. To sample an area of the image, Ctrl + drag a selection box. Once
the image is sampled, Screen Degrain is automatically enabled and grain
is removed from the image.

4 Drag in the Screen Degrain fields to modify the grain size and restore
edge sharpness.

To:Use:

Enable the degrain algorithm.Enable

Enable RGB to degrain on all channels. The degrain algorithm is optim-
ized for blue screen degraining.

RGB

Estimate the size of the grain in the image.Grain Size

Unsharpen the edge of the image. By default, Degrain sharpens the
edges. Use the Edges field to restore the natural look of the edges in
the image.

Edges

5 If you are not satisfied with the result, you can start over with a new
sample, and then adjust the Screen Degrain fields. To resample an area
of the image, Ctrl + Alt + drag the image.

NOTE You can also reset Screen Degrain parameters. To reset Screen Degrain
parameters, click the Reset button under the Screen Degrain UI.

6 If resampling the image and adjusting the Screen Degrain fields does not
sufficiently remove grain, select RGB to increase the overall effect of
Screen Degrain.
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Suppressing Spill
After you create a key and key out any trouble areas, some of the background
color may have spilled over the edge of the key. Use the Spill controls to
suppress or disguise color spill in the front image.

To gesturally remove color spill:

1 Set a Player view to Tool Output and, with the selection on the Keyer
super tool node, cycle to Comp Output—see Cycling Through Inputs and
Outputs on page 71.

2 Select Spill from the Sampling box or press S.

3 Remove any color spill. Click anywhere in the Player, and modify the
parameters that appear by dragging the sliders; you do not need to click
a specific area.

To:Drag:

Set the range for the removal of color spill along the edges of the key.
Drag right to soften the edge and remove color spill further into the
key. Drag left to harden, or create a thinner, edge.

Range

Modify and suppress colors that are adjacent to the primary sample.Hue

NOTE To reset Spill and Blend parameters, click the Reset button, below the Edge
Balance trackball.

Modifying Blend
Using the Blend parameters you can gesturally modify the luminance at the
edge of the key, so that it blends with the luminance in the background image.
For example, when the front image is darker than the back image, you can
use the Blend parameters to lighten the edge of the key.

With the Blend Luminance controls, you can adjust the edge blending and
maintain the edge detail. Adjusting the Edge Size amount uses pixel analysis
to determine the extent of the adjustment.
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To blend the front and back images:

1 Set a Player view to Tool Output and, with the selection on the Keyer
super tool node, cycle to Comp Output—see Cycling Through Inputs and
Outputs on page 71.

2 Select Blend from the Sample menu or press Shift + B.

3 Blend the front and back image. Click anywhere in the image window,
and modify the parameters that appear by dragging the sliders; you do
not need to click a specific area.

To:Drag:

Darken or lighten the edge of the key. Luminance only affects the luma
of the edge.

Luminance

Set the range for the blend. Drag right to soften the edge and blend
further into the key. Drag left to harden, or create a thinner edge.

Edge Size

534 | Chapter 22   Pulling Keys and Creating Mattes



4 To modify both parameters, move the mouse between them to highlight
a parameter, or drag the pen vertically. When you highlight the parameter
you want to adjust, drag the slider.

NOTE If you do not like the result, you can click Undo to reset parameters
after you complete an operation.

5 When you are finished modifying the displayed parameters, click another
area of the image without highlighting a parameter to hide them or press
the Esc key.

6 To add a cast to the edge of the key and improve the overall look by
matching the edge with a color cast in the back image, drag the Edge
Balance trackball toward the color you want to add. The trackball only
affects the chroma of the edge.

Modifications made using the trackball are cumulative; each movement
of the trackball is added to the previous one.

NOTE To reset Spill and Blend parameters, click the Reset button, below the
Edge Balance trackball.
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Masking

Topics in this chapter:

■ About Masking on page 537
■ Masking Concepts on page 538
■ Garbage Mask Tool Tabs on page 538
■ Creating Masks on page 540
■ Editing Masks on page 543
■ Transforming Masks on page 548
■ Creating and Editing Edges on page 554
■ User Settings on page 555
■ Output Tab Settings on page 558
■ Options Tab Settings on page 559
■ Pixel Masking on page 560
■ Masking Parameters on page 561

About Masking
Masking is the process of hiding a region of an image. You can use masks to
remove the area outside the mask shape and keep the area inside the mask
shape, or you can use masks to remove the area inside the mask shape and keep
the area outside the mask shape.
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Pixel Masking lets you temporarily isolate specific areas of the footage. You
can apply effects to the selected area of an image without affecting the rest.

Masking Concepts
You can use garbage masks to key undesired elements in an image and to do
rotoscope work. A garbage mask affects the image's alpha channel, which is
where the transparency information is stored. You can use a mask to create
the alpha channel, or you can use a mask to add to an alpha channel.

Garbage matte  A matte that isolates unwanted elements from the primary
element in an image. Garbage mattes are also referred to as garbage masks.

Auto Tangent  When selected, the mask is created with tangents.

Intensity  Defines the alpha value defined by the mask.

Opacity  Defines the transparency of the mask.

Invert  The area outside of the mask is covered by the garbage mask settings.

Edge Distance  The inner or outer offset from the edge of the mask.

Edge Position  The position of the edge handle from the first control point
of the mask.

Edge In/Out  The inner/outer offsets from the edge of the mask.

Garbage Mask Tool Tabs
The Garbage Mask is a three-tabbed tool consisting of Garbage mask
controls—see Creating Masks on page 540, Global Composite Output
controls—see Output Tab Settings on page 558, and the Options tab—see
Options Tab Settings on page 559.
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Garbage Mask Controls
The Garbage Mask tab consists of the following controls and parameter settings:

Mask List  The Mask List displays all the masks that have been created for
the current composition. It also displays some of the masking parameters and
navigation buttons.

To:Use:

Activate the Solo flag to isolate a mask. Only one
mask can be isolated at a time.

Activate the Visible flag.

Activate the Lock flag. Locking a mask locks the
points, shape, edges, tangents, and composite
parameters.

Change the name of a mask. With the cursor in the
text field, press F2, type in a new name and press
Enter.

Set the opacity of the mask.

Set the intensity of the mask.

Invert the mask.

Select a compositing operator. The default is the
Over mode—see Compositing Operators on page
563.
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To:Use:

Reset the Comp operator, Opacity, Intensity and
the mask Invert toggle of selected masks.

Move selected masks to the bottom of the Mask list.

Move selected masks down one place in the Mask
list.

Move selected masks up one place in the Mask list.

Move masks to the top of the Mask list.

Duplicate selected masks. The duplicate appears
over the selected mask in the Player.

Delete selected masks.

Creation Tools  Use the following Creation tools to draw garbage masks.

To:Use:

Create freeform Bézier spline shapes.

Create freehand shape.

Create rectangular shapes. These shapes can be a
square, fixed size, proportional, or unconstrained.

Create elliptical shapes. These shapes can be a circle,
fixed size, proportional, or unconstrained.

Creating Masks
When you select a Creation tool, default values for future masks are made
available for modification. These default values are initially set to the previously
saved values. You can reset default values in each Garbage Mask tab by selecting
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the Factory Default button—see User Settings on page 555. You can change
the following parameters once a Creation tool is selected:

■ Garbage mask Name

■ Opacity (animatable)

■ Intensity (animatable)

■ Smoothing

■ Invert (animatable)

■ Compositing Operator—see Compositing Operators on page 563.

■ Correlation. Specify how input mattes are correlated. This can be used to
improve the quality of the composite in special cases. For example, if you
composite two mattes that share a good portion of their outline, you should
indicate if they are Adjacent or Superposed. By default, the correlation
mode is None, assuming that normally, the input mattes are not correlated.

■ Mask Color and Auto Mask Color toggle

■ Initial In/Out Edge distance

■ Edge Color

To create a shape using the Freeform tool:

1 Select the Freeform tool button or press D.

2 Set initial mask parameters if necessary.

3 Click and drag on the image in the Player to place the first control point
and adjust the tangent (if not in Auto Tangent), or (if in Auto Tangent)
to move the point.

4 Move the cursor to the location where you want the next control point
to be and click.
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5 Continue to click in the image to add more control points.

6 To close the shape, click on the first control point you created, or press
Enter. If you hold Ctrl + Alt, the shape will be closed in Auto Tangent
mode.

Once the first control point has been created using the Freeform tool, the
garbage mask is automatically set to edit mode.

NOTE If you are not in Auto Tangent mode and want to create several points in
Auto Tangent, hold Ctrl + Alt when creating the points.

To create a rectangular mask:

1 Select the Rectangle tool button or press S.

2 Set initial mask parameters if necessary.

3 Select Rectangle Options settings if necessary. These options include:

To:Use:

Click and drag the cursor to draw the mask from the center of
the first mouse/pen click.

From Center

Create an unconstrained mask. Click and drag to draw and change
the shape of the mask.

Unconstrained

Click and drag to draw a perfect square.Square

Create a rectangular mask based on width and height values you
set. Once the values are set, click the location in the image you
want the shape to appear.

Fixed Size

Create a rectangular mask based on width and height proportions
you set. Once the values are set, click and drag to create the
shape.

Proportional

542 | Chapter 23   Masking



To create an elliptical mask:

1 Select the Elliptical tool button or press W.

2 Set initial mask parameters if necessary.

3 Select Ellipse Options settings if necessary. These options include:

To:Use:

Click and drag the cursor to draw the mask from the center of
the first mouse/pen click.

From Center

Create an unconstrained mask. Click and drag to draw and change
the shape of the mask.

Unconstrained

Click and drag to draw a perfect circle.Square

Create an elliptical mask based on width and height values you
set. Once the values are set, click the location in the image you
want the shape to appear.

Fixed Size

Create an elliptical mask based on width and height proportions
you set. Once the values are set, click and drag to create the
shape.

Proportional

Editing Masks
Once you create a mask, you can use different tools to modify it. As the portion
of the image that you are masking changes over time, you will need to adjust
the points of the mask to exactly match the image. The mask editing options
can be applied to a single point, a group of points, a single shape, or a group
of shapes by:

■ Selecting a point or group of points in the Player.
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■ Selecting a shape or group of shapes from the mask list.

■ Selecting a shape or group of shapes in the Player.

There are two mask editing tools in the Garbage Mask UI; the Point tool and
the Transform tool.

Use the Point tool to edit mask points. Depending on what hot key is pressed
and on the location of the mouse cursor, the mouse cursor updates and displays
a visual cue for the current edit mode.

You can nudge the position of selected mask control points, selected shapes,
and edge handles (in increments of one pixel) by holding down the Shift key
and pressing the arrow keys on the keyboard. To nudge the position of control
points, selected shapes, and edge handles in increments of 10 pixels, hold Ctrl
+ Shift and press the arrow keys on the keyboard.

The following mask point parameters (for each point) can be animated. They
are accessible from the animation timeline and expressions can be assigned
to all of them:

■ X

■ Y

■ Tangent In angle

■ Tangent In Distance

■ Tangent Out angle

■ Tangent Out Distance

NOTE Tracking information can be assigned to point position—see Tracking and
Stabilizing on page 753.

To insert a control point:

 ➤ Press and hold the Alt key and click on the curve dragging the point to
move it.

544 | Chapter 23   Masking



To delete control points from a mask:

 ➤ Press and hold the Alt key and click on the control point you want to
delete or, select points and press the Delete key.

To move control points:

 ➤ Do one of the following:

■ Click and drag a control point. Hold Ctrl + Alt while moving the point
to move in Auto Tangent mode.

■ Click or drag a bounding box around a point to select the point. Type
the position values into the X and Y value editor under the Position
label and press Enter.

■ Click or drag a bounding box around a point to select the point. Click
+ drag inside the value editor.
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To add or delete tangent handles:

 ➤ Press and hold the Ctrl key and click on the control points to go from a
sharp curve to a smooth curve with tangent handles and drag to adjust
the tangents. Press and hold the Ctrl key and click on the control point
a second time to delete them.

To adjust the length of a single unbroken tangent handle:

 ➤ Do one of the following:

■ Click and drag the handle.

■ Type the distance value into the In Dist or Out Dist value editor under
the Tangent label and press Enter.

■ Click + drag inside the value editor.
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To adjust the length of both sides of an unbroken tangent handle:

 ➤ Hold the Alt key and drag the handle. When you press Alt and drag an
unbroken tangent handle, both tangent handles are automatically given
the same length.

To break a tangent handle:

 ➤ Press Ctrl then click and drag the handle. Press Ctrl then click and drag
the handle again to make the handle continuous.
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To move a curve between points:

 ➤ Hold Ctrl + Alt over the location on the curve you want to move then
drag the curve. The curve and tangents adjust accordingly based on the
location of the cursor.

Transforming Masks
Once your mask is created, use the Transform tool to fine tune its position,
shape, and size. You can manipulate the mask inside the player. These settings
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can also be animated. Once you select the Translate tool, the following
parameters are displayed:

The following mask shape Transform parameters can be animated. They are
accessible from the animation timeline and expressions can be assigned to all
of them:

■ Translation X

■ Translation Y

■ Rotation R

■ Scale X

■ Scale Y

■ Pivot X

■ Pivot Y

■ Pivot R

NOTE Tracking information can be assigned to shape transformation—see Tracking
and Stabilizing on page 753.
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To:Use:

Translate the mask in the X and Y direction.Translation X,Y

Add an offset to the translation of a garbage mask.Offset X,Y

Rotate the mask.Rotation

Change the mask's X or Y scale (or both with Link enabled).Scale

Adjust the X and Y location of the mask's center of rotation/scaling.
Use the Center button to set the pivot point to the center of the
mask's bounding box.

Pivot

Reset all the transform parameters to their initial values.Reset

To translate the mask:

 ➤ Do one of the following:

■ Place the cursor inside the mask's bounding box, and click + hold and
then drag the mask to translate in any direction.

■ Type the position into the X, Y value editors and press Enter.

■ Click + drag inside the value editor.
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To add an offset to the translation of a mask:

 ➤ Do one of the following:

■ Type the offset position into the X, Y value editors and press Enter.

■ Click + drag inside the value editor.
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To rotate a mask:

 ➤ Do one of the following:

■ With the cursor over the rotation handle, rotate the mask.

■ Type the angle of rotation (in degrees) into the Rotation value editor
and press Enter.

■ Click + drag inside the value editor.

To scale a mask:

 ➤ Do one of the following:

■ With the cursor over the one of the mask's resize handles, click + drag
the mask.

■ Type the X and Y scale values into the X and Y Scale value editors
and press Enter.

■ Click + drag inside the value editor.
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To adjust the X and Y location of the mask's center of rotation (pivot point):

 ➤ Do one of the following:

■ With the cursor over the mask's pivot handle, click + drag the mask.

■ Type the X and Y pivot position values into the X and Y Pivot value
editors and press Enter.
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■ Click + drag inside the value editor.

Creating and Editing Edges
If you have not set initial edge gradient parameters before creating a mask
shape. You can do so while in edit mode.

The following mask In and Out Edge point parameters (for each edge point)
can be animated. They are accessible from the animation timeline and
expressions can be assigned to all of them:

■ Position

■ Distance

To create an edge point:

 ➤ Hold down Ctrl and click on the mask curve and drag the point. An edge
point with two handles is created.
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To change the edge distance or position:

1 Do one of the following:

■ Drag the outer edge handle towards the outside of the mask to create
an outer edge gradient, or towards the center of the mask to create
an inner edge gradient.

■ Type the distance (in pixels) into the Distance value editor and
position (relative to the first control point generated for the mask)
then press Enter.

■ Click + drag inside the value editor.

NOTE You can also multi-select several edge handles using the Shift key and
change the distance or position of more than one edge by the same value.

2 Press Alt to lock the position of the edge while changing its distance.

To change the color of an edge handle:

1 Select any shape.

2 Click the color pot under Edge Settings.

3 Select a new color from the Color Picker UI and click Set.

NOTE This operation changes the color of every edge handle in the mask.

To set the edge handle visibility to not visible:

 ➤ Click the Visible (default) button under Edge Settings.

User Settings
Each tab has a set of User Setting buttons you can use to store initial mask
parameters that can be reused during the rotoscoping process. By default, the
first time you create a mask without changing any initial settings, the mask
will have the following default settings.
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Any subsequent mask you create will inherit the same settings except for the
mask color (which by default is on Auto and picks a random color), and the
mask name instance (the next mask would be named GMask(2)).

If you change the parameters for a second mask, for example, its name, color
and toggle off the Auto Color, all masks you create afterward will retain those
parameters.

If you need to create masks with a particular set of parameters that you will
need from time to time during your rotoscoping process, use the User Settings
buttons.

To:Use:

Save initial mask parameters as a user favorite.

Reset mask parameters to a previously saved user
favorite.

Reset mask parameters to factory default settings.

Reset mask parameters to those of a selected mask
in the Mask List.

Example: User Settings Workflow
The following example procedure demonstrates the User Settings workflow
where an artist needs to create the following series of masks:

■ Default settings freeform mask.

■ Red ellipse of fixed size with Auto Color turned off and saved as a user
favorite.

■ Green rectangular mask drawn from center.

■ Freeform mask reset to default (second instance).

■ Second instance of the red ellipse (reset to user favorite).
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■ New rectangular mask (second instance) reset to the green square selected
from the Mask List.

To create a series of garbage masks working with User Settings:

1 Select the Freeform creation tool

(or press D) and draw a freeform mask using default values.

2 Select the Ellipse tool.

(or press W).

3 Change the name to Red and press Enter.

4 Select a red color and turn Auto Color off.

5 Set the fixed size dimensions.

6 Select Save As User Favorite.

7 Click once in the Player to create the mask.

8 Select the Rectangle tool.

(or press S).

9 Change the name to Green and press Enter.

10 Change the color to a green.

11 Toggle From Center

12 Click and drag in the image to create the mask.

13 Select the Freeform tool

(or press D).

14 Select Reset To Default.
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15 Create the mask in the image.

16 Select the Ellipse tool.

(or press W).

17 Select Reset To User Favorite.

18 Click once in the Player to create the mask.

19 Select the Mask named Green from the Mask List.

20 Select the Rectangle tool

(or press S).

21 Select Reset To Selected.

22 Click and drag in the image to create the mask.

Output Tab Settings
Use the Global Composite settings to specify how all masks, combined together
using their individual modes, affect the alpha channel for the selected input
source image.
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To:Select:

Choose which compositing mode will be used —see Global Composite
Operators on page 564.

Comp

Specify how input mattes are correlated. This can be used to improve
the quality of the composite in special cases. For example, if you com-

Correlation

posite two mattes that share a good portion of their outline, you should
indicate if they are Adjacent or Superposed. By default, the correlation
mode is None, assuming that normally, the input mattes are not correl-
ated.

Change the size of an image—see Crop Tool on page 410.Crop

Store initial mask parameters that can be reused during the rotoscoping
process—see User Settings on page 555.

User Settings

Options Tab Settings
Use the Options tab to set default settings for creating and editing masks.

To:Use:

Set the visibility mode of Bezier tangents. Choose from only
those tangents Selected, All, or None

Bezier Tangent Visibil-
ity

Toggle the Bezier tangent creation mode from Off to Auto
Tangent.

Auto Tangent
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To:Use:

Set how mask points will be keyframed. Choose from Selection,
Point, or Shape. If a mask control point is moved (animated)

Keyframing

the following attributes will be keyframed based on the Key-
framing mode.

■ Shape (default) X, Y positions, Tangent Angles In and
Out, and Tangent Lengths In and Out for all points of the
shape.

■ Point  X, Y position and its Tangent Angle In and Out,
and Tangent Length In and Out

■ Selection  X and Y position.

Set how the tool behaves once a shape is closed. When a
shape is closed and Create has been selected from the list, the

Default Tool

tool will revert back to the Creation tool (Freeform, Rectangle,
or Ellipse) that created the shape. If Edit is selected, the tool
will revert to edit mode. If Current is selected, the tool will
revert back to the current setting.

Store initial mask parameters that can be reused during the
rotoscoping process—see User Settings on page 555.

Options tab User Set-
tings

Pixel Masking
Pixel Masking lets you limit the effect of an image modifier to a subset of the
input pixels (those covered by the mask). All tools that support masking have
a Mask image input.

The actual masking is implemented by blending the original input with the
tool output using the pixel values in the mask as the control weights in the
blend.
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Masking Parameters
The masking parameters are in a separate tab in the Tool UI. This tab is
immediately to the right of the tool tab the mask will originate from.

To:Select:

Create an instance of a masking tool selected from the pull-down list.
The tool is created in the current composition and its output is connected

Create

to the Mask input of the current tools. The list is editable in the user
settings tab under Masking Menu Tools.

Return to the tool UI to change its parameters.Edit

Determine whether masking is enabled or disabled. By default, masking
is on.

NOTE If no image is connected to the Mask input, the value of Active
has no effect. That is, no masking is applied in any case.

Active

Invert the mask prior to using it in the blend operation. By default, Invert
is off.

Invert

Select one of R, G, B, A. This is the channel of the Mask image to be
used for masking. By default, Channel is A.

Channel

Scale the mask (after optional inversion) prior to using it in the blend
operation. By default, Intensity is 1 (full intensity).

Intensity

The list of tools in the masking tool menu contains all plug-in tools that
describe they can act as masks. The most recently used masking tool becomes
the default selection in the menu, for all maskable tools. This most recently
used masking tool is stored as a user setting.

When you add a masking tool from the masking tool input menu, it is added
to the dependency graph and its output is connected to the masked tool's
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input. If there is already a tool connected to the masking input, there are two
behaviors:

■ If the new masking tool has an image input, the current masking tool
output is disconnected from the masked tool, and connected to the new
masking tool's primary image input.

■ If the new masking tool does not have an image input, the current masking
tool output is simply disconnected from the masked tool.

NOTE A masking tool with no image input, such as a mask generator, takes its
output format and resolution from the composition settings.

The Active, Invert, Channel, and Intensity controls in the masking tab
correspond to the Masking structured input. The Image text field shows the
name of the node connected to the masking input (if any).

Pixel Masking Example
The following example illustrates how you can use several masking inputs to
perform simple color corrections (using CC Basics) on different parts of an
image.

By using the masking inputs, four color corrections (sky, water, sand, and
chairs) were quickly applied.
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(a) Original Image

(a) Sky corrected (b) Water corrected (c) Sand corrected (d) Chairs corrected

Compositing Operators
The following table lists the compositing operators applicable between
generated masks and previously composited masks:

Result:Operator

Composites the generated mask (front) over the previously composited
masks (back). The output will cover any area covered by either the front

Over

or the back. Where the front and back overlap, the output will show the
front.

Completely replaces the previously composited masks with the generated
mask.

Replace

Similar to the Over operator, but the output will cover the same area
covered by the previously composited masks.

Atop

Composites the generated mask (front) over the previously composited
masks (back), but the output will cover only the area covered by both
front and back.

Inside
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Result:Operator

The output will be equal to the generated mask (front) except that the
part of the front overlapping the previously composited masks (back) will
be missing. No part of the back will be visible in the output in any case.

Outside

The output will be equal to the previously composited mask (back) except
that the part of the back covered by the generated masks (front) will be

Cutout

missing. No part of the front will be visible in the output in any case. Ba-
sically this operator is equal to the Outside operator with the front and
back roles reversed.

Both generated mask (front) and previously composited masks (back) are
copied to the output except for the part where they overlap.

Xor

Global Composite Operators
The following table lists the compositing operators applicable between the
input image and previously composited masks:

Result:Operator

Composites the previously composited masks (front) over the input image
(back). The output will cover any area covered by either the front or the
back. Where the front and back overlap, the output will show the front.

Over

Completely replaces the input image alpha channel with the previously
composited masks.

Replace

Similar to the Over operator, but the output will cover the same area
covered by the input image alpha channel.

Atop

Composites the previously composited masks (front) over the input image
alpha channel (back), but the output will cover only the area covered by
both front and back.

Inside

The output will be equal to the previously composited masks (front) except
that the part of the front overlapping the input image alpha channel (back)

Outside

will be missing. No part of the back will be visible in the output in any
case.

The output will be equal to the input image alpha channel (back) except
that the part of the back covered by the previously composited masks

Cutout

(front) will be missing. No part of the front will be visible in the output in
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Result:Operator

any case. Basically this operator is equal to the Outside operator with the
front and back roles reversed.

Both previously composited masks (front) and input image alpha channel
(back) are copied to the output except for the part where they overlap.

Xor
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Raster Paint

Topics in this chapter:

■ About Raster Paint on page 567
■ Paint UI on page 568
■ Layer Editor on page 568
■ Paint Brush Controls and Attributes on page 569
■ Paint Stroke Controls on page 572
■ Working with Layers on page 572
■ Adding, Deleting, Clearing, and Wiping Layers on page 574
■ Layer Behavior on page 578
■ Stroke Operations on page 582

About Raster Paint
The raster paint module in Composite is represented by a supertool node. The
Paint node lets you work at any resolution, with any number of layers, and bit
depths.

The paint node contains one or many layers of raster images and the compositing
operators combine them to produce a single output image.

All operations, including painting, can be carried out while viewing the whole
composited layer stack. Painting can be applied to any layer in the stack and
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the composite view is constantly maintained. Individual layers can also be
muted selectively.

Committing and Undoing Operations
You can undo multiple paint strokes in layer-based Paint. In the context of
undo, a stroke is whatever you paint on the canvas until you commit.

Do any of the following to commit paint strokes to the undo stack:

■ Press any key.

■ Move the cursor out of the current viewport.

For example, if you use a 20-pixel brush to apply several strokes to the canvas
and then click Ctrl + Z (for Windows and Linux) or Cmd + Z (for Mac OS), all
of the strokes created with this brush are erased. On the other hand, if you
press Spacebar between each stroke and then click Ctrl + Z (for Windows and
Linux) or Cmd + Z (for Mac OS), the strokes will be erased one at a time.

Paint UI
The Paint tool UI consists of three areas:

(a) Layer editor (b) Paint brush controls (c) Stroke controls

Layer Editor
The Layer Editor lets you create layers and reorder them. For each layer, you
can apply a blending mode and set the opacity to define how it is blended
with the layer below it. You can also mute layers or use them in reveal
operations. The current layer indicates which layer is being drawn into. From
the current layer, you can also select either the front or the alpha as the target.
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(a) View checkbox (b) Reveal checkbox (c) Alpha (d) Name (e) Opacity/Blend controls
(f) Canvas controls (g) Layer controls

To:Use:

Mute or view a layer.V (view)

Conduct reveal operations with this layer.R (reveal)

Select the alpha channel to paint on.Alpha

Use Name to give the layer a name.Name

Set the layer opacity.Opacity

Set the Blend mode. Click the Blend button select a
mode—see Blend Modes on page 345.

Blend Mode

Navigate through raster layers, and copy, add, and delete
layers.

Layer controls

Clear the last committed stroke from the canvas or wipe a
new color onto the current canvas. To select a color for the

Layer Canvas controls

wipe operation, click the color pot, select a color from the
color picker, and click Set.

Paint Brush Controls and Attributes
The brushes define the look of the paint strokes. You can customize brushes
to define the look of a stroke.

The paint brush controls have the following parameters:
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■ Stamping Patterns  The brush stamping pattern is a bitmap image that
is used as a pattern to create a stroke. They can be resized from 1 pixel to
512x512 pixels. Composite comes with a set of predefined brushes and
they are stored as an image file in the Composite installation directory
under \Resources\Brushes. You can create your own brushes using
third-party software and add them to the stamping pattern list by putting
them in the \Brush folder. Brushes can be any pixel size, but every brush
will be reformatted to 512 x 512. For best results, it is best to create your
stamp patterns as 512 x 512 grayscale.tiff images, but any file format and
size supported by Composite will be accepted.

■ Color  Define the color of the paint stroke. Click a color pot and select
a color from the color picker. You can store two colors and use the toggle
button to reverse them or press X.

■ Opacity  Set the opacity (transparency) of the brush. A value of 100%
applies a fully opaque color. Use a lower value to apply a more transparent
color.

■ Size  Set the brush size. The brush size is indicated by the diameter of
the white circle surrounding the brush. To increase the brush size, hold
down the S key and drag the brush to the right on the canvas. To decrease
it, hold down the S key and drag to the left. You can also type the brush
size in the Size field or drag the value editor in the Size field.
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(a) Brush size 100, opacity 1.000 (b) Brush size 25, opacity.500

■ Rate  The brush rate is the rate at which brush strokes are applied to the
canvas. A high value produces a smooth continuous stroke, and a low
value produces a less continuous stroke with larger gaps between brush
images.

■ Constant  The stamping process can be configured by specifying the
stamping rate and forcing constant distance between stamps.

(a) Rate value = 100 (b) Rate value =20 (c) Rate value = 20 + constant
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Paint Stroke Controls
Strokes are rendered based on the brush attributes and the stencil. The stroke
shape is formed by stamping the brush shape along the path created by the
pen (or mouse) movement.

The paint stroke controls have the following parameters:

■ Operation  Paint materials define the material used to render the brush.
Materials include: Paint (default, solid color), Reveal, Clone and Erase.

■ Pressure  When drawing with a tablet, the pressure can be mapped to
the size, opacity, or both (or can be set to Off) of the stamping pattern
while drawing.

■ Blend  The blending modes define how the stroke is blended with the
current drawing—see Blend Modes on page 345.

■ Matte Off & Invert  You can use stencils to apply paint strokes to an
image—see Using Stencils on page 592.

Working with Layers
A raster paint layer is a canvas into which you draw strokes. The strokes are
merged together as they are drawn to produce the resulting raster image. Each
layer has a front and an alpha. You can select the one on which you want to
draw by selecting its proxy image in the Layer Editor.

For example, the following graphic shows that the layer named “University”
is selected and its front image selected for painting (it has a white frame around
its proxy image).
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Raster Layer Format
When you create a new layer in Raster Paint, you can change the layer's format
as long as you haven't committed any paint strokes to the layer. To change
the layer's format, double click the paint node, then click to highlight the
raster layer node. You can adjust the settings in the Raster Layer tab. However,
once a paint stroke is committed to the layer, the following settings cannot
be changed:

■ Format

■ Width and height

■ Image aspect ratio

■ Rate

■ Channels

■ Depth

■ Repeat mode
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If you want to change the format settings of a layer, you must create a new
layer and start over.

Adding, Deleting, Clearing, and Wiping Layers
All layers appear in the Layers list. The Layers list allows you to view and
rearrange layer ordering in the Paint node, as well as select layers to be hidden
or revealed.

Layers can be internal or external to the Paint node. An internal layer is a
transparent layer that can only be added from the Paint node. It can be used
to create, for example, an alpha.

An external layer does not originate from the Paint node. It can be an image
and can include a front and/or alpha. An external layer is connected to the
Paint node by means of a Layer node, whereas an internal layer needs no such
connection since it originates with the Paint node. A common reason for
adding an external layer is to touch up an image's front or alpha. When you
paint on an external layer, you are compositing strokes onto the incoming
image. This makes it possible to change the incoming image without losing
your strokes.

When you add either an internal or external layer, it goes to the top of the
Layers list. The order in the Layers list reflects the layer order on the canvas.
The topmost layer covers the image data of the underlying layers. Layers can
be hidden or rearranged within the Layers list.

When you delete a layer, it is removed from the Layers list. When you clear
a layer, it remains in the Layers list but all strokes are removed.

Adding a Layer
When you add an internal layer, it includes both a layer front and a layer
alpha. When you add an external layer that only includes the front, a black
layer alpha will automatically be created.
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(a) Internal layer - front (b) Internal layer - alpha

(a) External layer - front (b) External layer with its alpha

To add an internal layer:

 ➤ Click the Add Layer button at the bottom of the Layer Editor.

(a) Add Layer button
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To add an external layer:

 ➤ Do one of the following:

■ Select the Add Layer button at the bottom of the Layer Editor then
connect an input image to the new layer node's input.

■ Drop a composition (or compositions) containing a rendered result
onto the Paint node and select Create Layer from the drop gate.

NOTE The newly added layer has the same format as the linked rendered
result. The drop gate is also activated when you drop a tool or files that can
be imported. In that case, the new layer is created using the composition
format.

NOTE To rename a layer node, double-click the Paint tool node. Once inside,
select the raster layer node to rename. In the Tool Options of the node's UI, type
the new name in the Name field and press Enter.

Deleting Layers
You can delete the layers you no longer need.

NOTE You cannot use the Delete key to delete a layer node from the Layer Editor.

To delete a layer from the Layer Editor:

1 Highlight the layer you want to delete.

2 Select the Delete Layer button at the bottom of the Layer Editor.
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(a) Delete Layer button

The layer is deleted.

Clearing a Layer
Clearing a layer is the same regardless of the layer type. When an entire layer
(not just the front or alpha) is selected for clearing, the front input is set to
be cleared by default. You must specify which input of the layer you want to
clear by selecting its proxy.

You cannot clear more than one layer at a time. If you select two layers to
clear and then select the Clear button, the front input of the first layer you
selected will be cleared.

The act of clearing only clears strokes for the current frame. It does not clear
the incoming front and alpha of an external layer.

To clear a layer:

1 Select either the front or alpha input from the layer you want to clear (a
white box should appear around its proxy).

2 Select the Clear button at the bottom of the Layer Editor.
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(a) Clear Layer button (b) Selected layer to clear

The layer is deleted.

Wiping Layers
Wipe a layer when you want to apply a uniform color. For example, you can
wipe the color of the bottom layer in the Layers list to change the background
color.

NOTE Any strokes that have been applied will not be maintained when you apply
a wipe.

To wipe a layer with a color:

1 Select the layer from the Layers list. Select either the Front or the Alpha
input to wipe.

2 Pick the wipe color by clicking the color pot next to the Wipe button—see
Color Picker on page 154.

3 Select the Wipe button to apply the color to the layer Front or layer Alpha,
depending on which one is currently selected.

Layer Behavior
Raster layer behavior is constrained based on the alpha of the layer being
manipulated. The dependency graph shown in following image displays a
Paint tool node consisting of one external raster layer named Raster Layer.
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The image doesn't yet have its own alpha channel. By default, the Paint tool
creates one for it and is shown as a proxy beside that of the input image
illustrated in the following graphic of the Layer Editor.

The following graphic displays the result of painting a black stroke across the
front input image.

Note that the alpha channel is not affected (as represented in the proxy image
in the Layer Editor) because its input was not selected for a paint operation.

The following images show the result of selecting then painting the alpha of
the same image.
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In this case, only the alpha portion of the image was manipulated, however,
since a black stroke was used, part of the alpha has become transparent. If a
white stroke were used there would be no change to the alpha. If a color other
than black or white were used, varying transparencies would occur on the
front image and varying shades of gray would result on the alpha.

The next example illustrates layer behavior when the front input image is
combined with its own alpha channel. In this case, a Diamond Keyer is added
to the dependency graph and the blue screen is keyed out of the image.
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(a) Composition output view (b) Tool output view (Keyer)

When a stroke is added to the front image (in this case using black), the stroke
is constrained to the white part of the alpha, and since the alpha was not
selected, no change to the alpha was made.

(a) Black stroke contained within boundaries set by alpha

When the alpha is painted with a black stroke, the resulting output image is
also altered; more of it becomes transparent.
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If a white stroke is used, the transparency of the alpha is decreased.

Stroke Operations
There are four paint stroke operations available in the Paint tool.

DescriptionOperation

Lets you paint on a selected layer's front or alpha—see Paint on page
582.

Paint

Lets you use the contents of one or more layers as the paint source
for a different layer—see Revealing Parts of an Image on page 586.

Reveal

Lets you copy a region of a layer and paint it on a destination
area—see Cloning a Region of an Image on page 589.

Clone

Lets you erase paint strokes—see Erasing Paint Strokes on page 592.Erase

Paint
The Paint stroke operation lets you paint on a selected layer's front or alpha.
Each raster layer has a front image and an alpha which you can apply strokes
to.

In the following example, a red sunset is added to the image of the ocean. In
the first image a round brush with a slight blur around its edge is used to
create the sun.
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To hide the lower half of the sun so that it lines up with the horizon, a
sharp-edged square stroke was used, and the stroke operation was changed
from Paint to Erase. The sun was then painted out.
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The last step is to add the sun's reflection to the water.
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Drawing a Straight Line

To draw a straight line:

1 Click the location in the image where you want the line to begin.

2 Press Shift and click the location in the image where you want the line
to end.

The line is drawn between the two points.

Painting the Alpha
You can retouch mattes with the paint tool.

A new internal layer has an empty, black layer matte. An external layer's alpha
contains the matte information of the incoming image.

Painting on the alpha of an internal layer is accomplished in one of two ways:
implicitly or explicitly. Implicit alpha strokes are added when you paint on
the layer front. For every stroke added to the layer front, a corresponding
stroke is added to the layer alpha. Explicit alpha strokes are added when
painting directly on the layer alpha.

Painting on the alpha of an external layer can only be accomplished explicitly.
When you add strokes to the layer front, corresponding strokes are not added
to the alpha.Strokes added explicitly to the layer alpha will be visible on the
layer front (nor in its proxy) in composition view when you commit the
stroke(s).

Pen to be removed from image shown in the alpha and the comp.
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Unwanted areas can be removed from the image by painting on the alpha of
the image.

Revealing Parts of an Image
The Reveal operation lets you use the contents of one or more layers as the
paint source for a different layer. You can include the contents of as many
layers as you like. For example, if one layer has a tree that you want to include
on a different layer, you can select the layer with the tree and then paint it
onto the other layer.

You can also offset the layer to be revealed. For example, if a bicycle appears
at the left on one layer, but you want to paint it onto the right side of another
layer, you can offset the reveal destination.

To reveal one or more layers:

1 Under Stroke, select the Reveal operation.

The brush changes from white to red.

2 Set Pressure and Blend attributes—see Blend Modes on page 345.

3 Set the brush attributes—see Paint Brush Controls and Attributes on page
569.

4 For each layer you want to reveal, select the R (reveal) option in the Layer
Editor. If you selected the R (reveal) option for more than one layer at
once, paint strokes will reveal the layer at the bottom of the list.

NOTE You can reveal layers that are marked as hidden in the Layers list.
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5 To reveal the contents of a different frame than the one you are currently
viewing, enter its frame number in the Slip field.

6 In the Layer Editor, click the layer that you want to paint on.

(a) Layer to paint (b) Layer to reveal

7 To see the layer or layers selected for reveal, select the V (view) option,
and adjust the opacity.

The Preview option offers a more intuitive way of previewing the effects
of the reveal. When you enable Preview, the layer is superimposed over
the layer or layers selected for reveal, and the Opacity field is activated
to allow for transparency adjustments. This lets you see exactly what your
brush strokes will reveal.

8 Click and drag on the canvas to apply strokes that reveal the contents of
the selected layers.
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To reveal and offset a layer:

1 Perform steps 1 to 6 from the previous procedure, “To reveal one or more
layers”.

2 To set the source area, press Ctrl and click the canvas. When you click
the canvas, the red brush is anchored and the green brush reappears.

Setting destinationSetting source area

3 Position the green brush over the destination area and click the canvas.
The offsets are made and immediately shown in the X and Y Offset fields.

The green and red brushes are now locked into positions relative to each
other and move in tandem.
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4 To set precise coordinates for the reveal offset, use the X and Y Offset
fields.

5 Click and drag on the canvas to apply offset strokes that reveal the
contents of the selected layers.

Revealed portion of layer using Average blend method.

Cloning a Region of an Image
The Clone tool lets you copy a region of the layer and paint it on a destination
area. For example, if your clone source includes a sailboat, when you paint
on the destination area, the sailboat will be replicated. The clone source and
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destination occupy the same layer. To clone part of one layer on a different
layer, use the Reveal tool—see Revealing Parts of an Image on page 586.

To clone part of a layer and paint it on the same layer:

1 Under Stroke, select the Clone operation.

The brush changes from green to red.

2 Set Pressure and Blend attributes—see Blend Modes on page 345.

3 Set the brush attributes—see Paint Brush Controls and Attributes on page
569.

4 To clone the contents of a different frame than the one you are currently
viewing, enter its frame number in the Slip field.

In this example, the sailboat will be cloned to a location further to the
right.

5 Set the source area of the clone and the target destination for the clone
by pressing Ctrl and clicking once. When you click the canvas, the red
brush is anchored and the green brush reappears.

NOTE The Preview option offers a more intuitive way of previewing the
effects of the reveal. When you enable Preview, the layer is superimposed
over itself, and the Opacity field is activated to allow for transparency
adjustments. This allows you to see exactly what your brush strokes will clone.
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6 Position the green brush over the destination area, then click + drag the
canvas to create the clone stroke. The offsets are made and immediately
shown in the X and Y Offset fields.

The green and red brushes are now locked into positions relative to each
other and move in tandem.

7 To set precise coordinates for the reveal offset, use the X and Y Offset
fields.

Cloning of a sailboat in preview mode.
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Erasing Paint Strokes
When you erase paint strokes, you can select the brush size and type for
different effects.

To erase paint strokes:

1 Under Strokes, select the Erase operation.

2 From the Layer Editor, select the layer on which you want to erase strokes.

3 Set a brush type and size—see Paint Brush Controls and Attributes on
page 569.

4 Click and drag on the canvas to erase.

Using Stencils
You can enable/disable a stencil to paint without or through a stencil on a
per stroke basis. The stencil is applied transiently, only the part of the strokes
that pass through it are kept.

There are three stencil modes:
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Result:Stencil:

Default setting, no stencils are used.Matte Off

Strokes will be constrained by the matte inputted into the layer.Use Layer

Forms a stencil from what is currently available in that layer.Use Stroke

Inverts the stencil.Invert
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Vector Paint

Topics in this chapter:

■ About Vector Paint on page 595
■ Vector Paint Image Inputs on page 596
■ Shape Properties on page 596
■ Vector Paint UI on page 597

About Vector Paint
Composite's Vector Paint tool can be used to draw, to rotoscope, to clone parts
of an image in a different location, or to reveal a completely different image.

In the Vector Paint tool, you draw by creating shapes on the canvas. Contrary
to Composite's Raster Paint, once a shape is created in Vector Paint, you can
edit its parameters to change the shape's location and orientation, for example
using a tracker to animate the shape. If the shape is a Bézier, you can edit
individual points, changing their opacity or their tangents, for example. You
can do this using the same key frame animation techniques you use in other
Composite tools. All the shapes drawn in a given Vector Paint tool are
composited back to front over an optional background image to produce the
Vector Paint output image.

Additionally, Vector Paint has strong similarities with other Composite
shape-based tools, such as the Garbage Mask, Remove Dust, and Warp 2D tools.

25
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Vector Paint Image Inputs
You can optionally connect images to the Vector Paint image inputs. The
Vector Paint node in the Schematic has two image input tabs. The top-most
tab is the background image input. Connect an image to this input to use as
your canvas background. If left unconnected, your paint shapes will be applied
over a black background.

The bottom-most tab is for clone/reveal image sources. You can connect as
many images as you wish to this tab, and select any one of these sources to
be the clone/reveal source for a paint shape drawn in clone or reveal mode.
If left completely unconnected, the only possible clone/reveal source will be
the background (or black, if the background is also unconnected).

Shape Properties
When you draw using the Vector Paint tool, you are creating shapes on the
canvas. All shapes share basic properties, such as:

■ Translation

■ Pivot Point

■ Rotation

■ Scale

■ Shear

Other shared properties control how the shape is drawn on the canvas, and
are described in the following sections. These properties can be edited and
animated over time. Unless otherwise noted, all shape properties are
animatable.

In Vector Paint, shapes are of two types: Bézier or line strip.

Line strip shapes are also called freehand shapes. These shapes are created
using the freehand tool (if Auto Make Bézier is off). Line strips can have large
numbers of individual points with better performance than a Bézier curve
with the same number of points. The drawback is that individual points in
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line strips cannot be edited. To edit them, make a Bézier curve out of the line
strip.

Shapes in Vector Paint have a duration: they appear at their Mark In frame,
and are removed at their Mark Out frame.

Vector Paint UI
The Vector Paint UI is composed of five tabs: the main (Vector Paint) tab, the
Transform tab, the Brush tab, the Output tab, and the Settings tab. Each tab
has two panes, with a divider between them that can be used to adjust the
relative size of the two panes.

The left pane, the shape and tools pane, is identical in all five tabs. It is
composed of the shape browser on the left, and on the right, a column with
shape creation and editing tools, Bézier creation controls,and pen pressure
controls.

All controls in the Vector Paint UI feature tool tips to provide information
about their use.

Shape Browser
The shape browser displays all shapes created in the current Vector Paint tool.
By default, the shape browser presents shapes in bottom to top compositing
order, with the bottom-most shape at the bottom of the shape browser, and
the top-most shape at the top. The name column is the only column on which
sorting can be done. The sort order can be inverted by clicking on the name
title to provide front to back ordering (back stroke at the top of the browser).

The following columns are shown in the shape browser by default:
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To:Use:

Control the visibility of the shape (mute or
view).

V

Provide a meaningful name for the shape.Name

Set the shape opacity.Opacity

Set the frame at which the shape becomes
visible.

Mark In

Set the frame at which the shape disap-
pears.

Mark Out

The following columns are optional, and can be added to the shape browser
display by right-clicking on the title row of any existing column.

To:Use:

Lock. When enabled, prevents any change
to the shape through the browser or in the
player.

L

Blend mode of the shape with the compos-
ited shapes and/or background image be-
hind it.

Blend

Set stream in which the shape will be
drawn, for multi-stream or stereo painting.

Stream

Draw Mode for the shape, stroked or filled.D Mode

Open/Closed state.C

Operation, paint, clone, or reveal.Oper
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To:Use:

Which channels will be affected by the
shape.

Channels

Anti-Aliasing. Filled shapes (without a
gradient) will have sub-pixel antialiased

AA

rendering, and stroked shapes will have
sub-pixel positioning of strokes.

In general, all columns (except Lock) have their equivalent in the main tab's
main section.

At the bottom of the shape browser are controls for operating on shapes.

To:Use:

Select all shapes.Select All

Reset selected shape(s).Reset

Convert selected line strip shape(s) into
shapes.

Make Bézier

Move selected shape(s) to the back of the
compositing order.

Move to Back

Move selected shape(s) one position down
towards the back of the compositing order

Move Down

Move selected shape(s) one position up
towards the front of the compositing order.

Move Up

Move selected shape(s) to the front of the
compositing order.

Move to Front

Duplicate selected shape(s).Duplicate

Delete selected shape(s).Trash

Shape Creation and Editing Tools
At the right of the shape and tools pane are the shape creation and editing
tools, as well as Bézier creation controls and pen pressure controls. The creation
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tools form the first row of the shape creation and editing tools, and the editing
tools form the second.

To:Use:

Create a freehand line strip shape.Freehand

Create a Bézier shape point by point.Bézier

Create a rectangular (or square) Bézier
shape.

Rectangle

Create an elliptical (circular) Bézier shape.Ellipse

Create a line Bézier shape.Line

Edit a shape's transform.Transform

Edit points in a Bézier shape.Edit

Edit the clone/reveal transform of a shape.Clone/Reveal Transform

NOTE Notice that the Rectangle, Ellipse, Line and Bézier shape tools all create
Bézier shapes.

Immediately below the shape creation and editing tools are the Erase controls.
Contrary to many other drawing packages, Vector Paint does not have
dedicated erasing tools. Instead, you choose the erase mode you want (erase
to background, to transparent, or to background color),and use the standard
creation tools to create new shapes that erase. These shapes can be edited,
tracked, and changed just as other shapes.

Make Bézier Controls

To:Use:

Automatically convert new freehand shape.Auto
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To:Use:

Set the pixel tolerance when converting
freehand shapes to Bézier.

Tolerance

Pen Pressure Controls

To:Use:

Have pen pressure control brush size.Size

Have pen pressure control opacity.Opacity

Main Tab
Vector Paint's main tab contains the most common settings that affect a shape.

Main Shape Attributes
The leftmost section in the main tab contains the basic shape controls. Its
title shows the currently selected shape's name, or "New Shape" if a creation
tool is selected.

To:Use:

Set the two colors (named "front" and
"back") used by shapes drawn with the

Color

Paint operation (see Operation, below).
The front color is used for drawing, and
the back color is used for erasing. Another
use for the back color is to toggle quickly
between two colors, either using the swap
button in the UI or by using the hotkey
(default: X)
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To:Use:

Control shape opacity.Opacity

Control the blending mode of the shape.
See Blend Modes in the Blend Alpha on
page 344 section.

Blend

Set the stream in which the shape will be
drawn. Note that this parameter is not

Stream

animatable. See Multi-stream Compositing
on page 371.

This button is only visible when a creation
tool is selected. When creating a shape in

Use Player Stream

a player, this mode will set the new shape's
stream to be that of the player. In a stereo
workflow, this allows you to draw in one
stream (e.g. left stream), change the play-
er's stream, and draw in the other stream.

Set the shape's draw mode. Stroked shapes
will stamp the brush image along the

Draw Mode

shape's path. Filled shapes will fill the
polygon defined by the shape.

Set whether the shape is considered to be
an open or closed shape.

Closed

Enable rendering for this shape (whether
or not it is visible).

Visible

Set the shape to Paint, Clone, or Reveal.
Paint will draw using the solid foreground

Operation

color. Clone and Reveal will use an image
source to draw.

Set which channels of the image will be
affected by the shape. Alpha modes use
the current color's luminance.

Channels

Set rendering quality, depending on the
draw mode. For Stroked shapes, this con-

Anti-Aliasing

trols whether sub-pixel positioning of brush
stamps will be used. For Filled shapes, this
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To:Use:

controls whether smoothing will be applied
to pixels that are only partially covered by
the shape.

Reset all parameters described in this sec-
tion.

Reset

Clone/Reveal Attributes
This section contains attributes relevant to shapes that use an image source
as their color content, when the shape Operation is Clone or Reveal, as opposed
to a solid color, when the shape Operation is Paint.

To:Use:

Select the image source that will be cloned
or revealed into the shape. The menu offers

Source

the images that are connected to the
node's "Clone/Reveal Sources" input, as
well as the background image, labeled as
[Background].

Set the X, Y translation for the clone/reveal
image source.

Translation X/Y

Set the rotation for the clone/reveal image
source.

Rotation (R)

Select which frame to use as the clone/re-
veal source, according to the Absolute
toggle.

Frame

Control the interpretation of the Frame
value. Enable to have the Frame value be

Absolute
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To:Use:

an absolute frame index, disable to inter-
pret the Frame value as an offset relative
to the current frame.

Control how pixels outside the clone/ re-
veal image source are generated. Transpar-

Edges

ent sets them as transparent, Edge extends
the edge pixel of the clone/reveal source,
Repeat repeats the clone/reveal image
source, and Mirror mirrors the clone/reveal
image source.

Control how pixels read from the clone/
reveal image source will be filtered before

Filtering

being applied by the stroke. Nearest is the
fastest, but lowest quality. Bilinear provides
very good quality at excellent speed. Other
modes provide excellent quality, at far
slower speeds. See Cropping and Filtering
the Output on page 482.

Control drawing the clone/reveal image
source overlay, to ease placement of the

Preview

source. This can be very useful in combin-
ation with the clone/reveal transform tool.

Control the opacity of the clone/reveal
image source overlay.

Preview Opacity

Reset all parameters described in this sec-
tion.

Reset

Point and Gradient Attributes
This section shows attributes for the currently selected shape point or edge
gradient point. These will only be enabled when the Edit tool is selected. Please
note that only Bezier shapes have editable points. Line strips must first be
converted to Bezier shapes if you need to edit individual points. For more
information about Point attributes, see the Editing Masks on page 543 in the
Masking chapter.
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To:Use:

Controls the point's position.Position X,Y

Controls the point's pressure. This can be
used to change brush size or shape opa-
city.

Presssure

Controls whether the point is used for
drawing the shape. Since this parameter

Active

is animatable (as almost all other Vector
Paint parameters), deactivating a point
over a range of frames may be useful if you
want to keep points part of the shape, but
temporarily don't need it.

Control the incoming and outgoing tan-
gent angle (in degrees) and length.

Tangent

Gradients can be added to any Bézier shape, but not to line strips. Gradients
will only be rendered on filled shapes, not on stroked shapes. Shapes don't
need to be closed for gradient to render. This is a good way to have a stroke
with detailed falloff control.

Edge gradients can be added by adding a gradient point on the curve with
Ctrl-Click on Windows and Linux, Cmd-Click on Mac OS. For more
information about Edge gradient attributes, see Creating and Editing Edges
on page 554 in the Masking chapter.
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To:Use:

Control edge gradient point distance from
the shape. Negative means inside the
shape if the shape is closed.

Distance:

Control gradient point position on the
shape relative to the shape's point indices.

Position:

For example, 2.5 represents a gradient
point midway betweeen points 2 and 3,
while 2.75 is 3/4 of the way from point 2
to 3.

Transform Tab
This tab displays controls for two separate transforms that affect the shape:
Shape Transform and Clone/Reveal transform.

The Shape Transform controls the shape's position and aspect. This section is
only enabled when an editing tool is selected. For more information about
the shape transform, see Transforming Masks on page 548 in the Masking
chapter.

The Clone/Reveal Transform controls the transform of images used in
clone/reveal shapes. These controls only have an effect if the shape's current
operation is Clone or Reveal. The Paint operation does not make use of this
transform.

In Clone mode, by default, only the translation is composed with that of the
shape, which provides the expected result when dealing only with translations.
Using the "x Shape" (by shape) toggle controls, other parts of the
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transformation will be composed by the shape transform. If the "x Shape"
toggle is off, they will be absolute.

In Reveal mode, all parts of the transform are absolute, with scale, rotation
and shear with respect to pivot, as expected. The "x Shape" toggle controls are
not used.

The examples below display the rotation attribute for rectangle and
clone/reveal areas.

Default rotation position

Rectangle rotation at 30 .
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Rectangle rotation at 30, x Shape button enabled.

Clone/Reveal rotation at 20, x Shape button enabled.
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Rectangle rotation at 30, Clone/Reveal rotation at 20, x Shape button enabled.

NOTE Clone/reveal transform controls are also found in the main tab for translation
x, y and rotation.

Brush Tab
The brush tab has controls that affect drawing of stroked shapes. As for other
tabs, it has the shape and tools pane at the left. In the right pane, from left
to right, are the following columns:

■ Brush Attributes

■ Brush Profile Editor

■ Brush Preview

■ Brush Palette

■ Brush Palette Controls

Brush attributes control how new or existing stroked shapes will be rendered.

To:Use:

Control brush base shape, elliptical or
rectangular.

Type

Control brush size in nominal pixels. Result
is independent of pixel aspect ratio.

Size

Control spacing between stamps, in per-
centage of brush size.

Rate

Set the brush shape rotation in degrees.Angle

Control the aspect ratio of the brush shape.Aspect
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To:Use:

Enable/disable anti-aliased brush rendering.Anti-Alias

Enable/disable whether brush transform is
affected by shape transform.

Transform

Toggle to create stamps when no pointer
movement is detected

Airbrush

Factor applied to the brush profile when
Airbrush is enabled.

Flow

Brush Profile Editor
The Brush Profile Editor allows you to specify a radial profile for your brush.
You can use this to create a smooth falloff, or add control points to create a
complex profile for artistic effect. Click profile control points to select them,
and click and drag control points or tangent points to change the profile.
Alt-click will add a profile control point. Use Ctrl-Alt-Click to break tangents.

At the bottom of the Brush Profile Editor are controls to modify your profile.

To:Use:

Flip brush profile vertically, along with its
animation.

Flip Vertical

Flip brush profile horizontally, along with
its animation.

Flip Horizontal

Straighten selected brush profile segments.Straighten

Enable/disable tangent editing.Edit Tangents

Reset the brush profile to its default.Reset
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Brush Preview
The brush preview displays a rendered preview of the brush, with all parameters
applied, including its profile. At the bottom of the brush preview are brush
center controls.

To:Use:

Set brush center x coordinate, relative to
the brush size. -1 is left, 1 is right.

X

Set brush center y coordinate, relative to
the brush size. -1 is bottom, 1 is top.

Y

Display brush center indicator in preview.x

Brush Palette and Brush Palette Controls
The brush palette displays a preview of all brushes in the current brush set.
Click on a brush to use it with the current shape. Shift-click to use only the
brush profile. Click in an empty location to create a brush.

Once a brush is selected, you can use the brush palette controls to replace,
copy, paste, cut, or delete the brush selection. You can also select a different
brush set, delete the current one, or create a new brush set.
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Output Tab
The Output tab provides controls that are used when Vector Paint does not
have an image connected to its background image input. In such a case, Vector
Paint behaves as an image generator.

For more information about image generator properties and formats, see
Setting Image Generation Properties and Formats on page 420 section in the
Image Processing and Tools chapter.

Settings Tab
The Settings tab provides controls to change default shape durations, colors
for symbols drawn in the player, Bézier tangent settings, keyframing settings,
and post shape creation tool selection.

For Bézier tangent settings, Keyframing settings, and Default Tool settings,
see Options Tab Settings on page 559 in the Masking chapter.

To:Use:

Set the default duration for newly-created-
shapes using the Paint, Clone, and Reveal-
operations, respectively.

Default Shape Duration

Set the curve color in the player.Curve Color

Enable curve visibility when the edit tool
is selected.

Curve Visible
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To:Use:

Set the Bézier handle color in the player.Handle Color

Set the edge gradient curve color in the
player.

Edge Color

Enable edge gradient curve visibility in the
player.

Edge Visible

Brush outline color in the player.Brush Color

Brush outline visibility in the player.Brush Visible

Hotkeys
For a detailed list of Vector Paint hotkeys, open the Hotkey Editor, and go to
the "Tools --> Vector Paint and Tools --> Shape Editor" category. For more
information about the Hotkey Editor, see Hotkey Editor on page 163 in the
Getting Familiar with your Workspace chapter.

Some hotkeys are not listed in the hotkey editor, as they are fixed and cannot
be changed. These are:

■ Alt for creating lines constrained to multiples of 45 degree angles.

■ Alt for constraining shape rotation to multiples of 45 degree angles.

■ Alt for creating centered ellipses/rectangles.

■ Shift for keeping 1:1 proportions when creating ellipses and rectangles,
thus creating circles and squares.

■ Ctrl-alt-click in the brush profile editor, to break tangents.

■ Shift-click in the brush library to use pictured profile without changing
the current brush parameters (size, rate, angle, ...).

■ Alt-click on the "Replace" button in the brush library, to replace the current
brush without confirmation.

■ Alt-click on the "Delete" button in the brush library: delete the selected
brush without confirmation.
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Performance Notes
Here are some notes on the following topics: Rendering, Clone/Reveal Filtering,
Mulit-Shape Editing and Manipulators.

Rendering
Vector Paint uses the normal Composite high performance computation
engine when rendering images used by the nodes connected to its output
(downstream nodes). This provides the best overall performance and
throughput, but can introduce noticeable lag (or latency) when drawing shapes
in a player.

For this reason, in player Tool Output display mode, Vector Paint uses a
low-latency renderer that ensures all interactions are fluid and images are
produced with minimal lag.

You can use this to your advantage depending on the type of interaction you
need. For example, if you need maximal performance and are not creating
strokes interactively, you can connect a Pass-Through tool node to Vector
Paint's output and set a context point on the Pass Through, to view Vector
Paint's output. When rendering large numbers of strokes on large images, this
will produce the highest throughput. The quality and pixel accuracy of both
rendering methods is identical.

Clone/Reveal Filtering
Bilinear filtering has an optimization for situations where only translations
are used that will make it notably faster than the other filters.

Using clone/reveal sources or a background with non-square pixels disables
filtering performance optimizations.

Multi-Shape Editing
When multiple shapes are selected, parameter changes made in the UI will
apply to all selected shapes. The following actions, however, do not follow
this convention and only apply to the primary selected shape:

■ Changing the Front and Back Color in the Main Tab.

■ Changing shape and edge gradient points in the Main Tab.
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■ Changing the brush profile, in the Brush Tab.

■ Resetting parameters through ctrl-click or right-click.

Manipulators
As for the other shape-based tools, many aspects of the the shapes' appearance
and positioning can be modified by manipulating them directly in the player.

One notable exception to this is the shear parameters which, for both shape
and clone/reveal transforms, can only be modified through the Transform
tab.

Shape Transform Manipulators
When the Transform tool is active, the selected shapes' pivot and bounding
box are drawn on top of the rendered shape. Handles on these symbols allow
the translation, rotation, scale and pivot to be manipulated. Please refer to
the Transforming Masks on page 548 section for detailed information about
shape transform manipulation.

Point Editing Manipulators
When the Edit tool is active, the selected shape's curve, points, edge gradient
(if any) are drawn on top of the rendered shape.

The color used to draw these symbols can be changed in the Settings tab, and
applies to all the shapes in the currently selected Vector Paint node.

The curve and edge gradient symbols can be turned off, if needed, to avoid
clutter. See the Settings Tab for these parameters, and consult the Hotkey
Editor for the hotkeys associated with toggling the curve and edge gradient
visibility

Please refer to the Editing Masks on page 543 section for detailed information
about point and edge gradient manipulation.

Clone/Reveal Transform Manipulators
Shapes using the Clone or Reveal Draw mode can have their source image
transform adjusted directly in the player using the Clone/Reveal Transform
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tool. This manipulation tool is available for single-shape selections, and its
manipulators will only be drawn if the selected shape's Operation is set to
Clone or Reveal.

The manipulators appear in the player at the pivot position for the image
being used. This means that the manipulators will not necessarily be close to
the actual shape using the image. The shape's name is indicated beside the
manipulator to identify which shape's clone/reveal transform is being edited.

This tool has two editing modes: one for editing the translation/rotation/scale,
and one for editing the pivot and its rotation. You can toggle between the
two using the "Set Clone|Reveal Pivot" hotkey, which defaults to "Ins". When
the pivot is being edited, the text "(Pivot)" appears after the shape's name close
to the manipulator.

This manipulation tool is the same as the one found in the 2D Transform
tool. Please refer to the 2D Transform Tool on page 432 for further details.

Please note that the clone/reveal preview can be enabled when manipulating
to have a better idea of which section of the image is being used.
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Color Correction

Topics in this chapter:

■ About Color Correcting on page 618
■ Applying LUTs on page 618
■ Working with ASC CDLs on page 624
■ Broadcast Safe Tool on page 625
■ Transforming Color Space with the Log and Delog Tools on page 627
■ Color Correcting with CC Basics on page 630
■ CC Histogram on page 639
■ Clamp Color Tool on page 644
■ Color Space Tool on page 645
■ Processing Images with Photo Lab on page 646
■ Inverting an Image on page 649
■ Remap Color on page 649
■ Set Fill Color on page 654
■ Solarizing an Image on page 654
■ Creating a Monochrome Image on page 655
■ Modifying a Display With the Pass Through Tool on page 656
■ Setting the Amount of Gray in an Image on page 656
■ Converting an Image to sRGB on page 656
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About Color Correcting
Color correction describes any process that modifies the perceived color of an
image. The CC Basics tool options include a complete selection of color
manipulation tools that give you precise control over color values. You can
modify luma ranges in an image (shadows, midtones, and highlights), sample
colors, and set the color balance. You can also apply simulated camera exposure
and film development effects to images using the Photo Lab tool.

NOTE All color correction tools have a masking input that allows you to limit the
effect of the color correcting tool to a specific range of pixels—see Pixel Masking
on page 560.

Applying LUTs
Film projects generally use digitized film images originating from a datacine
conversion process. These high-resolution scans of film frames preserve much
of a film's resolution, color depth, and grain. Digital film scan formats consist
of logarithmic data, which allows for more subtlety in the lower luma ranges
of an image. Linear data maps the luma range in equal intervals from black
to white. Because the algorithms are optimized for linear data, a look-up table
(LUT) can be used to convert the logarithmic data for a linear data
environment.

A LUT is an ASCII file that describes specific pixel values used for image data
conversion both on import and export. For example, you can use a LUT to
convert a 10-bit logarithmic film image to a 16-bit linear image on import.
Typically, you would apply the inverse LUT on export to restore the 10-bit
logarithmic data, ensuring that the result film prints match the original shots.
You can use two kinds of LUTs: 1D LUTs and 3D LUTs.

Calibrating your Monitor
Before using LUTs, you should calibrate your monitor. Monitor LUTs affect
the way images are displayed on the monitor without altering the image data.
If you import logarithmic film scans without conversion, you need to use a
monitor LUT to display the images correctly. Even when you apply a LUT to
film scans on import, you may still require a monitor LUT to reproduce the
gamma qualities of film—see Chapter 4, Lustre Color Calibrator in the Lustre
Color Management User's Guide on the Composite Web Portal.
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Working with 1D LUTs
A 1D LUT is generated from one measure of gamma (white, gray, and black)
or a series of measures for each color channel. You typically work with a pair
of 1D LUTs: the first converts logarithmic data to linear data, and the second
converts the linear data back to logarithmic data to print to film.

1D LUTs can be used as import and export LUTs, and as monitor LUTs. Import
and export LUTs are mainly used to convert between the logarithmic data
contained in film scans and the linear data used within the application.
Monitor LUTs ensure the image displayed on the monitor resembles the final
output without the actual image data being modified.

You can apply a 1D LUT when importing a film clip, and then convert the
image data back to logarithmic data when exporting the final output. For
example, you can use a 1D LUT on import to convert 10-bit to 8-bit, 16-bit,
32-bit, or linear images for manipulation. Typically, you would then apply
the inverse LUT on export to restore the logarithmic data, ensuring that the
modified film print exactly matches the original shot.

NOTE You can use 1D LUTs created outside the environment. However, to be
recognized, the 1D or 3D LUT file must be in the correct format and be named
correctly. Comment lines are permitted.

Using 1D LUTs Created Using Third Party Software

You can use 1D LUTs created in other applications as long as they are in the
recognized format. All 1D LUT files must have the .lut extension. You should
save all 1D LUTs in the project's LUT folder for ease of use, and so they can
be archived with the setups of the project.

The 1D LUT Format

The 1D LUT file begins with a declaration of the number of tables and the
number of entries per table:

LUT: <number of tables> <number of entries per table>

The number of tables in the file depends on the channel resolution required.
For a LUT in which all three RGB channels are converted using the same
values, just one table is required. To convert the three channels using different
values, use three tables. For three channels plus alpha, use four tables. The
number of entries in each table corresponds to the bit depth of the source file:
256 entries for 8-bit resolution, 1024 for 10-bit and 4096 for 12-bit. For
example, a LUT operating on three 8-bit channels independently would have
the following declaration:
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LUT: 3 256

Each line following the header contains a single entry indicating the value to
which the source is converted. For example, a table converting 10-bit
logarithmic values to 8-bit linear would contain 1024 entries, corresponding
to the 0–1023 intensity range of pixels in the source file. Each of these entries
would be in the range 0–255, corresponding to the intensity range in the
destination.

Blank lines and comment lines (starting with a number sign [#]) are ignored.
Comment lines are useful for indicating the end of one table and the beginning
of another, or for describing how the script or program works.

Floating Point 1D LUT File Format

Floating point LUTs are supported and are reversely compatible in most cases.
You can specify your own floating-point 1D LUT using an ASCII editor as long
as it is in the correct format and is named correctly.

The following illustration represents a 1D floating-point LUT that consists of
one channel of five values that fall between the range of 0.0 and 2.0.
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Applying a 1D LUT

LUTs are typically stored in a folder within the application or on a network,
you should store LUTs created externally in the same folder for ease of use.

Three formats are supported:

■ 8-bit unsigned integer

■ 16-bit signed float

■ 32-bit signed float
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To apply a 1D LUT to an image:

1 From the Tools tab, drag the 1D LUT tool from the Color Correction
folder to the dependency graph in the Schematic view.

2 In the 1D LUT tab, click the LUT Browser button. Locate the 1D LUT you
want to use and drag it to the dependency graph in the Schematic view.

3 Select the Input Depth.

4 Set the Exposure if required.

The 1D LUT is applied.

NOTE  Exposure adjustment is an animatable attribute—see Setting Keys Manually
on page 676 and Validating and Applying the Expression String on page 729.

Modifying a 1D LUT

You can modify a 1D LUT by changing values in its ASCII file without having
to reset the 1D LUT field.

To modify a 1D LUT:

1 Open the ASCII file of the 1D LUT and make the necessary modifications.

2 Save the LUT.

3 Click Refresh.

The image is refreshed with the modified parameters.

NOTE If you want to modify a 1D LUT that is provided with the 1D LUT tool, save
the modified 1D LUT under a different file name to preserve the original LUT as
is.
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Working with the Lustre Color 3D LUTs
Lustre Color LUTs provide a wide range of generic, out-of-the-box display and
conversion capabilities. There are two main types of LUTs: display and
conversion.

It is important to note that the LUTs were built for generic use in production,
meaning that, while delivering an accurate print film rendition, it may not
match that of a particular film lab. This is expected behavior, because each
lab processes film differently. However, the LUTs use 3D cubes in order to
ensure the best possible match between the film output and your display while
taking into accounts its physical limitations. For example, a CRT monitor
cannot physically represent all of the colors available for film.

LUTs are typically stored in a folder within the application or on a network.
You should store LUTs created externally in the same folder for ease of use.

For complete information on the Lustre Color LUTs, refer to the Lustre Color
Management User's Guide on the Composite Web Portal.

Applying a 3D Display LUT

Display LUTs provide a simulation of the final output for a given film stock
and display device without rendering. All display LUTs have an accompanying
gamut warning LUT, which displays in magenta all out-of-gamut colors. That
is, those colors that are not reproducible on the display device—see Applying
a LUT or Color Conversion Tool to the Player on page 210.

Applying a 3D Conversion LUT

Conversion LUTs render in effects for a given film stock and display device
in order to create a new clip for use in a subsequent step in the DI process.
There are several types of conversion LUTs, and many of these offer a selection
of mapping methods, so you can choose the type best suited to your footage.

To apply a 3D LUT:

1 From the Tools tab, drag the 3D LUT tool from the Color Correction
folder to the dependency graph in the Schematic.

2 In the 3D LUT tab, click the LUT Browser button.
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(a) LUT Browser button

The LUT Browser appears, displaying the Lustre_Color_3DLUTs folder.

3 Open the folder and select a LUT from the Conversion folder. Drag it to
the dependency graph in the Schematic.

4 In the 3D LUT tab, set the Exposure, Negative Film Gamma, Cineon
Reference, and Linear Reference—see Modifying Negative Film Gamma,
Cineon Reference, or Linear Reference Levels on page 628.

The 3D LUT is applied.

NOTE Exposure is an animatable attribute—see Setting Keys Manually on
page 676 and Validating and Applying the Expression String on page 729.

Working with ASC CDLs
Composite supports the American Society of Cinematographers' Color Decision
List (ASC CDL). The ASC CDL was developed by the American Society of
Cinematographers in a unique collaboration between manufacturers,
cinematographers, and colorists. The ASC CDL was developed to ensure that
basic color grading adjustments can be shared amongst different manufacturer's
systems, from on-set through post-production.

The American Society of Cinematographers CDL color specification defines a
common language for primary color correction. A CDL is expressed by nine
numbers (three RGBtriplets) representing predefined color functions: offset,
slope, and power. The ASC has defined a number of formats in which a CDL
may be carried. Composite supports the form where a single set of CDL
parameters is stored in an XML file. If you are working on a project in which
the cinematographer is making use of CDLs, you can use the 3D LUT tool as
a display modifier to preview your work in the context of the cinematographer's
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intended look—see Applying a LUT or Color Conversion Tool to the Player
on page 210.

Within the3D LUT tool, the CDL is applied after the (optional) linear to log
conversion but before the 3D LUT. Note that you may use the CDL even if
you don't select a 3D LUT (and vice-versa).

The ASC CDL defines the color grading metadata, but it does not specify the
color management that should be used with it. In order to get the best results,
you should check with the provider of the CDLs to understand what color
management was being used when they were created. Currently, most CDLs
are used in the context of log images being previewed through a print-film
simulation transform. If a custom 3D LUT is not provided to you, one of the
3D LUTs from the Lustre Color collection may get you close.

To apply a CDL:

1 From the Tools tab, drag the 3D LUT tool from the Color Correction
folder to the dependency graph in the Schematic.

2 In the 3D LUT tab, click the CDL Browser button.

(a) CDL Browser button

3 In the Browser, open the folder that contains the CDL you want to use
and select the CDL.

The CDL is applied to your composition.

Broadcast Safe Tool
When working with material that is intended for television broadcast, the
Broadcast Safe Colors tool ensures the images in your composites translate
well (and safely) to a television display.
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About Broadcast Safe Colors
Since most computer monitors and television displays have different color
ranges, the same image on a computer display can appear very different on
an NTSC or PAL monitor.

Colors appear much brighter on a television display. This is because video
uses a different gamma curve for luminance than a computer monitor. Also,
most computer monitors use RGB color space, and television displays use YUV
color space.

Some pure colors, such as red and yellow, can cause bloomed (very saturated,
fuzzy) images. In some cases, colors can cause interference with broadcasting,
which is referred to as NTSC illegal colors.

Broadcast Safe Color Controls
The Broadcast Safe Colors tool automatically reduces the luminance or
saturation of portions of the image, or isolates unsafe or safe colors that you
can then adjust manually.

To:Select:

Set the unsafe colors as NTSC or PAL.Format

Determine how the unsafe colors will be fixed, or identify the colors so
you can fix them.

Method

Adjust the video signal amplitude, where 120 is maximum, and 90 is
the minimum. The default amplitude is 110.

Max Signal
Amplitude

Click to select the replacement color from the color picker. Then click
Set.

Replacement
Color
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To use the Broadcast Safe tool:

1 From the Tools tab, drag the Broadcast Safe tool from the Color Correction
folder to the dependency graph in the Schematic view.

2 From the Format list, select NTSC or PAL (your video format).

3 From the Method list, select one of the following:

To:Select:

Automatically reduce the luminance of the offending portions of the
image to broadcast legal. Use Maximum Signal Amplitude to adjust

Reduce Lu-
minance

the limits of the luminance. Note: The Maximum Signal Amplitude
should be limited to 110.

Automatically make any overly saturated portions of the image broad-
cast legal. Use the Maximum Signal Amplitude to adjust the limits of
the saturation.

Reduce Satur-
ation

Cut out the unsafe colors from the image, leaving only the safe color
regions.

Key Out Un-
safe

Cut out the safe colors from the image, leaving only the unsafe color
regions.

Key Out Safe

Fill the unsafe portion of the image with the selected color.Replace Color

NOTE Use the Key Out Unsafe and Key Out Safe options to see any problem colors
in your image immediately. For example, you can fix the problems in the Color
Corrector by adding the output of the Broadcast Safe tool as the masking input
to the Color Corrector.

Transforming Color Space with the Log and
Delog Tools
Logarithmic data is automatically converted to linear data on import by
applying a 1D LUT to the imported image. However, if you need to work in
log space, you can modify both the display and image data by using the Log
and Delog tools.

The Log and Delog tools let you transform between linear and log color space.
The Log tool transforms from linear to log space and the Delog tool transforms
from log to linear space.
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The log space in Composite is very similar to that used by Cineon encoding,
but it does not clamp high dynamic range values, and it is scaled with respect
to the Cineon codes. That is, a Cineon code of 1023 corresponds to a value
of 1.0.

The transformations can be controlled with the negative film gamma, the
Cineon reference, and the linear reference. These reference points are expressed
in units of the log space described above. You can display their value either
as raw or as Cineon codes.

Modifying Negative Film Gamma, Cineon Reference,
or Linear Reference Levels
The transformation between log and linear color spaces is controlled by three
parameters: negative film gamma, Cineon reference, and linear reference.
Gamma controls the contrast, while Cineon reference and linear reference
establish a correspondence between points in the two color spaces. The Cineon
code, specified as the Cineon reference, is transformed to the value specified
as the linear reference. For example, you may want to base the transformation
on the 90% white card and specify a Cineon reference code of 685 and a
corresponding linear reference value of 90.

NOTE All Delog and Log parameters are animatable —see Setting Keys Manually
on page 676 and Validating and Applying the Expression String on page 729.

■ The white reference is mapped to 0.9 in linear space. Cineon codes above
reference white are mapped to values above 0.9, however, these values can
be greater than 1. This tool does not clamp to 1, so there is no loss of
information.

■ All incoming pixels with values between 1 and 95 produce black pixels.

NOTE All channels are linked by default.

To uniformly modify values with the Log or Delog tool:

 ➤ Do one of the following:

■ Drag the red (R), green (G), or blue (B) channel fields to the right to
increase, or to the left to decrease, values uniformly on all three
channels. Alternatively, you can also drag the luminance (L) field to
achieve the same result.
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■ Select a single channel that you want to modify by deselecting the
Lock button.
Drag the red channel field to the right to increase, or to the left to
decrease, the level of the red channel.

The green and blue channels are not affected. However, the overall
luminance field updates to reflect the change.

NOTE You may also type values into the channel fields and press Enter. In the
case of modifying all channels uniformly, when values are typed into any field,
the other fields update. The luminance field will update regardless of which method
is used to modify the values.

Using the Trackball to Modify Negative Film Gamma, Cineon Reference and
Linear Reference

The trackball allows you to modify levels with a more freestyle, intuitive
approach. The trackball emulates a typical 360-degree color wheel that can
be dynamically changed by dragging the center of the color wheel.
Consequently, the effect on the red, blue, and green channels is predictable.

For example, dragging the trackball towards the red portion of the color wheel
increases the value of the red channel, but decreases the values of both the
blue and green channels, and adds blue and green to the shadows and
midtones of the image.

Modifications made using the trackball are cumulative; each movement of
the trackball is added to the previous one. The trackball changes color to reflect
the degree of change.

To modify levels with the trackball:

 ➤ Drag the trackball to modify levels in the image.
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NOTE To reset the trackball, channel, and luminance levels, select the Reset
button below the trackball or the Reset button in Tool Options area on the
right side of the UI (this button resets the entire tool).

Color Correcting with CC Basics
The CC Basics UI contains the controls used to perform color correction. CC
Basics lets you:

■ Color correct shadows, midtones, and highlights separately or together

■ Rewire the red, green, or blue channels of an image

■ Set the hue, saturation, or contrast of an image

■ Set the color balance

■ Set the red, green, blue, or RGB channels by modifying the gamma, gain,
and offset values for the channel

■ Match colors

■ Perform color suppression

NOTE  Many of the CC Basics fields are animatable attributes—see Setting Keys
Manually on page 676 and Validating and Applying the Expression String on page
729.

Determining the Sequence of Corrections
After you have analyzed the image, it is important to determine what sequence
to use to make the color corrections. Some corrections may interfere with
previous adjustments that you have made, or change results that were
satisfactory. In general, you should not set saturation before applying
modifications to the hue, as hue shift affects the saturation value.

For predictable results, perform color corrections in the following sequence:

■ Correct the hue color balance

■ Correct the light and dark areas of the image using gamma, gain, offset,
and contrast

630 | Chapter 26   Color Correction



■ Correct the saturation

Color Correcting Shadows, Midtones, and Highlights
When you modify saturation, gamma, gain, offset, and contrast, you can color
correct the shadows, midtones, and highlights ranges in the image individually
or all together.

To color correct shadows, midtones, and highlights:

 ➤ Under Ranges, select a luma range to modify.

To Modify:Click:

The entire image. Modifications made in the Master range are applied
after individual range modifications.

Master

Dark areas in the image.Shadows

Midlevel areas in the image.Midtones

Light areas in the image.Highlights

Rewiring Controls
Rewiring color channels redirects the information contained in one channel
to another, and in some cases, makes adjustments to that information.

The following modes are available from the Rewire list.
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To:Select:

Return the footage to its original values.Normal

Create a monochrome (black and white or grayscale) version of the
image.

Mono

Create a negative version of the image.Negative

Redirect information from one color channel to another.Custom

The following rewiring options are available.

To:Select:

Use color values for the red channel.

Replace color values of the red channel with those of the green channel.

Replace color values of the red channel with those of the blue channel.

Replace color values of the red channel with the luma of all channels.

Replace color values of the red channel with its inverse. For example,
1 corresponds to the maximum value of the given color channel. In 8
bits, this value is 255.
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NOTE The green and blue channels are rewired in the same way as the red channel
(described in the previous table).

To rewire a color channel:

1 Select a rewire mode from the Rewire list.

2 Select a rewiring option.

You can redirect the information from one channel into any of the other
channels. You can also direct a pixel's luma value into a component, or
make a negative of a channel's information.

The Color Wheel
The color wheel acts as a reference and monitoring guide or template. You
can see how the colors that are 180 degrees apart are complements, and how
the RGB and CMYK points are distributed around the wheel.

Because RGB is an additive color model, magenta, cyan, and yellow are
expressed as combinations of two other colors.

The default display of the color wheel is the following:

■ Red is at 3 o'clock.

■ Blue is at 7 o'clock.

■ Green is at 11 o'clock.

■ Magenta (red plus blue) is at 5 o'clock.

■ Cyan (green plus blue) is at 9 o'clock.

■ Yellow (green plus red) is at 1 o'clock.
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Setting Hue Shift
Shifting the hue changes the colors in the image.

You can use hue shift to compensate for material that is too hot or too cool,
or simply to correct undesired tones present in the images. Note that in a
monochrome or very low saturation image, a hue shift produces no results,
since there is no hue to begin with.

Since you are working with a circle, a hue shift value of 360 returns to the
original color or image. A hue shift of 180 is equivalent to a negative, as the
colors are at their complements. The default for the Hue parameter is 0.

To apply a hue shift:

 ➤ Select the range that you want to modify, then do one of the following:

■ Set the Hue Shift field by either dragging inside the field or typing in
a value.

■ Place your mouse on the outer ring of the color wheel and drag in a
circular motion.

Setting Saturation
Saturation indicates how concentrated the color is: a saturated color has very
little gray, while a desaturated one is dampened with more gray. For example,
a pastel blue has a very low saturation level, while a blue screen is heavily
saturated. A scarlet red has a high saturation, while a pale pink has a low one.

To set the saturation:

 ➤ Set the Saturation field by either dragging inside the field or typing in a
value.

Setting Contrast
Contrast indicates the difference between the light and dark colors in an
image. A high-contrast image is mostly black and white, with very little gray.
A low-contrast image is very flat, foggy, and composed mostly of midtones.
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To set the contrast:

 ➤ Set the Contrast field by either dragging inside the field or typing in a
value.

Color Balancing with Hue and Gain
The two parameters used with color balancing are hue and gain. The value of
hue determines the color to add and the value of gain specifies the amount
of color to use.

To color balance with hue and gain:

 ➤ Do one of the following:

■ Set the Hue and Gain fields by either dragging inside the field or
typing in a value.

■ Drag the center of the wheel. Repeat to set a different range (shadows,
midtones, or highlights) of colors.

Pure red is the 0-degree point for hue on the color wheel. When you increase
the hue value, you move counterclockwise on the color wheel. When you
decrease the hue, you move clockwise on the color wheel.

The center of the color wheel represents 0 gain. As you increase the value of
gain, you move towards the edge of the color wheel and add more of the
selected color to the image.

NOTE If saturation is set to 0, no color balancing is performed, regardless of the
gain value.
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Quick Gain
The Quick Gain controls are used to set the Gain in three specific ways:

NOTE The main Gain value is applied after the other Gain fields, so changes to
main Gain do not change the separate channel Gain fields or the Quick Gain fields.

To:Modify:

Set gain using a scale from warm (-100) to cool (100), which results in
orange to cyan. It affects the Red and Blue Gain fields.

Temp

Set gain using a scale from green (-100) to magenta (100). It affects
the Red, Green, and Blue Gain fields.

M/G

Set gain using a scale from dark (0) to bright (200). It affects the Red,
Green, and Blue Gain fields.

Value

To modify the image using the Quick Gain controls:

 ➤ Drag the field to set the gain. You may also type values into the field and
press Enter.

NOTE You can reset all fields simultaneously by clicking Reset in the Tool
Options area located on the right side of the UI.

Setting the Gamma
You can set the gray values of an image by setting the gamma to brighten or
darken an image without greatly affecting the shadows or highlights.

To set the gamma of the image:

1 Select the tonal range that you want to modify.
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2 Drag the Gamma field to change the value (you can also type values into
the field). Lower the gamma value to increase the contrast or raise the
gamma value to decrease the contrast.

Setting the Gain and Offset
You can boost the colors in an image by increasing the gain and offset values.
Gain and Offset controls multiply the pixel color values by the gain and then
adds the offset value. The resulting color values are clipped at the maximum
color value of 255 in 8-bit mode, or 1 in floating point mode.

You can also reduce the colors in the image by decreasing the gain and offset
values. The resulting color values are clipped at the minimum value of 0.

Gain is expressed as a percentage value. The default value of 100% has no
effect on the image since the color values are multiplied by 1.

NOTE You can set the gain for individual ranges, or across all ranges simultaneously
(by using the Gain fields in the global controls).

To boost or reduce the colors in the image:

1 Select the range that you want to modify.

2 Drag the Gain field for the color channel that you want to modify (you
may also type values into the field).

3 Drag the Offset field for the color channel that you want to modify (you
may also type values into the field).

Suppressing Colors
Unwanted color can be caused by factors such as inconsistent lighting
conditions during a shoot. This can result in images that contain unnatural
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looking colors or one predominant color, which gives the image an unwanted
color cast. You can dampen the channel information for one or more channels.
It is available for all channels.

To suppress a color or channel:

 ➤ Under Suppress, disable the color or channel by selecting it.

NOTE Suppressing blue may result in a subtle overall pale yellow cast, since
yellow is the spectral complement of blue. The effect of suppressing any color
will unsuppress its complement.

Matching Colors
There are four options available for transferring the color value settings from
one image to another. One color match option will almost certainly work
better than all others for each particular shot, but it may take trial and error
to determine which option works best.

Not all color match options use all sample values. Match All and Match SMH
(Shadows, Midtones, Highlights) use all of the four pairs, but Match Gain and
Match Offset only match the Master pair of colors. In this second case, the
gamma, gain, and offset of the Master range is changed to perform the match.

To match a source image to a reference image:

1 Under Color Match, click a tonal range.

2 Ctrl + click in the Source field and use the eyedropper to sample a pixel
in the Player for that tonal range.

The sampled color is displayed in the Source field and stored as the source
value for the selected tonal range.
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3 Ctrl + click in the Reference field to invoke the eyedropper and sample
a pixel in the player for that tonal range.

The sampled color is displayed in the Reference field and stored as the
value for the selected tonal range.

4 To match other tonal ranges, repeat the preceding steps.

You may want to match the Master, or you may want to match just the
Shadows, Midtones, the Highlights, or any combination thereof.

5 Select one of the following Color Match options.

To:Select:

Match RGB values; match gamma, gain, and offset; and match shadows,
midtones, and highlights from source to reference.

Match All

Match shadows, midtones, and highlights from source to reference.Match SMH

Apply gain to the source to match it to the reference of the master
color sample pair.

Match Gain

Apply Offset to the source to match it to the reference of the Master
sample pair.

Match Offset

The Result field updates to reflect the changes made to match the color.

CC Histogram
The Histogram controls help you visualize how the individual pixel RGB values
are distributed across the image.

The histogram is a visual representation of all the color values contained in
the image as they are distributed over the range of pixel values (0–255). The
color values depend on the bit depth (255 is the highest value for 8-bit).
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You can view histograms for the red, green, or blue channels, or you can view
the histogram for the entire image (RGB).

NOTE If vertical lines are too small to be viewed, you can zoom in by placing the
cursor in the histogram viewer and then using the Up arrow and Down arrow
keys.

CC Histogram Controls
The Color Correct Histogram UI displays the input and output level
adjustments for the selected tonal range and channel, as well as the histogram
for the selected channel. The Ranges tab also displays the histogram for the
selected channel, as well as the Shadows, Midtones, and Highlights curves.

The four Tonal Ranges selectors select the tonal range to operate on, namely
Master (all pixels), Shadows, Midtones, and Highlights.

The four channel selectors select the channel to operate on, namely luminance
labelled Main, Red, Green, and Blue.

There is one set of input and output levels adjustments for each channel of
each tonal range for a total of sixteen sets of input and output levels
adjustments.
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(a) Input (b) Output

NOTE  The CC Histogram's input and output level controls' fields are animatable
attributes—see Setting Keys Manually on page 676 and Validating and Applying
the Expression String on page 729.

Input Sliders

The Input sliders below the histogram viewer are used to control the range of
input color values in the image. The white slider on the right sets the
maximum value for the range. The black slider on the left sets the minimum
value for the range.

The histogram shown in the main tab is that of the selected channel creating
a total of four possible histograms. The histogram background color matches
that of the selected channel: gray for luminance, red, green, or blue.

All main tab values are shown in the range [0 to 1].

The input slider controls the values that are clamped to 0 (below the minimum)
and to 1 (above the maximum). Values in between are scaled from 0 to 1. You
can also use this to increase contrast.

You can set the maximum and minimum limits for the color range by entering
the values in the Input fields on either side of the histogram.

NOTE Input levels increase contrast (remap more grays to blacks and whites),
while output levels decrease contrast (remap more blacks and whites to grays). If
you have an image that requires some softening of color or tone, the output levels
re-introduce some midtones to the image.

To increase contrast with the input sliders:

1 From the Tools tab, drag the CC Histogram tool from the Color Correction
folder to the dependency graph in the Schematic view.
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2 Select Master, Shadows, Midtones, or Highlights to select the areas of the
image that you want to modify.

3 Select Main, Red, Green, or Blue to select the channel that you want to
work with.

4 Do one of the following:

■ Position the cursor on the black slider below the histogram. Set the
level until the value that you want to use as the lower limit for the
color range appears in the Minimum field.
This darkens the shadow areas.

■ Position the cursor on the white slider below the histogram. Set the
level until the value that you want to use as the upper limit for the
color range appears in the Maximum field.
The brightness in the highlight areas increases.

5 To cancel the changes, select Reset in Tools Options.

Output Sliders

The sliders on the Output levels bar below the histogram contain the Output
level controls. Use these controls to set the range of colors in the image.

The white slider on the right sets the maximum value for the range. The black
slider on the left sets the minimum value for the range.

The Output slider remaps pixel values produced by the input level. Values at
0 are remapped to the minimum, values at 1 are remapped to the maximum,
and values in between are linearly interpolated. The output slider background
is a linear ramp of the same color as the selected channel: gray, red, green, or
blue.

You can also set the maximum and minimum limits for the color range by
entering the values in the Output fields on either side of the histogram.

To reduce contrast with the Output sliders:

1 From the Tools tab, drag the CC Histogram from the Color Correction
folder to the dependency graph in the Schematic view.

2 Select Master, Shadows, Midtones, or Highlights to select the areas of the
image you want to modify.

3 Select Main, Red, Green, or Blue to select the channel that you want to
work with.
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4 Do one of the following:

■ Position the cursor on the black slider below the Output levels bar.
Set the level until the value that you want to use as the lower limit
for the color range appears in the Minimum field.
The shadow areas are lightened.

■ Position the cursor on the white slider below the Output levels bar.
Set the level until the value that you want to use as the upper limit
for the color range appears in the Maximum field.
The brightness in the highlight areas is decreased.

5 To cancel the changes, select Reset in Tools Options.

Ranges Controls
When using a CC Basics or CC Histo tool, you can redefine what constitutes
a shadow, midtone, or highlight.

(a) Shadows curve (b) Midtones curve (c) Highlights curve

To display the curves for the three tonal ranges:

 ➤ Select the Ranges tab.

To redefine shadows, highlights, or midtones:

1 Select a Display parameter from the drop-down menu.

2 Drag the tangent handle connected to the curve you have selected to
modify.
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To see the effects of the curves on color balance:

1 Open the CC Basics UI.

2 Under Balance, adjust the Hue and Gain to set the color balance for each
of the Shadow, Midtone, and Highlight ranges.

3 Go back to the Ranges controls and set the curves.

4 Go back to the CC Basics controls. Without changing the color balance
setup, note that the resulting image is different from that in step 1.

The difference is the result of the changes that were made to the curves
of the shadows, midtones, and highlights.

Clamp Color Tool
The Clamp Color tool lets you clamp colors that are outside a given color
gamut. This is useful when you want to clamp an HDR image before using it
with certain esoteric blend modes in a composite or when you want to clamp
negative color components before using other color correction tools. Most of
the time, you will want to clamp colors against the conventional [0,1] range,
so this is the default behavior of the tool. This tool is an image modifier; it
can be masked and muted and can only affect the RGB channels.

The Clamp color tool has the following parameters:

To:Use:

Set the minimum color values in the image to be clamped.Min

Set maximum color values in the image to be clamped.Max

As an aid in visualizing which pixels are affected by its operation, this tool
has two secondary outputs: It generates a one-channel image (a mask) where
all out of range pixels are set to one and the rest are set to zero. It generates a
pseudo-color image (a map) where all pixels that are below the range are
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represented in blue, all the ones above the range in red, and the ones within
the range are desaturated, almost turned to grayscale, to provide context and
better locate the out of range pixels with respect to image features.

To view the Clamped Mask or Clamped Map:

 ➤ Normally, you will not connect the secondary outputs to other tools, but
you may want to look at them in the Player by cycling through the tool
outputs by pressing the 6 hotkey.

Original image

NOTE Secondary outputs can be neither masked nor muted.

Color Space Tool
The Color Space tool lets you convert to and from a variety of common color
spaces, as well as invert the color space conversion without having to change
selections in the source and destination space menus.

The Color Space tool covers all transformations between the following color
spaces:

■ RGB (REC 709)
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■ CMY

■ HSV

■ HLS

■ Y'CbCr (YUV) 709

■ Y'CbCr (YUV) 601

■ YIQ

■ CIE XYZ

■ CIE Yxy

■ CIE L*a*b*

■ CIE L*u*v*

Processing Images with Photo Lab
The Photo Lab tool lets you simulate camera exposure and photo development
changes in images. You can change the exposure to brighten or darken an
image in incremental steps, providing perceptually relative uniform changes
in luminance. Photo development adjustments can produce images with
different color distribution.

Photo Lab Processing
With the Photo Lab tool, you can set the exposure, gamma, pivot, and lift of
each color channel independently and in a variety of units, such as F-stops
or printer lights for exposure.

The input image is first subjected to a gain adjustment, then to a gamma
correction around a pivot point, and finally to a lift. Each step is optional.

646 | Chapter 26   Color Correction



NOTE  Many of the Photo Lab tool's fields are animatable attributes—see Setting
Keys Manually on page 676 and Validating and Applying the Expression String on
page 729.

Setting Exposure, Contrast, Pivot Point, and Lift of an
Image
■ Exposure  Exposure can be expressed in terms of F-stops, printer lights,

or gain. As with cameras, increasing the exposure by one F-stop results in
an image with the luminance value that is double that of the original.
Printer light units work very much like F-stops, but it usually takes six
printer light units (default setting) to get the same effect that you get if
you set exposure by one F-stop. If you are trying to simulate a calibrated
printing device for which you have accurate measurements, Photo Lab
allows you to specify how many printer lights there are in one F-stop.
Increasing the exposure by one F-stop also increases the gain by a factor
of two.

■ Contrast and Pivot  Gamma correction is applied about a pivot value.
In other words, pixel values equal to the pivot value are left unchanged.
This is useful when you want to use gamma correction to change the
contrast of an image, but do not want to affect a particular luminance
level. The amount of gamma correction can be expressed in terms of
contrast or in terms of the usual gamma exponent. Increasing the gamma
exponent decreases contrast.

■ Lift  The lift is simply a uniform offset added to all the pixel values
(different offsets for different color components). Lift is usually applied as
the last step of the process and can be used to control the overall brightness
of the image.

NOTE This tool simulates the physical workings of camera exposures and printing
devices as long as the media is encoded in a linear color space. All channels are
linked by default.

Use the following procedures to set values for exposure, contrast, pivot point
and lift. Note that menus are available for selecting exposure and contrast
units.

Setting Exposure, Contrast, Pivot Point, and Lift of an Image | 647



To uniformly modify the levels on all channels or on a single channel of an
image:

1 From the Tools tab, drag a Photo Lab tool from the Color Correction
folder to the dependency graph in the Schematic view.

2 Select exposure and contrast units.

3 Set Printer Lights per F-stop by dragging the field to the right or to the
left.

4 Do one of the following:

■ Drag any of the red (R), green (G), or blue (B) channel fields to the
right to increase or to the left to decrease levels uniformly on all three
channels. Alternatively you can also drag the overall luminance (L)
field to achieve the same result.

■ Enter a value into any channel's field and press Enter.

■ Select a single channel that you want to modify by deselecting Lock,
then drag the channel field to the right to increase, or to the left to
decrease, the values of the channel. You may also enter a value into
any channel's field and press Enter.
The other two channel fields and the overall luminance field update
to reflect the change.

Using the Trackball to Modify the Levels of an Image

The trackball allows you to modify values with a more freestyle, intuitive
approach. The trackball emulates a typical 360-degree color wheel that can
be dynamically changed by dragging the center of the color wheel.
Consequently, the effect on the red, blue, and green channels is predictable.

For example, dragging the trackball towards the red portion of the color wheel
increases the value of the red channel, but decreases the values of both the
blue and green channels, and adds blue and green to the shadows and
midtones of the image.

Modifications made using the trackball are cumulative; each movement of
the trackball is added to the previous one. The trackball changes color to reflect
the degree of change.
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To modify the levels of an image using the trackball:

 ➤ Drag the trackball to modify levels in the image.

NOTE To reset the trackball, channel, and luminance levels, select the Reset
button below the trackball or the Reset button in Tool Options area on the
right side of the UI (the latter resets everything).

Inverting an Image
You can convert an image into a negative by applying the Invert tool.

NOTE You can invert just RGB, just Alpha, or RGB and Alpha, see the Affects menu
in Tool Options.

To invert an image:

 ➤ From the Tools tab, drag the Invert tool from the Color Correction folder
to the dependency graph in the Schematic view.

The image is inverted.

Remap Color
The Remap Color tool lets you view High Dynamic Range (HDR) images on
a limited dynamic range display, such as a computer monitor. You can also
use the Remap Color tool as a 1D LUT tool to remap an image's color output
using interactive histogram and color curve tools.

For more information on 1D LUTs, see Applying LUTs on page 618.

To remap the color of an image:

1 From the Tools tab, drag the Remap Color tool from the Color Correction
folder to the dependency graph in the Schematic view.
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2 From the Remap Color UI, select a mode in which to remap the color:

■ Linear: Maps a given range of the input values to the output interval.
You can specify which luminance value in the input maps to black
and which one maps to white. In this mode, you can click the Clamp
button to have the curve defined by constant output values outside
the level range. Otherwise, the straight line between black and white
is interpolated for the entire range.

■ EXRDisplay: Popular among Open EXR users, compresses a large
portion of the high dynamic range into the gamut of the display
without introducing clamping artifacts.

3 Under Output Depth, set the depth at which you want to output the
image.

4 In the Remap Color UI, adjust the parameters for the mode you selected:

To:Use:Mode:

Set the minimum and maximum input color values in
the image.

In Min and In
Max

Linear

Set the minim-
um and maxim-

Out Min
and Out
Max um output col-

or values in the
image.

Set the gray
values. Increase

Gamma

to brighten and
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To:Use:Mode:

decrease to
darken.

Set the exposure of the image. You can lighten or
darken the image to reveal detail in the high or low
end.

ExpEXRD-
isplay

Compensate
for fogging due

Defog

to stray light in
the recording
device.

Set the white
level of the im-

Knee Low
and Knee
Hi age, which de-

termines which
value is
mapped to the
maximum in-
tensity of the
display.

Set the gray
values. Increase

Gamma

to brighten and
decrease to
darken.

Working with the Histogram
Controls on the left side of the histogram/curve viewer let you control how
you want to view the histogram. The source histogram is white and the result
histogram is black. By default both the source and result histogram are
displayed in gray. You can view the source or result histogram, or a
combination of the two at the current time.

Working with the Histogram | 651



NOTE The histogram is not updated during playback.

To frame the histogram:

 ➤ Under Histo View, click the Frame button.

To view the source or result histogram:

 ➤ Under Histo View, click the button beneath the Frame button and select
Source or Result.

To zoom the histogram:

 ➤ Under Histo View, enter a value in the Zoom box.

To zoom the histogram/curve viewer:

 ➤ Do one of the following:

■ To zoom in, press the Up Arrow key.

■ To zoom out, press the Down Arrow key.

■ To zoom in/out, press Ctrl + Spacebar and drag (for Windows and
Linux) or Cmd + Spacebar (for Mac OS).

To pan the histogram/curve viewer:

 ➤ Press the Spacebar and drag.

Setting the Source Color

If you have a specific color in mind, you can set the source color by picking
it from the remap color input image. Once you select a source color, the result
color is automatically generated, and the orange color bar in the
histogram/curve viewer moves to indicate where in the range the color exists.
Then you can adjust the curve until you're satisfied. While you're doing this,
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a dashed color bar indicates the changes you've made to the color, relative to
the source color you set.

To set the source color:

 ➤ Click the Source color pot and select a color from the image in the Player.

The result color is automatically generated.

Working with Curves
You can view and set values for the red, green, or blue histogram channels
individually or for the curve representing the entire image (RGB).

When using the Remap Color tool, there are three curves displayed in the
histogram/curve viewer: the basic curve, adjusted curve, and final curve. The
basic curve is the result of the mode you selected and is displayed as a dashed
line. The adjusted curve is the result of any changes you made to the curve
itself; this is the only curve you can directly manipulate. It is displayed as a
white line. The final curve is a combination of the basic and adjusted curves,
and is displayed as a heavy white line. By default, the final curve is always
displayed, but you can view the basic and adjusted curves individually.

To view individual R, G, or B curves:

 ➤ Under Curves, click the channel selection button (second button) and
select Red, Green, or Blue.

To frame the curve:

 ➤ Under Curves, click the Frame button.

To adjust the curve:

1 Under Curves, click the curve selection button (third button) and select
Adjust.

The Adjust curve is displayed.

Working with Curves | 653



2 Do any of the following:

■ Click the control point in the middle of the curve and adjust the
tangent handles.

■ Add control points by pressing the Plus (+) sign and clicking the curve.
Press the Esc or zero (0) key when you're done.

■ Delete control points by pressing the Minus (-) sign and clicking the
points to delete. Press the Esc or zero (0) key when you're done.

3 Click the Adjust button to mute the adjusted curve.

4 To reset the curve, click the Reset Adj. button.

TIP To reset the Remap Color tool, click the Reset button in the Tool UI Area.

Set Fill Color
This tool lets you set the fill color (RGBA) of an image without affecting any
of the other characteristics of the image. This tool in an image modifier; since
it only affects the fill color and does not change the pixels of the input image,
this tool cannot be masked; it can be muted; it affects the color and alpha of
the fill color only. This tool does not modify the pixel format or image
resolution of its input.

The Set Fill Color tool has the following parameters:

Solarizing an Image
You can set the inversion threshold of an image to create solarizing effects.

654 | Chapter 26   Color Correction



To solarize an image:

1 From the Tools tab, drag the Solarize tool from the Color Correction
folder to the dependency graph in the Schematic view.

The Solarize tool UI appears with the Threshold set to zero and the image
inverted (by default).

2 Adjust the Threshold to change the amount of solarization.

Things to Remember

■ You can reset the threshold field by selecting Reset in Tool Options.

NOTE  The Solarizing tool's Threshold field is an animatable attribute—see Setting
Keys Manually on page 676 and Validating and Applying the Expression String on
page 729.

Creating a Monochrome Image
You can convert a color image into a monochrome image by using the Mono
tool.

To create a monochrome image:

 ➤ From the Tools tab, drag the Mono tool from the Color Correction folder
to the dependency graph in the Schematic view.

The image becomes monochrome.
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Modifying a Display With the Pass Through Tool
See Applying a LUT or Color Conversion Tool to the Player on page 210.

Setting the Amount of Gray in an Image
You can set the amount of gray in a color image.

To set the amount of gray in an image:

1 From the Tools tab, drag the Gray tool from the Color Correction folder
to the dependency graph in the Schematic view.

The Gray tool UI appears with the Gray Amount field at its default of
100%.

2 Adjust the Amount field to change the amount of gray in the image.

Things to Remember

■ You can reset the Amount field by selecting Reset in Tool Options.

NOTE  The Gray tool's Amount field is an animatable attribute—see Setting Keys
Manually on page 676 and Validating and Applying the Expression String on page
729.

Converting an Image to sRGB
Use the sRGB tool to convert an image into sRGB color space.
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To convert an image into sRGB color space:

1 From the Tools tab, drag the sRGB tool from the Color Correction folder
to the dependency graph in the Schematic view.

2 Select the output depth and set the exposure.

NOTE  The sRGB tool's Exposure field is an animatable attribute—see Setting Keys
Manually on page 676 and Validating and Applying the Expression String on page
729.
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Animation

Topics in this chapter:

■ Animation Concepts on page 660
■ The Animation Tab on page 661
■ Composition Browser on page 661
■ Animation Editor on page 662
■ The Animation Property Area on page 666
■ Player Controls on page 667
■ Working with Cue Marks on page 668
■ Contextual Menus on page 670
■ Keyframing Workflows on page 674
■ Marking Attributes for Keyframing on page 674
■ Setting Keys Manually on page 676
■ Setting Keyframes Automatically on page 680
■ Editing Keyframes in the Tool UI on page 681
■ Editing Keyframes in the Animation Editor on page 682
■ Adding and Deleting Keyframes on page 683
■ Modifying Interpolation on page 687
■ Modifying Extrapolation on page 688
■ Temporarily Modifying Attribute Values on page 688
■ Customizing the Layout when Working with Animation Curves on page 689
■ Global Time vs. Local Time on page 690
■ Time Offsets, Keyframing, and Instancing on page 690
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Animation Concepts
Simply defined, animation is a simulation of movement created by displaying
a series of pictures, or frames. From one frame to the next certain values are
changed. Almost all values can be animated. A value can be anything from
the position, rotation, scaling, or transparency of an object, to the gamma,
gain, or offset in a color correction.

Keyframe Animation
Keyframing is the simplest form of animating an object. It is based on the
notion that an object has a beginning state, or condition, and changes over
time in position, form, color, luminosity, or any other property to some
different, final state. Keyframing takes the stance that we only need to show
the keyframes or conditions that describe the transformation of the object,
and that all other intermediate positions can be figured out from these—see
Keyframing and Interpolation on page 660 and Setting Keyframes on page 660.

Keyframing and Interpolation
When you keyframe, you determine what an object looks like at specific points
in time, while algorithms fill the frames in between the keyframes. This
technique is called in-betweening. The intermediate values between the
keyframes are computed by interpolation.

Extrapolation is used to determine the behavior of a channel before the first
or after the last keyframe—see Modifying Interpolation on page 687.

Setting Keyframes
You can set keyframes for just about anything that has a value, including an
object transform, visual attribute, as well as any tool attribute. When you set
a keyframe to animate a particular parameter, a function curve is created. The
curve is a graph that represents the animation of that parameter over time.
You can edit the animation by editing its curve in Animation Editor or by
modifying the attribute values in the Tool UI. You can set keyframes manually
or automatically—see Setting Keys Manually on page 676 and Setting Keyframes
Automatically on page 680.

660 | Chapter 27   Animation



The Animation Tab
The Animation tab is where you can edit animations in the tool UI. It is
composed of three areas:

To:Use:

View tool parameters and set keyframes in the current anima-
tion—see Composition Browser on page 661.

Composition
Browser

Display the animation curves and tracks for a composition—see
Animation Editor on page 149.

Animation Editor

Set animation properties, views, and functions—see The Animation
Property Area on page 666.

Property Area

To access the Animation tab

 ➤ Select the Animation tab in the tool UI.

The Animation tab UI appears.

Composition Browser
The Composition Browser is the area where you select one or more specific
curves to be displayed and edited in the timeline. It is located on the left of
the Animation tab. It also exists as a standalone view, which can be accessed
by swiping through the east gate (right) of the Gate UI.

By default, the Composition Browser shows tools in the dependency graph.
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You can also select other filter types from the Filter list.

Animation Editor
The Animation Editor allows you to work in either a curve view or a track
view. Click the View button in the Animation Tab Property Area to choose
one or the other. For further information on other options for the Animation
Editor, see The Animation Property Area on page 666.

NOTE You can access the same options available in the Animation Property Area
from the Animation tab in the Tool UI.

Curves View
Animation curves provide an accurate representation of a tool's relative
behavior over time.

You can work with animation curves either from the Animation tab UI or in
the Animation browser, which can be accessed by swiping east through the
The Gate UI on page 12 .

The following graphic shows the Animation tab UI curves view.
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(a) Time cursor

The time cursor is displayed as a vertical yellow line and can be moved along
the time range by dragging it. The time cursor position represents the current
frame. You can move to any frame by dragging the yellow current frame cursor
to the new frame number.

Tracks View
The tracks view allows you to see your work in overview mode. You can move,
add, and delete keys but not edit their value.

Tracks are used to edit the attribute values using the value editor, which is
located on the right side of the Tracks view (you must select the keyframe to
edit).

In track mode, each channel displays all of its keyframe positions. Each channel
group and each tool displays a track that corresponds to the start and end of
all included channels.

For example, the following graphic shows the tracks view displaying a
composition that includes the Blur tool. Five keyframes have been set on the
Gaussian's X track and the track is selected.

(a) X channel of Gaussian Blur attribute in Composition Browser (b) Blur, Gaussian,
and Radial tracks (c) Time cursor
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You can move the contents of the Animation Editor using the following keys
while the cursor is focused on the Animation Editor:

To pan:

 ➤ Spacebar + drag.

To zoom:

 ➤ Do one of the following:

■ Ctrl + Spacebar + drag (Windows and Linux) or Cmd + Spacebar (Mac
OS)

■ Up Arrow to zoom in and Down Arrow to zoom out.

To resize the Animation Editor:

1 Select and drag the horizontal separator located just above the tool UI
up or down.

2 Select and drag the separator located between the Animation Editor and
Composition Browser to the left or right.

3 To reset a separator to its previous location, you can move it manually
or press Ctrl + click.

4 You can also use your mouse wheel to resize the editor.

Animation Editor Feedback
To help simplify large and complex animations, the Animation Editor provides
contextual roll-over feedback.

The following list displays the various roll-over feedback and their meanings.

■ Attribute name highlighting  When the cursor is positioned over a curve
(selected or not), the name of the animated parameter is displayed and a
C appears beside the cursor. This tells you what curve you are about to
select or what input a particular curve is associated with.
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(a) Blue channel of Photolab's Lift attribute (b) Cursor on curve

■ Keyframe values highlighting  When you position the cursor over a
keyframe, the keyframe coordinates are displayed beside the cursor, just
under the name of the input. When you move a keyframe, the updated
value is displayed, as well the translation offset from the beginning of the
manipulation.

(a) Moved keyframe (b) Key position (c) Key offset (d) Attribute

■ Keyframe feedback  Rolling over a keyframe in the Animation Editor
will evoke different feedback depending on the state of the keyframe.

(a) Cursor over keyframe. (b) Cursor over keyframe with Auto tangent on, indicated
by the lower-case “a”. (c) Cursor over keyframe tangent with Auto tangent off. The
orange-brown circle indicates the tangent handles.
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The Animation Property Area
The Property Area is used to switch the display from curves to tracks, apply
curve functions, and edit keyframe parameters.

The Property Area contains the following parameters.

To:Select:

Toggle Auto Tangent on or off for selected keyframes when fine tuning
a curve. When a keyframe is selected and Auto Tangent is on, a lowercase

Auto Tan-
gent

“a” appears on top of the keyframe. When Auto Tangent is off, tangents
are displayed normally. You can toggle Auto Tangent by selecting the
button or by pressing the T key.

Edit the selected cue mark’s name.Cue Name

Edit the selected cue mark’s time (in frames).Cue Time

Frame and fit the selected keyframe(s) in the Animation Editor.Frame Selec-
ted

Frame and fit all visible keyframes contained in the Animation Editor.Frame All

Select from a list of math operations, enabling you to modify a keyframe
or group of keyframes.

Curve Opera-
tions

Select from three different layout options for the Animation EditorLayout

Enable Snapping mode for the keyframe when moving or creating it.Snap To

■ Grid: Snaps to the grid in Animation Editor.

■ Frame: Snaps the time value of keyframes to the closest frame.

■ Off: turns option off.

Switch between curve and track views—see Contextual Menus on page
670.

View
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To:Select:

Select from a list of extrapolation types to set the interpolation of selec-
ted keys.

Interpolation

Select from a list of extrapolation types to define the shape of a curve
after the selected keyframes.

Extrapolation

Move to previous keyframe.

Move to next keyframe.

Delete keyframe.

Add keyframe.

Modify the time (X axis of the graph) of the currently selected keyframe.Time

Modify the value (Y axis of the graph) of the currently selected keyframe.Value

Player Controls
The Player Controls are located along the top of the Animation tab and contain
several animation controls located on the far left.

To:Select:

Select a playback mode.

Move to previous cue mark.

Set a cue mark.

Move to next cue mark.
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To:Select:

Move to previous keyframe.

Set keyframe.

Move to next keyframe.

Set keyframes automatically—see Setting Keyframes
Automatically on page 680.

Working with Cue Marks
Cue marks are time-based points of interest with annotations. They function
as high-level keyframe controls that let you associate a keyframe with a mark.
Instead of viewing a clip over and over again in order to evaluate and record
(usually on paper) important timing points, you can view footage and add
cue marks.

Once you've set a cue mark, you can go back to the animation timeline and
tweak the positions of the cue marks, give them names, and even add notes
to them.

You can also set keyframes based on these marks by navigating from one mark
to another using the Next Cue Mark and Previous Cue Mark buttons.

Setting keys links the temporal position of the keyframe to the cue mark at
that time; as you move the cue marks, the keyframes follow. If you move a
keyframe in time, the link to the cue mark is broken. However, by moving a
keyframe to the exact time of a cue mark, you link the keyframe to that cue
mark.

To add a cue mark:

 ➤ Select the Set Cue Mark button in the Player controls.

NOTE You can also set a cue mark by pressing the U key while your cursor is in
an Animation Editor, or in the Player navigation bar's current frame counter.
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(a) Cue marks in Animation Editor

To set a cue mark to a specific frame of a film clip:

1 Do one of the following:

■ Drag the time cursor in the Player navigation bar (or type in the frame
number) to the frame on which you want to set a cue mark.

■ Play the composition, so that you can add cue marks during playback.

2 Select the Set Cue Mark button in the Player navigation controls (left
side) or set the cue mark while the footage is playing by pressing the U
key. Play-and-set is a more interactive method of adding cue marks.

3 Repeat steps 1 and 2 to add more cue marks.

NOTE You can also add a cue mark by right-clicking in any Animation Editor and
selecting Add at Select Time or Add From Current Time from the Cue Marks
sub-menu.

To delete a cue mark:

1 Select the Cue Marks tab in the tool UI.

2 Select a cue mark.

3 Right-click and select Delete.

To delete a cue mark using the contextual menu in any Animation Editor:

1 Select the cue mark you want to delete by selecting the top of it (it will
turn from black to yellow when selected).

2 Right-click and select Delete (or Delete All) from the Cue Marks sub-menu.
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Adding and Renaming Cue Marks
You can keep track of your cue marks by renaming them. There are several
ways you can do this:

To rename to a cue mark using the Cue Marks tab:

1 Select the Cue Marks tab in the tool UI.

The list of cue marks appears (by default, unnamed cue marks are
numbered in succession).

2 Select the name field and press F2 or right-click and select Edit.

3 Type in a name for the cue mark and press Enter.

4 Repeat steps 1 to 3 to add a description to or set a new frame for the cue
mark.

To rename a cue mark using the Cue Name field in the Animation tab
Properties area:

1 Select the existing name in the Cue Name field.

NOTE The cue mark must be selected before the text edit is allowed.

2 Type in the new name.

3 Press Enter.

Contextual Menus
You can access many of the animation controls while in any Animation Editor
by right-clicking and accessing a contextual menu.

You can access items stored in your Pick List.
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Navigating the Animation Editor
Contextual navigation controls are available for both Keyframes and Cue
Marks. They let you perform the following operations:

To:Select:

Move the time cursor to the next keyframe among the selected
curves.

Next (Keyframes)

Move the time cursor to the previous keyframe among the selected
curves.

Previous (Key-
frames & Cue
Marks)

Move the time cursor to the next cue mark.Next (Cue Marks)

Move the time cursor to the previous cue mark.Previous (Cue
Marks)

Move the time cursor to the first keyframe among the selected
curves.

First (Keyframes)

Move the time cursor to the last keyframe among the selected
curves.

Last (Keyframes)
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To:Select:

Select next keyframe or curve.Select Next (Key-
frames & Cue
Marks)

Select previous keyframe or curve.Select Previous
(Keyframes & Cue
Marks)

Select all keyframes or curves.Select All (Key-
frames & Curves)

Deselect all keyframes and curves.Deselect All (Key-
frames & Curves)

Adds cue mark at the position that you click with your mouse.Add Click Time
(Cue Marks)

Adds cue mark at the current time.Add Current Time
(Cue Marks)

Delete a specific cue mark.Delete (Cue Marks)

Delete all cue marks.Delete all (Cue
Marks)

Local Controls
You can navigate through a set of keyframes using the Previous Keyframe and
Next Keyframe buttons in the Tool Options located on the right side of the
tool UI, Player controls tool bar, or by using the contextual navigation menu
in any Animation Editor.

When using the Next Keyframe and Previous Keyframe buttons in the Tool
Options, keyframe navigation is restricted to the keyframes set for that
particular tool. However, when using the keyframe navigation controls in
either the Player controls or Animation tab Property Area, you can navigate
through keyframes of all marked tools attached to the dependency graph.
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Selecting Keyframes
For the Contextual selection controls, see the Contextual navigation controls,
in Navigating the Animation Editor on page 671.

Setting Cue Marks
There are several options related to cue marks. For more information see,
Navigating the Animation Editor on page 671.

NOTE The first two options are always available. The other options are only
available when a cue mark is selected. The two navigation options are available
when next or previous cue marks are available respectively.

Setting Zoom and Pan
Placing the mouse cursor over the View Layout sub-menu displays selections
you can use to store up to four zoom and pan settings. This is useful when
you want to jump back and forth between different points on an animation
curve—see View Layouts on page 153.

To set a zoom and pan view:

1 Zoom and pan to the area of the animation curve you want to set as a
view layout.

2 Right click in the Animation Editor view and select one of the four Set
options from the View Layout sub-menu or press Ctrl + F(1,2,3,4).

3 Repeat steps 1 and 2 to add more layout views (maximum 4).

4 Press F (1,2,3,4) to activate the view or select Activate from the View
Layout sub-menu.
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5 Press Shift + Ctrl + F (1,2,3,4)  to delete the layout view or select Delete
from the View Layout sub-menu.

Keyframing Workflows
The following is the workflow for setting animation keyframes:

■ Mark the attributes for keyframing—see Marking Attributes for Keyframing
on page 674.

■ Set a keyframe by selecting the Set Keyframe button—see Setting Keys
Manually on page 676.

■ Setting keyframes automatically - see Setting Keyframes Automatically on
page 680.

■ See also Working with Cue Marks on page 668.

Marking Attributes for Keyframing

The workflow for keyframing using marking consists of the following:

1 Selecting attributes to be marked.

2 Changing values.

3 Setting keyframes for all marked values.

So the first step in setting keyframes for animation is marking which attributes
you wish to animate. Almost all attributes can be marked for keyframing. You
can mark attributes for keyframing in either the tool UI, Composition Browser,
or Animation tab UI.

To mark an attribute for keyframing in the Tool UI:

 ➤ Select the attribute label to turn marking on or off.

The label and value editor change to yellow, as in the following example
where the Hue and Saturation of the CC Basics tool have been marked.
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You can also mark attributes by right-clicking a value editor and choosing one
of the following options:

To:Select:

Mark all animatable attribute labels of the current tool. Note that this
is only available if no attribute is presently marked in the tool node.

Mark Tool

Mark current attribute label.Mark

Set keyframe for current attribute value field—see Setting Keyframes on
page 660.

Set Key

Set expression for current attribute value field—see Validating and Ap-
plying the Expression String on page 729.

Set Expres-
sion

Reset the values to default state.Reset

To mark an attribute for keyframing in the Composition Browser:

1 Expand the tool channel to the attribute level (in this example, the Hue
and Saturation attribute of the Master range of the CC Basics tool).

2 Select the radio button of each attribute that you wish to mark in the M
(mark) column.

The Hue and Saturation attributes are now marked for keyframing.

You can also mark attributes in the Composition Browser by right-clicking an
attribute field and choosing the same Mark and Mark Tool options provided
in the tool UI.

To unmark an attribute in the Animation tab:

 ➤ Do one of the following:

■ Click on the attribute label.
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■ Right-click the attribute field and select an unmarking option.

To:Select:

Unmark all animatable attribute labels of all current tools in the depend-
ency graph.

Unmark All

Unmark all animatable attribute labels of current tool.Unmark Tool

Unmark current animatable attribute label.Unmark

You can also unmark attributes in the Composition Browser by right-clicking
over an attribute field where you will be given the same Unmark All and
Unmark Tool and Unmark options provided in the tool UI.

Setting Keys Manually
You can set keyframes for any animatable parameter at any time, and in any
order. When you add a keyframe, the interpolation between the previous and
the next keyframe is computed automatically. Setting a keyframe over another
keyframe replaces the old keyframe.You can set keyframes the following ways:

■ The Keyframe button in the Player controls, which only sets keyframes on
marked attributes.

■ The Add Keyframe button in the Tool Options.

■ The Add Keyframe button in the Animation Tab.

■ The Set Keyframe option list when you right-click on an attribute's value
field in the tool UI or in the Composition Browser.

■ The Set Keyframe hotkey (K).
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NOTE When you use the K hotkey in the Animation Editor, keyframes are
added as follows:

■ If none of the inputs of the selected node are selected, a keyframe is
added at the current viewer's time for every input in the selected node
(as if you selected every input in the tool).

■ If at least one input is selected, keyframes are set on the selected inputs
only.

■ Every time a keyframe is set, there is no check for previous animation
on inputs. This means that pressing the K hotkey will set keyframes on
inputs even if the inputs were not already animated.

■ The Set Keyframe for marked attributes hotkey combination (Shift + K).

NOTE The Shift + K hotkey has the same behavior as the Set Keyframe buttons
mentioned above. It will set keyframes for all the marked attributes of the
currently selected tool. The K hotkey, on the other hand, can only be used in
an Animation Editor context.

Example: Animating Using the Tool UI
In this example, you'll be creating a simple animation that would change the
amount of gray in an image over the span of 96 frames. You'll be manually
setting keyframes using the tool UI.

NOTE It is assumed that the composition is loaded and that the Gray tool has
been added to the dependency graph.

To animate the amount of gray in an image using the Gray tool UI:

1 Click on the Gray tool and select the Amount attribute label, marking it
for keyframing. A yellow rectangle appears on the tool node indicating
that it has been marked for keyframing.
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2 At the first frame leave the value at 1.00000.

3 Select the Set Keyframe button in the Tool Options (see Node-Specific
Tabs on page 26) or the Player controls.

A green line appears at the top of the attribute label, indicating that the
attribute is now animated and has a keyframe at the current frame.

4 Move the time cursor in the Player navigation bar to frame 30.

The green line changes to red to indicate the attribute is animated but
has no keyframe at the current frame.

5 Change the value in the Amount field to .50000.

6 Select the Set Keyframe button.

The green line changes back to red. Again, this indicates that a new
keyframe has been added to the timeline.

7 Repeat steps 3 to 6 as required.

8 Select the Gray attribute in the Composition browser.

9 Select Frame or Frame All to view the curves in a Animation Editor (or
press Home).

NOTE You can also set keyframes in the tool UI by right-clicking an attribute field
and choosing any of the options to mark attributes and set keyframes.
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Example: Animating Using the Composition Browser
You can also use the Composition Browser to manually set keyframes. The
following procedure uses the same example of adjusting the amount of gray
in an image.

NOTE It is assumed that the film footage is loaded and that the Gray tool has
been added to the dependency graph.

To animate the amount of gray in an image using the Gray tool in the
Composition Browser:

1 Expand the Gray tool in the Composition Browser.

2 Mark the Amount attribute for keyframing by selecting its radio button
in the M column.

3 At the first frame, leave the initial value as is.

4 Select the Set Keyframe button to set a keyframe on the Amount attribute.

A green line appears over the attribute’s value, indicating a keyframe has
been added for this attribute at that frame.

5 Move the time cursor in the Player navigation bar to frame 30.
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NOTE When you move the time cursor to the next frame, you will notice
that the green line turns red, indicating that the attribute is animated, but
has no keyframe at the current frame.

6 Click in the value editor in the Composition Browser and either type the
new amount of gray, then press Enter, or drag inside the value editor.

7 Repeat steps 4 to 6 as required.

8 Select Frame or Frame All to see the curves in the Animation Editor.

Setting Keyframes Automatically
You can set animation keyframes automatically each time you modify the
attribute values. This process is called AutoKey.

AutoKey lets you to skip the steps of marking attributes and pressing a button
or hotkey every time you want to set a keyframe. When AutoKey is on and
you modify an attribute value in any way (using the tool UI, direct
manipulation, or scripting) a keyframe for the modified attribute value is set
at the current time, whether or not the attribute is marked for animation. The
Autokey setting therefore overrides all markings for animation settings. This
is also valid while playing and is usually done this way to define the initial
shape of the animation.

To turn AutoKey on:

1 Select the AutoKey button.

You are now in AutoKey mode.

2 Select AutoKey again to turn off AutoKey mode.
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Editing Keyframes in the Tool UI
Aside from modifying attribute values, you can also perform a variety of
common operations by right-clicking in a value field, then selecting an
operation from the menu. The following table lists these operations and
describes their function:

To:Select:

Copy the keyframe.Copy frame

Cut the keyframe but maintain its information in the memory.Cut frame

Paste the keyframe to another location on the timeline where there
isn't already a key. This operation is available if a keyframe has been
copied or cut.

Paste frame

Remove the keyframe from the timeline.Delete Keyrame

Navigate to the first keyframe in the timeline.First frame

Navigate to the previous keyframe.Previous frame

Navigate to the next keyframe.Next frame

Navigate to the last keyframe in the timeline.Last frame

Copy the animation of the selected channel.Copy Animation

Remove the animation from the selected channel but retain its
values in the clipboard.

Cut Animation

Paste the animation values that were placed in the clipbaord using
copy or cut.

Paste Animation

Remove the animation from the attribute without retaining its in-
formation in the pasting buffer.

Remove Anima-
tion
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Editing Keyframes in the Animation Editor
The Animation Editor gives you precise control over keyframes and animation
between keyframes. You can also move a keyframe in time in the Animation
Editor.

To edit a keyframe in the Animation Editor in the Animation tab:

1 In the Property area, select View to Curves.

2 In the Composition Browser, select the channel whose keyframe you
want to edit. When you select a channel, all its keyframes are displayed.

NOTE To select several channels for editing, draw a selection box around
the channels you want to select or Ctrl + click each one.

The curve appears in the editor.

3 Select the keyframe(s) that you want to edit.

4 Select and drag a keyframe up or down to change its value. Drag left or
right to move it in time.

5 Drag a tangent handle to change the shape of the curve at the keyframe
when the Bezier interpolation is chosen.

To move a keyframe in time in the Animation Editor Tracks view:

 ➤ Select and drag the selected keyframe to the right or left.
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Adding and Deleting Keyframes
You can add or delete keyframes in a variety of ways when focused in a
Animation Editor.

To add a single keyframe to an animation curve:

1 Press and hold the Alt key.

2 Place the cursor on the curve at the point where you want to add a
keyframe.

3 Click once.

A single keyframe is added.

To delete a single keyframe from an animation curve:

1 Press and hold the Alt key.

2 Move the cursor over an existing keyframe. “K+” will be shown next to
the cursor.

3 If needed, enlarge radius of eraser by pressing Ctrl + click and moving
the cursor to the right (to increase) or to the left (to decrease).

4 Place the cursor on the curve at the point at which you want to remove
the keyframe.

Note that the cursor becomes active (turns from orange to yellow) when
it comes in contact with a keyframe.
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5 Click once.

The keyframe is deleted.

To remove more than one keyframe with a single mouse click, enlarge
the cursor so that it encircles several keyframes.

6 Click once. All keyframes within the area of the cursor are deleted.

To quickly delete a series of keyframes along an animation curve:

1 Press and hold Alt + Shift.

2 Drag the mouse along the curve.

The keyframes are deleted.
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Precision Keyframe Editing
There are several precision keyframe editing controls available to you in the
form of hotkeys. The following section lists the hotkeys, their function, and
how the keyframe appears in the editor—see Animation Editor on page 662.

Keyframe in Animation EditorHotkey and Function

Shift + T
Locks keyframe time

Shift + V
Locks keyframe value

Shift + L
Locks tangent length
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Keyframe in Animation EditorHotkey and Function

Shift + O
Locks tangent orientation

Ctrl + Shift + L (Windows
and Linux) or Cmd + Shift
+ L (Mac OS)
Unifies tangent length

Ctrl + Shift + O (Windows
and Linux) or Cmd + Shift
+ O) (Mac OS)
Unifies tangent orientation

NOTE To return the keyframe to its previous state, press the hotkey again.

Other hotkeys are available for keyframing—see Hotkeys on page 817.

686 | Chapter 27   Animation



Modifying Interpolation
Once you create keyframes for a channel, you can use interpolation to
determine the channel values for the in-between frames. The appearance of
the animation in the Animation Editor depends on the interpolation method
used. In the Animation Editor, the interpolation method is represented by
the shape of the curve that joins the keyframes. You can set the interpolation
for an entire curve or for individual keyframes.

The following interpolation methods are supported:

■ Constant (key values do not change in time between keys, tangents are
absent)

■ Linear (straight interpolation between keys, tangents are absent)

■ Bezier (spline interpolation, you can edit the tangent length and
orientation)

(a) Bezier (b) Linear (c) Constant

NOTE The default interpolation setting is Bezier.

To set the interpolation method for an individual keyframe or an entire curve
using the Animation tab Property area or the Animation Editor view controls:

1 Select the keyframe(s) for which you want to change the interpolation.

2 Select Interpolation and select the interpolation method.
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Modifying Extrapolation
Extrapolation is used to determine the behavior of a channel before the first,
or after the last, keyframe. Extrapolation is useful when you want to create a
cyclical effect, such as shutter flicker (as you would find in an old-time movie).
You create one period in the flicker cycle, then use extrapolation to repeat
the period over and over again. You will see the effects of extrapolation only
if the film image has frames before the first keyframe or after the last keyframe.

The following extrapolation types are supported:

■ Constant  Applies the value at the first or last keyframe to all the frames
that come before or after the last or first keyframe.

■ Linear  Continues the curve in a linear fashion before the first keyframe
or after the last keyframe using the tangent.

■ Loop  Cycles the animation as it appears between the first and last
keyframe.

■ Ping Pong  Cycles the animation as it appears between the first and last
keyframes forward then backward.

■ Relative  Cycles the animation as it appears between the first and last
keyframe. This is similar to “Loop”, but the relative offset is based on the
channel value derived from either the first or last keyframe.

■ Key Linear  Continues the curve in a linear fashion before the first
keyframe or after the last keyframe, disregarding all tangents.

Temporarily Modifying Attribute Values
Even if an attribute is animated, you can temporarily modify its value to see
what the result would look like, without actually modifying the animation
data. You can do this by using the tool UI or by direct manipulation when
AutoKey is off. When you do so, the green or red bar across the top of the
value field in the tool UI turns yellow.

NOTE To acknowledge the change, you must set the keyframe either using the
keyframing controls with marked attributes or the context menu actions.
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Modifying the current editing time (the time at which the editors are currently
parked) in any way, clears the temporary modifications if the attribute is
animated. You can change the editing time using the Player controls.

This is how existing applications usually deal with temporary modifications,
but you can display the same film image at different times in two different
players. If you are viewing the same image in two Players stationed at different
times, then changing the focus from one Player to the other changes the
current editing time, resulting in the loss of the temporary modifications,
unless you have used the hotkey as an override.

Another difference with applications is the presence of time offsets which can
result in multiple instances of the same object being processed. In this context,
modifying attribute values can affect the attribute by modifying it at more
than one time. This is dealt with by maintaining an attribute modifying curve,
and not just a modifying value. These curves are not visible and are not
displayed in the curve viewer.

Customizing the Layout when Working with
Animation Curves
Once you are ready to work with animation curves, you may want to modify
the layout.

A generic Animate UI Preset displaying a Animation Editor view, Composition
Browser and Player view is available on the taskbar. However, you can modify
this preset and save it, or create an entirely different preset consisting of
whatever views you need —see Working with a Task-Based UI on page 140.
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Global Time vs. Local Time
Global time is the time a Player, Schematic, or Animation Editor view uses.
This time may be either master or standalone time. Remember, you can use
master and standalone time to synchronize or separate playback between two
or more views—see Playing Back in Multiple Views on page 192.

Local time becomes relevant when you add a Time Offset tool to a node of
the composition. A Time Offset tool creates a local time in all nodes that
precede it along the branch, i.e. the nodes at the left of the Schematic. When
you select a node affected by a Time Offset tool, you can disable the Global
button in the Tool Options area of the Tool UI to see the local time of the
tool—see Converting the Frame Rate on page 695 and Offsetting Time on page
696.

The Time Offset tool lets you adjust the timing relationship between two
branches of the dependency graph. For example, if you need to synchronize
action in two separate shots, you can create a composition with a branch for
each shot and use a Time Offset tool along one branch to adjust the timing
relationship between the two shots.

You can examine the local time and global time of a node affected by a Time
Offset node in the Tool Options area of the tool UI.

Time Offsets, Keyframing, and Instancing
Only a single animation channel and a single set of animation keyframes per
attribute are stored. Selecting the Set Key button sets a keyframe per instance
and per local time.
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Time Tools

Topics in this chapter:

■ Retiming Footage with the Retimer Tool on page 691
■ About Timing Curves on page 692
■ Converting the Frame Rate on page 695
■ Offsetting Time on page 696

Retiming Footage with the Retimer Tool
The Retimer tool lets you generate output footage at a frame rate that is different
from that of the input by retiming the image. Two interpolation modes are
available to perform the retiming: the Warp interpolation mode, which uses
motion estimation to generate intermediate frames, and the Blend interpolation
mode, which generates a weighted average of adjacent frames. The Warp mode
provides significantly better quality.

Additionally, motion blur (temporal anti-aliasing) can be added so that moving
objects appear blurred, as they would when filmed with a real camera, which
has a finite shutter speed. You can then modify the timing and/or speed curves
through the Animation editor in the UI to create a constant or non-constant
time warp.
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About Timing Curves
Time warps are created by modifying the timing of the source footage or by
changing its playback speed. When you change a clip's timing, you are
essentially changing the time that it takes for a clip to reach a given frame.
For example, in a 100-frame clip, you can adjust the timing so that only the
50th source frame is reached by the end of the clip's 100 frames. This halves
the clip's playback rate. A negative playback rate can be achieved by reversing
a clip's timing curve (by changing the value at the last keyframe to the value
of the first keyframe and the other way around). In the Timing Animation
editor, a steeper timing curve results in a faster playback rate.

Adjusting the clip's speed has different results. Setting the speed to 2.0 doubles
the playback rate. A speed value of .5 plays the clip at half speed (or in slow
motion). A negative speed value corresponds to playing the clip in reverse
(where a -1.0 speed value creates a clip that plays back at the normal rate, but
backward).

NOTE To avoid indexing black frames, set clip link Repeat parameter to Loop.

Speed and time curve editors are identical to animation curve editors and have
most of the same controls.

When in Warp interpolation mode, the Retimer has the following parameters:

To:Use:

Implement “a frame is a frame” timing. You can control the
mapping of output frames to input frames using the Animation

Frames
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To:Use:

Editor. For example, you can add keyframes and have the output
frames jump ahead, repeat, run backwards, slow down, or speed
up. The Current Frame field will display the input frames and the
Frames value editor will display the mapped output frame.

To:Use:

Control the mapping of output time to input time. When output
= input, the clip has normal speed. When output > input, the clip

Seconds

is accelerated. When output < input, yet is increasing, the clip is
slowed. When output stays constant, a constant frame is shown.
When output decreases, time reverses.

To:Use:

To control the mapping of input time to output time. When speed
= 1, the clip has normal speed. When speed > 1, the clip is accel-

Speed

erated. When 0 < speed < 1, the clip is slowed down. When speed
= 0, a constant frame is shown (time remains constant). When
speed < 0, time is reversed. The speed curve begins with two key
frames. Once created, the key frame times are not automatically
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To:Use:

updated with respect to changes in start and end times. Remem-
ber to set clip link Repeat parameter to Loop to avoid indexing
black frames.

To:Use:

Control the quality of the internally-generated motion vectors in
warp mode by applying the motion analysis only to lower-resolu-

Quality

tion versions of the input image, up to the resolution specified
by the quality parameter. This parameter is disabled as soon as
one vector input is connected. Limiting the quality of motion
vectors to half or a quarter for a high-resoultion (ex: 1080p or
film resolution) input clip can greatly accelerate warp processing,
with little loss in resulting retimed output clip quality.

Control how long the camera shutter stays open, and therefore
the time range over which the samples will be distributed. A value

Shutter (camera
analogy)

of 1 means a full frame time. Values above 1, though not physically
possible, can be specified for artistic effect.

Control when a reference motion vector offset is used. If reference
is set, the motion vector at the Reference Position is subtracted

Reference

from all motion vectors in the image. The result is that the pixel
at the reference position will appear to be motionless, and so will
pixels with similar motion vectors. Conversely, pixels which were
motionless will appear to move with the subtracted Reference
Position motion vector. This reference motion vector offset
changes over time using the velocity of “neutralized” vectors, so
you will seldom have to manually set offset keyframes using Ref-
erence Position.

Set the amount of blur to apply at the reference position. A value
of zero means that no blur should be applied. This is the default.

Reference Weight

A value of one means to blur by the same amount as the forward
vectors at the Reference Position. This is equivalent to disabling
the use of a reference vector offset. A value of one half means to
blur half as much as the forward vectors at the Reference Position.

Describes the x coordinate of the normalized reference position.Reference X

Describes the y coordinate of the normalized reference position.Reference Y
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When in Blend interpolation mode, the Retimer has the same frames, seconds
and speed controls as in the Warp interpolation mode. In addition, it also has
the Mix control:

To:Use:

Control the number of next and previous frames to blend.Mix

Converting the Frame Rate
You can convert the frame rate of an input source with the Rate Convert tool.

To convert the frame rate of input source footage:

1 In the Tools tab, drag the Rate Convert tool to the Schematic view and
connect it to the dependency graph.

The Rate Convert tool UI appears.

2 Select a frame rate to convert to.
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Offsetting Time
You can define a time offset (in units of frames) for an input source with the
Time Offset tool. Time offsets are useful when you need to animate local time
(tool time) to a master cue.

To define a time offset for an input source:

1 In the Tools tab, drag the Time Offset tool to the Schematic view and
connect it to the dependency graph.

The Time Offset tool UI appears.

2 Adjust the offset by the value in the Frames field.

If you have an Animation Editor open, you can view both the global time and
tool time as they appear on the same animation curve. Setting the Animation
editor display parameters to Tool will set global time frame markers.

To view global time frame markers in an Animation Editor:

1 While focused in the Animation Editor, open the Gate UI and swipe south
to the Animation Editor Options.

The Animation Editor's Display UI appears.
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2 Under Display, select the Tool option.

Note that the animation curve changes to reflect the time offset that has
been applied and global time frame markers appear.

(a) Global time cursor as shown when Animation editor display is set to
Composition
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(a) Tool time cursor (b) Global time frame markers
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Customization Tools

Topics in this chapter:

■ The Macro Super Tool on page 699

The Macro Super Tool
The Macro super tool lets you design your own tool. You can drag tools from
the Tools tab directly into the Macro super tool in order to customize it for your
composition.
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To use the Macro super tool:

1 Do one of the following:

■ Middle-click your mouse or press the tilde key (~) to open the Gate
UI. Swipe to the east to open the Tools tab. From the Tools tab, select
the Macro super tool or select a Macro super tool preset, if you have
previously created one. Drag the Macro super tool into the Schematic
view.
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■ Or, from the Schematic view, select the nodes that you want to include
in the Macro super tool, right-click and then select Create Macro.

2 Click the Macro super tool to display the Macro tab in the Tool UI. Notice
that most of the tab is empty. You'll customize the tab with the tool
inputs that you add to the Macro super tool.
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On the left side of the tab, the Customize UI button allows you to customize
the Tool UI. The Customize UI button is enabled once you are in edit mode.

Just above the Customize UI button, there are six more buttons. Once you
have added tools to the Macro super tool, you can assign each of these buttons
to a tool. Select a tool in the Schematic and then click a button while holding
down the Ctrl key to assign it to a tool.

NOTE When the Customize UI button is pressed, these six buttons are disabled.

In order to customize the Macro super tool, you must be in edit mode.
Right-click on the Macro super tool and select Edit or double-click on it. This
allows you to enter the Macro super tool.
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Once inside the Macro super tool, what you see will depend on whether you
connected the tool to a dependency graph or not. If the Macro super tool is
not connected to a dependency graph, you will see an input and an output
image, which are simply placeholders that represent the Macro's potential
connections outside of edit mode. If the Macro super tool is connected to a
dependency graph, then the two nodes that it is connected to will be displayed
instead of the input and output images.

Next, you can decide what tools you want to add to the Macro super tool.
Open the Gate UI and swipe to the east to open the Tools tab. Now you can
drag tools from the Tools tab directly into the Macro super tool.
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You'll notice that when you click on any of the tools you've added to the
Macro super tool, the tab corresponding to the tool in the Tool UI will specify
that it is part of the Macro super tool.

To customize the Macro super tool:

1 Once you have added tools to the Macro super tool, click the Customize
UI button.

2 Open a Composition view. Middle-click your mouse or press the tilde (~)
key to open the Gate UI. Then swipe east.

3 Click the View tab. From the View tab, drag a Composition view into a
viewport. Once the Composition view is open, you will see a Macro
sub-menu.
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4 Click the Macro sub-menu to reveal the tools that you added to the Macro
super tool.

5 Now you can open each tool individually and load the tool inputs that
you want into the Tool UI of the Macro super tool.
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You can do that by dragging and dropping tool inputs from the Macro
sub-menu of the Composition view into the Tool UI of the Macro super
tool. As you drag tool inputs into the Tool UI, either a green arrow or a
red x will appear, indicating whether it is possible to drag the input into
the Tool UI or not.

NOTE Animation data and other nodes cannot be dragged into the Tool UI.

You can add as many inputs as you like, however if there are too many
inputs, some of them will be hidden at the bottom of the pane.
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You can remove an input at any time by right-clicking it and selecting
Remove.

You can rename an item by double-clicking its name and entering a new
name in the field.

6 Once you have determined which inputs you want to include in the
Macro super tool, you can save it as a preset by clicking the Save button
in the Tool options area. You will be required to give the preset a name.

You can access this preset through the Tools menu. Middle-click your mouse
or press the tilde key (~) to open the Gate UI, then swipe to the east to open
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the Tools tab. Select the Macro super tool. In the lower menu, right-click the
Macro super tool and select Presets.

To use a preset in a composition, click it and drag it into the Schematic view.
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NOTE Adding a preset to a composition does not prevent you from modifying it.
You can continue to add or remove tool inputs from the Macro preset and modify
its UI. However, these changes will not be reflected in the composition that the
preset has been added to since there is no direct link between the preset and the
composition that it is added to.

The Macro Super Tool | 709



710



Vectors

Topics in this chapter:

■ About Motion Vectors on page 711
■ Importing Motion Vectors From Maya on page 712
■ Computing Motion Vectors on page 714
■ Show Vectors on page 716

About Motion Vectors
Motion Vectors are 2D vectors that represent the displacement in normalized
pixel units of a pixel in the current frame to the next frame (forward motion
vector), or its displacement from the previous frame (backward motion vector).

Motion Vectors can be rendered by a 3D application when dealing with synthetic
images, or produced through image analysis when images come from live action
footage.

The Motio tool lets you generate forward and backward motion vectors with
an image source. Motion vectors can be used as inputs for a wide variety of
image transformation, analysis, or restoration tools. In Composite, Motion
Vectors can be used as inputs to the Retimer tool (see Retiming Footage with
the Retimer Tool on page 691), the Blur tool (see About Blurs on page 385), the
Remove Dust tool (see Remove Dust Tool on page 380), and the Remove Grain
tool (see Removing Grain from a Composition on page 504).
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NOTE To avoid nonsense backward vectors on the first frame and nonsense
forward vectors on the last frame, the repeat mode of the clip should be such that
the image before the first frame and the image after the last frame are similar or
identical to the first and last frames, respectively.

Importing Motion Vectors From Maya
There are two types of render passes that you can use in Maya to render your
motion vectors: the 2D Motion Vector and the Normalized 2D Motion Vector.

NOTE You can import 2D motion vectors that were computed in another
application (e.g. 3D render)—see Importing Media on page 118

The 2D Motion Vector appears as “mv2dtoxik” when it is created. If you render
your motion vectors in Maya using the 2D Motion Vector render pass, the
motion vectors data is kept intact. Furthermore, you don’t need to set any
motion vector options on import in Composite.

The Normalized 2D Motion Vector appears as “mv2dnormremap” when it is
created. If you render your motion vectors in Maya using the Normalized 2D
Motion Vector render pass, the motion vectors are normalized between 0 and
1. When importing the render pass in Composite, you have to set motion
vector import options to convert the motion vector data to the true values.

NOTE For both the 2D Motion Vector and the Normalized 2D Motion Vector,
you must make sure to render your motion vectors in the EXR format.

In Composite, you can set the motion vector options on import or after
importing the render pass.
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To set the motion vector options on import:

1 Open an Import Browser.

2 Browse to the render pass and select it.

3 Next, from the tool UI, enable the “Motion Vectors” button and set the
Type menu to “ReelSmart.”

4 Finally, set the Max Displacement to the same value that was set in Maya.

In Maya, the Max Displacement value appears under the Normalized 2D
Motion Vector render pass options. You can access the render pass options
by double-clicking the render pass in the Render Settings window. By default,
the Max Displacement value is set to 256.

To set the Motion Vector options after importing the render pass:

1 Select the import node in your composition.

2 From the tool UI, enable the Motion Vectors button.

3 Set the Type menu to “ReelSmart.”

4 Finally, set the Max Displacement to the value that it was set in Maya.

Importing 2D Motion Vectors from 3ds Max
If your motion vectors are coming from 3ds Max, you have to set the Motion
Vectors type to “3ds Max” and set Max Displacement values as they were set
in 3ds Max.
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Importing 2D Motion Vectors from SmoothKit
If your motion vectors are coming from SmoothKit, then you have to set the
Motion Vectors type to “SmoothKit”.

Once you have imported your motion vectors, refer to Vector Blurs in theAbout
Blurs on page 385 section in order to know how to set motion vectors.

Computing Motion Vectors
The Motio tool uses the assumption of brightness consistency of an image to
generate motion vectors from one frame to the next. That is, the luminance
values remain constant over time, but their 2D position in the image may
change. Flashing lights, shadows, and other image changes that violate
brightness consistency may interfere with the generation of motion vectors
and cause problems with your retiming operation. You may want to first fix
these problems using a Paint tool or CC Basics tool for example, then calculate
the adjusted forward and backward motion vectors with a Motio node. Once
this is done, you can connect the adjusted vectors to a Retimer tool and use
your original image as the input.

If no motion vectors have been imported, you can compute them inside a
composition by adding a Motio node. Certain tool nodes, such as the Retimer,
will detect the absence of motion vector inputs, and will trigger the use of its
internal Motio engine to automatically compute motion vectors. Computing
motion vectors explicitly allow you to use the vectors for more than one vector
consumer tool. For example, you may want to retime some footage with
different speeds and then quickly compare the results. Instead of computing
the vectors twice (in each Retimer), you can use the Motio tool's output twice.

The Motio tool has a non-animated scalar parameter, called Quality, as a well
as a Show Vectors parameter—see Show Vectors on page 716. This parameter
controls the quality of the motion vectors by applying the motion analysis
only to lower-resolution versions of the input image, up to the resolution
specified by the quality parameter.
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To compute motion vectors inside a composition with the Motio tool and
compare retimed footage:

1 Drop a Motio tool into the Schematic view of a composition you want
to retime.

2 Connect the output of the footage to the input of the Motio node.

3 Add a Retimer tool to your dependency tree, and rename it HalfSpeed.

4 Make the Speed value 0.5.

5 Set the Retimer's context point to C1—see Setting Context Points on page
191.

6 Connect the three Motio outputs to the corresponding inputs of the
HalfSpeed Retimer.

7 Set the target of a Player to context point C1—see Setting the Target on
page 191.

8 Add a second Retimer to Schematic and change its name to QuarterSpeed
and enter 0.25 into its Speed value editor.

9 Set the Retimer's context point to C2—see Setting Context Points on page
191.

10 Connect the three Motio outputs to the corresponding inputs of the
QuarterSpeed Retimer.

11 Set the target of a second Player to context point C2—see Setting the
Target on page 191.

12 Play and compare the two retimed clips.
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Show Vectors
The Show Vectors tool is a three input, single output image pass-through tool
that allows in-player viewing of 2D vectors as overlays on an RGBA image.
Images representing a 2D vector per pixel can be used as image inputs to
indicate pixel displacement from one frame to another. These 2D vector images
can either be generated for artistic effect, the result of an analysis, or imported
from a render generated from a 3D package.

The 2D vector (x, y) components are directly stored as the red and green
channels in the vector image; the blue and alpha channels are unused. The
Show Vectors tool makes viewing 2D vector images far more intuitive. Instead
of showing a red, green, yellow (mix of red and green) or black (negative
components) image, actual arrows are shown, indicating the origin, direction,
and amplitude of motion, for either the forward vector input image, the
backward vector input image, or both. Because the vectors are shown as
overlays on top of a regular RGBA image, the positional relationship between
the vectors and the RGBA image can clearly be seen. This is often crucial to
understand how the 2D vectors will affect that RGBA image.

Forward vectors
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Backward vectors

Forward and backward vectors

The Show Vectors tool has the following parameters:
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To:Select:

Set the interval between shown vectors. By default, this value is
16 (shows a vector every 16 pixels). This controls the density of

Interval

the displayed vectors, and is applied to both the forward and
backward vectors.

Set the display Scale of the shown vectors. By default, this value
is 1.0 (shows a vector with its original length). This controls the

Display Scale

displayed length of the vectors, and is applied to both the forward
and backward vectors.These values only control the player display.
They have absolutely no influence on processing, since the Show
Vectors tool is an image pass-through of its primary input.

Set the color of displayed vectors. Click the color pot to display
the color picker—see Color Picker on page 154.

Forward/Backward
vectors color pots

To display motion vector overlays on an image with the Show Vectors tool:

1 Drop a Show Vectors tool node onto a composition.

2 Connect the Show Vectors primary image input to the footage node.

3 Connect the Show Vectors Forward Vectors input, and/or the Backward
Vectors input to vector image output(s).

4 Select the Show Vectors tool node. The Player shows forward vectors (if
connected) as 2D vectors on top of the input image.

5 Press the m key (lowercase) to display backward vectors (if connected) as
2D vectors are on top of the input image. Press it again to display both
forward and backward vectors on top of the input image. Pressing it a
third time will only show the input image. Pressing it a fourth time will
start the cycle over.
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Expressions

Topics in this chapter:

■ About Expressions on page 720
■ Short Expressions on page 721
■ Expression Input Paths on page 722
■ Visual Linking on page 722
■ Visual Linking Methods on page 722
■ Navigating the Expression String on page 728
■ Validating and Applying the Expression String on page 729
■ Viewing the Expression on page 729
■ Associating Comments with an Expression on page 730
■ Editing an Expression on page 731
■ Removing an Expression on page 732
■ Setting Expressions Examples on page 733
■ Expression Reference Tables on page 745
■ Arithmetic Operators on page 746
■ Comparison Operators on page 746
■ Operator Precedence on page 747
■ Math Functions on page 747
■ Vector Functions on page 748
■ Random Number Functions on page 749
■ Rounding Functions on page 750
■ Trigonometric Functions on page 750
■ Constants on page 751
■ Time Functions on page 751
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■ Profile Functions on page 751
■ Conditional Functions on page 752

About Expressions
Expressions are mathematical formulas that let you control any parameter
that can be animated, such as translation, rotation, scaling, material, or texture.
You can create almost any association between parameters, from simple A=B
relationships to very complex ones using predefined variables, standard math
functions, random number generators, and more.

An expression is a string of characters that may include object and parameter
names, math operators, and tokens representing functions or constants. For
example, to constrain object A's Y rotation to object B's X translation, you
might set an expression on A.Transform.Rotation.Y consisting of the
string B.Transform.Position.X

Expressions are created by using the Expresso Calculator, which is

an extension of the regular Calculators on page 161. To set an expression you
need to access the calculator by right-clicking in the value field of a parameter.

The Expresso button is a toggle. Clicking it again collapses the Expresso
Calculator.

NOTE If you display the regular calculator by using Alt + C, then the Expresso
button is inactive. The Expresso button only toggles if you first prompt the Expresso
Calculator.
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What attributes can expressions refer to?
Expression strings refer to sockets by name. The sockets can be either input
or output sockets. Expressions perform operations based on numerical values,
therefore you do not access pixels in the context of expressions. However,
you can still access numerical values of image attributes such as height and
width.

Short Expressions
In cases where you may not want to type the full name of an attribute that is
at the same level as the attribute being expressed, you can enter expressions
that refer to an input by its short name.

For example, if you want to add an expression to the Gaussian Rotation based
on the value of the Gaussian X Radius, instead of writing out the long
expression, you only need to refer to its short expression.
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This applies to all grouping levels, be it inputs on a node, or inputs in a
structure, or inputs on a node that is in a group.

Expression Input Paths
To avoid having to manually enter a long expression based on the input of
an attribute, you can right-click on that attribute's value field either in the
tool UI or Composition Browser and select Copy Path, then use Ctrl + V
(Windows and Linux) or Cmd + V (Mac OS) to paste the path into the Expresso
Calculator.

Visual Linking
Visual linking based on expressions is used to quickly make a connection
between nodes or inputs without having to manually set expressions through
the Expresso Calculator. You can link simple or structured inputs. Linking
structured inputs links individual inputs in a single operation. Its purpose is
to quickly define a link between two attributes. It does so by defining a B=A
expression, B being the link target and A the link source.

Visual Linking Methods
You can visually link attributes within the Tool UI, in the Composition Browser
or between the Tool UI and the Composition Browser. However, visual linking
of structured inputs can only be done through the Composition Browser.
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Visual Linking in the Tool UI
The Tool UI displays editors (value editors, toggle buttons or menus) and
labels. Visual linking relies on the attribute labels as zones to trigger a link
gesture. Labels are already used for marking.

To link the Red and Blue components of a color input in the same group:

 ➤ Click the Red channel label, drag and drop on the Blue channel label.

This sets an expression on the Blue channel attribute referring to the Red
channel attribute without ever displaying the Expresso Calculator.

In the same way, you can link inputs belonging to separate groups, setting an
expression in the target attribute referring to the source input.

Visual Linking in the Composition Browser
You can perform visual linking operations within the Composition Browser.

Linking Simple Inputs

Linking simple inputs in the Composition Browser works like in the tool UI;
you can click and drag attribute names (labels) to define a link expression.
Simple inputs are defined as those inputs that have only one socket name.
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Once the visual link has been established, the target attribute's value assumes
that of the reference attribute. A green E then appears in the A column of the
Composition Browser.
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Linking Structured Inputs

Linking structured inputs is done by dragging and dropping a structured input
onto another. If the target structured input's topology doesn't match the source
one, the drop is not accepted (i.e. the drop feedback is not given to you while
dragging the pointer). The graphic below illustrates how an attribute with
structured inputs (Master Gamma) can be visually linked with another attribute
with structured attributes (Master Gain).
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When the source and target structured inputs match (that is, when they have
the same number of inputs) an expression per input is set, linking inputs
individually.
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Visual Linking between the Composition Browser and
the Tool UI
You can initiate a drag from the Composition Browser and drop it on a label
on the tool UI, linking the source and target attributes with an expression.
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Navigating the Expression String
You can type an expression into the text field at the top of the calculator or
press the buttons to generate an expression string.

All the text field hotkeys are enabled when editing the expression string. You
can therefore navigate the string normally. When using the function buttons
to insert function tokens into the expression text field, the cursor position is
updated to the following local position in the string. This lets you simply tap
with a pen and insert expression tokens without having to move the cursor
position manually.

Expression functions and operators are grouped by categories. The Math
category of functions is available by default. Although you can type into the
text field directly, showing the buttons helps you to memorize the available
functions.

Clicking the C button clears the expression string.

Once an expression is used to drive an attribute value, you can no longer
keyframe the value. You must delete the expression before setting a keyframe.
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Validating and Applying the Expression String
Once you have entered the expression, you need to validate it. This is done
by pressing the Enter key on your keyboard. If no error is found, the expression
is parsed and validated. An invalid expression string returns an error message
in the taskbar at the bottom of the screen. The Apply button is grayed out
unless the expression has been previously validated. Pressing it applies the
expression to the associated attribute by attaching an expression node to it.

Viewing the Expression
You can view a valid expression in a graph view by clicking the Graph button.
The graph view displays the shape of the expression curve plotted over time.
The initial time extents are the same as those of the composition.

You can also display the expression curve in the Animation Editor Viewer
with other animation curves. The expression curve is visually differentiated
by being displayed in a green line and will always appear underneath animated
curves. The expression curves cannot be selected nor modified. To Display
the curve, select the attribute containing the expression from the Composition
Browser.
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NOTE You can zoom the view by placing the cursor inside the view and using
the Up and Down arrow keys, or by using Ctrl + Spacebar + click (Windows and
Linux) or Cmd + Spacebar + click (Mac OS). You can also pan the view by
simultaneously holding down the Spacebar on the keyboard and the left mouse
button.

NOTE To return to the main Expresso Calculator view, select the Graph button
again.

Associating Comments with an Expression
You can associate comments with an expression by clicking the Comment
button.
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NOTE To return to the main Expresso Calculator view, select the Comment button
again.

Editing an Expression
You can easily edit an expression.

To edit an expression:

1 Right-click the parameter field that contains the expression you want to
edit.

2 From the menu select Edit Expression.

The Expresso Calculator appears with the expression highlighted in the
text field.
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3 Edit and reapply the expression.

To save time, you can cycle through the various expression tokens that make
up the string by using Alt + slash (/) on the keyboard. This is particularly useful
when you are not sure of the exact sequence or writing convention of the
expression string.

Removing an Expression
You can remove expressions from any attribute.

To remove an expression node from an attribute:

1 Right-click the value field of the parameter that contains the expression
you want to remove.

2 From the menu select Remove Expression.

The expression node is removed.
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Setting Expressions Examples
The following examples will show you some of the ways expressions can be
used to save time in building your animations. You can create an expression
for one channel and use the same expression for other channels so that the
other channels automatically behave in relation to the first one.

Example: Using Linked Attributes to Drive Animation
This example consists of a simple animation where the Photo Lab red channel
Gain attribute drives the Radial Ramp tool's Y Center attribute—see Setting
Keys Manually on page 676, Radial Ramp Tool on page 426, and Processing
Images with Photo Lab on page 646.

NOTE It is assumed that you currently have the Player, Schematic, and Composition
Browsers open. With the focus on Schematic, use Ctrl + N (Windows and Linux)
or Cmd + N (Mac OS) to create a new composition.

To create an animation where the Photo Lab's red channel Gain attribute
drives the Radial Ramp's Y Center position attribute:

1 From the Tools tab, drag the Radial Ramp tool from the Image Generation
folder to the dependency graph in the Schematic view.

2 Drag the Photo Lab tool from the Color Correction folder to Schematic
and place it after the Radial Ramp tool.

The dependency graph should look like this.

3

4 In the Player controls, change the composition's total number of frames
to 100.
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5 In the Radial Ramp tool UI, modify the following attribute values with
the following settings:

New SettingAttribute

0.500Start Color Green (G) channel

30X Radius

16Y Radius

85X Falloff

116Y Falloff

The Radial Ramp should look like this.

You can now set an expression for the Y Center attribute that enables it
to be driven by the Photo Lab's Gain, Red channel attribute.
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6 Right-click inside the Y Center value field. And select Set Expression.

The Expresso Calculator appears along with a dashed green line at the
top of the Y Center value field. This indicates that an expression has been
applied.
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(a) Bar above value changes to a dashed green line

7 In the text field at the top of the calculator, type in the following
expression string.

This string is typical of what an expression looks like. The Y Center of
the Radial Ramp points to the red channel of the gain controls in the
Photo Lab tool, and links them. If you are familiar with expressions, you
can simply type the expression into the text field (using the correct syntax
and order), but if you are not sure of the exact sequence or writing
convention, you can cycle through the various expression tokens that
make up the string by using Alt + slash (/) on the keyboard.

NOTE Both Alt keys work, but only the slash (/) that is on the question mark
(?) key can be used.
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By opening a Composition Browser view, you can see the socket names
of each tool attribute once the menus are expanded. You can use these
names as a reference when creating expression strings, as this is how they
should look in the expression.

NOTE When cycling through and selecting a tool's attribute levels, you must
separate each level with a period.

8 Open the Photo Lab tool UI.

9 Select Autokey.

10 Change the exposure units to Gain.

11 Mark the red (R) channel of the Gain for keyframing by clicking the R
label—see Marking Attributes for Keyframing on page 674.
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12 In intervals of 20 keyframes, increase the gain on the red channel, so that
it is at its maximum by frame 100.

13 Play the animation.

Example: Using Functions to Drive Animation
This example shows you how pre-established functions can be used as
expressions to drive animation—see Expression Reference Tables on page 745.

The goal of this example is to create random noise using the Noise tool—see
Noise Tool on page 427. You could create the appearance of random noise by
modifying the Noise Seed attribute using periodic keyframes. However, a more
simple approach is to use a random number function. In this case, the
TrueRand function is used.

NOTE It is assumed that you currently have the Player, Schematic, and Composition
Browsers open. With the focus on Schematic, use Ctrl + N (Windows and Linux)
or Cmd + N (Mac OS) to create a new composition.

To create random noise using a random number function:

1 From the Tools tab, drag the Noise tool from the Image Generation folder
to the dependency graph in the Schematic view and connect it to the
Output node.

2 In the Player controls, change the composition's total number of frames
to 100.

3 In the tool UI, set the Fill, Start, and End color preferences.
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4 Right-click the Noise Seed value field and select Set Expression from the
menu.

The Expresso Calculator appears along with a dashed green line at the
top of the Noise Seed value field. This indicates that an expression is
about to be applied, or has already been applied.

(a)  Dashed green line appears

5 Select the Random button if it is not already selected.

6 Select the TrueRand button.
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An empty expression appears in the text field.

NOTE If you are familiar with the syntax of expressions, you can type them
directly into the text field.

As the TrueRand function description indicates (see Random Number
Functions on page 749) the function returns a truly random value between
two given numbers. Since the Noise Seed value can range from 0 to 1, it
is suggested that these values be used as the range.

7 Enter the value range of 0 to 1 between the brackets in the text field,
making sure you separate the values with a comma.

8 Play the composition.

NOTE You can view the expression in a graph view at any time by right-clicking
the attribute's value field containing the expression, and then selecting Edit
Expression from the menu. The Expresso Calculator appears. Select the Graph
button to view the expression in a graph.

There are other expressions, and combinations of expressions that you can
use to achieve the same results. For example, you can create random noise
(with the Noise tool) by using the Rand function where the seed is calculated
as time (t) multiplied (*) by the number of frames in the composition.
Therefore, if the composition is 100 frames long, the expression would look
like this:
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Another expression that can be used to create random noise with the Noise
tool is the Abs math function.

This expression indicates the Noise Seed is based on an absolute value
(anything between 0 and 1) of the angle (in radians) of the sine wave created
by the current time (t). It is then multiplied (*) by a frequency of 50. The
expression would still be valid if the Abs math function were not part of the
string.

Example: Animating Layers in Reaction
This example is somewhat more involved in that it uses the Eval time function
within a Reaction node—see Time Functions on page 751 and Basic Compositing
in Reaction on page 243.
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This example has two parts. First you'll set up the display and then you'll
create the animation.

NOTE It is assumed that you currently have a Player, Schematic, and Composition
Browser open. With the focus on Schematic, use Ctrl + N (Windows and Linux)
or Cmd + N (Mac OS) to create a new composition.

Before you begin, make sure that you set the Player display settings as follows.

To set Player display settings for Reaction:

1 Open the Gate UI and swipe south to display the Player options.

The Player control panel is displayed across the bottom of the screen. By
default the Display tab is selected and you can immediately access the
display settings and options.

2 Select Tool Output to view the results of the Reaction composition in the
Player.

3 Under Guides, select Frame Outline.

4 Under Reaction, select Interactivity.

To create an animation in Reaction using expressions:

1 From the Tools tab, drag the Reaction tool to the dependency graph in
the Schematic view, and connect it to the Output node.

NOTE Usually, before you composite or add effects such as an animation in
Reaction, you typically set the background. The background is the rendering
plane for the composition and sets the format. If you connect a Reaction tool
to an image or tool output in an existing dependency graph, the background
is set automatically. You can change the background at any time.

2 Select the Reaction tab.

3 In the Player controls, change the composition's total number of frames
to 100.
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4 At the bottom of the Layer Editor, select Box and click Create.

A new layer (a cube) is added to Reaction. Rename the layer by clicking
in its text field and pressing F2. Type in the new name, Box1, and press
Enter.

Depending on which preset you have chosen to view, the box you have
created most likely takes up the entire Player view.

5 Select the Reaction tab.

(a) Translate tool

NOTE To help you create an appropriate view of the animation, you can
modify the Player view by adjusting the zoom—see Zooming and Panning
on page 39.

6 Use the Translate tool to move the box to the bottom-left corner of the
view by grabbing the X or Y axis with the cursor. If you do not see the
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axes icon in the Player, go to the Player display options and select Tool
Output under Display, and Icons under Guides.

7 Mark the X and Y Position attributes for keyframing.

8 Select Autokey.

9 Using the Translate tool, create a motion path with the cube in Autokey
to the right-hand side of the Player view. Try to span all 100 frames.

10 Play the animation.

11 Select the Reaction tab and create a second box, Box2, layer by following
steps 5 through 8.

12 Right-click in Box2's X Position attribute value field and select Set
Expression.

The Expresso Calculator appears.

13 Insert the following expression.

14 Repeat steps 12 and 13 for Box2's Y Position attribute, but make sure the
Position token is replaced with a Y.

15 Play the animation.

This expression indicates that the X and Y Position attributes of Box2 are
being driven by the X and Y Position attributes of Box1. There is also a time
offset of one second (or number of frames per second) added to the expression.
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NOTE Unfortunately, it is beyond the scope of this guide to provide examples of
all the expressions and possible combinations of functions that you can use to
drive animations. The examples provided are just a small sampling of what is
available. It is strongly suggested that you explore the use of expressions as they
can prove to be an extremely powerful tool in creating complex effects and saving
time.

Expression Reference Tables
The following expression reference tables serve as a set of basic expression
syntax formats in order to get you started using expressions. They are classified
by function, and include operator reference tables and function reference
tables.

There are 12 expression reference tables:

DescriptionExpression Table

Perform basic mathematical functions—see Arithmetic Operators
on page 746.

Arithmetic Operators

Compare two values with each other—see Comparison Operators
on page 746.

Comparison Operat-
ors

Operations are performed in a specific order—see Operator
Precedence on page 747.

Operator Precedence

Advanced math functions—see Math Functions on page 747.Math Functions

Operators that are based on vector behavior—see Vector Func-
tions on page 748.

Vector Functions

Operators that return random values based on given vectors
and seed values—see Random Number Functions on page 749.

Random Number
Functions

Returns rounded values—see Rounding Functions on page 750.Rounding Functions

Returns or converts values based on trigonometric functions—see
Trigonometric Functions on page 750.

Trigonometric Func-
tions

Returns values based on quantities that never vary—see Con-
stants on page 751.

Constants

Returns values based on time—see Time Functions on page 751.Time Functions
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DescriptionExpression Table

Returns values based on curve profiles—see Profile Functions on
page 751.

Profile Functions

Returns values based on explicit conditions—see Conditional
Functions on page 752

Conditional Func-
tions

Arithmetic Operators
Use the following arithmetic operators to perform basic mathematical
operations.

DescriptionArithmetic Operator

Addition+

Subtraction-

Multiplication*

Division/

Integer Modulo%

Exponentiation^

Comparison Operators
Use the following operators to compare two values with each other. When
two values are compared using these operators, the result is 1 if the comparison
is true and 0 if the comparison is false.

DescriptionComparison Operator

Equal to==

Not equal to!=

Less than<

Less than or equal to<=

Greater than>

746 | Chapter 31   Expressions



DescriptionComparison Operator

Greater than or equal to>=

Boolean AND&&

Boolean OR||

Boolean NOT!

Operator Precedence
When you combine several operators in a single expression, the operations
are performed in the following order.

DescriptionOperatorOrder

Boolean NOT!1

Negation (as in -1)-2

Multiplication, division, exponentiation,
and modulus

*, /, ^, and  %3

Addition and subtraction+ and -4

Comparison<, <=, >, and >=5

Equivalence== and !=6

Boolean AND&&7

Boolean OR||8

Math Functions
DescriptionFunction

Returns the absolute value of a given number.Abs (number)

Returns the sign of the given number.Sign (number)

Returns a number to the power of an exponent.Pow (number, power)
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DescriptionFunction

Returns the square root of a given number.Sqrt (number)

Returns the remainder from dividing one number by an-
other.

Mod (number, divisor)

Returns the average of the given values.Average (number1, num-
ber2)

Returns the logarithm to base 10 of the given value (for
base -2 log, use Ln).

Log (number)

Returns the natural logarithm of the given value.Ln (number)

Returns the exponential of the given value.Exp (number)

Returns the smaller of the given numbers.Min (number1,number2)

Returns the larger of the given numbers.Max (number1, number2)

Vector Functions
DescriptionFunction

Returns a vector composed of the evaluation of the individual
component expression.

(expr1, expr2, expr3)

Returns the dot product of two vectors.Dot (vector1, vector2)

Returns a vector, the cross product of two vectors.Cross (vector1, vec-
tor2)

Returns the length of a given vector.Length (vector)

Returns a rotation vector based on a target position, an observ-
er position and an align direction vector.

LookAt (targetPos,Ob-
serverPos, AlignVector)

Returns a rotation vector such that a designated axis of an
object is aligned with the direction of the object's movement.

Align (targetPos,
alignVector,
bankingAngle) The banking angle controls the rotation around the axis, in

radians.
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DescriptionFunction

Returns the distance between the two points represented by
the vectors pos1 and pos2.

Distance (pos1, pos2)

relangle (point1, point2, delta1, delta2): returns the angle
between two vectors (point1,point2) and

relangle

(point1+delta1,point2+delta2). All parameters are 2D vec-
tors.This is used for implementing rotation tracking.

relscale (point1, point2, delta1, delta2): returns the ratio
between the length of vector (point1+delta, point2+delta2)

relscale

and (point1, point2).All parameters are 2D vectors.This is used
for implementing scale tracking.

Random Number Functions
DescriptionFunction

Returns a random value between 0.0 and 1.0, based on the
given seed.

Rand (seed)

Returns a truly random value between two given numbers.
The sequence of returned values constantly changes, never
producing past results.

TrueRand (low, high)

Returns a random value between -1 and 1, based on a given
seed.

Noise (seed)

Returns a random value between -1 and 1, based on a given
vector and with the ability to control the level of smoothness
of the resulting curve.

Turbulence (seed,
level)

Returns a random vector for all elements in a vector between
-1 and 1.

Noise3 (seed)

Returns a random vector with all the elements in the vector
between -1 and 1, with the ability to control the level of
smoothness of the resulting curve.

Turbulence3
(3d_seed,level)
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Rounding Functions
DescriptionFunction

Returns a number rounded to the nearest integer.Round (number)

Rounds a number up to the next integer value regardless of
its value.

Ceil (number)

Rounds a number down to the next integer value regardless
of its value.

Floor (number)

Returns the integer value of a number by truncating its frac-
tional part.

Trunc (number)

Trigonometric Functions
DescriptionFunction

Converts angle units from radians into degrees.Degrees (angle)

Converts angle units from degrees into radians.Radians (angle)

Returns the cosine of a given angle in degrees.Cos (angle)

Returns the sine of a given angle in degrees.Sin (angle)

Returns the tangent of a given angle in degrees.Tan (angle)

Returns the arc-cosine (in degrees, from 0 to 180) of a given
number.

Acos (number)

Returns the arcsine (in degrees, from -90 to 90) of a given
number.

Asin (number)

Returns the arctangent (in degrees, from -90 to 90) of a given
number.

Atan (number)

Returns the arctangent of y/x, using the signs of both argu-
ments to determine the quadrant of the return value. The re-
turned angle is given in degrees within the range 180 to -180.

Atan2 (X, Y)

750 | Chapter 31   Expressions



Constants
DescriptionConstant

Archimedes' Constant (PI = 3.14159265358979323846264338327950)PI

Natural logarithmic base (E =
2.71828182845904523536028747135266)

E

Time Functions
DescriptionFunction

Returns the current time in seconds.t

Returns the value of a given expression at another point in time.Eval

Profile Functions
DescriptionFunction

Returns the Gaussian (normal distribution) function, also
known as a bell-shaped or bell curve, based on the center
time, height and half-height-width of the curve.

Bell (center, height,
width)

Returns an increasing Hermite-like transition S-curve between
two given times.

EaseIn (start time, end
time)

Returns a decreasing Hermite-like transition S-curve between
two given times.

EaseOut (start time, end
time)

Returns a sinus profile curve based on the given period,
amplitude and offset values.

Sinus (period, amp-
litude,offset)

Returns a square profile curve based on the given period,
amplitude and offset values.

Square (period, amp-
litude,offset)
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Conditional Functions
DescriptionFunction

Returns the value of the second or third expression, depend-
ing on the evaluation of the first one: if expr1 evaluates to

If(expr1, expr2, expr3)

true, returns to expr2; returns expr3 otherwise. Expr1 is a
boolean expression. Expr2 and expr3 can be two values,
two vectors, or two boolean expressions. This enables users
to piece together snippets along the time domain.
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Tracking and Stabilizing

Topics in this chapter:

■ About Tracking and Stabilizing on page 754
■ Tracking Concepts on page 754
■ Stabilizing Concepts on page 755
■ Tracker UI on page 755
■ Tracking Workflow on page 757
■ Choosing a Reference Point on page 762
■ Positioning the Reference Box on page 763
■ Resizing the Reference and Tracker Boxes on page 764
■ Resetting the Reference Box on page 766
■ Resetting the Tracker Box on page 767
■ Changing the Color of a Tracker on page 768
■ How the Tracker Works on page 769
■ Tracking Position on page 770
■ Tracking the Scale of an Object on page 773
■ Tracking the Rotation of an Object on page 775
■ 4-Point Tracking on page 777
■ Tracking Difficult Shots on page 780
■ Correcting Errors on page 782
■ Stabilizing on page 783
■ 1-point Stabilizing on page 786
■ 2-point Stabilizing on page 788
■ Simultaneous Stabilizing and Tracking on page 790
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About Tracking and Stabilizing
Understanding how to use the Tracker tool and apply the tracking data to
elements in a composition, and determining to which parameters you want
to apply the tracking data are key factors for producing basic to complex
effects. The more experience you gain from using the Tracker tool and applying
tracker data to elements, the more you see all the effects that trackers can
produce. If your composition is jittery, use the stabilizing feature within the
Tracker tool or the Panner tool to remove, for example, unwanted camera
jitter.

Tracking and stabilizing are often processes of trial and error. You should track
or stabilize with default settings, and if the tracker box strays, fine-tune the
analysis.

Much of the tracking and stabilizing work you do will be done using the
Reaction supertool—see Reaction Compositing and Effects on page 240, and
the 2D Transform Tool—see 2D Transform Tool on page 432.

Tracking Concepts
The Tracker is a tool for following and capturing the motion of an on-screen
feature, and then applying that stored motion to a second element, so that
the two appear to be locked together.

You can track any number of features in a length of footage:

1-point tracking  Tracks a single feature for position.

2-point tracking  Tracks two features, using the relationship between the
two to track scale/rotation.

4-point tracking  Tracks four features, also referred to as corner pinning.

Multiple-point tracking  Tracks as many features as you want.

You can apply the stored motion to various elements:

Center point of an object  For example, you could track a halo over the
head of a person in a clip. Assume that in the clip a woman tilts her head and
advances toward the camera. You would want the halo to reflect the position,
scaling, and rotational changes of the tracked features on the woman's head.

NOTE When you track scaling, you are not performing 3D tracking in true Z-space.
You are simply measuring the amount of change over time in the size of the tracked
object.
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Control points of an object  The shape of the object changes to reflect the
motion of the reference feature its control points are locked to. For example,
if you want to replace the label on an actor's clothing, each corner on the new
label would track a corner on the old label. The shape of the new label would
change to correspond to those movements.

Stabilizing Concepts
Stabilizing is a powerful process that represents one of the most common uses
of the Tracker.

In most tracking the Tracker applies the reference motion to the desired
element so that the two are locked. In stabilizing, the Stabilize filter uses the
Tracker data to invert the analyzed motion to correct unwanted camera or
subject motion.

You can stabilize any number of features in a composition:

1-point stabilizing  The positional (location in X and Y) motion you want
to eliminate is vertical, horizontal, or both vertical and horizontal.

2-point stabilizing  The motion you want to remove involves
scaling/rotation. It may also involve vertical/horizontal shifts.

With stabilizing, the shift values are inverted, for example, (3, -2) would
become (-3, 2) before they are applied. This inversion results in an elimination
of the motion.

The Stabilize filter uses the Tracker data to move the image so that the reference
feature occupies the same position it did in the preceding frame. In other
words, the reference feature stays still because the frame is being moved.

4-point stabilizing  By adding two extra Tracker Analyzers you can perform
4-point stabilization and eliminate translation, rotation, scale, and pivot
motion.

Tracker UI
The Tracker UI contains the following parameters:
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(a) Tracker browser (b) Add Analyzer (c) Display controls (d) Analyze controls
(e) Reference box controls (f) Tracker box controls (g) X and Y shift controls

To:Use:

View a list of all tracker analyzers you add to the tracker. Right-
clicking any tracker analyzer to display a list of options to delete,
rename or select all tracker analyzers.

Tracker Browser

Add tracker analyzers to the tracker.Add

View the most recent match found for the tracker. Clicking it
again disables the control.

Display Preview

Determine how much the reference area appears magnified in
the reference box by setting the Zoom factor.

Display Zoom

Change the color of the tracker and reference boxes by clicking
the color pot, then selecting a new color from the color picker.

Display Color

Run the analysis forward. Click again to turn tracking on and
off.

Analyze Forward

Run the analysis backward. Click again to turn tracking on and
off.

Analyze Backward

Advance the analysis forward by one frame.Analyze Forward one
frame

Advance the analysis backward by one frame.Analyze Backward
one frame

Leave the contents of the reference box unchanged during
tracking. This is faster than Roaming. It is also less flexible since
it assumes little or no change to the reference feature.

Fixed Reference

Update the contents of the reference box at each frame. Use
this option when the reference feature undergoes significant

Roaming reference

changes in luma or shape cues during the footage. For example,
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To:Use:

if the reference feature undergoes lighting changes, choosing
Roaming increases the chances of finding a match at each frame.

Set how much tolerance for error there is in locating a match
for the reference box. A keyframe is only set for the frame if a

Tolerance

match is found. If Tolerance is set to 100%, a match is always
found, regardless of how wrong it may be. If Tolerance is set
to 0%, a keyframe is only set for the frame if an exact match
for the reference box is found.

Update the contents of the reference box at the current frame.Snap

Change the size and position of the reference box.Reference

Change the size and position of the tracker box.Tracker B

Change or reset the shift values.Shift

Tracking Workflow
Tracking workflow usually consists of the following steps:

■ Choosing a reference point.

■ Positioning the reference box.

■ Resizing the reference and tracker boxes.

■ Resetting the reference and tracker boxes (optional).

■ Analyzing the footage.

■ Correcting errors.

Adding a Tracker Tool to the Dependency Graph
Once your project folders, project preferences, layout (including the Player
Options) are set up, and the media is imported and opened, you are ready to
begin your tracking task.
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To add a Tracker tool to the dependency graph:

 ➤ Do one of the following:

■ From the Tools tab, drag the Tracker tool to Schematic.

■ From the Tools tab, open the Tracker folder and drag the Tracker
Analyzer tool to Schematic. You do not need to attach it directly to
the dependency graph but rather to the image sequence you want to
analyze as it is not going to be modifying the image but rather you
will be using data associated with that tracker.

Unlike the Tracker Analyzer, the Tracker lets you add multiple Tracker
Analyzer tools. If you added the Tracker tool and you want to add more
than one Tracker Analyzer, click Add in the File Browser.

You can also add Trackers and Tracker Analyzers to a dependency graph using
the Create Trackers feature found in any tools with position, rotation, scale,
and pivot parameter controls. These tools include the Panner, 2D Transform,
Reaction, Warp 2D, Garbage Mask, and Remove Dust. Furthermore, shape
tools (Warp 2D, Garbage Mask, and Remove Dust) also let you create Trackers
on a per point basis.

The Create Trackers toggle button is found in the Tracker Selection Dialog. It
only applies if you are going to press the Link button. Ordinarily the Tracker
Selector Dialog allows you to select a set of 1 or more tracker analyzers to link
or copy to. However, if Create Trackers is selected, then when you press Link,
it will actually create the required number of tracker analyzers. Where it creates
them depends on whether you have a tracker tool selected or not. If one is
selected, it creates the new analyzers in that tool, otherwise, it creates a new
tracker tool, with the required number of analyzers. In the following example
procedure, the 2D Transform tool is used to create the Tracker and required
number of tracker analyzers specified by the Transform Type selected.
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To create Trackers and Tracker Analyzers for 4-point tracking using the Create
Trackers feature:

1 Add a 2D Transform tool to the dependency graph.

2 Select 4 Point from the Transform Type menu.

3 Right-click the Source label and select Set Trackers.

The Tracker Selector window is displayed.

4 Toggle the Create Trackers button and click Link.
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A Tracker with four Tracker Analyzers is created in the dependency graph.

To add a Tracker and Tracker Analyzer for a single point in a shape (Warp
2D, Remove Dust, Garbage Mask):

1 Select the point you want tracked in the Player.
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NOTE If you want to track all the points in the shape, use Ctrl + A to select
all the shapes while your cursor is in the player.

2 Right-click the point and select Set Trackers.

The Tracker Selector window is displayed.

NOTE You can also right-click the Position label under the Point # label to
display the Tracker Selector window.
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3 Toggle the Create Trackers button and click Link.

A Tracker and Tracker Analyzer is created in the dependency graph.

NOTE If you selected all the points in the shape, a Tracker Analyzer will be
created for each point.

Choosing a Reference Point
A good reference point is a high-contrast pattern that has good definition
both vertically and horizontally, which allows for perfect registration in both
directions. Preferably, the reference point should not change much over time.

To choose a good reference point, play the footage several times to become
familiar with the material. Ideally, you should try to find a pattern that is
present in every frame. However, this is not always possible, and you may
have to track two different features, such as object that disappears behind
another one, or an object that moves out of the frame. The reference frame
(the frame on which you place the reference box) should be the frame where
the reference point is most representative in terms of shape, size, and rotation.
Generally, you position the reference box over the reference point in the first
frame of the sequence, but you could also place it on the last frame and analyze
backwards. Another alternative is to place it on a frame in the middle of the
footage and analyze from that frame backward to frame 1, and then analyze
from that frame forward to the end of the footage.
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Positioning the Reference Box
When you position the reference box, the tracker box automatically moves
to the same location so that when you start analyzing, both boxes are
positioned over the reference point.

To position the reference box:

1 Go to the frame where you want to position the reference box.

2 If the tracker you want to position does not appear on the image, click
the appropriate Tracker in the File Browser, and enable Active.

(a) Active column (b) Selected Tracker Analyzer set to Active

NOTE Each tracker is automatically assigned a different color. However, you
can customize the color at any time—see Changing the Color of a Tracker
on page 768.

3 Position the cursor to the center of the reference box until it changes
from a cross to a multi-arrow shape.
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4 Click and hold the reference box and drag it over the pattern you want
to track (in the example below, the rider's head). The reference box is
magnified to make it easier to select a position. By default, the tracker
box stays with the reference box.

Resizing the Reference and Tracker Boxes
You can resize the reference box to make it surround the feature you chose
to track more closely. By only including the recognizable feature in the box
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with no other details that may change throughout the footage, you minimize
the possibility of the tracker losing the reference point.

NOTE Sometimes a small reference point does not give good results. Try enlarging
the box to include more of the selected feature. Note that the larger the box, the
slower the analyzing speed.

Resize the tracker box, so that it is large enough to accommodate the most
frame-to-frame movement of the reference point. For example, if the
movement of the reference point is mostly horizontal, you can increase the
width and reduce the height of the tracker box. If there is a large amount of
movement both horizontally and vertically, increase both the width and the
height of the tracker box.

(a) Reference box (b) Tracker box

To resize the reference and tracker boxes:

 ➤ Do one of the following:
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(a) Resize height cursor (b) Resize width cursor (c) Resize proportionally cursor

■ To resize a box interactively on the frame, position the cursor on the
edge of the box you want to resize. The cursor changes shape. Drag
the box to the desired dimension.

■ To use the Tracker or Tracker Analyzer menu to move or resize the
reference or tracker box for the current tracker, enter values in the
appropriate fields.

(a) Reference box position and size fields (b) Tracker box position and size fields

Resetting the Reference Box
If you decide to choose a different reference point, you can reset the reference
box.
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To reset the reference box:

 ➤ Do one of the following:

■ Click Reset at the bottom of the Reference label portion of the UI.

The reference box size is reset to its default values and it is positioned
in the center of the Player window.

■ Type values into the respective value fields and click Enter.

Resetting the Tracker Box
By default, the tracker box stays with the reference box as you position it.
Generally, you do not need to move the tracker box separately from the
reference box. If you separated the tracker box from the reference box and
want to reposition it over the reference box, you can reset the tracker box.

To reset the tracker box:

 ➤ Do one of the following:

■ Under Track, click Reset.

The tracker box size is reset to its default values and it is positioned
in the center of the player window.

■ Type values into the respective value fields and press Enter.
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To reset the shift values:

 ➤ Do one of the following:

■ Under Shift, click Reset.

The shift values are reset to their default values.

■ Type values into the respective value fields and press Enter.

To reset a tracker:

1 Select the tracker from the File Browser.

2 Click Reset in the Tool Options.

The size and position of the reference box, tracker boxes, and the X and
Y Shift values are reset.

Changing the Color of a Tracker
Each Tracker Analyzer is automatically assigned a different color. However,
the color may be obscured by existing colors in the footage you are tracking.
You can change the color of the tracker to make tracking easier.
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To change the color of a tracker:

1 In the File Browser, click the Tracker that corresponds to the tracker you
want to change.

2 Under Display, click the color pot next to Color.

The color picker appears.

3 Select a new color that can be easily seen in the footage and click Set.

The tracker changes color.

How the Tracker Works
The Tracker first tracks motion of the reference feature(s), then applies or
inverts that motion, depending on if you are tracking or stabilizing.

Once you have set up your trackers, the analysis can begin. This is how the
Tracker analyzes and remembers the motion of the reference feature:

■ The Tracker stores the position of the reference box on frame 1.

■ The Tracker advances to the next frame and positions the tracker box in
the same place as in the previous frame.

■ It searches the tracker box for an area that matches the contents of the
reference box. The Tracker uses luma cues (white versus black) and shape
cues to determine what is a match.

■ Once it finds a match, the Tracker uses the location of the match to move
the center of the tracker box over the center of the match. This change in
position is stored as an X and Y shift value.

■ On the next frame, and on all future frames, the Tracker gets a little smarter
about where it positions the tracker box. It extrapolates the likely position
of the reference feature based on the amount and direction of the motion
that occurred between the last two frames. The Tracker makes an educated
guess of where the feature may be, based on past matches.

NOTE This means the Tracker works best when the motion of the reference
feature is regular and does not suddenly or erratically change direction or
speed.

■ Once the Tracker has analyzed the motion of the reference feature, and
stored it as Shift values for each frame, it copies the motion of the reference
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feature to the element that you are tracking, so that the two appear locked
together.

In all tracking except for stabilizing, the Tracker applies the shift values without
modification.

With stabilizing, the Stabilizer operator inverts the shift values, resulting in a
negation (and therefore elimination) of the motion—see Stabilizing on page
783.

Tracking Position
In this example, you want the object to track only the changes in position of
the reference feature. The object follows the X and Y motion without
undergoing changes in scale or rotation.

For example, you have footage of a bird flying and you want to attach a small
blue arrow to the to top of the bird's wing. You can add an image of an arrow
from the File browser to the footage. You need to track the arrow to one point
on the wing. Note in this example there are no scale or rotation changes to
the wing.

NOTE Although this example uses the 2D transform tool, there are many other
tools that have position and translation parameters that can be tracked, such as
Reaction, Panner, the Garbage Mask, Remove Dust tool, and the Warp 2D tool.

To track position:

1 Play the footage a few times to evaluate what reference feature you want
to use and if there are any foreseeable problems for the tracking.

2 Determine a good reference frame. In this example, it is the first frame
of the footage.

3 From the Tools tab, drag a Tracker Analyzer tool to Schematic. You do
not need to attach it directly to the dependency graph as it is not going
to be modifying the image but rather, you will be using data associated
with that tracker. Once you have finished tracking, you can remove the
tracker tool from the dependency graph.

4 Position the Reference and Analyzer boxes on the position you want
tracked. In the case below, the tip of the bird's wing has been selected.
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5 Click Analyze Forward to track reference position in the footage.

6 From the Tools tab, open the Composition folder and drag a Blend and
Comp node to the dependency graph between the footage node and the
Output node.

7 Connect the bird footage to the Back input of the Blend and Comp node.
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8 The image of the arrow is then dragged into Schematic and linked to the
composition and attached to the Front input of the Blend and Comp
node.

9 A 2D Transform tool is then added between the arrow image and the
Blend and Comp node. Select the 2D Transform node.

10 From the 2D Transform tool UI, select 1 Point from the Transform Type
menu. The Source and Destination coordinate value editors appear.

11 The Source X and Y coordinates are set to 0, 0 fixing the center of the
arrow image exactly at the center of the tracker.

12 To set the Destination transform, right click on the Destination label and
select Set Tracker. The Tracker Selector appears. Expand the Tracker and
select the Tracker Analyzer.

13 Enable Use Offset and click the Link button.
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The arrow is tracked to the tip of the bird's wing. Play the footage.

Tracking the Scale of an Object
In some cases, you may want the object to remain stationary and track only
changes in scale. For example, assume that a camera is looking down a straight
road at a car approaching. You need to track the license plate as the car
approaches.

The Tracker requires two tracker boxes to measure scaling. The changing
distance between the centers of the two reference boxes determines the scale.

In our example, you want to lock a new license plate to the old one. You
would position one reference box over one corner of the license plate and the
other reference box over the diagonally opposite corner.

The license plate is a layer. It assumes you have a Reaction node with two
layers—the background layer and the source layer. In this example, the
background is the car footage and the source is the license plate footage or
object.

NOTE You can also use the 2D Transform, and the scale parameter controls of
the Garbage Mask, Remove Dust and Warp2D tools.

To track changes in scale only:

1 Determine a good reference frame and position the background footage
at that frame.
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2 Select the Tracker Analyzer tool from the Tools tab and drag it to the
Schematic. You do not need to attach it directly to the dependency graph
as it is not going to be modifying the image but rather, you will be using
data associated with that tracker.

3 Attach the composition to the input of the tracker.

4 Add a second Tracker Analyzer.

5 Resize and reposition each Tracker, so that they track the scaling change.
(In this example, the Trackers are placed over the upper-right and
lower-left corners of the license plate.)

6 Adjust the settings for each Tracker.

7 Select the first analyzer from the File browser and click Analyze to start
the analysis.

8 Return to the first frame.

9 Select the second analyzer from the File browser and click Analyze to
start the analysis.

10 Drag a Reaction tool from the Tools tab and place it in the dependency
graph between the footage node and the Output node.

11 With the cursor over the Reaction node, right-click and select Add Source.

12 At the bottom of the Layer Editor, select Bilinear and click Create.

A new layer is created.

13 Attach the second composition (or object) as source 1.

14 Go back to the first frame.

15 Click the Reaction tab.

16 Right-click Scale and select Track Scale.

17 Select both Tracker Analyzers using Ctrl + click, and click Link.
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An expression is automatically created linking the tracking data to the
scaling of the new license plate.

18 Play the footage to view the result.

NOTE When tracking data needs to be applied to more than one layer in a
composition, add an extra axis node to the dependency graph and connect it to
the appropriate layers. Linking the axis to several layers facilitates panning multiple
objects inside a reaction. In this case you would then click the axis node instead
of the Layers node at step 15, and right-click the Scale label and continue the
procedure.

(a) Axis node connected to two layers inside Reaction.

Tracking the Rotation of an Object
In some cases, you may want the object to track only a rotational change. The
Tracker requires two tracker boxes to track rotation. The first Tracker goes over
the pivot point of the rotation you want to track. You place the second over
an area that describes the axis of the rotation you want to apply to the object.

NOTE You can also use the 2D Transform, and the rotation parameter controls
of the Garbage Mask, Remove Dust and Warp2D tools.

To track changes in rotation only:

1 Determine a good reference frame and position the footage at that frame.

2 Select the Tracker Analyzer tool from the Tools tab and drag it to
Schematic. You do not need to attach it directly to the dependency graph
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as it is not going to be modifying the image but rather, you will be using
data associated with that tracker.

3 Attach the composition to the input of the tracker.

4 Add a second Tracker Analyzer

5 Place the first Tracker over the pivot point of the rotation you want to
track.

6 Click Analyze Forward to analyze the footage.

7 Go back to the first frame.

8 Place the second tracker over an area that describes the axis of the rotation
you want to apply.

9 Click Analyze Forward to analyze the footage.

10 Drag a Reaction tool from the Tools tab and place it on the dependency
graph between the footage node and the Output node.

11 With the cursor over the Reaction node, right-click and select Add Source.

12 To associate a layer with the source you just created, select Bilinear at the
bottom of the Layer Editor and click Create.

13 In the Layer Editor, right-click inside the Z field under Rotation and select
Track Rotation.

The Tracker Selector browser appears.

14 Using Ctrl + click, select both the trackers then click Link.

The rotation has been tracked.

NOTE When tracking data needs to be applied to more than one layer in a
composition, add an extra axis node to the dependency graph and connect it to
the appropriate layers. Linking the axis to several layers facilitates panning multiple
objects inside a reaction. In this case, you would then click the axis node at step
13 instead of the Layers node, and continue the procedure.
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(a) Axis node connected to two layers inside Reaction.

4-Point Tracking
In order to correctly project images onto televisions, bulletin boards, and other
quadrilaterals in an image sequence use the 4-Point tracking workflow.

With four-point tracking (also known as corner pinning), you use four trackers
to generate tracking data for anchoring the four corners of a bilinear surface
to background footage.

The reference points you use must be well-defined; it is recommended that
you plan them when shooting the sequence (for example, add markers to the
scene). It is not always possible to do four-point tracking when the reference
points are not well-defined.

In the following example, the goal is to pin an image of a jet to the screen of
a monitor as the camera moves.

NOTE You can also use the Reaction tool, and the position and translation
parameter controls of the Warp2D tool, and the position and translation vertices
parameter controls of the Garbage Mask, and Remove Dust tools.

4-Point Tracking | 777



To corner pin and track a bilinear surface to background footage:

1 In the Schematic view, the basic dependency graph has been set up with
the following nodes:

PurposeNode

This is the footage that will tracked.Input image
(front)

This image will be corner-pinned onto the front footage.Input image
(back)

The Keyer is used to remove the blue portion of the monitor.Keyer

The Tracker will track and analyze the movement of the four corners
of the monitor. The Tracker super tool is used because multiple
Tracker Analyzers are required.

Tracker super
tool

The Blend & Comp node will combine the two processed images.Blend & Comp

The 2D transform tool will apply the necessary transformations to
the image to be corner-pinned.

2D Transform

Outputs the final composition.Output

2 Remove the blue screen from the monitor with the Keyer.
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3 Create four Tracker Analyzers and name them as per their corner positions,
then position them in the locations that will make up the four corners
to pin.

4 Adjust the Display, Analyze, Reference box and Tracking box settings.

5 Analyze each track (do not forget to reset the footage back to the start
frame after each analysis). You can also select the first Tracker Analyzer
and Shift + click the last one to select all trackers to analyze at the same
time.
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6 Connect the RGBA output from the Keyer to the Front input of the Blend
& Comp node, and the output of the second image into the Back input
of the Blend & Comp node.

7 Add a 2D Transform tool to the graph between the second image and the
Blend & Comp node.

8 With the 2D Transform tool highlighted, select 4 Point from the
Transform Type menu.

9 Click Fit To Source

10 Right-click on the Destination label and select Set Trackers.

11 Select the trackers in the same sequence as you created them from the
Tracker Selector window and activate the Use Offset toggle.

12 Click Link.

The bilinear image is pinned to the background image.

13 If the corner-pinned image is too small or too large for the screen it's
replacing, create another transform and adjust its scale while in the SRT
transform type.

Tracking Difficult Shots
This section provides different strategies that you can use to track difficult
shots.
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Positioning the Tracker Box Manually
When the reference point is temporarily covered by another object, position
the tracker manually.

To manually position the tracker box:

1 Click the Analyze Forward button to stop the analysis.

2 Advance the clip to the frame where the reference point becomes visible
again, and reposition the tracker box over the reference point.

3 Click Analyze to restart the analysis at this frame. Since the X and Y shifts
are recorded as keyframes in channels, the translation values for the
frames in which the reference point was covered are calculated. The final
result will be a smooth motion.

Tweaking the Tolerance Value
The Tolerance value determines how exact a match the Stabilizer requires
when identifying the reference point. With a tolerance of 100%, the Stabilizer
accepts anything as a match. With a tolerance of 0%, the feature being tracked
must be exactly the same as the reference point. If a match is not found, a
keyframe is not set, and the position of the reference point is interpolated
between the previous keyframe and the next keyframe.

If the reference point is temporarily hidden by another object, you can use
the Tolerance value to make the tracker ignore the reference point in parts of
the clip where it is hidden, then continue tracking it normally when it
reappears. This can prevent or reduce the need to manually reposition the
tracker box during an analysis.

To use tolerance to track a temporarily hidden object:

1 Analyze the footage with full (100%) tolerance.

2 The tracker loses the reference point when it is hidden. Press Backspace
to delete keyframes and go back to the last bad keyframe. Lower the
Tolerance value until the cross hair disappears from the tracker box. The
keyframe at that frame is deleted. The cross hair indicates that a frame
has a keyframe.

3 Click Analyze to continue the analysis. Further analysis automatically
discards the undesirable keyframes, and the position of the reference
point is interpolated until the reference point reappears.
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Correcting Errors
If the tracker box strays from the reference point that it is supposed to be
tracking, incorrect keyframes result. If such an error occurs, you can stop the
analysis, correct it, and restart it at any frame.

There are a number of different methods you can try to correct tracking errors.
Try the strategies given below, then redo the analysis to generate new
keyframes based on the updated information you provide.

Updating the Reference Point
If the tracker loses the reference point, you can delete the incorrect keyframes,
then, at the last good keyframe, update the reference point to the current
contents of the tracker box.

To update the reference point to the tracker box contents:

1 Select the appropriate tracker by clicking the appropriate Tracker button.

2 Press Backspace.

The last keyframe is deleted and the positioner moves back one frame.
The tracker box is now on the previous keyframe.

3 If you want to remove this keyframe, press Backspace again.

4 Repeat step 2 for all incorrect keyframes.

5 When you reach the last good keyframe, click Snap. This updates the
reference point from the one originally specified in the reference frame
to the image currently inside the tracker box.

6 Click Analyze to continue the tracking process.

Resetting the Tracker
If the tracker loses the reference point early in the analysis, you may want to
reset the entire tracker and find a new reference point—see Resetting the
Tracker Box on page 767.
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Adjusting the Tracker Box
If the Stabilizer cannot find the reference point within the boundaries of the
tracker box during analysis, the tracker box strays from the reference point
and produces incorrect keyframes. Although you can manually correct these
keyframes, it is easier to make the tracker box large enough to accommodate
the movement of the reference point. Note that processing time increases as
the size of the tracker box increases.

To adjust the size of the tracker box:

1 Stop the analysis by clicking the Analyze Forward button.

2 Press Backspace until you reach the last good frame before the tracker
box strayed from the reference point. Adjust the size of the tracker box,
so that it is large enough to accommodate the largest frame-to-frame
movement of the reference point.

NOTE Backspacing deletes the keyframes as you go back. If you do not delete
the keyframes, they will be overwritten when you reanalyze. Backspacing in
this instance makes it easier to see the tracking path clearly.

3 Click Analyze Forward to continue the analysis.

Stabilizing
Stabilizing is a powerful process that represents one of the most common uses
of the Tracker. Stabilizing is most often used to remove unwanted camera
jitter.

The stabilizing workflow is almost identical to the tracking workflow except
the data analyzed by the tracker is inversed to negate the unwanted movement
in the footage.

In stabilizing, link the Tracker data to the Panner tool to invert the analyzed
motion and correct unwanted camera or subject motion in the X and Y
directions.

How the Stabilizer Works
To start stabilizing, select one or more reference points on your clip. Locate
the first frame containing the movement to be tracked (the reference frame).
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In general, the reference frame is the first frame of the sequence. The choice
of reference point depends on whether you are tracking or stabilizing. When
tracking, the reference point is a feature you want to track; when stabilizing,
the reference point represents the point around which the image is
stabilized—see Choosing a Reference Point on page 762. Place the reference
box(es) around the selected feature(s).

Once you have set the tracker positions, start the tracking process, also referred
to as analyzing the footage. During the analysis, the tracker box associated
with each tracker moves as the Stabilizer looks for a pattern that matches the
reference in each frame of the clip.

The Stabilizer calculates the difference between the position of the tracker box
and the position of the reference box to produce X and Y Shift values. Shift
values are a measurement (in pixels and subpixels) of how much the reference
point has moved.
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When the analysis is complete, you can fine-tune it if a tracker box has strayed
from the reference it was supposed to follow. Once you are satisfied with the
results, you can apply the data to the footage.

To track, the Stabilizer applies the Shift values as is. To stabilize, the Stabilizer
inverts the X and Y Shift values in each frame of the sequence, and moves the
image according to these values. This gives the impression that the reference
point stays in the same position throughout the sequence. Because the image
is moved during stabilization, a border appears on one or more edges, which
means that some pixels are lost. The following illustrations show the process.
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1-point Stabilizing
1-point stabilizing is useful when the motion you want to remove is
horizontal/vertical (side-to-side/up and down).

Hand-held camera and helicopter shots nearly always have undesired
horizontal or vertical motion jitter.
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In the following example, the camera was bumped several times during filming
which caused unwanted camera motion along the Y axis.

To perform 1-point stabilizing:

NOTE Although this example uses the Reaction tool, any tool that has position
and translation parameter controls can be used to perform 1-point stabilization,
such as the Panner tool, 2D Transform, Warp 2D and the vertices in the Garbage
Mask and the Remove Dust tools.

1 Play the footage to verify that you have a good reference feature.

A decorative point at the six o'clock position was chosen as the reference
feature.

2 Click Analyze Forward to track the selected reference position in the
footage.

3 Drag a Reaction tool from the Tools tab and place it on the dependency
graph between the footage node and the Output node.

4 With the cursor over the Reaction node, right-click and select Add Source.

5 To associate a layer with the source you just created, select the source
layer from the Layer Editor. At the bottom of the Layer Editor, select
Bilinear and click Create.

6 In the Reaction tab, under Position, right-click inside the Y field and
select Stabilize Position Y.
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The Tracker Selector appears.

7 Select the Tracker Analyzer from the list and click Link.

An expression is automatically created linking the tracking data to the
stabilizing filter for position Y.

8 Play the footage to view the result.

2-point Stabilizing
2-point stabilizing is useful when the motion you want to remove involves
changes in scale/rotation (zoom/roll). For example, your camera may be
zooming out from someone in a rocking chair.
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As in tracking, when you choose to stabilize combinations of position, scale,
and rotation simultaneously, the roles of each of the points are additive:

■ If you track both scale and rotation, the first point indicates the pivot point
of the rotation; the second indicates the arc of the rotation; and the
distance between the two indicates the scaling changes.

■ If you track position at the same time, the first point also indicates the
vertical/horizontal motion you want to eliminate.

■ If you track scale, choose two reference features that are at the same Z-depth
throughout the shot. For example, if you have two rows of trees lining a
driveway, choose two trees at about the same Z-depth (distance away from
camera).

■ If you track rotation, choose two reference features that are as far as possible
from each other. This gives the Tracker the maximum amount of roll to
analyze and correct.

■ If you do 2-point stabilizing, each of the two reference features stays fixed
throughout the stabilized clip. That is, if you are stabilizing scaling, the
scaling change is eliminated. If you are stabilizing rotation, the rotation
is eliminated.

To perform 2-point stabilization:

1 Track the video clip using a Tracker node with 2 trackers.

2 Connect the clip into a Transform2D node.

3 Set Transform Type to 2 Point.

4 Click on Set Source Trackers and choose the 2 trackers.

5 Click on Set Destination Trackers and choose the same 2 trackers, but
select the frame number to which you want the clip stabilized. This will
set the destination points to a non-animated value, positioning the
stabilized clip to match the desired frame. Alternatively, you can just edit
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the values of the Destination 1 and 2 boxes to create the desired stabilized
position.

6 Click Link.

7 Play the clip. The unwanted motion is eliminated.

NOTE You can also perform 4-point stabilization by adding 2 extra tracker
analyzers.

Simultaneous Stabilizing and Tracking
The fact that you can associate trackers with both source and destination
points of the transform means that you can effectively do stabilization and
tracking simultaneously. This is used to place one moving object in a clip onto
a second moving object in a different clip.

To 2-point track one moving element onto another moving element:

1 Track the first video clip using a Tracker node with 2 trackers. In this
example, footage of a pair of moving eyes was tracked.
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2 Track the second video clip using a Tracker node with 2 trackers. A moving
image of a cat was tracked.

3 Track the second video clip using a Tracker node with 2 trackers.

4 Connect the first clip into a Transform2D node

5 Set Transform Type to 2 Point.
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6 Click on Set Source Trackers and choose the 2 trackers from the first video
clip. Make sure Use Offset is toggled to active, then click Link.

7 Click on Set Destination Trackers and choose the 2 trackers from the
second video clip. Make sure Use Offset is toggled to active, then click
Link.
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8 Add any correction using the Translation, Rotation, Scale parameters.
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Video Tools

Topics in this chapter:

■ About Video Tools on page 795
■ Deinterlace on page 795
■ Interlace on page 801
■ Pulldown on page 802

About Video Tools
Use the Video tools to perform the following operations:

■ Inputting interlaced material and converting it to progressive.

■ Outputting progressive material to interlaced format.

■ Removing or adding 3:2 pulldown to convert the frame rate of footage.

Deinterlace
Video media is interlaced, meaning one frame consists of two fields representing
different points of time. Since each field is sampled on only the odd or even
scanlines, each field is missing half the pixels needed to make a full frame at
that point in time. Deinterlacing is a process of interpolating the missing
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information on fields to make full frames at particular points in time. A missing
pixel can be interpolated by vertical interpolation of the field at the given
time or by temporal interpolation using the previous and next field or a blend
of the two. Adaptive video de-interlacing calculates a separate blend factor for
each pixel based on the amount of local motion, so that vertical scanline
interpolation is used in areas of motion, and temporal interpolation is used
in static portions of the scene. This preserves detail in static portions of the
scene while removing interlacing artifacts in areas of motion.

Use the Deinterlace tool to perform the following steps of the deinterlacing
process:

■ Determine the field dominance.

■ Select fields (frame rate conversion).

■ Adjust the adaptive threshold.

■ Choose a scanline (spatial) interpolation method.

■ Choose antialiasing parameters.

■ Choose a temporal interpolation method.

The Deinterlace tool UI has the following parameters:

Adaptive thresholdTemporal interpola-
tion

Spatial interpola-
tion

Field and format
settings

Determining Field Dominance
The field dominance is whether the top field comes before or after the bottom
field in time. The top field means the field which contains the highest vertical
scanline to be displayed.

To set the field dominance:

1 Set the format to either Non-NTSC or NTSC. If the format is NTSC the
dominance will be labeled Upper First-Field 2 and Lower-First Field 1. If

796 | Chapter 33   Video Tools



the format is Non-NTSC the labels will be Upper First-Field 1 and Lower
First-Field 2.

2 Set the value of the Dominance (upper or lower first).

3 If you do not know the field dominance, you can press the Guess
Dominance button and it will be determined for you. Keep in mind that
this may take several seconds to analyze frames and may take even longer
if the input has a long sequence of static frames before the action. To
stop the analysis, press the Cancel Guess button.

Field Selection
Basic video de-interlacing discards one field for each frame (say field 2) and
uses some form of scanline interpolation to reconstruct the missing lines.
Composite provides you with three choices when you convert interlaced media
to progressive. You can opt to remove fields which outputs the first field of
each frame, merge the fields which outputs a merge of the two fields of each
frame, or change fields to frames which outputs all input fields separately as
a frame (creates clip of twice the duration).

Depending on the parameter settings, the set of output frames will vary as
described in the following table. The actual frame rate of the output is
unchanged from the input. Each input frame consists of 2 fields, numbered
individually as shown in the top part of the table.

A Fields to Frames operation converts 30i into 30p having twice the duration
of the input. If you desire to have 60p output, you may add a Rate Convert
node after the Deinterlace node.

To choose a field selection method:

 ➤ Click the Conversion button and select a method from the list.
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Adjusting the Adaptive Threshold
Adaptive deinterlacing is essentially controlled by the Motion Threshold,
which gives a trade-off between interlacing artifacts and preservation of detail.
This threshold indicates at what point a pixel is considered to be in motion.
All pixels above this threshold are treated as moving and are interpolated
spatially, meaning there is a loss of detail because every second line is thrown
away. Pixels below this threshold are considered to be static parts of the scene
and we preserve both fields of input, i.e., we use temporal interpolation. If
you place the motion threshold at 100, then we consider all pixels to be static
and output both fields, essentially not deinteracing, as seen in the following
image:

The above image has great detail in the static grey rock region (because it keeps
both fields of input), but has objectionable interlacing feathering in the waving
baton. If you push the threshold all the other way to 0, as in the following
image, the interlacing artifacts disappear, but the static brick region loses
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detail, because now all pixels are being vertically interpolated, after throwing
away every second line.

So you must move the slider down from 100 until all interlacing artifacts
disappear, as in the following image, where the Motion Threshold is 30. Here
we see that the baton has no interlace artifacts, but the details of the static
brick areas of the scene are preserved.

The softness threshold can be used to make a smoother ramp between the
thresholded regions, but since the internal calculation of motion already has
a bit of blurring built in, you may not want to add more.
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Setting Spatial Interpolation
The next step is to interpolate the missing vertical scanlines in areas of motion.
You can select from four levels of quality with the default setting of Cubic
being the best. Cubic is based on information calculated from four scanlines.
Linear means to take the average of lines from two fields, whereas Nearest
means to just copy the line from above or below. Selecting the Black parameter
will display which pixels are being interpolated. This is useful when setting
the Motion Threshold.

The Edge Preserve value field lets you set the amount of edge antialiasing you
want to apply, while the Angles parameter is a performance/quality trade-off
setting which effectively controls the amount of searching for appropriate
edge direction. Increasing the number of angles sets the number of steps from
0 to 90 degrees, or the direction of the antialiasing.

Setting Temporal Interpolation
To create an output frame from a given input field, we copy the field, consisting
of every second line of input, to the output frame. The remaining lines in the
output must be interpolated somehow. Temporal interpolation is what is used
in areas of the scene that are considered to be static (non-moving), as
controlled by the Motion Threshold. The choices of temporal interpolation
are Nearest or Linear. Nearest means to just copy the lines from the other field
in the same input frame, whereas linear means to take the average of lines
from two fields: the other field in the same input frame and the field either
2 fields before or 2 fields after that.

When should one use Linear and when should one use Nearest? The short
answer is to always use Linear unless you need to preserve grain in static areas,
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or if you want to do a traditional field merge. The long answer is that if the
static region of the image is undergoing lighting changes, then you need to
use Linear to avoid alternating lines having different intensities. If the static
region is not undergoing lighting changes and is perfectly static, then you get
the same result whether you use Linear or Nearest. That is why you should
usually use Linear. However, if the static region has grain that changes from
frame to frame, then using Linear will blur this a bit (being the average of 2
fields), so you may want to switch to Nearest.

The other time one might want to use Nearest for Temporal interpolation is
when performing a traditional field merge. Here the user would set the Motion
Threshold and Motion Softness both to 0.0, which disables the Adaptive
deinterlacing. By setting the conversion to do Merge Fields and setting the
Temporal Interpolation to be Nearest, the final result is exactly equivalent to
a field merge, where each output line is a weighted sum of the corresponding
input line, and the lines above and below it, with weights of 0.5, 0.25, and
0.25 respectively.

Interlace
Use the Interlace tool to convert a sequence of progressive frames to an output
of interlaced video frames. Each pair of input frames result in one output
frame.

To convert progressive frames to interlaced frames:

1 Select either NTSC or Non-NTSC from the Format menu.

2 Select the field order. If the upper field is first, then the upper field is
taken from the first frame of the input pair and the lower field is taken
from the second frame of the input pair; otherwise, upper and lower fields
are reversed.

The output is always at the same frame rate as the input, and the action will
play twice as fast. You can always use a Rate Convert node before the Interlace
if needed. The following table shows how frames are interlaced. The input
frames are numbered consecutively from 1 as shown in the top part of the
table. Each output frame shows two numbers, which indicates the input frame
indices for field 1 and field 2 respectively.
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Pulldown
3:2 pulldown is the process of going from 24 frames per second of film to 60
fields per second of interlaced video (30 video frames per second). This is
usually what a Telecine does when transferring film to video. Pulldown can
also be applied to convert between 24 frames per second and 50 fields per
second of interlaced video (PAL). In this case, it is referred to as PAL pulldown
or 2:2:2:2:2:2:2:2:2:2:2:3.

The 3:2 process works on chunks of 4 film frames to produce chunks of 5
video frames (10 fields); given film frames A, B, C, and D, it produces video
frames AA, BB, BC, CD, DD (the first and second letter correspond to what
goes in the first and second field respectively).

To recover the original 24 frames per second of film and perform compositing
work on progressive frames, you need to go through the reverse process, called
3:2 pullup. In order to do this, you need to know:

■ Cadence  At which video frame the repeating pattern starts.

■ Field Dominance  Which field comes first in time, Field 1 or Field 2?

The Pulldown tool will do both pulldown and pullup for 30 and 25 frames
per second. The four possible operations are selected from the Conversion
menu.
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You can then select the pulldown cadence by choosing one of the following
five patterns of whole (W) and split (S) frames from the Cadence menu.

Whole and Split frames are a consequence of using every second input frame
to create three output fields and every other input frame to create two output
fields, as in the following list of output field pairs.

PAL Cadences
For PAL pulldown, 12 frames of progressive input become 25 fields of interlaced
output. This means that out of every 12 input frames, 11 contribute to exactly
2 output fields, and 1 contributes to 3 output fields.

One example might be the following list of output field pairs where the 6th
input frame is used 3 times:

There are actually 25 cadence possibilities for 25i, as compared to only 5 in
the NTSC 30i case. It is too awkward to refer to these cadences in the same
way as for NTSC, for example: WSSSSSSSSSSSSWWWWWWWWWWWW.
Therefore, the 25 cadences have been labeled 1 to 25 in the Cadence
drop-down menu where the number indicates the index of the split frame
that follows a whole frame.

Autodetecting the Cadence
Similar to the Deinterlace tool, you can push the Guess Cadence button to
analyze the sequence of interlaced frames to automatically set the proper
cadence and dominance. Note that this assumes that the cadence and
dominance do not change over the length of the input sequence. This button
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would only be active if the operation is set to 30i to 24p, or 25i to 24p. This
starts to search for which type of cadence (one of 5 or 25 possibilities) exists.

While analyzing, the Guess Cadence button will be labeled as “Cancel
Guessing”, and provides you with a way out of the guessing analysis. As in
the Deinterlace tool, a text label appears while guessing to indicate the current
frame number being analyzed.

The frame rate of the output is modified to match the ratio of the conversion.
For instance, the conversion 30i -> 24p will create output with a frame rate
4/5 of the input. Normally the input would be 30 fps and the output 24 fps,
but the input can be any frame rate and the output will just be this frame rate
multiplied by the appropriate ratio. Therefore the Pulldown is a true frame
rate converter, unlike the Deinterlace and Interlace, and the Pulldown tool
will not affect the apparent speed of action of the clip. The 30i to 24p
conversion can also be used for 29.97i input, but the frames output will
correspond to a frame rate of 23.98. If you wish to transform 30i into 23.98p,
then a Retimer tool may be added.
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Utilities

Topics in this chapter:

■ About Utilities on page 805
■ Comparison Tool on page 806
■ Notes Tool on page 812
■ Pass Through Tool on page 813
■ Switcher Tool on page 814

About Utilities
Utilities are analytic tools that you can use to view images without changing
pixel data; they are display modifiers only. Utilities are available in the Utilities
folder of the Tools tab.

The utilities tools available:

DescriptionTool

Lets you....Link Image

Lets you view the output of your composition.Output

Lets you compare images—see Comparison Tool on page 806.Comparison

Lets you....Freeze Frame

34

805



DescriptionTool

Lets you add notes to a composition—see Notes Tool on page 812.Notes

An image tool that passes its input to its output unmodified—see
Pass Through Tool on page 813.

Pass Through

Lets you.....Show Tiles

An image tool that allows you to switch between nodes—see
Switcher Tool on page 814.

Switcher

Comparison Tool
The Comparison tool is a viewer tool for comparing two images.

You can place the Comparison tool in either of two locations by dragging and
dropping the tool from the Tools tab. Like any other tool, you can place the
Comparison tool anywhere in the current composition by dropping the tool
in the Schematic, Player, etc.

The Display Tools is the desired location for the Comparison tool. The Display
Tools contains two place holders; one for the Comparison tool and one for
the Display Modifier. By default these place holders contain the Comparison
and the Display Pass Through tools.

The Comparison tool can be placed either before or after the display modifier.
This placement is controlled by the Display Tools Order setting in the User
Preferences (Creative tab), which has a default value of Comparison before
the display modifier.
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Access to the Display Tools Comparison tool is through the Player options
menu in the south gate. By dropping a Comparison tool on the appropriate
tab in the Player options, it will replace the current Comparison tool. This is
similar to creating a display modifier.

Enabling the Comparison tool
By default the Comparison tool will already exist in the Player (Display Tools)
but will be muted.

To enable the Comparison tool:

 ➤ Do one of the following:

■ Right-click in the Player and select Comparison.

■ Press Shift + C (or Shift + D for the Display Modifier).

■ Select the Mute button in the tool options of the Comparison Tool
tab.

To delete the Comparison tool from the Display Tools:

 ➤ Select the Delete button in the tool options of the Comparison Tool tab.

This causes the Comparison Pass Through tool to be used.
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Selecting the Primary and Reference Inputs
The comparison tool’s primary input is connected to the output that the
viewer would be showing without the comparison tool. The reference input
is set to current composition and has all of the display options available in
the normal player. They are tool input/output, composition, and context
points 1 - 4. These options can be changed by using the context menu
Reference sub menu in the player. The display options in this menu refer to
those of the reference input.

Hotkeys to switch the display options (1-8) will affect either the primary or
reference input depending on which side of the manipulator the hotkey event
takes place. The player information will indicate what sources are being shown
for the primary and reference inputs—see Cycling Through Inputs and Outputs
on page 71.

Comparison Tool Controls
The Comparison tool has the following parameters:

The comparison tool contains a list of manipulators; a split bar and a region,
which can be selected to change the behavior of what areas are being
compared.

The split bar is the default manipulator. Through direct manipulation, the
bar can be moved, rotated, and can have its pivot point changed. By default
the split bar separates the viewer horizontally in two with the reference input
on the bottom side.

There is a pivot point (indicated by a small box) around which the split bar
can be rotated, or from which the split bar can be moved. The letter R next
to the pivot box indicates the side of the bar where the reference input is
displayed.
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Reference processed with Gray tool.

To rotate the split bar around its pivot point:

 ➤ Drag the split bar either above or below the pivot point.

Reference processed with Gray tool.

To move the split bar:

 ➤ Drag the pivot point. You can also Ctrl + click the viewer to place the
pivot point under the cursor, and then drag over the viewer to move the
split bar.
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Reference processed with Gray tool.

The region rectangle is created and modified through direct manipulation.
By default the region will be centered in the viewers. There are pivot points
(indicated by small boxes) on each corner and side to change the width and
height of the region. The letter R next to the left pivot point indicates whether
the reference input is displayed in the interior or exterior of the region.

Reference processed with Color Space tool.

To move the region:

 ➤ Do one of the following:

■ Drag the interior of the region.
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Reference processed with Color Space tool.

■ Place the cursor at the location where you want the center of the
region to be and press Ctrl + click.

To resize the region:

 ➤ Drag any of the pivot points.

Reference processed with Color Space tool.

To show or hide a particular manipulator:

 ➤ Press Shift + H. When the manipulator is hidden, it is still active.
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To change which area of the manipulator the reference input occupies:

 ➤ Press Shift + R.

To:Use:

Set a time offset—see Linking Compositions on page 234. This
parameter applies only to the reference image.

Offset

Set the repeat mode —see Linking Compositions on page 234.
This parameter applies only to the reference image.

Repeat

Set in and out points—see Linking Compositions on page 234.
These parameters apply only to the reference image.

Mark In/Mark Out

Vary the opacity of the reference input to reveal the underlying
primary image. The transparency will only affect the primary input

Opacity

side of the manipulator. The reference side will always remain
100% opaque. Use Shift + O to toggle the opacity.

Translate and scale the entire viewer using the pan and zoom
hotkeys currently implemented. To translate and zoom the refer-

Zoom/Translate
X/Translate Y

ence image, use the controls in the Comparison tool UI. To
translate and zoom the primary image, swap the images and use
the controls in the Comparison tool UI.

Notes Tool
The Notes tool lets you add comments to your composition which can be
useful when collaborating on an effect or project with other artists. You can
use the Notes tool to add notes to any node in a dependency graph. And
because the Notes tool is an image pass through tool, you can add it to an
image connection. Once you've added comments, you can use standard cut,
copy, and paste commands to edit the text.

Notes added to dependency graph.
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To add notes to a composition:

1 From the Tools tab, drag a Notes tool from the Utilities folder to the
dependency graph in the Schematic view.

2 In the Notes tool UI, type in your comments.

Pass Through Tool
The Pass Through tool is an image tool that passes its input to its output
unmodified. No image copying, format change, or content change is
performed. It can also be used as a placeholder in the Display Tools for most
color conversion and image modifying tools, and affects only what you see
in the Player.

To add a display modifier to the Display Pass Through placeholder:

1 Drag a tool from the Tools tab and pause in the Player, then middle-click
or press the tilde (~) key.

2 Go through the south gate to the Display Options and drop the tool onto
the Display Pass Through tab.

Pass Through Tool | 813



To delete a display modifier from the Display Pass Through placeholder:

 ➤ With the Display (modifier) tab active, click the Delete button in the Tool
Options area.

The Pass Through tool is very useful as a connection point in the dependency
graph. The Pass Through tool node allows you to make multiple output sockets.
Use this node as the input to a group to simplify the representation of a
complex effect. Once all the necessary Pass Through output connections have
been made, any other tool that you want to add before the Pass Through
branching point can be done without having to cut and reestablish the
connections.

Switcher Tool
The Switcher is a standalone tool that allows you to alternate between different
output views from multiple nodes without having to disconnect and reconnect
nodes. It has multiple image inputs, but only one output. There is a single
primary input, and a secondary input that can receive input from multiple
nodes. The Switcher functions as a pass through for one selected image.
Specifically, the output acts as a pass through for the primary input.

The Switcher tool has just one option in the UI. The list of node inputs is
displayed so you can select a node to connect to the primary input. The name
of the node connected to the primary input is always visible. The list of nodes
connected to the secondary input can be viewed by clicking the name button
in the Switcher tool UI. The user just has to click one of the nodes displayed
in the list of nodes connected to the secondary input, and it will automatically
become connected to the primary input. The change will immediately be
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visible in the Schematic view. You can also use the S hotkey to switch between
inputs.

To add a Switcher to a composition:

1 From the Tools & View tab, drag a Switcher tool from the Utilities folder
to the Schematic view or directly into a dependency graph.

2 Connect one node to the primary input on the Switcher. Multiple nodes
can be connected to the secondary input.

To switch inputs:

1 In the Switcher tool UI, click the name button to display the nodes
connected to the secondary input.

2 Select the node from the list of secondary inputs that you want to connect
to the primary input.
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Hotkeys

Topics in this chapter:

■ Hotkeys on page 818
■ Windows and Linux on page 818
■ Login Screen on page 818
■ General on page 818
■ User Interface Elements on page 819
■ Browsers on page 823
■ Composition Hotkeys on page 824
■ Views on page 827
■ Tools on page 832
■ Mac OS on page 837
■ Login Screen on page 838
■ General on page 838
■ User Interface Elements on page 839
■ Browsers on page 842
■ Composition Hotkeys on page 843
■ Views on page 846
■ Tools on page 851
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Hotkeys
The following chapter is divided into two sections: the first section describes
the hotkeys for Windows and Linux on page 818, the second describes the
hotkeys forMac OS on page 837.

Windows and Linux
The following are the Composite hotkeys for Windows and Linux.

Login Screen
The following hotkeys work in the login screen.

To:Press:

Log in.Enter

Exit Composite.Ctrl + Q

General
The following hotkeys work throughout the application.

Exit
The following hotkey is to exit the application.

To:Press:

Exit Composite.Ctrl + Q
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Context Menus
The following hotkeys are available for context, or right-click, menus.

To:Press:

Display the context menu. If a keyboard includes the context
menu key, it is typically located three keys to the right of the
Spacebar.

context menu +
click or right-click

Select, Edit, Undo/Redo
The following hotkeys are available to perform basic editing operations.

To:Press:

Cut the element.Ctrl + X

Copy the element.Ctrl + C

Paste the element.Ctrl + V

Add to, or remove from, the selection.Ctrl + click

Select the range of elements between this one and the last one
selected.

Shift + click

Undo the last operation.Ctrl + Z

Redo the last undo.Ctrl + Y

User Interface Elements
The following hotkeys are available for different interface elements.

Menubar and Taskbar
The following hotkeys are available for the menubar and taskbar.

To:Press:

Turn the taskbar on or off.Ctrl + T
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To:Press:

Turn the menubar on or off.Ctrl + M

Layout Presets
The following hotkey is available for the layout presets.

To:Press:

Previous layout preset.Ctrl + Backspace

Cursor
The following hotkey is available for the cursor.

To:Press:

Reset the cursorCtrl + Alt + Shift + C

Tabs and Controls
The following hotkeys are available for tabs and controls.

To:Press:

Go to previous control.Shift + Tab

Go to next controlTab

Go to previous tabAlt + Left Arrow

Go to next tabAlt + Right Arrow

Text Editor and Text Fields
The following hotkeys are available in the text editor and in any text field.

To:Press:

Text editor: Add a line break. Text field: Accept text.Enter
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To:Press:

Select current word.Double-click

Delete previous character.Backspace

Delete next character.Delete

Move to beginning of line.Home

Move to end of line.End

Move cursor left.Left Arrow

Move cursor right.Right Arrow

Select text from current position to beginning of line.Shift + Home

Select text from current position to end of line.Shift + End

Select one character to the left of the cursor.Shift + Left Arrow

Select one character to the right of the cursor.Shift + Right Arrow

Text editor only. Select from current position backward to same
position on previous line.

Shift + Up Arrow

Text editor only. Select from current position forward to same
position on next line.

Shift + Down Arrow

Move cursor left by one word.Ctrl + Left Arrow

Move cursor right by one word.Ctrl + Right Arrow

Select word to the left of the cursor.Ctrl + Shift + Left
Arrow

Select word to the right of the cursor.Ctrl + Shift + Right
Arrow

Cancel text entry.Esc

Auto Complete.Alt + /
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Numeric Fields (Value Editors)
The following hotkeys are available in numeric fields.

To:Press:

Increment (with autorepeat).Up Arrow

Decrement (with autorepeat).Down Arrow

Increment * 10.Ctrl + drag

Increment / 10.Alt + drag

Increment * 100.Ctrl + Shift + drag

Increment / 100.Alt + Shift + drag

Edit text.Enter

Reset to default.Ctrl + click

Display the standard calculator.Shift + click

Display the Espresso calculator if you can animate the field, or
the standard calculator if you cannot.

Alt + Shift + click

Display the pop-up menu.context menu +
click or right-click

Pop-up Dialogs
The following hotkeys are available in pop-up dialogs.

To:Press:

AcceptEnter

CancelEsc
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Browsers
The following hotkeys are available in any browser. The Browser view and the
File workspace are browsers.

To:Press:

DeleteDelete

RefreshF5

Select all.Ctrl + A

CopyCtrl + drag

Add to, or remove from, the selection.Ctrl + click

Select the range between the last element selected and this one.Shift + click

Add the column to the sort criteria.Shift + click (on Sort
area of the column)

Edit the text.F2

Cancel the text edit.Esc

Move to next row.Down Arrow

Move to previous row.Up Arrow

Move to next column.Right Arrow

Move to previous column.Left Arrow

Move to next page.Page Down

Move to previous page.Page Up

Move to first item in list.Home

Move to last item in list.End

Open (File Browser).Double-click

Bookmark path.Ctrl + D

Browsers | 823



Floating Browsers
The following hotkeys are available for the Floating Browser.

To:Press:

Activate/deactivate Floating File Browser.Ctrl + I

Activate/deactivate floating viewAlt + O

Activate or deactivate the Floating File Browser.Ctrl + O

Close the Floating Browser.Esc

Composition Hotkeys
The following hotkeys are available when working with a composition.

To:Press:

Save compositionCtrl + S

Go to Pick List tab.Ctrl + P

Toggle play backward.J

Toggle play forward.L

Move to the first frame.Shift + Left Arrow

Move to the last frame.Shift + Right Arrow

Move to the next frame.Right Arrow

Move to the previous frame.Left Arrow

Set mark in.I

Set mark out.O

Set cue mark.U

Next cue markCtrl + Right Arrow

Previous cue mark.Ctrl + Left Arrow
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To:Press:

Toggle Timecode/Frame.Shift + T

Select downstream node.Alt + Shift + Right
Arrow

Select upstream node.Alt + Shift + Left Ar-
row

Select next input/output.Alt + Shift + Down
Arrow

Select previous input/output.Alt + Shift + Up Ar-
row

Create a new composition.Ctrl + N

Previous view.Ctrl + Shift + Tab

Next view.Ctrl + Tab

Refresh. This includes a refresh of the current composition if it
is out of date (its composition icon is red).

F5

Reset node.Ctrl + R

Close composition.Ctrl + W

Go to previous tool.Shift + Tab

Go to next tool.Tab

Go to home tool.Shift + Home

Go to next tab.Alt + Right Arrow

Go to previous tab.Alt + Left Arrow

Toggle Marking State of Current Selection.Shift + A

Selection History back.Alt + Left Arrow

Selection History forward.Alt + Right Arrow

Composition Hotkeys | 825



Gate UI
The following hotkey is available for the Gate UI.

To:Press:

Display the Gate UI.Middle-click

Display the Gate UI. The backquote key ( ) shares the same key
with the tilde key (~) and is located below the Esc key on the
keyboard.

(backquote key)

Close the Gate UI.Esc

Continue displaying the UI element of the gate you swiped
through.

Alt + swipe (through
a gate)

Calculator
The following hotkeys are available for the Calculator.

To:Press:

Activate or deactivate the Calculator.Alt + C

Close the Calculator.Esc

Color Picker
The following hotkeys are available in the Color Picker.

To:Press:

Perform an average (rectangle).Ctrl + drag in the
color spectrum

Use the eyedropper to pick a color without displaying the Color
Picker.

P

Pick a color for a color pot without displaying the Color Picker.Ctrl + click color pot

Activate or deactivate the pop-up Color Picker.Alt + P

Accept.Ctrl + Enter
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To:Press:

Cancel.Esc

Views
The following hotkeys are available in Schematic, Animation Editor, and Player
views.

To:Press:

PanSpacebar + drag

Reset zoom and pan.Home

Zoom in.Up Arrow

Zoom out.Down Arrow

Integer zoom in.Ctrl + Up Arrow

Integer zoom out.Ctrl + Down Arrow

ZoomCtrl + Spacebar +
drag

Zoom region.Shift + Spacebar +
drag

Zoom selected items.Ctrl + Home

Zoom all scene.Ctrl + Alt + Home

Activate Viewpoint [1-4].[F1 - F4]

Set Viewpoint [1-4].Ctrl + [F1 - F4]

Delete Viewpoint [1-4].Ctrl + Shift + [F1 -
F4]
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Animation Editor
The following hotkeys are available in the Animation Editor.

To:Press:

Add key mode.+ (plus)

Delete key mode.- (minus)

Cancel add/delete key mode.Esc

Lock keyframe time.Shift + T

Lock keyframe value.Shift + V

Lock tangent length.Shift + L

Lock tangent orientation.Shift + O

Unify tangent length.Ctrl + Shift + L

Unify tangent orientation.Ctrl + Shift + O

Cycle interpolation mode keyframes.Shift + I

Cycle extrapolation mode curves.Shift + E

Set keyframe.K

Set keyframe for marked attributes.Shift + K

Delete keyframe.Delete

Select all curves.Ctrl + A

Select all keyframes on selected curves.Ctrl + Alt + A

Move to previous keyframe on selected curves.Ctrl + Left Arrow

Move to next keyframe on selected curves.Ctrl + Right Arrow

Add previous keyframe on selected curves, to selection.Ctrl + Shift + Left
Arrow

Add next keyframe on selected curves, to selection.Ctrl + Shift + Right
Arrow
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To:Press:

Increase brush size in Delete Key mode.Shift + plus sign (+)

Decrease brush size in Delete Key mode.Shift + minus sign (-)

Player
The following hotkeys are available in the Player.

To:Press:

Set a region of interest (ROI). Click and drag to define an initial
ROI, then use the cursor to adjust the size or location of the re-
gion.

Shift + Z

Toggle full screen Player.F

View the red channel of the target.R

View the green channel of the target.G

View the blue channel of the target.B

View the alpha channel of the target.A

View the channels of the target.C

Display C1 Output (output of context point 1).1

Display C2 Output (output of context point 2).2

Display C3 Output (output of context point 3).3

Display C4 Output (output of context point 4).4

Display Tool Input (input of the currently selected tool).5

Display Tool Output (output of the currently selected tool).6

Display Composition (output of the composition's output node).7

Display rendered version.8

Display previous rendered version.Shift + 8
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To:Press:

Display rendered output.9

Reset nodes.Ctrl + R

Toggle Comparison tool.Shift + C

Toggle Display Modifier tool.Shift + D

Next stream (stereo)0

Previous stream (stereo)Shift + 0

Separators
The following hotkey is available for manipulating UI separators.

To:Press:

Reset to previous location.Ctrl + click

Schematic
The following hotkeys are available in the Schematic view.

To:Press:

Set a context point on that node. The number indicates the
number of the context point. For example, pressing 1 + click
sets context point 1. Pressing 3 + click sets context point 3.

[1-4] + click a node

Clear the context point. The number indicates the number of
the context point to clear. For example, pressing 2 + click clears
context point 2, and pressing 4 + click clears context point 4.

[1-4] + click the
background of
Schematic

Connect the two nodes (Kiss). Release Shift and continue
dragging to cancel the operation.

Shift + drag a node
into contact with an-
other node

Insert the node between the two nodes joined by that connec-
tion. Release Alt and continue dragging to cancel the operation.

Alt + drag a node
onto a connection
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To:Press:

Disconnect the nodes joined by that connection or by those
connections.

Ctrl + drag through
one or more connec-
tions

Group or ungroup the selected node(s).G

Edit the selected group.Double-click

Exit the group.Double-click (back-
ground)

Mute or unmute nodes.M

Clean up Schematic.C

Delete nodes.Delete

Reset nodes.Ctrl + R

Mark node for keyframe.A + click (node)

Toggle node thumbnails.T

Display the details of a selected node without opening the node.D (drag over node)

Show all node details.Shift + D

Expand or collapse node.E

Select all nodes and connections.Ctrl + A

Select all upstream nodes. You can select multiple branches
without clearing the selection.

X + click

layout selected.L

Layout all.Ctrl + L

Increase Auto-pan speed.Ctrl

Decrease Auto-pan speed.Alt

Create boundary node.(outside of viewer)

Group nodes (visual).Shift + G
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To:Press:

Open visual group.Shift + O

Close visual group.Shift + C

Add to visual group.V + drag

Remove from visual group.Shift + V + drag

Copy nodeC + drag

Tools
The following describes hotkeys available in specific tools.

Garbage Mask (also applies to Remove Dust and
Warp 2D tools)
The following hotkeys are available in the Garbage Mask tool.

To:Press:

Create Freeform.D

Create Rectangular.S

Create Elliptical.W

Finish shape.Esc

Edit.E

Transform.T

Nudge left.Shift + Left Arrow

Nudge right.Shift + Right Arrow

Nudge up.Shift + Up Arrow

Nudge down.Shift + Down Arrow
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To:Press:

Nudge left (large).Ctrl + Shift + Left
Arrow

Nudge right (large).Ctrl + Shift + Right
Arrow

Nudge up (large).Ctrl + Shift + Up Ar-
row

Nudge down (large).Ctrl + Shift + Down
Arrow

Close shape.Enter

Select all control points.Ctrl + A

Select next control point.Ctrl + .

Select previous control point.Ctrl + ,

Insert a control point.Alt + click (on curve)

Delete a control point.Alt + click (on con-
trol point)

Move a control point in auto tangent mode.Ctrl + Alt + click +
drag (on control
point)

Add tangent handle. Repeat to remove tangent handle.Ctrl + click (on con-
trol point)

Adjust the length of both sides of a tangent handle.Alt + drag (the
handle)

Break a tangent handle.Ctrl + click + drag
(the handle)

Move a curve between points.Ctrl + Alt + drag
(over location on a
curve)

Create an edge point.Ctrl + click+ drag
(on the curve)
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Keyer
The following hotkeys are available in the Keyer tool.

To:Press:

Sample matte.M

Sample patch [1-9].Shift + [1-9]

Sample degrain.D

Spill suppress.S

Adjust blend.Shift + B

Master Keyer
The following hotkeys are available in the Master Keyer tool.

To:Press:

Sample matte.M

Sample patch [1-9].Shift + [1-9]

Paint
The following hotkeys are available in the Paint tool.

To:Press:

Adjust brush size. Drag right to increase, drag left to decrease.S + drag

Clone brush.Ctrl + click

Line brush.Shift + click

Flip foreground/background colors.X
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Spill & Blend
The following hotkeys are available in the Spill & Blend tool.

To:Press:

Spill suppress.S

Adjust blend.Shift + B

Reaction
The following hotkeys are available in the Reaction tool.

To:Press:

Orbit the camera.Q

Orbit grasp.Q + click

Truck the camera.W

Truck grasp.W + click

Dolly the camera.E

Dolly grasp.E + click

Enter Move mode.M

Enter Rotate mode., (comma)

Enter Scale mode.. (period)

Cameras
The following hotkeys for the camera are available in the Player when using
the Reaction tool.

To:Press:

Switch cameras. If you are using more than one camera, you
will cycle through each camera.

Shift + 1

View from perspective camera.Shift + 2
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To:Press:

View from front.Shift + 3

View from Left.Shift + 4

View from Top.Shift + 5

Reset camera.Shift + Home

Resize
The following hotkeys are available in the Resize tool.

To:Press:

Symmetrical resize.Ctrl + drag

Maintain ratio.Shift + drag

Maintain image input ratio.Shift + I +
drag

Maintain image output ratio.Shift + O +
drag

Retimer
The following hotkeys are available in the Retimer tool.

To:Press:

Cycle show vectors mode.M

Tracker
The following hotkeys are available in the Tracker tool.

To:Press:

Delete track point.Delete

Delete track point and step back.Backspace
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Warping Tools
The following hotkeys are available in the Warping tools:

To:Press:

Input transform manipulator.M

Effect transform manipulator.'

Output transform manipulator..

Crop./

Set Pivot (also for 2D Transform tool)Insert

Twirl Rotation.T

Comparison
The following hotkeys are available in the Comparison tool:

To:Press:

Opacity.Shift + O

Toggle tool visibility.Shift + H

Swap reference.Shift + R

Move pivot point or region center.Ctrl + click

Cycle through inputs and outputs.Player hotkeys 1 -
9 on reference side
of manipulator

Cycle between channels and alpha.Player hotkeys C, A
on reference side of
manipulator

Mac OS
The following are the Composite hotkeys for Mac OS.
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Login Screen
The following hotkeys work in the login screen.

To:Press:

Log in.Enter

Exit Composite.Cmd + Q

General
The following hotkeys work throughout the application.

Exit
The following hotkey is to exit the application.

To:Press:

Exit Composite.Cmd + Q

Context Menus
The following hotkeys are available for context, or right-click, menus.

To:Press:

Display the context menu. If a keyboard includes the context
menu key, it is typically located three keys to the right of the
Spacebar.

context menu +
click or right-click

Select, Edit, Undo/Redo
The following hotkeys are available to perform basic editing operations.

To:Press:

Cut the element.Cmd + X

Copy the element.Cmd + C
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To:Press:

Paste the element.Cmd + V

Add to, or remove from, the selection.Ctrl + click

Select the range of elements between this one and the last one
selected.

Shift + click

Undo the last operation.Cmd + Z

Redo the last undo.Cmd + Shift + Z

User Interface Elements
The following hotkeys are available for different interface elements.

Menubar and Taskbar
The following hotkeys are available for the menubar and taskbar.

To:Press:

Turn the taskbar on or off.Cmd + T

Turn the menubar on or off.Ctrl + M

Layout Presets
The following hotkey is available for the layout presets.

To:Press:

Previous layout preset.Cmd + Backspace

Cursor
The following hotkey is available for the cursor.

To:Press:

Reset the cursorCtrl + Alt + Shift + C

User Interface Elements | 839



Tabs and Controls
The following hotkeys are available for tabs and controls.

To:Press:

Go to previous control.Shift + Tab

Go to next controlTab

Go to previous tabAlt + Left Arrow

Go to next tabAlt + Right Arrow

Text Editor and Text Fields
The following hotkeys are available in the text editor and in any text field.

To:Press:

Text editor: Add a line break. Text field: Accept text.Cmd + Return

Select current word.Double-click

Delete previous character.Backspace

Delete next character.Delete

Move to beginning of line.Cmd + Home

Move to end of line.Cmd + End

Move cursor left.Left Arrow

Move cursor right.Right Arrow

Select text from current position to beginning of line.Cmd + Shift + Home

Select text from current position to end of line.Cmd + Shift + End

Select one character to the left of the cursor.Shift + Left Arrow

Select one character to the right of the cursor.Shift + Right Arrow

Text editor only. Select from current position backward to same
position on previous line.

Shift + Up Arrow
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To:Press:

Text editor only. Select from current position forward to same
position on next line.

Shift + Down Arrow

Move cursor left by one word.Alt + Left Arrow

Move cursor right by one word.Alt + Right Arrow

Select word to the left of the cursor.Ctrl + Shift + Left
Arrow

Select word to the right of the cursor.Ctrl + Shift + Right
Arrow

Cancel text entry.Esc

Auto Complete.Alt + /

Numeric Fields (Value Editors)
The following hotkeys are available in numeric fields.

To:Press:

Increment (with autorepeat).Up Arrow

Decrement (with autorepeat).Down Arrow

Increment * 10.Ctrl + drag

Increment / 10.Alt + drag

Increment * 100.Ctrl + Shift + drag

Increment / 100.Alt + Shift + drag

Edit text.Enter

Reset to default.Ctrl + click

Display the standard calculator.Shift + click

Display the Espresso calculator if you can animate the field, or
the standard calculator if you cannot.

Alt + Shift + click
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To:Press:

Display the pop-up menu.context menu +
click or right-click

Pop-up Dialogs
The following hotkeys are available in pop-up dialogs.

To:Press:

AcceptEnter

CancelEsc

Browsers
The following hotkeys are available in any browser. The Browser view and the
File workspace are browsers.

To:Press:

DeleteDelete

RefreshF5

Select all.Cmd + A

CopyCtrl + drag

Add to, or remove from, the selection.Ctrl + click

Select the range between the last element selected and this one.Shift + click

Add the column to the sort criteria.Shift + click (on Sort
area of the column)

Edit the text.F2

Cancel the text edit.Esc

Move to next row.Down Arrow

Move to previous row.Up Arrow

842 | Appendix A   Hotkeys



To:Press:

Move to next column.Right Arrow

Move to previous column.Left Arrow

Move to next page.Page Down

Move to previous page.Page Up

Move to first item in list.Home

Move to last item in list.End

Open (File Browser).Double-click

Bookmark path.Cmd + D

Floating Browsers
The following hotkeys are available for the Floating Browser.

To:Press:

Activate/deactivate Floating File Browser.Cmd + I

Activate/deactivate floating viewAlt + O

Activate or deactivate the Floating File Browser.Cmd + O

Close the Floating Browser.Esc

Composition Hotkeys
The following hotkeys are available when working with a composition.

To:Press:

Save compositionCmd + S

Go to Pick List tab.Cmd + P

Toggle play backward.J

Toggle play forward.L
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To:Press:

Move to the first frame.Shift + Left Arrow

Move to the last frame.Shift + Right Arrow

Move to the next frame.Right Arrow

Move to the previous frame.Left Arrow

Set mark in.I

Set mark out.O

Set cue mark.U

Next cue markCtrl + Right Arrow

Previous cue mark.Ctrl + Left Arrow

Toggle Timecode/Frame.Shift + T

Select downstream node.Alt + Shift + Right
Arrow

Select upstream node.Alt + Shift + Left Ar-
row

Select next input/output.Alt + Shift + Down
Arrow

Select previous input/output.Alt + Shift + Up Ar-
row

Create a new composition.Cmd + N

Previous view.Ctrl + Shift + Tab

Next view.Ctrl + Tab

Refresh. This includes a refresh of the current composition if it
is out of date (its composition icon is red).

F5

Reset node.Ctrl + R

Close composition.Cmd + W
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To:Press:

Go to previous tool.Shift + Tab

Go to next tool.Tab

Go to home tool.Shift + Home

Go to next tab.Alt + Right Arrow

Go to previous tab.Alt + Left Arrow

Toggle Marking State of Current Selection.Shift + A

Selection History back.Alt + Left Arrow

Selection History forward.Alt + Right Arrow

Gate UI
The following hotkey is available for the Gate UI.

To:Press:

Display the Gate UI.Middle-click

Display the Gate UI. The backquote key ( ) shares the same key
with the tilde key (~) and is located below the Esc key on the
keyboard.

(backquote key)

Close the Gate UI.Esc

Continue displaying the UI element of the gate you swiped
through.

Alt + swipe (through
a gate)

Calculator
The following hotkeys are available for the Calculator.

To:Press:

Activate or deactivate the Calculator.Alt + C

Close the Calculator.Esc
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Color Picker
The following hotkeys are available in the Color Picker.

To:Press:

Perform an average (rectangle).Ctrl + drag in the
color spectrum

Use the eyedropper to pick a color without displaying the Color
Picker.

P

Pick a color for a color pot without displaying the Color Picker.Ctrl + click color pot

Activate or deactivate the pop-up Color Picker.Alt + P

Accept.Ctrl + Enter

Cancel.Esc

Views
The following hotkeys are available in Schematic, Animation Editor, and Player
views.

To:Press:

PanSpacebar + drag

Reset zoom and pan.Home

Zoom in.Up Arrow

Zoom out.Down Arrow

Integer zoom in.Cmd + Up Arrow

Integer zoom out.Cmd + Down Arrow

ZoomCmd + Spacebar +
drag

Zoom region.Shift + Spacebar +
drag

Zoom selected items.Cmd + Home
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To:Press:

Zoom all scene.Cmd + Alt + Home

Activate Viewpoint [1-4].[F1 - F4]

Set Viewpoint [1-4].Cmd + [F1 - F4]

Delete Viewpoint [1-4].Cmd + Shift + [F1 -
F4]

Animation Editor
The following hotkeys are available in the Animation Editor.

To:Press:

Add key mode.+ (plus)

Delete key mode.- (minus)

Cancel add/delete key mode.Esc

Lock keyframe time.Shift + T

Lock keyframe value.Shift + V

Lock tangent length.Shift + L

Lock tangent orientation.Shift + O

Unify tangent length.Cmd + Shift + L

Unify tangent orientation.Cmd + Shift + O

Cycle interpolation mode keyframes.Shift + I

Cycle extrapolation mode curves.Shift + E

Set keyframe.K

Set keyframe for marked attributes.Shift + K

Delete keyframe.Delete

Select all curves.Cmd + A
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To:Press:

Select all keyframes on selected curves.Cmd + Alt + A

Move to previous keyframe on selected curves.Cmd + Left Arrow

Move to next keyframe on selected curves.Cmd + Right Arrow

Add previous keyframe on selected curves, to selection.Cmd + Shift + Left
Arrow

Add next keyframe on selected curves, to selection.Cmd + Shift + Right
Arrow

Increase brush size in Delete Key mode.Shift + plus sign (+)

Decrease brush size in Delete Key mode.Shift + minus sign (-)

Player
The following hotkeys are available in the Player.

To:Press:

Set a region of interest (ROI). Click and drag to define an initial
ROI, then use the cursor to adjust the size or location of the re-
gion.

Shift + Z

Toggle full screen Player.F

View the red channel of the target.R

View the green channel of the target.G

View the blue channel of the target.B

View the alpha channel of the target.A

View the channels of the target.Cmd + Shift + C

Display C1 Output (output of context point 1).1

Display C2 Output (output of context point 2).2

Display C3 Output (output of context point 3).3
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To:Press:

Display C4 Output (output of context point 4).4

Display Tool Input (input of the currently selected tool).5

Display Tool Output (output of the currently selected tool).6

Display Composition (output of the composition's output node).7

Display rendered version.8

Display previous rendered version.Shift + 8

Display rendered output.9

Reset nodes.Cmd + Shift + R

Toggle Comparison tool.Shift + C

Toggle Display Modifier tool.Shift + D

Next stream (stereo)0

Previous stream (stereo)Shift + 0

Separators
The following hotkey is available for manipulating UI separators.

To:Press:

Reset to previous location.Ctrl + click

Schematic
The following hotkeys are available in the Schematic view.

To:Press:

Set a context point on that node. The number indicates the
number of the context point. For example, pressing 1 + click
sets context point 1. Pressing 3 + click sets context point 3.

[1-4] + click a node
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To:Press:

Clear the context point. The number indicates the number of
the context point to clear. For example, pressing 2 + click clears
context point 2, and pressing 4 + click clears context point 4.

[1-4] + click the
background of
Schematic

Connect the two nodes (Kiss). Release Shift and continue
dragging to cancel the operation.

Shift + drag a node
into contact with an-
other node

Insert the node between the two nodes joined by that connec-
tion. Release Alt and continue dragging to cancel the operation.

Alt + drag a node
onto a connection

Disconnect the nodes joined by that connection or by those
connections.

Cmd + drag through
one or more connec-
tions

Group or ungroup the selected node(s).G

Edit the selected group.Double-click

Exit the group.Double-click (back-
ground)

Mute or unmute nodes.M

Clean up Schematic.C

Delete nodes.Delete

Reset nodes.Ctrl + R

Mark node for keyframe.A + click (node)

Toggle node thumbnails.T

Display the details of a selected node without opening the node.D (drag over node)

Show all node details.Shift + D

Expand or collapse node.E

Select all nodes and connections.Cmd + A

Select all upstream nodes. You can select multiple branches
without clearing the selection.

X + click
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To:Press:

layout selected.L

Layout all.Cmd + L

Increase Auto-pan speed.Ctrl

Decrease Auto-pan speed.Alt

Create boundary node.(outside of viewer)

Group nodes (visual).Shift + G

Open visual group.Shift + O

Close visual group.Shift + C

Add to visual group.V + drag

Remove from visual group.Shift + V + drag

Copy nodeC + drag

Tools
The following describes hotkeys available in specific tools.

Garbage Mask (also applies to Remove Dust and
Warp 2D tools)
The following hotkeys are available in the Garbage Mask tool.

To:Press:

Create Freeform.D

Create Rectangular.S

Create Elliptical.W

Finish shape.Esc

Edit.E
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To:Press:

Transform.T

Nudge left.Shift + Left Arrow

Nudge right.Shift + Right Arrow

Nudge up.Shift + Up Arrow

Nudge down.Shift + Down Arrow

Nudge left (large).Ctrl + Shift + Left
Arrow

Nudge right (large).Ctrl + Shift + Right
Arrow

Nudge up (large).Ctrl + Shift + Up Ar-
row

Nudge down (large).Ctrl + Shift + Down
Arrow

Close shape.Enter

Select all control points.Cmd + A

Select next control point.Cmd + .

Select previous control point.Cmd + Shift + .

Insert a control point.Alt + click (on curve)

Delete a control point.Alt + click (on con-
trol point)

Move a control point in auto tangent mode.Ctrl + Alt + click +
drag (on control
point)

Add tangent handle. Repeat to remove tangent handle.Ctrl + click (on con-
trol point)

Adjust the length of both sides of a tangent handle.Alt + drag (the
handle)
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To:Press:

Break a tangent handle.Ctrl + click + drag
(the handle)

Move a curve between points.Ctrl + Alt + drag
(over location on a
curve)

Create an edge point.Ctrl + click+ drag
(on the curve)

Keyer
The following hotkeys are available in the Keyer tool.

To:Press:

Sample matte.M

Sample patch [1-9].Shift + [1-9]

Sample degrain.D

Spill suppress.S

Adjust blend.Shift + B

Master Keyer
The following hotkeys are available in the Master Keyer tool.

To:Press:

Sample matte.M

Sample patch [1-9].Shift + [1-9]
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Paint
The following hotkeys are available in the Paint tool.

To:Press:

Adjust brush size. Drag right to increase, drag left to decrease.S + drag

Clone brush.Ctrl + click

Line brush.Shift + click

Flip foreground/background colors.X

Spill & Blend
The following hotkeys are available in the Spill & Blend tool.

To:Press:

Spill suppress.S

Adjust blend.Shift + B

Reaction
The following hotkeys are available in the Reaction tool.

To:Press:

Orbit the camera.Q

Orbit grasp.Q + click

Truck the camera.W

Truck grasp.W + click

Dolly the camera.E

Dolly grasp.E + click

Enter Move mode.M

Enter Rotate mode., (comma)
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To:Press:

Enter Scale mode.. (period)

Cameras
The following hotkeys for the camera are available in the Player when using
the Reaction tool.

To:Press:

Switch cameras. If you are using more than one camera, you
will cycle through each camera.

Shift + 1

View from perspective camera.Shift + 2

View from front.Shift + 3

View from Left.Shift + 4

View from Top.Shift + 5

Reset camera.Shift + Home

Resize
The following hotkeys are available in the Resize tool.

To:Press:

Symmetrical resize.Ctrl + drag

Maintain ratio.Shift + drag

Maintain image input ratio.Shift + I +
drag

Maintain image output ratio.Shift + O +
drag
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Retimer
The following hotkeys are available in the Retimer tool.

To:Press:

Cycle show vectors mode.M

Tracker
The following hotkeys are available in the Tracker tool.

To:Press:

Delete track point.Delete

Delete track point and step back.Backspace

Warping Tools
The following hotkeys are available in the Warping tools:

To:Press:

Input transform manipulator.M

Effect transform manipulator.'

Output transform manipulator..

Crop./

Set Pivot (also for 2D Transform tool)Insert

Twirl Rotation.T

Comparison
The following hotkeys are available in the Comparison tool:

To:Press:

Opacity.Shift + O
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To:Press:

Toggle tool visibility.Shift + H

Swap reference.Shift + R

Move pivot point or region center.Ctrl + click

Cycle through inputs and outputs.Player hotkeys 1 -
9 on reference side
of manipulator

Cycle between channels and alpha.Player hotkeys C, A
on reference side of
manipulator
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Composite Executables

Topics in this chapter:

■ Working with the Composite Executables on page 859
■ composite Executable on page 860
■ txcheck Executable on page 860
■ txperf Executable on page 862
■ txversion Executable on page 866

Working with the Composite Executables
The Composite executable files let you verify stored information, edit settings,
and perform certain tasks. The Composite executable files reside in the
Composite program directory or in the Compositebin directories for Linux and
Mac.

NOTE As the behavior of Composite is the same on a Linux or Mac workstation as
on a Windows workstation, the screen shots in this chapter were taken from
Composite running on a Windows workstation.

You can access the executables via a shell.

B
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NOTE There are no file extensions on Linux and MAC OS workstations. Therefore,
the executables don't have the “.exe” extension as they do on Windows. However,
the functionality of the executables as well the list of command line parameters
are identical on all platforms.

You can get a list of command line parameters for any Composite executable
by running the executables without any parameters. In general, this provides
some form of usage/help message.

To access the Composite Command Prompt:

 ➤ In the Windows Start menu, choose Programs > Autodesk >Autodesk
Composite 2011> Composite Command Prompt.

composite Executable
The composite executable is used to start the interactive application.

To start Composite from a command line:

 ➤ In a shell, enter composite.

To set the Composite command line arguments,initialization options and
environement variables—see Initialization Variables on page 873.

txcheck Executable
The txcheck executable checks the installed Composite license for each
Composite feature, checks the CPU type, configuration, and supported
processor features, checks the graphics card and driver, and parses an .xml file
(for example, Composite UI resource and config files, Composite composition
files, (.txcomposition), Composite project (.txproject), and user (.txuser)
preference files) and checks whether it is valid or not.

To show the usage of the txcheck executable:

 ➤ In a shell, enter txcheck.
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To check the Composite license installed on a workstation:

 ➤ In a shell, enter txcheck license.

To check the cpu:

 ➤ In a shell, enter txcheck cpu.

Summarized information regarding the CPU type, configuration, and
supported processor features is listed. To get a full report on a cp, in a
shell, enter the following: txcheck cpu full.

To check the graphics:

 ➤ In a shell, enter txcheck graphics.
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A detailed check list is displayed. The list includes information on the
graphics card, driver version, screen resolution, bit depth, refresh rate,
OpenGL® version, vendor string, and available OpenGL extensions.

To check the xml:

 ➤ Enter a single parameter to parse the given Composite xml file and check
it’s validity. For example, from the Composite installation folder:txcheck
xml/resources/toolUi/crop.xml.

txperf Executable
The txperf executable is used to test the performance of various Composite
subsystems. txperf is built by the Composite application layer as a separate
executable which depends on several Composite libraries. It runs a number
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of performance tests either individually or simultaneously and covers the
following subsystems:

■ Disk I/O

■ File System

■ Content Server I/O

■ Memory Transfers

Each test subsystem can be configured with various parameters. Any number
of subsystems can be tested simultaneously but each subsystem will only have
one configuration during the execution of the performance tool. The profiling
tool will not run simultaneously with Composite or any Composite process
including itself.

Disk IO
The disk IO tests are invoked by the -disk switch. These tests consist of reading
and writing bytes through single threaded calls.

The behavior of disk IO tests are controlled by the following suboptions:

■ size

■ read block

■ write block

■ file

■ iterations

size=<n> where <n> is the number of bytes the operation read/write. This
suboption measures the speed at which bytes can be read/written depending
of the size of the file. This measures the effect of file fragmentation depending
on file size.

rblock=<b> where <b> is the size of each read. This suboption indicates that
the file created will be read in chunk of <l> bytes.

rblock=<b> where <b> is the size of each write. This suboption indicates that
the file created will be read in chunk of <l> bytes.

file=<filepath> where <filepath> indicates where the file will be created.
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iteration=<i> where <i> indicates the number of times the test is repeated.

File System
The file system tests are invoked by the -fs switch. These tests consist of
opening files, closing files, listing directories, verifying the existence of files,
creating files, and deleting files.

The behavior of file-system tests is controlled by the following sub-options:

■ files

■ subdir

■ location

files=<n> where <n> is the number of files to create. This suboption measures
the speed at which files can be created and the number of creations which
can be done per second, then verifies the existence of each file to measure the
performance of determining a file's existence. Once all files are verified, each
file is opened, then all files are closed and timing data for closing files is
collected. The last three operations—verifying the existence of files, opening
files, and closing files—are be performed in various orders (sequential, reverse,
random, butterfly). The default is 256 files.

subdir=<l> where <l> is the number of subdirectory levels. This suboption
indicates that files created by the test will be spread across a directory tree of
depth <l>. The default is to create a flat directory structure. Valid range is
from 1 to 16.

loc=<path> where <path> indicates where files will be created. A directory
will be created below <path>. That directory will contain all the files created
during the execution of the tool. When the tool finishes its execution, the
created subdirectory will be destroyed along with all its contents. The default
is specified by the TMP environment variable.

Content Server
The content server tests is invoked with the -content switch. Content server
will measure read and write operations using the Composite content server.
Collected data on I/O will include average throughput, sustained throughput
and average/min/max latency.
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The behavior of disk I/O tests is controlled by the following sub-options:

■ Mode

■ Size

■ Blocks

■ Queue

mode=<ro|wo|rw> where ro indicates that only read performance is
measured, rw indicates that both read and write performance is measured and
wo that only writing performance is measured. The default mode is ro.

time=<s> where <s> is the number of seconds devoted to each transfer test.
The default is 5. For each of read and write, performance measurements will
be accumulated over <s> seconds.

size=<s> where <s> is the number of kilobytes of each file used for testing
I/O performance. The default size is 4096.

blocks=<s> where <s> is the size of I/O blocks, in kilobytes used for testing
I/O performance. I/O will be performed in blocks of this size. The default will
be 512.

queue=<q> where <q> is the number of outstanding requests. The default
will be 32.

Memory
The memory performance tests are controlled by the -mem switch. Using this
switch will cause memory-to-memory transfers to be measured for performance.
The goal of these tests is to allow the FSB to be used during disk and cache
tests so that FSB contention can be detected.

The behavior of memory tests is controlled by the following sub-options:

■ Time

■ Blocks

■ Memory

time=<s> where <s> is the number of seconds devoted to the memory tests.
The default is 5. Performance numbers will be accumulated over <s> seconds.
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blocks=<s> where <s> is the size of blocks copied from memory-to-memory.
The default is 512K.

freq=<f> where <f> is the frequency in hertz of memory transfers. The default
is 96Hz. If 0 is specified than memory transfers will be performed continuously.

txversion Executable
The txversion executable reports the version of Composite. txversion supports
one command line parameters called -full, which returns the extended
version information.

To verify the version of Composite:

 ➤ In a shell, do one of the following:

■ Enter txversion

■ Enter txversion -full
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Python Scripting

Topics in this chapter:

■ About Python Scripting on page 867

About Python Scripting
Scripting in Composite is implemented by extending the Python language
(http://www.python.org). Composite is written in the C++ programming language,
so some libraries, known as Python extension modules, allow for a script to
invoke the Composite code through Python functions. The result is the
Composite Python API.

NOTE The Composite Python API documentation can be accessed through the
Help, via the Scripting menu (the HTML files are located in the
documentation/scripting directory of the Composite installation).

With Python and the Composite Python API installed, you can write scripts to
automatically perform certain repetitive managerial tasks and creative work on
a project, such as creating compositions, adding nodes to it, importing material,
versioning, rendering, and so on.

Composite ships with a number of sample scripts for performing common tasks.
These sample scripts are located in the

C
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resources/scripts/examplessubfolder of the Composite installation
directory.

NOTE Example Python scripts are provided with no guarantee of effectiveness or
efficiency.

There are also scripts that Composite itself invokes (archiving, rendering,
pre-comp import, etc.) in the resource/scriptssufolder of the Composite
installation directory. You may find these scripts helpful both as examples
and as a starting point for your own scripts. In some cases, the script command
that Composite launches to accomplish a given task is specified in the project
preferences. For example, the “Render Actions” tab in the project preferences
contains the “Render Executable” setting that specifies the Python command
line executed each time you render a composition in Composite. By default,
that command line launches the “render.py” script. You can edit the command
line to launch a different script or change the “render.py script (located in
resources/scripts) to modify the default rendering behavior, like
performing post-render tasks, for example.

How to Run a Composite Python Script
To successfully run a Python script that makes use of the Composite Python
API (or more specifically, a script that imports Composite Python modules),
it is important to run it in the right environment, in order for the Python
interpreter to find the Composite Python modules and libraries, and for the
Composite code to execute properly afterwards.

There are two contexts in which a script can be run. First, in the Composite
embedded Python interpreter, i.e. within the Composite interactive application.
And secondly, in an external Python interpreter, i.e. within a separate Python
process, typically from a shell.

Setting Up the Environment
Setting up the environment involves either an embedded or external
interpreter.

Embedded
In the case of the embedded interpreter, the environment is already set up by
Composite for a Python script to run properly.
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Externally
An external interpreter can either be set up manually or automatically.

Manual Setup
In the case of a script ran in an external Python interpreter, the shell from
which the Composite Python script is invoked must have the following
environment variables set (except on Mac OS which doesn't require any). In
the following paths,<INSTALL_DIR>refers to the path of the Composite
installation directory:

On all operating systems, except Mac OS:

 ➤ DL_INSTALL_DIR=<INSTALL_DIR>

On Windows

1 PYTHONHOME = <INSTALL_DIR>/python

2 PATH = <INSTALL_DIR>/program;<INSTALL_DIR/plugins

On Linux

1 PYTHONHOME = <INSTALL_DIR>

2 LD_LIBRARY_PATH =
<INSTALL_DIR>lib:<INSTALL_DIR>/plugins:<INSTALL_DIR>/lib/python2.5/site-packages/autodesk_toxik/libs

Automatic Setup
The procedure to automatically set up the environment required to run a
Composite Python script from a shell can be found here: Working with the
Composite Executables on page 859.

Running the Script
Running the script can be done with an embedded Python interpreter or
externally.
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Embedded

To run a python script in the Composite embedded Python interpreter, do
the following:

1 Locate the script in a Composite "File Browser" ("Ctrl-I" (Windows and
Linux) or “Cmd+ I” (Mac OS) to bring up a floating browser for example).
Note that in order for Composite to recognize a file as a Python script, it
must have the “.py” extension. Composite identifies Python scripts with
a thumbnail that represents the Python logo:

2 Right-click on the script.

3 To run the script without any parameter choose “Run”.

4 To run the script with parameters choose "Run with Parameters" and type
in the script arguments as you would in a shell.

Externally

WARNING To run a Composite Python script, it is strongly recommended to use
the Python distribution shipped with Composite (deployed under the Composite
installation directory). Running a Composite Python script with any other Python
distribution might not work properly and is very likely to result in a crash.

On Windows:

 ➤ <INSTALL_DIR>/program/python.exe myScript.py

On Linux

 ➤ <INSTALL_DIR>/bin/python myScript.py
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On Mac OS

 ➤ <INSTALL_DIR>/Contents/Frameworks/Python.framework/Versions/Current/bin/python
myScript.py

Scripted Actions
Custom actions can be implemented as Python scripts that can be invoked
from the UI in the same way as native Composite actions.

Action scripts can be located anywhere on the local file system or on the
network. Two environment variables (and toxik.ini options) control the loading
and searching of action scripts:

DL_SCRIPTED_ACTIONS_LOAD_ON_STARTUP
(toxik::scripting::scriptedActionsLoadOnStartup)

1 Set to 1 or 0 to control whether to load and register the scripted actions
during the Composite startup.

2 The default behavior is to register action scripts on startup.

3 Action scripts can be loaded (or reloaded) at any time through the
(Re)Load Scripts entry of the Scripts top menu.

DL_SCRIPTED_ACTIONS_PATH (toxik::scripting::scriptedActionsPath)

1 Search path for action scripts; a list of directory paths separated by the
character conventionally used by the operating system to separate search
path components (“:” on Linux and Mac OS, “;” on Windows).

2 By default, the search path is empty, but the following directory of the
Composite installation is always searched for action scripts:
resources/scripts/actions.

For more information on how to write scripted actions and examples, please
refer to the main page of the scripting API documentation.

Viewing Output and Error Messages
Some scripts may output some information or error messages during execution.
All output explicitly printed by the script writer goes to the script console,
which is a pop-up window with one line of text. New text overrides any
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previous text. When the scripts complete, the window closes. If there were
errors during the script execution, another window is displayed, containing
information or the stack trace that was generated when the error occurred.
Information and error messages are displayed by default, but you can turn
them off in the user preferences.

To turn off feedback while running scripts:

1 In the taskbar, click your user name to open the User Preferences window.

2 Select the Embedded Scripting tab.

3 Deselect any of the following:

■ Script Console (Show)  Controls whether the script console is
displayed when the script executes.

■ Post Execution Message Box (Show Only on Errors) In addition to
errors, displays all outputs that were produced.

■ Standard Output (Captured) Normal messages are captured. If
capture is disabled, messages go to the shell on Linux. On Windows,
messages are lost.

■ Standard Error (Captured) Error messages are captured. If capture
is disabled, messages go to the shell on Linux. On Windows, messages
are lost.
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Initialization Variables and
String Substitutions

Topics in this chapter:

■ Initialization Variables on page 873
■ String Substitutions on page 874

Initialization Variables
During installation, the toxik.ini file is created. These files can be found in
C:\Program Files\Autodesk\Autodesk Composite 2011\etc.You can disable any of
these files by adding the pound sign (#) before the toxik.ini file name.

The initialization variables are listed in a table as they appear in the Composite
initialization file. The table is available from the Help menu via the The Menu
Bar on page 19. If you specify the command line argument, the argument takes
priority over the environment variable and the initialization variable. If you
specify the environment variable, then it takes priority over the initialization
variable.

To edit the Command Line switches via the Window's shortcut:

1 In the Windows Start menu, choose Programs > Autodesk > Composite
2011, then right-click the Composite menu entry and choose Properties.
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2 In the Properties dialog that appears, click in the Target field and add the
desired startup option to the end of the line.

The option must be placed after the quotation mark.

3 Click OK and close the dialog.

The changes will take effect the next time you start Composite.

To view the environment variables settings on Windows:

1 Right-click the My Computer icon on the desktop and choose Properties.

If Composite is running or My Computer is not shown on the desktop,
hold down the Windows key and press E to start Windows Explorer, then
right-click My Computer and choose Properties.

The System Properties dialog appears.

2 On the Advanced tab, click the Environment Variables button.

The Environment Variables dialog appears, displaying system variables
in the lower part of the dialog and variables defined for the current user
in the top part.

To set the environment variables on Linux:

 ➤ Issue the following command in a tcsh shell:

# setenv <variable name> <value>

OR

In a bash shell:

# export <variable name> <value>

To view the environment variable settings on Linux:

 ➤ Issue the following command in a shell:

# env

String Substitutions
You can perform string substitutions in various Composite components to
change the default execution settings. A table which lists the strings that can
be edited is available from the Help menu via the The Menu Bar on page 19.
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NOTE Two of the tokens, <Time> and <Date>, will return different results,
depending when they are evaluated.
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Glossary

List of Terms
This glossary contains industry-standard terms and terms that apply to Autodesk
Composite.

1D LUT  A 1D Look-up Table (LUT) is generated from one measure of gamma
(white, gray, and black) or a series of measures for each color channel. With a
pair of 1D LUTs, the first converts logarithmic data to linear data, and the second
converts the linear data back to logarithmic data to print to film.

1-point stabilizing  A technique for removing the horizontal or vertical jitter
motion from a camera.

1-point tracking  Tracking or stabilizing a single feature in motion, then
applying that motion to a second element, so that the two appear to be locked
together.

2-point stabilizing  A technique for removing the motion or changes in
scale/rotation (zoom/roll).

2-point tracking  A technique for tracking two features, using the relationship
between the two to track scale/rotation.

3D LUT  A type of LUT for converting from one color space to another. It
applies a transformation to each value of a color cube in RGB space. 3D LUTs
use a more sophisticated method of mapping color values from different color
spaces. A 3D LUT provides a way to represent arbitrary color space
transformations, as opposed to the 1D LUT where a component of the output
color is determined only from the corresponding component of the input color.
In essence, the 3D LUT allows cross-talk, i.e. a component of the output color
is computed from all components of the input color providing the 3D LUT tool
with more power and flexibility than the 1D LUT tool. See also 1D LUT.
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4-point tracking  Tracks four features, also referred to as corner pinning.
With four-point tracking, four trackers are used to generate tracking data for
anchoring the four corners of a bilinear surface to background footage.

alpha  The name given to a fourth channel matte when bundled together
with a three-channel color image. Also known as a matte channel. An alpha
channel can be further described as either: 1. A TV signal that defines a portion
of an image or clip to be keyed, or overlaid with a second image. A grayscale
representation of an image used to create a mask for keying images.2. A matte
or mask that defines a portion of an image or clip. The portion of a
four-channel image that is used to store transparency information. 3. A raster
channel defined by a paint or brush stroke.

animation  The process of creating the illusion of moving images by
displaying sequential images in rapid succession. In each successive image,
two or more values are changed over time, and the items drawn or recorded
in the images appear to move.

animation curve  Also known as function curve or fcurve. It is a graphical
representation of an animated parameter. The time and value of the animated
parameter is displayed on two axes: the vertical axis representing the value,
and the horizontal axis representing the time.

AutoKey  A mode that, when activated, sets a keyframe whenever you change
the selected object's properties.

background  The composition background defines the rendering plane and
sets its format after which other layers can be created.

bit depth  1. The number of bits used to represent the color of a pixel. Black
and white images use a bit depth of 1; 16-color images use a bit depth of 4,
256-color images use 8, and so on. 2. The number of bits used to represent an
audio sample. The more bits there are, the more accurately you can represent
the amplitude at that point in time.

blue screen  A special effects procedure in which the subject is photographed
in front of a uniformly illuminated blue or green background. A new
background image can be substituted for the blue or green during the shoot
or in post production through the use of chroma key. See also keying.

Boolean  A system of logic that lets you combine objects using logical
operators, such as And, Or, Xor, Min, and Max. Boolean operators can be used
for combining mattes in a single layer.

browsers  A generic term which refers to the program or tool used for
information searching in a window.
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camera  A device for viewing scenes from a different angle or “vantage
point”.

capture  1. To digitally transfer audio or video material from an external
device, such as a videotape recorder, to a shared storage location or the local
disk storage on your workstation. 2. To convert analog video and audio signals
to digital signals.

channel  1. A physical audio input or output. 2. One of several color
components that combine to define a color image. An RGB image is made up
of red, green and blue color channels. In color correction, you can redefine
color channels by blending color components in different proportions.

chrominance  An image processing property that defines the hue and
saturation of a pixel.

color  A means of identifying colors in a source according to its component
parts of RGB, hue, saturation, chrominance, luminance, sharpness, softness,
tolerance or threshold, and computer-generated imagery.

color correction  The process of adjusting the color characteristics of video
material to achieve an accurate representation of color and consistency of
color from one clip in a sequence to another. The term generally refers to
adjustment changes made as part of a single effect.

color curves  Color curves lets you remove color spill by either suppressing
a sampled color, by modifying the red, green, blue, or hue, by modifying the
saturation, or by modifying the luminance of the selected color, or by shifting
the hue of a color range to a sampled hue shift target. Each curve in color
curves is a hue gradient. When you change the shape of a curve, the colors
along the curve's gradient change to reflect the result. For example, if your
hue shift target is magenta, as you raise the green portion of the default hue
shift curve, it gradually becomes magenta, becoming fully magenta when you
reach the full value (75%).

comparison operators  Operators that use Boolean algebra to compare two
values with each other, if the comparison is true the result is 1, if the
comparison is false the result is 0.

composition  Composition is media imported into the application that can
be used to insert, merge, or link to or from another composition.

computer-generated imagery (CG)  Images created or generated with a
computer.

conform  A compound object created by projecting the vertices of one object,
called the Wrapper, onto the surface of another object, called the Wrap-To.
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context point  A specific tool node you mark as the target for a Player view.
Context points are especially useful when you want to see how changes to a
tool node that precedes the node with a context point affect the context point.

corner pinning  A technique used to pin the four corners of one static image
(usually) onto another static image.

cue marks  High-level keyframe controls that let you associate a keyframe
with a mark. Instead of viewing a clip over and over again in order to evaluate
and record important timing points, you can view footage and add cue marks.

dependency graph  A set of connected nodes consisting of one or more
inputs, an output, and any number of effects or compositing operations.

depth of field  The range of acceptable focus in front of and behind the
primary focus setting. It is a function not only of the specific lens used but
also on the distance from the lens to the primary focal plane, and of the chosen
aperture. Larger apertures will narrow the depth of field, smaller apertures will
increase it.

Domain of Definition (DOD)  A usually rectangular region that defines the
maximum boundaries of useful information in an image. Generally, everything
outside of the DOD will have a value of 0 in all channels of the image. The
DOD is usually determined automatically, as opposed to a Region of Interest.
See also Region of Interest.

expressions  Mathematical formulas that let you control any parameter that
can be animated, such as translation, rotation, scaling, material, or texture.

Expresso calculator  An extension of the standard calculator that allows you
to create expressions that generate values used in numerical fields.

external matte  A matte taken from another clip. See also matte, garbage
matte, static matte and traveling matte.

garbage mask  Garbage masks can key undesired elements in an image and
to do rotoscope work. A garbage mask affects the image's alpha channel, which
is where the transparency information is stored. You can use a mask to create
the alpha channel, or you can use a mask to add to an alpha channel.

garbage matte  A rough simple matte that you create in an image's alpha
channel that isolates unwanted elements from the primary element in an
image. Garbage mattes are also referred to as garbage masks. See also matte,
external matte, static matte, and traveling matte.

hue  A specific color from the color spectrum, disregarding its saturation or
value.
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intermediate results  The results rendered at any node in the dependency
graph, other than the output node.

interpolation  A mode that automatically defines the shape of an animation
curve between keyframes in the curve. Infers a point which does not actually
exist by averaging real points near it, either in space or time. See also
extrapolation.

keyframe  The value of an animated parameter that you set at a given point
in time. Parameter values between keyframes are obtained by interpolating
between keyframe values.

keyframing  The simplest form of animating an object. It is based on the
notion that an object has a beginning state, or condition, and changes over
time in position, form, color, luminosity, or any other property to some
different, final state. Keyframing takes the stance that we only need to show
the key frames or conditions that describe the transformation of the object,
and that all other intermediate positions can be figured out from these.

keying  The process of isolating a region of an image by selecting pixels of
a particular color and making those pixels transparent, or creating an alpha
channel where those pixels are located.

layer  An object that you can composite over another layer using a matte.
A layer composed of a source input that you assign to a geometrical support,
or 3D geometry, and a material node that is automatically generated.

layers  Layers are composed of three separate components: a surface (3D
geometry) object and local axis, a multi-channel material object, and a layer
element.

linear color space  An abbreviation Linear color space. A color space in which
the relationship between a pixel's digital value and its visual brightness remains
constant (linear) across the full gamut of black to white.

lights  An object (algorithm) used to illuminate your scene and apply lighting
effects to surfaces. Different types of lights include: omni, directional, and
spot.

log color space  An abbreviation for Logarithmic color space. A nonlinear
color space whose conversion function is similar to the curve produced by
the logarithmic equation.

luminance  An image processing property that defines the brightness of a
pixel. Expressed in percentages, 0% luminance is black and 100% luminance
is white. Values between 0 and 100% define a range of grays. Colored pixels
have a luminance value equivalent to the mean of their RGB values.
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LUT  A Look-up Table (LUT) is an ASCII file that describes specific pixel
values used for image data conversion both on import and export. For example,
you can use a LUT to convert a 10-bit logarithmic film image to a 16-bit linear
image on import. You can use two kinds of LUTs: 1D LUTs and 3D LUTs. See
1D LUT, and 3D LUT.

masking  The process of hiding a region of an image. You can use masks to
remove the area outside the mask shape and keep the area inside the mask
shape, or you can use masks to remove the area inside the mask shape and
keep the area outside the mask shape. Pixel Masking lets you temporarily
isolate specific areas of the footage. You can apply effects to the selected area
of an image without affecting the rest.

material  A material defines how a layer interacts with lights to define how
a scene is rendered. Each layer must have a material associated with it, but
many layers can share a single material.

matte  An image used to define or control the transparency of another image.
When you pull a key, a matte that defines the transparency of the front source
is generated. There are several types of mattes. See also keying, external matte,
garbage matte, static matte and traveling matte.

metadata  Information embedded in the image attained through tags that
further describes the image.

motion blur  A digital effect that simulates the blur of fast-moving objects.

multiple-point tracking  Multi-point tracking tracks as many features as you
want. You can apply the stored motion to various elements, such as the center
point of an object. For example, you could track a halo over the head of a
person in a clip. Assume that in the clip a woman tilts her head and advances
toward the camera. You would want the halo to reflect the position, scaling,
and rotational changes of the tracked features on the woman's head.

mute  To turn off a node.

node  An element for connecting a composition in a dependency graph.
There are several types of nodes, including input, output, group, tool, and
super tool.

NTSC  National Television Standards Committee. The committee that
established the color transmission system used in the United States, Canada,
Mexico and Japan. Also the broadcast standard for North America. The NTSC
standard uses 525 horizontal lines per frame with two fields per frame of 262.5
lines. Each field refreshes at 59.94 Hz. See also PAL, and SECAM.

object  Any element in a 3D scene, such as lights, camera, and surfaces.
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PAL  Phase Alternate Line. The color broadcasting standard used in most of
Europe, China, Australia, New Zealand, the Middle East, and parts of Africa.
The PAL standard uses a total of 625 lines per frame scanned at a rate of 25
fps, with two fields per frame of 312.5 lines each. Each field refreshes at 50
Hz. See also NTSC, and SECAM.

Pick list  A list of frequently used tools and other elements that you can pick
and assemble.

pinning  With corner pinning (also known as four-point tracking), you use
four trackers to generate tracking data for anchoring the four corners of a
bilinear surface to background footage. See also 4-point tracking.

premultiply  An image whose red, green, and blue channels have been
multiplied by a matte that is usually stored as the alpha channel of this image.

preset  A saved configuration of views and settings appropriate for a particular
task.

process  To create the final image or sequence of images using effects,
transitions, composite, or container clips in your sequence.

proxy  A low resolution copy of a high resolution image, one for each frame.
Proxies are used to provide real-time playback of processed results and to
provide low resolution stand in clips in a compositing environment so
composites can be quickly created. See also composition thumbnails.

Region of Definition (ROD)  In Composite each image has a size and position
within a 2D reference plane also called the Image Reference Frame (IRF). The
Region of Definition (ROD) of an image is the rectangle enclosing that image
in the IRF. This rectangular region is always aligned with the main X & Y axes
of the IRF.

Region of Interest (ROI)  A region (usually rectangular) that is determined
by the user in order to limit certain calculations. See also Domain of Definition
(DOD).

render  The process of creating a final image or sequence of images from a
scene.

resolution  The amount and degree of detail contained in the video image,
measured along both the horizontal and vertical axes by dots or lines.

RGB  A color model that defines pixels according to red, green, and blue
channel values.

ROD  See Region of Definition.

ROI  See Region of Interest. See also Domain of Definition.
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safe action area, safe title area  An area in the center of the video image
considered safe to place a title or other graphic, or capturing movement, so
that none of it is cut off at the edges of the TV screen. The safe action area is
10% percent smaller than the maximum image size, and the safe title area is
20% smaller.

saturation  1. Saturation is the brilliance or purity of a given color. For
example, the difference between a pastel and a pure color is defined by the
amount of saturation. 2. The intensity of colors. 3. The degree by which the
eye perceives a color as departing from a gray or white scale of the same
brightness.

Schematic  A view in which the artist builds a dependency graph for a
composition. See also dependency graph.

SECAM  Séquentiel couleur à Mémoire. A color television standard developed
in France and used throughout Eastern Europe. The SECAM standard uses 625
lines per frame. See also NTSC, and PAL.

shader  A program that defines the look of objects in a scene. Shaders are
part of the rendering pipeline.

sharpness  Sharpness can be defined as the visual sense of the abruptness
of an edge. It highlights the detail in an image or image sequence.

SMPTE  Society of Motion Picture and Television Engineers. A frame
numbering system used for electronic editing and timing of video productions.
Each frame of video is assigned a number. Timecode denotes the hours:
minutes: seconds: frames (00:00:00:00) elapsed on videotape. There are two
types of timecode: drop frame and non-drop frame.

softness  Colors that fall within the softness range are partially transparent.
These areas appear gray (a dark gray to light gray range) in the matte. For
example, softness makes the transition between the foreground and
background of a composition more convincing by softening what would
otherwise look like an abrupt cutout. Softness can also be used to retain
transparent key-in materials or shadows that you want to appear in the result
composition.

stabilizing  To remove motion jitter and unwanted camera movement from
a clip.

super tool  A tool comprised of a set of tools that includes Reaction, Garbage
Mask, 2D Compositor, Image Import, Keyer, Tracker, and Paint.

surface  A geometric object onto which a source is mapped to create a layer
for a composition. Geometric types include: bilinear, frustum, box, plane, and
sphere.
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tangent  A line that extends from a control point that controls the direction
of a Bézier curve. Tangent handles also control key points on function curves
when the curve point's type is set to Bézier.

task group  A set of one or more preset UI configurations grouped according
to task.

tolerance  Tolerance or Threshold is the colors that fall within the tolerance
or threshold range is transparent. These areas appear black in the matte.

tracking  Tracking allows the capture and storage of motion that's applied
to a second element, so that the two appear to be locked together. Tracking
of one, two, four or multiple features is possible using 1-point, 2-point, 4-point
or multiple-point tracking.

traveling matte  A matte that changes position or shape over time. See also
matte, external matte, garbage matte and static matte.

X axis  The horizontal axis in a three-dimensional system.

Y axis  The vertical axis in a three-dimensional system.

Z axis  The axis that is perpendicular to the X and Y axes in a
three-dimensional system.
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Index

1D LUTs
applying 621
floating point file format 620
format 619
modifying 622
third party 619
working with 619

2D Compositing 358
2D Transform tool 432
about 339
adjusting matte luminance

curves 341
alpha levels 343
alpha, invert 358
Bilinear Ramp tool 421
Blend & Comp tool 367
blend curves 347
Blend Matte tool 368
blend modes 345
Blend tool 366
blur alpha 348
Blur tool 385
Channel Extract tool 362
channel processing tools 361
Channel Replace tool 363
Checkerboard tool 423
Clamp Alpha 349
Cleanup Alpha 349
Color Source tool 424
Comp Alpha tool 350
Comp Ops tool 369
composition tools 365
Control Edge tool 352
Convert Depth 410
Crop tool 410
Detect Edge tool 354
Drop Alpha tool 356
Edge tool 356
Extract Alpha tool 357
Fade tool 357
filtering tools 379
Flip tool 435

formatting tools 409
image generation tools 419
Invert Alpha tool 358
inverting alpha 358
Lens Blur tool 400
Linear Ramp tool 425
Math Ops tool 370
Median Alpha tool 358
Median tool 406
Noise tool 427
operators 352, 563
Orient tool 436
Out of Range tool 362
Panner tool 437
Premultiply tool 413
Radial Ramp tool 426
Remove Dust tool 380
Resize tool 415
Set Alpha tool 360
Sharpen tool 408
Slate tool 429
transform tools 431
Unpremultiply tool 414
Unsharp Mask tool 408

2D Compositor tool 339
2D textures

about 257
2D Transform tool 432
2D Transforms 478
3D LUTs

applying 623
tools 623
working with 623

4-point tracking 777

A

Add Grain tool 502
adding

keying tool 513, 757
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adjusting gain and offset
with CC basics 637

alpha
adding 360
clamping 349
cleaning 349
creating 360
dropping from primary input 356
extracting 357
inverting 358
remapping 358
replacing 360

alpha levels
matte cleanup 343

Alpha Levels tool 343
Alpha tools 342

alpha levels 343
blend curves 347
blend modes 345
Blur Alpha 348
Clamp Alpha 349
Cleanup Alpha 349
Comp Alpha 350
Control Edge 352
Detect Edge 354
Drop Alpha 356
Edge 356
Fade tool 357
Invert Alpha 358
Median Alpha 358
Remap Alpha 358
Set Alpha 360

animate resize 418
animation

about 660
Animation Editor 662–663
Animation Editor feedback 664
Animation Timeline 661
Composition Browser 661
contextual menus 670
contextual navigation 671
cue marks 668
customizing layout 689
global and local time 690
keyframe 660
Player controls 667

time offsets 690
timeline Property Area 666
using expressions 733

Animation Editor 662
adding and deleting keyframes 683
animation 662–663
deleting keyframes 683
edit keyframe 682
move keyframe 682

Animation Editor feedback
animation 664

Animation Timeline 661
accessing panel 661
Property Area 666

archive 104
changing default settings 109
linked compositions 106
relocating dependencies 108
restoring 107
restoring settings 109

arithmetic operators 746
articulate matte 510
ASC CDL 624
aspect ratio

pixel, toggle in Player 206
attributes

temporarily modifying values 688
Autokey 680
axes

about 241
add to Reaction 256
add to Reaction from tools/views

panel 256
using 256

B

Backburner 229
Bilinear Ramp tool 421
Blend & Comp tool 367
Blend Alpha tool 344
Blend Matte tool 368
blend modes 345
Blend tool 366
blending

curves 347
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images 366
mattes 368

blending mattes 344
blending modes

about 260
basic shading parameters 262
description of modes 260
glossiness 262
hardware 260
opacity 262
software 260

Blur Alpha tool 348
Blur tool 385–386, 391, 395

output controls 399
blurring

alpha channel 348
images 385

Broadcast Safe tool
broadcast safe color controls 626
broadcast safe colors 626

C

calculator 161
Expresso 161

camera mapping 281
camera shutter. See motion blur 292
cameras

about 241
accessing views 278
add a camera 275
current 275
dollying, trucking and orbiting 279
mapping 281
motion blur 280
Reaction node, add a camera

tab 275
Reaction node, add a camera

tools/views 275
resetting 280
setting options/parameters 276
transforming 279
transforming from cameras tab 279
transforming interactively 279
working with 274

catalogs
Hotkey 163

CC Basics tool
adjusting color balance 635
adjusting hue 634
color correcting shadows, midtones,

highlights 631
color wheel 635
gain and offset 637
gamma 636
matching colors 638
quick gain 636
Rewire controls 631
suppressing colors 637

CC Basics tool, color correcting 630
CC Histogram tool

accessing 640
input sliders 641
output sliders 642
ranges 643
reducing contrast 642

CDL (Color Decision List) 624
CGI 512
changing default settings

archive 109
channel processing tools 361

about 361
Channel Extract tool 362
Channel Replace tool 363
Channel Rewire tool 364
Out of Range 362
Set Alpha tool 360

Channel Replace 363
Channel Rewire tool 364
channels

extracting 362
replacing 363
set for Player target 195

Checkerboard tool 423
chrominance 511
Cineon reference 628
Clamp Alpha 349
Clamp Color tool, color correcting 644
clamping

alpha 349
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cleaning
alpha 349
matte 343

Cleanup Alpha tool 349
closing

composition 236
color

model 511
removing color spill 519

color balance
adjusting with CC Basics 635

color conversion
apply to Player 210
remove from Player 210

color correcting
1D LUT 621
3D LUT 623
about 618
broadcast safe tool 625
CC Basics tool 630
CC histogram 639
CDLs 624
Clamp Color tool 644
Color Space tool 645
color wheel 633
Gray tool 656
Invert tool 649
Log and Delog 627
Mono tool 655
Photo Lab 646
Remap Color tool 649
Set Fill Color tool 654
shadows, midtones, highlights 631
Solarize tool 654
sRGB tool 656

Color Curves
modify RGB, saturation, luma 521
modifying luma 521
removing color spill 519
shift the hue of a range 520
suppressing sampled color 521

Color Decision List (CDL) 624
color depth

changing 410
color model 511

color palette
creating 155

Color Picker 154
creating color palette 155
examining values 155
modifying color palette 155
reverting color palette 155
selecting from screen 155
selecting with pop-up palette 155
switching color palettes 155
working with 155

Color Source tool 424
Color Space tool, color correcting 645
color transformation language

CTL tool 463
color transformations 463

CTL tool 463
color wheel 633

in CC Basics 635
colors

picking 154
command line prompt 229
command line renderer

variables 229
Comp Ops tool 369
comparison operators 746
Comparison tool, utilities 806
complementary matte 510
compositing

3D 242
basic in Reaction 243
basic multilayer 242
building using layer in Reaction 243
intermediate results 226
publish operations 224
published results 224
snapshots, taking 228
workflow 242

compositing operators 352, 563
compositing tools

Math Ops tool 370
composition

adding Reaction tool 83
adding tools 83
closing 236
creating layers 83
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Image Import super tool 125
imported into project folders 126
importing media 81
inserting 223
linked composition status 236
linking 234, 236
opening 220
publishing 83, 228
setting current result 230
viewing 220
viewing status 224

Composition Browser
animation 661

composition tools
about 365
Blend 366
Blend & Comp 367
Blend Matte 368
Comp Ops 369

composition UDAs 176
computer generated imagery 512
conditional functions 752
constants 751
context points 191
contrast

adjusting with CC Basics 634
Control Edge tool 352
Convert Depth tool 410
creating

user defined attributes 176
creating UDAs 177
Crop tool 410
cropping

images 410
Crumple tool, warping 485
CTL tool 463
cue marks

adding 668, 670
deleting 668
naming 668, 670
setting 668

customized effects
PXL tool 440

D

database
archive, restore 104

default UDA tag 187
Degrain tool 504

fine-tuning 505
profiles, saving and loading 507
response curve 506

Deinterlace tool
adaptive threshold 798
field dominance 796
field selection 797
spatial interpolation 800
temporal interpolation 800
video format 796

depth of field
adding 292

Detect Edge tool 354
Diamond Keyer 514

UI 514
difference matte 510, 517
Difference Tool 517

UI 517
Directional Gaussian blur

Blur tool 386
Displace tool, warping 485
displaying UDAs 180
Drop Alpha tool 356
Drop Shadow tool 497

E

edge gradient
in masks 538

edge matte 510
Edge tool 356
effects tools

about 497
Drop Shadow tool 497
Glow tool 498

environment maps
about 264
set parameters 264
set texture 264
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Executable
about 859

exposure
adjusting with Photo Lab 647

expressions
about 720
animating layers in Reaction 741
animating with 733, 738
arithmetic operators 746
associating comments with 730
comparison operators 746
conditional functions 752
constants 751
editing 731
input paths, copy paths 722
math functions 747
navigating the string 728
operator precedence 747
profile functions 751
random number functions 749
reference tables 745
removing 732
rounding functions 750
short name 721
time functions 751
trigonometric functions 750
validating and applying 729
vector functions 748
viewing in graph mode 729
visual linking 722
visual linking in the Composition

Browser 723
visual linking in the Tool UI 723
visual linking methods 722

Expresso calculator 161
comment 730
graph 729, 738
set expression 733, 738

Extract Alpha tool 357
extracting

alpha 357
channels 362
key, Diamond Keyer 514
key, Luma Keyer 518

extrapolation 660
modifying 688

F

Fade tool 357
file name extension

on Linux 859
film grain

adding 502
defined 501
removing 504

film look, obtaining 501
filtering 417
filtering tools 379

Blur tool 385
defect matte viewing 385
dust removal workflow 381
global detection and repair UI 382
Lens Blur tool 400
Median tool 406
per-shape detection and repair 383
Remove Dust tool 380
Sharpen tool 408
Unsharp Mask 408

filters
Bilinear 482
Gaussian 482
Jinc2 482
Jinc3 482
Mitchell 482
Nearest 482

fit methods 417
fixed matte 510
Flip tool 435
formats

supported media 116
formatting tools

about 409
Convert Depth tool 410
Crop tool 410
Premultiply tool 413
Resize tool 415
Unpremultiply tool 414

frame rate
conversion 695

fullscreen Player 213
use 215
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functions
conditional 752
math 747
profile 751
random number 749
rounding 750
time 751
trigonometric 750
vector 748

G

gamma
adjusting with CC Basics 636

garbage mask 538
attributes 558
controls 539
creating 540
edges, creating and editing 554
editing 543
options tab settings 559
transforming 548
UI 538
user settings 555
user settings workflow example 556

garbage matte 510
generating

mattes 510
geometric surfaces 254
getting started 77
Global compositing operators 564
global time 690
Glow tool 498
grain

adding 502
fine-tuning 505
removing 504

grain profiles
saving and loading 507

Gray tool
accessing 656

guides
display in Player 203

H

hardware rendering 194
turn on/off 205

highlights
redefining with Ranges controls 643

histogram. See CC Histogram 639
hold-out matte 510
Hotkey

resetting a Hotkey 167
resetting all Hotkey 167

Hotkey Editor
about 163–164
accessing 166

Hotkey format 167
hotkeys 187

browsers 823, 842
calculator 826, 845
color picker 826, 846
context menu 819
Creative workspace 824, 843
Curve Editor 828, 847
editing 819
exit 818
floating browser 824, 843
Garbage Mask 832, 851
gate UI 826, 845
general 818
Hotkey Editor 163
Keyer 834, 853
Master Keyer 834, 853
numeric fields 822
Paint 834, 854
Player 827, 829, 846, 848
popup dialogs 822
Reaction 835, 854
resize 836, 855
Schematic 827, 830, 846, 849
selection 819
separators 830, 849
spill and blend 835, 854
taskbar 819
text editor 820
tools in Creative 832, 851
Tracker 836, 856
user interface elements 819
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viewers in Creative 827, 846
Hotkeys 818

about catalogs 163
catalogs 163
conflicting 167
editing 166
managing catalogs 163

hue 511
adjusting with CC Basics 634

I

icons
enable display in Player 208

image generation tools
2D Transform tool 432
about 419
Bilinear Ramp tool 421
Checkerboard tool 423
Color Source tool 424
Linear Ramp tool 425
Noise tool 427
Radial Ramp tool 426
setting properties and formats 420
Slate tool 429

image processing
about 339, 379

import
compositions into project

folders 126
media 118

importing media 81
initialization variables 873
inserting

composition 223
interface

presets 77
intermediate result

about 226
interpolation 660

modifying 687
setting method 687

Invert Alpha tool 358
Invert tool

accessing 649

inverting
alpha 358

inverting an image
with Invert tool 649

K

Keyer super tool 522
about 522
features 523
inputs/outputs 523
master keyer 526
node select 525
UI 525
workflow 524

keyframing
adding and deleting 683
animation 660
composition browser example 679
cue marks, setting 673
deleting keyframes 683
editing in Animation Editor 682
editing in tool UI 681
enabling Autokey 680
interpolation 660
local controls 672
marking attributes 674
precision editing 685
selecting 673
setting automatically 680
setting keyframes 660
setting manually 676
tool UI example 677
workflow 674
zoom and pan, setting 673

keying 510
about 509
accessing keying tools 513
adding keying tool 513
CGI 512
chrominance 511
cleaning mattes 343
extracting key, Luma Keyer 518
extracting, Diamond Keyer 514
hue 511
luminance 511
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matte cleanup 343
pulling a key 510
saturation 511
See also matte 510
sharpness 511
softness 512
threshold 512
tolerance 512
workflow 512

L

Layer Editor 150, 248
duplicating layers 252
reordering layers 252
transforming layers 288
transforming layers using UI 288
working with 152
working with layers 251

layers
about 241
assigning to a source 248
creating 248
duplicating 252
modifying motion blur 253
reordering 252
selecting 251
setting visibility properties 253
transforming 288
transforming using UI 288
working with 251

layouts
zoom and pan view with

hotkeys 153
Lens Blur tool 400

Lens Blur UI 401
Masking controls 406
Modulation controls 405
Output controls 405

Lens Distort tool, warping 487
lights

about 241
add projector texture 273
adding 269
directional 270
omni 270

set spotlight attributes 270
setting basic properties 271
shadow properties 272
spotlight 270
working with 268

Linear Ramp tool 425
linear reference 628
linked compositions

archive 106
linking

composition 234, 236
local time 690
Log and Delog tools

accessing 627
Login Screen for Windows and

Linux 818
Luma Keyer 518
luminance 511
luminance curves

adjusting 341
LUT

apply to Player 210
remove from Player 210

LUTs
applying 618
monitor, calibrating 618

M

Magnify tool, warping 491
manipulators

enable display in Player 208
mapping, camera 281
mask

garbage 538
masking

about 537
masks

display in Player 203
master keyer

generating matte 526
matching colors

with CC Basics 638
materials

about 241, 257
accessing UI 258
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setting color values 263
setting colors 263
setting properties 258
working with 257

materials UI 258
shader types 258

math functions 747
Math Ops tool 370
matte 510

articulate 510
blending 344, 368
cleaning 343, 356
complementary 510
compositing two mattes 350
difference 510
difference matte 517
edge 510
fixed 510
garbage 510, 538
hold-out 510
refining 356
See also keying 510
softening edges 352
static 510
traveling 510

media
definition 115
import 118
importing 81
mixed resolution 118
physical location 116
supported formats 116

Median Alpha tool 358
Median tool 406
Menu and Taskbar for Mac OS 839
mini-Player 211

use 212
Mirror tool, warping 492
modifying blend 533
modulaiton blur 391
modulation blur

Blur tool 391
Mono tool

accessing 655
creating monochrome image

with 655

morphing
Warp 2D tool 478

Motio tool, vectors 711
motion blur 398
Multi-channel file import

openexr file 133
multi-stream compositing

about 371
workflow 372

N

negative film gamma 628
modifying with Log/Delog

trackball 629, 648
network rendering 229
noise

adding to image 427
Noise tool 427
Notes tool, utilities 812
Numeric Dialogs for Mac OS 841

O

objects
about 240
selecting 251

open Composite Command Prompt
Windows workstation 859

open shell
Linux workstation 859

OpenEXR file
channel import 133

operators
arithmetic 746
comparison 746
compositing 352, 563
precedence 747

Options tab 469
Orient tool 436
Out of Range tool 362
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P

paint
adding layers 574
brush controls and attributes 569
clearing a layer 577
clearing layers 574
deleting layers 574
erasing 592
layer editor 568
stroke controls 572
stroke operations 582
UI 568
wiping layers 574, 578
working with layers 572

pan
in Player 209

Panner tool 437
Pass Through tool 656
Pass Through tool, utilities 813
patches

removing unwanted grays 529
performance

playback 192
Photo Lab

accessing 646
adjusting exposure 647
color correcting 646
processing images 646

Pick List 141
working with 142

Pinch tool, warping 492
pinning

tracking 777
pixel aspect ratio

toggle in Player 206
pixel aspect ratio, information 118
pixel expression language

built-in functions 456
built-in variables 456
comments 456
control statements 456
example procedure 456
example script 456
fundamental types 456
gather operator 456

image processing algorithm
categories 456

interface with Composite
executable 462

numeric constants 456
operators 456
point operator 456
PXL tool 456
qualifiers 456
scatter operator 456
variable declarations 456

pixel expressions 463
about 439
CTL tool 463
PXL tool 440

pixel mask
about 560
example 562
parameters 561

playback
in multiple views 192
performance 192
set frame rate for 197
set mark in/out points 197
set real-time playback

preference 198
set repeat mode for 197
synchronize/separate among

views 199
Player

about 190
apply LUT or color conversion

tool 210
context points 191
default settings 190
display masks/guides 203
display option information 206
display settings for Reaction 244
enable display of

icons/manipulators 208
explained 153
fullscreen Player 213
fullscreen Player and Gate UI 214
fullscreen Player controls 214
grid 201
hardware rendering 194
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hardware rendering turn on/off 205
In-player pixel display 209
mini-Player 211
multiple playback views 192
playback performance 192
region of interest 194
remove LUT or color conversion

tool 210
resolution 193
selecting layers 251
set a region of interest (ROI) 202
set channels for target 195
set frame rate for playback 197
set mark in/out points for

playback 197
set real-time playback

preference 198
set repeat mode for playback 197
set resolution 201
set target for 194
set update point 200
show/hide tiles 204
target 191
tiling 193
toggle pixel aspect ratio 206
use fullscreen 215
use the mini-Player 212
zoom/pan in 209

Player options
display in Player 206

Polar tool, warping 493
Pop-up Dilaogs for Mac OS 842
preferences

overview of project 96
set project 97
set user 168

Premultiply tool 413
presets 140

To Library 77
presets, tool 146
previewing video 172
processing images

with Photo Lab 646
profile functions 751
project UDAs 176

projects
definition 96
imported compositions into project

folders 126
preferences 96
preferences, set 97

Property Area
Animation Timeline 666

published results
about 224
snapshots 228

publishing
compositions 83

publishing to 232
publishing to Wiretap

Wiretap 232
Pulldown tool

autodetecting cadences 803
PAL cadences 803

PXL tool 457
adding parameters 441
applying scripts 441
blur 5x5 446
clouds 446
corner pin 446
customized effects 440
deleting parameters 441
develope mode 441
directional blur 446
distributing scripts 445
emboss 446
erode alpha 446
exporting scripts 441
gamma 446
image processing algorithm

categories 457
importing scripts 441
inputs 440
internal script editor 441
lattice 446
lens flare 446
main tab 441
mandelbrot 446
marble 446
masking tab 441
noise 446
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noise wipe 446
num colors 446
out of range 446
output tab 441
outputs 440
pixel expression language 456
pixel expressions 440
point operator 457
polygon blur 446
presets 446
resetting 441
resetting parameters 441
reverting scripts 441
ripple twirl 446
sharpen 5x5 446
sperical mapping 446
stereo anaglyph 446
user mode 441
wood 446
wood frame 446

Python
monitor executable 97
publish executable 97
restore executable 97

Q

quick gain 636

R

Radial blur 386
Radial Ramp tool 426
random number functions 749
ranges

in CC Histogram 643
Ranges controls

redefining highlights 643
redefining shadows 643

raster paint
about 567
layer behavior 578
layer format 573

Rate Convert tool 695
Reaction

adding to current composition 245

adding to new composition 83, 245
assign layer to source 248
axis 241
basic 3D compositing 242
basic compositing 243
basic compositing workflow 242
basic multilayer compositing 242
building composition using layer

editor 243
camera 241
compositing workflow 242
concepts 240
creating sources and layers 248
layer 241
Layer editor, setting the background

automatically 246
light 241
material 241
objects 240
Player display settings 244
rendering options 290
Schematic, add source 248
Schematic, creating sources and

layers 248
Schematic, setting the background

automatically 246
Schematic, setting the background

manually 246
Schematic, single step, add

source 248
setting composition format 290
setting the background 245–246
setting the background using drop

gate 246
shader 242
sources 240
surface 241
what is 240

Reaction motion blur
adding 292
modifying 253, 280

read-only UDA tag 187
reducing contrast

with CC Histogram tool 642
refractive index 262
region of definition (ROD) 194
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region of interest (ROI) 194
relocating dependencies

archive 108
Remap Alpha tool 358
Remap Color tool

working with curves 653
working with histogram 651

Remap Color tool, color correcting 649
remapping

alpha 358
remove dust, dirt, hair and scratches 380
removing color spill 519
rendering

hardware, turn on/off 205
in Reaction 290
options 290
over the network 229
setting Fx options 290
setting options 290
setting the Reaction composition

format 290
replacing

channels 363
Resize tool 415
resizing

filters 417
fit methods 417
images 415
using animation 418
using Letterbox 418

resolution
mixed 118
Player 193
set for Player 201

resonse curve
Degrain tool 506

resource files
XML 182

restore 104
archive 107

restoring settings
archive 109

result
publishing 228
setting as current 230

retrieving and storing
pixel aspect ratio information 118

rewiring RGB channels 631
RGB

color model 511
RGB channels

rewiring with CC Basics 631
Ripple tool, warping 494
ROD (region of definition) 194
ROI (region of interest)

setting in Player 194, 202
rounding functions 750

S

saturation 511
adjusting with CC Basics 634

Schematic
Reaction, setting the background

automatically 246
Reaction, setting the background

manually 246
Reaction, setting the background

using drop gate 246
scoped UDAs 176
screen degrain 531
search the database

archive, restore 104
set

project preferences 97
Reaction composition,

background 245
Reaction, Player display settings 244
user preferences 168

Set Fill Color tool, color correcting 654
shaders

about 242, 257
shadow matte 268
types 258

shading
how light affects 272

Shadow Matte 268
set parameters 268

shadows
redefining with Ranges controls 643
setting properties 272
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Sharpen tool 408
sharpening

images 408
sharpness 511
Shell

open 859
Slate tool 429
softness 512
Solarize tool

accessing 654
solarizing an image 654

source about 240
sources

connecting to materials 264
creating 248

sRGB image
creating with the sRGB tool 656

sRGB tool
accessing 656

Stabilizing
concepts 755
workflow 757

static matte 510
status

composition 224
stereo viewing

about 374
active shutter glasses 378
passive colored glasses 378
polarized glasses 377
supported graphics hardware 377
supported technologies 377

storing and retrieving
pixel aspect ratio information 118

string substitutions 874
stroke operation

committing operations 568
paint 582
painting the Alpha 585
parts of an image, revealing 586
region of an image, cloning 589
straight line, drawing 585
undoing operations 568
using stencils 592

super tool
Reaction 240

super tools
2D Compositor 339
Garbage Mask 538
Keyer 522
Paint 567
Tracker 754

supported media formats 116
suppressing colors

with CC Basics 637
suppressing spill 533
surfaces

about 241
bilinear 254
modifying 254
working with 254

Switcher tool, utilities 814
synchronizing playback among

views 199

T

target
setting for Player 191, 194

task groups 140, 146
Text Editor and Text Fields for Mac

OS 840
textures

about 257, 264
projector 273

threshold range 512
tiles

show/hide 204
tiling 193
time dilation

See modifying motion blur 280
time functions 751
Time Offset 690

setting 696
time tools

Rate Convert 695
retimer 691
Time Offset 696

timing curves
about 692

To Library preset 77
tolerance range 512
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tool presets 146
tools

2D Compositor 339
2D Transforms 432
Alpha Levels tools 343
Alpha tool 342
Bilinear Ramp 421
Blend & Comp 367
Blend Alpha tools 344
Blend Matte tool 368
Blend tool 366
Blur Alpha 348
Blur tool 385
Channel Extract tool 362
channel processing 361
Channel Replace 363
Channel Rewire tool 364
Checkerboard 423
Clamp Alpha tool 349
Cleanup Alpha tool 349
Color Source 424
Comp Alpha tool 350
Comp Ops tool 369
composition tools 365
Control Edge 352
Convert Depth tool 410
Crop tool 410
Detect Edge 354
Drop Alpha 356
Drop Shadow tool 497
Edge tool 356
Extract Alpha tool 357
Fade tool 357
filtering 379
Flip 435
formatting tools 409
Glow tool 498
image generation 419
Invert Alpha tool 358
Lens Blur tool 400
Linear Ramp 425
Math Ops 370
Median Alpha 358
Median tool 406
Noise 427
Orient 436

Out of Range 362
Panner tool 437
Pick List 141
Premultiply tool 413
Radial Ramp 426
Remap Alpha 358
Remove Dust tool 380
Resize tool 415
Set Alpha tool 360
Sharpen tool 408
Slate 429
transform tools 431
Unpremultiply tool 414
Unsharp Mask tool 408

Tracker
changing color 768
how it works 769
position 770
stabilizing 783
tracking rotation 775
tracking scaling 773

tracker box
resizing 783

Tracker Interface 755
tracking

1-point stabilizing 786
2-point stabilizing 788
4-point 777
correcting errors 782
difficult shots 780
pinning 777
Reference box resetting 766
Reference box resizing 764
reference box, positioning 763
reference point 762
simultaneous stabilizing and

tracking 790
Tracker box resetting 767
Tracker box resizing 764
workflow 757

tracking and stabilizing
about 754

tracking concepts 754
transform tools

about 431
Flip tool 435
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Orient tool 436
Panner tool 437

traveling matte 510
trigonometric functions 750
troubleshooting 233
troubleshooting Wiretap

Wiretap 233
Twirl tool, warping 495
txapp executable 860
txcheck executable 860
txperf executable 862
txversion executable 866

U

UDA
default tag 187
read-only tag 187

UDAs
composition version 176
creating 177
displaying 180
project 176
scoped 176
user 176
using 181

Universal Naming Convention 116
Unpremultiply tool 414
user

interface presets 77
user defined attributes

creating 176
user interface

presets 77
User Interface Elements for Mac OS 839
user preferences

set 168
user UDAs 176
users

example workflows 97
using UDAs 181
utilities

about 805
Comparison tool 806
Notes tool 812
Pass Through tool 813

Switcher tool 814

V

vector functions 748
Vector motion blur with alpha 398
vectors

computing within a
composition 714

Motio tool 711
Show vectors 716

vectors blur 395
Blur tool 395

video preview 172
video tools

about 795
Deinterlace tool 795
Interlace tool 801
Pulldown tool 802

view layouts
four zoom and pan settings 153

views
Layer Editor 150
synchronizing playback 199

W

Warp 2D tool 469
adding link points 474
cropping parameters 475
curve correspondance 474
destination shapes 467–468
fences 467–468
filtering 475
interpolation 469
interpolation parameters 475
link points 474
links 474
links view 477
locking shapes 469
morphing workflow 478
muting shapes 469
naming shapes 469
Options tab 477
Output tab 469, 475
render parameters 475

Index | 903



shape colors 469
shape drawing tab 469
smoothing 469
source shapes 467–468
timing parameters 475
user settings 475
warping parameters 475
workflow 468

Warp 2D tool, warping 467
warping

2D Transforms 478
about 467
cropping and filtering output 482
filters 482
Warp 2D tool 467

warping tools
Crumple 484
Displace 484
Lens Distort 484
Magnify 484
Mirror 484
Pinch 484
Polar 484
Ripple 484
Twirl 484
Warp 2D 467
Wave 484

Wave tool, warping 496
Wiretap

IFFFS libraries on the network 111

network assessing IFFFS libraries 111
workflow

3D 242
administrative tasks 97
basic multilayer 242
compositing 242
keying 512

workflows
export 126
import 126
tools 126

workspace
other workspace functions 187
presets 140
task groups 140, 146
tool presets 146

X

XML resource files 182
UdaMenu 184
UdaPushedToggle 185
UdaTextField 183
UdaValueEditor 184

Z

Z-buffer enabling 292
zoom

in Player 209
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